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Using This User Reference
This User Reference provides detailed information about Verifone's point-
ofsale (POS) devices on a function key-by-function key basis.

Each of the topics are divided into the following sections:
– Overview - This section contains a brief description about each 

topic.
– Using - This section explains how the particular topic or 

function is used to process and manage sales transactions.
– Configuring - This section contains information on how to 

configure the relevant parameters using Configuration Client.
– Reporting - This section contains sample reports with a detailed 

report description.
– Troubleshooting - This section may contain some trouble 

scenarios that may occur along with the steps needed to 
correct them. In some cases the user may need to perform 
procedures that are restricted to higher security levels (i.e. 
manager level as opposed to cashier).

Note:  Refer to the Feature Reference Documents for additional 
information on features. The Feature Reference documents are 
available on Premier Portal. 

Note:  Change the default configuration settings in Configuration Client 
only if you are sure you have to edit the settings. 
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POS Workstations Overview 
Verifone Point of Sale (POS) devices typically use Commander Site Controller as the 
server. 

Topaz 

 

The Verifone® Topaz™ XL workstation is a high-performance, reliable, point-of-sale 
terminal that supports peripherals such as scanners, cash drawers, PINpads, and 
customer displays. The Topaz utilizes the Commander Site Controller to connect to 
payment networks, fuel dispensers, car wash controllers, and loyalty providers. The 
Topaz has the ability to accept all payment options, including cash, checks, credit 
and debit cards, coupons, and various prepaid cards. 

The Topaz has a 15-inch color touchscreen display and 120-key programmable 
keyboard. A virtual receipt is displayed on the screen to display transactions 
information as items are being rung up. The configuration of the Topaz is handled 
through Configuration Client. The Topaz also has a built-in help menu to aid with 
sales transactions. 

Ruby2 
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Ruby2 is equipped with a 15-inch LED-backlit touch-screen interface and a multicore 
processor to allow fast and efficient store and customer management. Ruby2 does not 
have a keyboard interface which gives the site more counter space. The touch screen 
is made of hardened tempered glass making the screen incredibly durable.  It also 
provides full workstation access to store operations such as price changes, store 
updates and software program management. The Ruby2 only works with the 
Commander or RubyCi site controllers. 

RubyCi 

 

The RubyCi is Verifone’s all in one POS and site controller solution. It combines a 
Ruby2 POS with the functionality of the Commander Site Controller in one piece of 
hardware to provide fast, efficient, and complete store management. It enables users 
to have the ability to consolidate as well as upgrade their POS equipment with one 
piece of hardware. 

The RubyCi can interface with additional POS terminals such as the Ruby2 or the 
Topaz XL to expand sales operating capabilities. 

C18 
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C18 is Verifone’s most powerful, integrated POS for convenience stores with 
unsurpassed functionality and versatility. C18’s user interface is made for cashiers 
serving customers who want a frictionless experience. The brilliant, high definition 
screen is easy on the eyes. At an impressive 18.5 inches, there is abundant real estate 
for all sales needs. 

App Selector 

The C18 POS screen can be positioned to Home (Cashier facing) or Flip (Customer 
facing) and can be orientated to render applications in landscape or portrait 
orientations at Home and Flip positions. 

This hardware capability facilitates running multiple cashier and customer facing 
applications in portrait and landscape orientations. 

Note: Refer to the App Selector User Reference documentation for more 
information on this feature. The User Reference is available on the Premier 
Portal. 
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Commander Site Controller 
The Commander™ Site Controller is a high-powered server that increases the capacity 
and functionality of Verifone’s ethernet capable Point of Sale (POS) workstations by 
extending the processing and communications bandwidth for managing peripherals. 

Future needs are designed into the hardware to provide support for additional serial 
ports and CPU boards along with additional fan and/or power connection that may be 
needed as a result. Use of these expansion capabilities will be determined by 
Verifone. System peripherals, such as fuel dispensers, dispenser card readers (DCRs), 
and car wash controllers connect directly to the Commander Site Controller.  

In addition to Configuration Client, Commander also has other site management 
software: Report Navigator, Transaction Manager and Commander Console. Report 
Navigator is used to view reporting data for the store. Reporting information such as 
the close day report can be configured to include a multitude of report options. 
Transaction Manager allows for site transaction logs and data to be accessed from the 
Commander or archived locally. Commander Console enables multiple store reporting 
data to be consolidated into one place for easy visibility to monitor and track sales 
trends. 

 

The Commander Site Controller contains a built in V950, referred to as the V950SC. 

When a router is installed in this configuration, it can be configured so that the 
Commander Site Controller’s V950SC can: 

• Receive software upgrades remotely using Verifone’s Remote Software 
Download feature. 



Commander Site Controller 

28 

• Connect with the Verifone Helpdesk for remote troubleshooting and 
diagnostics. 

Configuration Client 

The Commander Site Controller can receive configuration changes through the use of 
Configuration Client.  Configuration client is a web-based utility that allows store 
personnel, Verifone Authorized Service Contractors, and Verifone Helpdesk to modify 
site information.  To utilize Configuration Client you must be using a supported web 
browser. The supported Web Browsers are: 

• Chrome versions 60 or higher 

• Firefox versions 53 or higher 

• Internet Explorer versions 8 or higher 

1. Key in the URL https://192.168.31.11/ConfigClient.html into the Web Browser 
and press [Enter]. 

 

2. Enter User Name and Password. 

3. Click Login. 

One-Time Password (OTP) Prompt 

In Base 47 and higher, there is an additional prompt for a one-time password (OTP) 
implemented into Configuration Client. As part of PCI/DSS v3.2 Requirement 8.3.1, 
this incorporates a multi-factor authentication for all non-console access into the 
Cardholder Data Environment (CDE) for personnel with administrative access. 

  

https://192.168.31.11/ConfigClient.html
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Menus that have this prompt include: 

• Security > Manage Users (Includes Roles) 
• Initial Setup 
• Date & Time 
• Local Area Network Config 
• VHQ Configuration 
• Payment Controller > POS Configuration 
• EPS Configuration > EPS Global Configuration 
• Full Service Attendant Configuration 
• InComm Configuration 
• LINQ3 Lottery Configuration 
• Payware Fleet and Loyalty Configuration 
• PCATS Loyalty Configuration 
• Proprietary Fleet Configuration 
• Punch Card Loyalty Configuration 
• Network Configuration (network references the name of the network 

installed, such as Buypass) 
• Loyalty Card Configuration 

 
While the preceding is the list of functions In Base 47 that include the OTP prompt 
within Configuration Client, it may be expanded to other areas and new features in 
future releases. 

 
 

Clicking on Guidelines to generate an OTP (see image above) will display the 
3 different ways to obtain the OTP. 

 
 

The OTP is 4 digits in length. When generated using any of the 3 methods above, it 
will appear on the 7- Segment status display of the site controller (displaying 2 
numbers at a time; the period indicates the first set of numbers). If generated from 
the POS/register, it will also display on the POS screen. 
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The OTP is directly tied to the user’s Configuration Client login session. If the OTP is 
generated and correctly entered, the OTP will be active until the user logs out or the 
Configuration Client session times out for inactivity (15 minutes). The OTP does not 
require re-entry after it has been saved for the session, meaning the user can go 
between menus that require entry, without being prompted. 

Note: The OTP requirement applies to backing up and restoring files to the 
site controller using SMS Import/Export. Files that require an OTP may not be 
restored to the site controller, and an error message (“One Time Password 
Required”) appears when attempting to do so. Clicking OK on the error prompt 
allows the rest of the import or export to proceed. Clicking Abort aborts the 
remainder of the import or export. In newer versions of SMS Import/Export, 
items that require OTP are removed from the backup and restore list. 
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Configuration Client Forms 
This topic contains all the Commander Site Controller Config Client forms. The 
configuration forms in this topic are described in the menu order displayed on the 
Commander Configuration Client.  

 

Security 

Manage Users 

Configure Users 

Use Security > Manage Users > Configure Users to add, edit, or remove users.  The 
current users are listed on the left side of the form. 
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Field/Button Allowable Value/Function 

Add Click to add a new user. 

Delete Select an existing user and click Delete to remove the 
user from the Users list. 

Name Enter the name of the user (number of characters are 
unlimited). 

Disallow Login Select to disallow the selected user to login to 
Configuration Client. 

Employee 

Assign an employee type to the user by selecting from 
the Employee drop-down list.  

The employee types with security levels are created 
using Security > POS Security > Employees form. 

Roles 
Roles are set up on the Configure Roles tab.  The 
roles assigned to the selected user are displayed in 
this box. 

Edit Click to display the available roles. Select one or 
more roles for the user and click Done. 

Password Settings 

Min Length Enter a minimum length for the user’s password (7 - 
30). 

Max Length Enter a maximum length for the user’s password (8 -
30). 

# of Days to Expire 

Enter the number of days until the password expires. 

Note: The password should be changed before it 
expires.  

Force Change on Next 
Login 

Select to make the user change their password the 
next time they log in. 
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Field/Button Allowable Value/Function 

New Password 
Enter the user’s new password.  The new password 
should meet the requirements of the password 
guideline. 

Confirm New Password Enter the password again to confirm. 

Password Guidelines Click to display password guidelines. 

Secure User Settings 

‘Secure user’ is a user who can access PA-DSS sensitive Card Holder Data (CHD) 
in ‘EPS Secure Reports’ from POS via the Network Manager’ menu. POS prompts 
for secure employee ID and secure user password prior to processing this menu 
item.  

To avoid having to type username on POS keyboard, this feature allows 
associating a POS employee ID to a user. When POS prompts, secure user must 
enter their ‘secure employee ID’ and the PA-DSS compliant ‘user’ password. On 
successful validation, PA-DSS sensitive Card Holder Data (CHD) is exposed in the 
EPS reports. If validation fails, masked PAN is provided in the EPS Reports. 

Secure Admin is a ‘secure user’ who can manage ‘secure user’ as well as ‘secure 
admin’ accounts. 

Note: The 'Secure User Administration' section is displayed when you log in as 
'manager' (the default secure user admin account) or any user that is configured 
as a secure admin. 

Secure User ID Enter the Secure User ID. 

Secure User 
Administration 

Enable if the user has secure user administration 
rights. 
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Field/Button Allowable Value/Function 

Verifone C-Site Management  

The Verifone C-Site Management application allows remote configuration of data 
for the POS system through the web. Without visiting each location changes and 
updates can be done remotely for any or all locations. These updates can be 
done selectively or all at once for all the POS devices from the web application. 

OTP is a one-time password generated by the Commander Site Controller for 
accessing certain menus. Verifone C-Site Management now supports remote 
generation and retrieval of OTP. Passwords generated this way are sent to the 
email address associated with the Verifone C-Site Management user login.  

Note: Refer to the Verifone C-Site Management User Reference 
documentation for more information on this feature. The User Reference is 
available on Premier Portal. 

User ID  
Add the same Verifone® C-Site Management Email 
address that was configured as part of OTP settings in 
the Verifone® C- Site Management application and 
Click Save.  

Configure Roles 

Use Security > Manage Users > Configure Roles to assign permissions, add new roles, 
edit and delete current roles, and add and delete functions from each role. These 
roles are assigned to users.  

The current roles are listed on the left side of the form. 

Addition, removal, or modification of the roles can only be performed by a secure 
administrator. The “Secure Role” attribute allows secure administrators to specify 
whether a role's access should be limited only to secure users. If this attribute is set, 
the role can only be assigned to a secure user. 
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To Edit a Role 

1. Select the role from the Roles list. 

2. Click Edit at the Functions box. 

3. Change the name in the Role Name text box. 

4. To edit the function assignment to the role, enable or disable the functions in 
the Functions form.  

5. Click Done in the Functions form. 

6. Click Save. 
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To Add Role and Add Functions to Role 

1. Click New. 

2. Enter the name in the Role Name text box. 

3. Click Edit at the Functions box to assign functions to the role.  

4. Select the function(s) for the role from the Functions form. 

5. Click Done in the Functions form. 

6. Click Save. 

To Delete a Role 

1. Select the role from the Roles list. 

2. Select Delete. 

3. Click Save. 

Role Function Description 

The following is the list of role functions and their descriptions: 

Function Description Additional Info 

allowAllCsrRpts Allow all cashier reports 
view 

Allow user to view all 
cashier reports that are 
available 

allowOpenCsrRpts Allow open cashier reports 
view 

Allow user to view open 
cashier reports (current 
and/or reports with MOP 
amounts not yet filled) 

allowRestricted Allow Restricted Access   

bypassEmployeeId Bypass employee id 
validation 

Bypass employee id 
validation in POS security 
functions 
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Function Description Additional Info 

cbeginupgrade Request Auto Upgrade 
Engine to begin upgrade 

  

ccarwashdisable Disable Car Wash   

ccarwashenable Enable Car Wash   

cclosedaynow Close Day Now   

ccwpaypointinit Initialize Carwash 
Paypoint 

  

ccwpdclose Carwash Paypoint Period 
Close 

Performs Period Close On 
Carwash Paypoint 

cdcrdriverinit Initialize DCR Driver   

cdcrinit Initialize DCR Initialize DCRs 

cdisablelogin Disable Helpdesk Login   

cenablelogin Enable Helpdesk Login   

cfeatureenablement Update a feature Update Licensed Features 

cFPDinit Init FP Display Config   

cfueldrvinit Initialize Fuel Driver   

cfuelinit Initialize Fuel   

cfuelprices Download Fuel Prices   

changepasswd Change Password   

cping Pings a given destination.   

crefreshcfg Refresh Configuration   

crefreshepsconfig Refresh Eps Config   
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Function Description Additional Info 

cswupgradepkg Update software   

diagdeleteclass Delete Diagnostic Class Delete a previously loaded 
dynamic diagnostic 
classfile 

diagloadclass Load Diagnostic Class Load a classfile to be run 
as dynamic diagnostic 

diagrunclass Run Diagnostic Class Execute a dynamic 
diagnostic class 

findfilename View report period 
filename 

  

getPLUsFromGempro Send plu.dat to NEWPRO Send plu.dat from GEMPRO 
to NEWPRO 

notifyamber Notify amber alert 
updates 

Notify Controller of amber 
alert updates 

releaseCredential Release the credential   

repeatEvent Repeat last event Notify specified event 
listener of the last 
occurrence of the 
specified event 

sendPLUsToGempro Send plu.dat to GEMPRO Send PLU data from 
NEWPRO to GEMPRO 

uagevalidationcfg Update age validation 
config 

  

ubannercfg Update banner config   

ubluelawcfg Update blue law config   

ucarwashcfg Update carwash config   
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Function Description Additional Info 

ucashaccsite Update cash acceptor 
config 

  

ucashierenddraweramts Update Cashier End 
Drawer Amounts 

  

ucashierreportreviewstatus Update Cashier Report 
Review Status 

  

ucashiertrackingcfg Update cashier tracking 
configuration 

  

ucouponfamcfg Update coupon family 
config 

  

ucurrencycfg Update currency config Update currency dataset 
configuration 

ucwpaypointcfg Update carwash paypoint 
config 

  

udatetime Set Time and Date Set the internal clock on 
Controller, including 
timezone and daylight 
savings time parameters 

udcrheadercfg Update DCR header config   

udcridlescreencfg Update DCR Idle Screen 
config 

Update DCR Idle Screen 
dataset configuration 

udcrmessagecfg Update DCR message 
config 

  

udcrtrailercfg Update DCR trailer config   

udiscountdenomcfg Update discount denom 
config 

  

uecheckcfg Update Echeck Config   
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Function Description Additional Info 

uemvcfg Update EMV Configuration Update All EMV 
Configuration Settings 

uemvinit Update EMV Initialization Update All EMV 
Initialization Settings 

uepsprepaidcfg Update EPS Prepaid Card 
Config 

  

uesafecfg Update Esafe Config   

ufeecfg Update fee config Update fee dataset config 

ufepcardcfg Update Fep's card 
configuration parameters 

Update Fep's card 
configuration parameters 
like various limits, 
enable/disable card 

ufepcardtypecfg Update Fep's card 
configuration parameters 
based on card Type 

Update Fep's card 
configuration parameters 
based on card Type like 
limits, enable/Disbale etc. 

ufepcfg Update Fep's configuration 
parameters 

Update Fep's configuration 
parameters like network, 
cashback etc 

ufoodservicecfg Update Food Service 
Config 

  

uFPDcfg Update FP Display Config   

ufuelcfg Update Fuel Site 
Configuration 

Update the fueling 
dispensers, products, 
mops, tanks, and prices 
for the site 

ufuelprices Update Fuel Prices Update the fueling prices 
for the site 
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Function Description Additional Info 

ufueltaxex Update Fuel Tax 
Exemption Config 

  

ufunctionlist Refresh function list   

ugrouplist Update Group List 
Configuration 

Update available report 
groups 

uifsfcfg Update IFSF Network 
Config 

  

uinhouseacctcfg Update in-house account 
config 

Update in-house account 
dataset config 

ukioskorder Commit kiosk order   

ulogocfg Update logo config Update logo dataset config 

uloyaltycardcfg Update Loyalty Card 
Configuration 

  

uloyaltycardtypecfg Update Loyalty Card Type 
Configuration 

  

uloyaltyglobalcfg Update Global Loyalty 
parameters 

  

uMaintenance Update NAXML 
maintenance dataset 

Update configuration 
datasets as NAXML 
maintenance documents 

umaintfprht Update maint fprht   

umaintpostal Update maint postal   

umaintregistrationkey Update maint registration 
key 

  

umainttelephone Update maint telephone   
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Function Description Additional Info 

umainttotalizers Update maint totalizers   

umanagedcfg Update Managed 
Configuration 

  

umanagedmodulecfg Update Configuration Update Module 
Configuration 

umanageradjustment Update Manager 
Adjustments 

  

umanagercorrection Update Manager 
Corrections 

  

umenucfg Update menu config Update menu dataset 
config 

umobilecfg Update Mobile 
Configuration 

  

umopcfg Update MOP config Update MOP dataset config 

umwscashmovementreport Update MWS Cash 
Movement Info 

  

unetposcfg Update Network 
Configuration 

Update POS related 
Network Configuration 

unetworkcfg Update Network Settings Update Network 
Settings(IP, route, etc..) 

unetworkpartcfg Update network settings   

upaymentcfg Update payment config Update payment dataset 
config 

upinpadmsgcfg Update Pinpad Idle and 
Swipe messages 

  

uPLUCacheList Update PLU cache list Update the list of PLUs 
cached on POS 
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Function Description Additional Info 

uplupromocfg Update PLU Promo config Update PLU Promo dataset 
config 

uPLUs Update PLU dataset   

upolicycfg Update policy config   

upopcfg Update pop config   

uposcfg Update POS config Update POS dataset config 

upospaymentconfig Update POS Payment 
Configuration 

  

upossecurity Update POS security 
config 

Update POS security 
dataset config 

uprepaidcfg Update Prepaid Card 
Config 

  

upscdcrcfg Update DCR config Update DCR dataset config 

upscdcrkeycfg Update DCR Key config Update DCR Key dataset 
config 

uregistercfg Update register config Update register specific 
dataset config 

ureportcfg Update Report 
Configuration 

  

ureportlist Update Report List 
Configuration 

Update the order of 
available reports 

ureportstatus Update Manager Review 
Status 

  

urestrictionscfg Update restriction config Update restriction dataset 
config 
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Function Description Additional Info 

usalescfg Update sales config   

usapphireprop Update Controller system 
properties 

  

uscreencfg Update POS Screen 
Configuration 

  

usecuritylogservercfg Update Security Log 
Server IP Address 

  

uslogancfg Update slogan config Update slogan dataset 
config 

usoftkeycfg Update softkey config Update softkey dataset 
config 

utaxratecfg Update tax rate config Update tax rate dataset 
config 

utlssite Update TLS config   

utriggerpullcfg Update Trigger Pull 
Configuration 

Update All Trigger Pull 
Configuration Settings 

uuseradmin User Administration User admin update 

uvendingmachinecfg Update Vending Machine 
config 

Update Vending Machine 
dataset config 

uvipercfg Update Viper's site level 
Config 

Update Viper's site level 
Config like various limits, 
and pop configuration 

vagevalidationcfg View age validation config   

validate Validate the credential   

vappcfg View App Specific Config   
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Function Description Additional Info 

vAppInfo View App Info View App Version Info 

vappmodules View App Module Names View the list of Application 
noted module names. 

vbannercfg View banner config   

vbluelawcfg View blue law config   

vcarwashcfg View carwash config   

vcashaccsite View cash acceptor config   

vcashierpdlist View cashier report period 
list 

View list of cashier report 
periods available 

vcashierrept Cashier Reports View the cashier period 
reports 

vcashiertrackingcfg View cashier tracking 
configuration 

  

vcashiertrackingrept View cashier tracking 
report 

  

vcouponfamcfg View coupon family config   

vcurrencycfg View currency config View currency dataset 
config 

vcwpaypointcfg View carwash paypoint 
config 

  

vcwpaypointpdlist View cw paypoint period 
list 

View list of cw paypoint 
periods available 

vcwpaypointpdrept View cw paypoint period 
report 
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Function Description Additional Info 

vdatetime Get Time and Date View the Controller 
internal time 

vdcrheadercfg View DCR header config   

vdcridlescreencfg View DCR Idle Screen 
config 

View DCR Idle Screen 
dataset config 

vdcrmessagecfg View DCR message config   

vdcrtrailercfg View DCR trailer config   

vdiscountdenomcfg View discount denom 
config 

  

vecheckcfg View Echeck Config   

vemvcfg View EMV Configuration View All EMV Configuration 
Settings 

vemvinit View EMV Initialization View All EMV Initialization 
Settings 

vepsprepaidcfg View EPS Prepaid Card 
Config 

  

vepssiteassetdata View Site Asset Data of 
EPS 

  

vesafecashierrept ESafe Cashier Reports View the cashier period 
reports 

vesafecfg View Esafe Config   

veventset Register event listener Register {alias, url} pair as 
event listener for a 
specific event type 

veventunset Unregister event listener Unregister the specified 
event listener for a 
specific event type 
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Function Description Additional Info 

vfeaturelist View feature list View list of installed 
features 

vfeecfg View fee config View fee dataset config 

vfepcardcfg View Fep's card 
configuration parameters 

View Fep's card 
configuration parameters 
like various limits, 
enable/disable card 

vfepcardtypecfg View Fep's card 
configuration parameters 
based on card Type 

View Fep's card 
configuration parameters 
based on card Type like 
limits, enable/Disbale etc 

vfepcfg View Fep's configuration 
parameters 

View Fep's configuration 
parameters like network, 
cashback etc 

vfepdetails View Basic Fep Details View Basic Fep Details like 
the available commands, 
enabled, is primary etc 

vfoodservicecfg View Food Service Config   

vFPDcfg View FP Display Config   

vfuelcfg Update Fuel Site 
Configuration 

Update the fueling 
dispensers, products, 
mops, tanks, and prices 
for the site 

vfuelposstat View fueling position 
status 

  

vfuelprices View In-effect Fuel Prices View the in-effect fueling 
prices for the site 
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Function Description Additional Info 

vfuelrtcfg In-effect Fuel Site 
Configuration 

View the in-efectfueling 
dispensers, products, 
mops, tanks, and prices 
for the site 

vfuelrtprices View In-effect Fuel Prices View the in-effect fueling 
prices for the site 

vfueltaxex View Fuel Tax Exemption 
Config 

  

vfueltotals Fuel Totals Report View the electronic 
dispenser report for a 
given period 

vfueltotalsz Compressed Fuel Totals 
Report 

View the electronic 
dispenser report for a 
given period (gzip) 

vgrouplist View Group List 
Configuration 

Review available report 
groups 

vifsfcfg View IFSF Network Config   

vinhouseacctcfg View in-house account 
config 

View in-house account 
dataset config 

vlogocfg View logo config View logo dataset config 

vloyaltycardcfg View Loyalty Card 
Configuration 

  

vloyaltycardtypecfg View Loyalty Card Type 
Configuration 

  

vloyaltyglobalcfg View Global Loyalty 
parameters 

  

vMaintenance View NAXML maintenance 
datasets 

View configuration 
datasets as NAXML 
maintenance documents 
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Function Description Additional Info 

vmaintfprht View maint fueling point 
running hose totals 

  

vmaintpostal View maint postal code   

vmaintregistration View maint registration   

vmainttelephone View maint telephone 
number 

  

vmainttotalizers View maint totalizers   

vmanagedcfgstatus View Managed Update 
Status 

  

vmanagedmodulecfg View Configuration View Current Module 
Configurations 

vmenucfg View menu config View menu dataset config 

vmobilecfg View Mobile Configuration   

vmobilehostlist View Hosts List View Mobile Hosts List 

vmobilereport View Mobile Report   

vmobilereportlist View Reports List View Mobile Reports List 

vmoddescmap View Module/Descriptions 
map 

View mapping of module 
names to their 
descriptions. 

vmodulecfg View a Module 
Configuration 

View Configuration of a 
given named module. 

vmodulecfgref View Module Referentials   

vmopcfg View MOP config View MOP dataset config 
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Function Description Additional Info 

vMovement View NAXML movement 
reports 

View reports as NAXML 
movement documents 

vmwscashierdraweramts View Cashier Drawer 
Amounts 

  

vmwscashmovementreport View MWS Cash Movement 
Report 

  

vmwslog Manager workstation 
event logs 

Report to indicate Manager 
workstation event logs 

vmwsposjournal View manager work 
station event in 
POSJournal reports 

View manager workstation 
related posjournal reports 

vnetposcfg View Network 
Configuration 

View POS related Network 
Configuration 

vnetworkcfg View Network Settings View Network Settings(IP, 
route, etc..) 

vnetworkmenu View Network Menu xml   

vpaymentcfg View payment config View payment dataset 
config 

vpayrollpdlist View Ruby payroll period 
list 

View list of Ruby payroll 
periods available 

vpayrollpdlist2 View payroll period list View list of payroll periods 
available 

vpayrollrept Payroll Reports View the payroll period 
reports 

vpayrollrept2 Payroll Reports (new 
format) 

View the payroll period 
reports (new format) 

vpendmdlcfg View Pending 
Configurations 
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Function Description Additional Info 

vperiodlist View period list View list of periods for 
which reports are 
available 

vpinpadmsgcfg View Pinpad Idle and 
Swipe messages 

  

vPLUCacheList View PLU cache list View the list of PLUs 
cached on POS 

vplupromocfg View PLU Promo config View PLU Promo dataset 
config 

vPLUs View PLU dataset   

vPLUUpdateStatus View PLU Update status View PLU Update status 
info 

vpolicycfg View policy config   

vpopcfg View pop config   

vposcfg View POS config View POS dataset config 

vposjournal View NAXML POSJournal 
reports 

  

vpospaymentconfig View POS Payment 
Configuration 

  

vpossecurity View POS security config View POS security dataset 
config 

vprepaidcfg View Prepaid Card Config   

vproprietarynetworkmenu View Proprietary Network 
Menu xml 

  

vpscdcrcfg View DCR config View DCR dataset config 
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Function Description Additional Info 

vpscdcrkeycfg View DCR Key config View DCR Key dataset 
config 

vpsinfo View process table - Text View process table and 
thread specific process 
table - Text 

vrefinteg View support doc View referential integrity 
support document 

vregistercfg View register config View register specific 
dataset config 

vreportcfg View Report Configuration   

vreportlist View Report List 
Configuration 

Review the available 
reports 

vreportpdlist View report period list View list of report periods 
available 

vreportstatus View Manager Review 
Status 

  

vrestrictionscfg View restriction config View restriction dataset 
config 

vrubyrept Ruby Reports View the processed reports 
for the site organized by 
period 

vsalescfg View sales config   

vsalesnetworkmenu View Sales Network Menu 
xml 

  

vsapphireprop View Controller system 
properties 

  

vscreencfg View POS Screen 
Configuration 
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Function Description Additional Info 

vsecuritylogservercfg View Current Security Log 
Server IP Address 

  

vsiteassetdata View Site Asset Data   

vslogancfg View slogan config View slogan dataset config 

vsoftkeycfg View softkey config View softkey dataset 
config 

vsyslog View system log - Text View system log (syslogd)- 
Text 

vsysresourcesmap View System Resource 
Mappings 

  

vtaxratecfg View tax rate config View tax rate dataset 
config 

vthemecfg View Screen Themes   

vtilleventreport View Till Event Reports   

vtlogpdlist View T-Log period list View list of periods for 
which reports are 
available 

vtlssite View TLS config   

vtransset Period Reports with fully 
masked card holder data 

Review reports for the site 
- fully masked card holder 
data 

vtranssetz Compressed Period 
Reports with fully masked 
card holder data 

Review reports for the site 
(gzip) - fully masked card 
holder data 

vtriggerpullcfg View Trigger Pull 
Configuration 

View All Trigger Pull 
Configuration Settings 
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Function Description Additional Info 

vupgradesummary View Upgrade Summary 
Report 

  

vuseradmin View User configuration User admin view 

vvendingmachinecfg View Vending Machine 
config 

View Vending Machine 
dataset config 

vvipercfg View Viper's site level 
Config 

View Viper's site level 
Config like various limits, 
and pop configuration 

vviperpdlist Allow Viper period list 
view 

View available periods on 
Viper 

vviperrept Viper reports View network reports from 
Viper 

Manage Devices 

The Manage Devices form is used to add and enable external POS devices like the 
Attendant Payment Terminal and Carbon Commander Workstation.  

Note: Refer to the Attendant Payment Terminal and Carbon Commander 
Workstation Feature References for more information on this feature. The 
Feature References are available on Premier Portal. 

 

1. In Commander Config Client, go to Security > Manage Devices. 

2. Click on Guidelines to generate a token, to read the guidelines. 
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3. Click Add to start adding the terminals. 

 

4. Enter the external POS ID in the Terminal ID field. The ID should be between 
151 and 199. Each application type should have a unique ID. This terminal ID 
should be entered as the POS ID for the terminal while configuring the 
terminal from Devices > Attendant Payment Terminal > Terminal.  

5. Select the application type from Application Type drop-down. 

6. Add a description for the terminal to help identify the terminal.  

7. Get the IP address and port for the terminal from the IT team. 

8. Select Enable to enable the device. 

9. Click Save. A one-time password (OTP) is required to save the configuration.  

10. Click Generate OTP and enter the OTP generated on the Commander Site 
Controller display. 
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11. After save is successful, 

a. User can see a ‘Generate’ button in ‘Token Action’ column of the form. 

b. User will not be allowed to modify the ‘Terminal ID’ of the saved entry. 

12.  On clicking ‘Generate’ button, token is sent to the corresponding device that 
is configured from Devices > Attendant Payment Terminal > Terminal. 

13. APT device is expected to accept the token and send the details like serial 
number, model, version, etc. to Commander Site Controller. 

14. When the Commander Site Controller receives a response from the device, 
‘Serial number’ and ‘Status’ columns are updated on the Config Client form 

15. Once token generation is successful, user will not be allowed to modify the 
‘Application Type’ of the device entry 

POS Security 

Employees 

Use to edit, add, and delete employees.  In addition to logging in and out of the 
register, this employee information is used for the Payroll Report, Summary by 
Register Report, and Summary by Cashier Report. The current employees are listed on 
the left side of the form. 
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Field/Button Allowable Value/Function 

Name Assign a name for employee. Alphanumeric, 1 - 30 
characters. 

Employee Number 

Assign a unique employee number, such as a company 
assigned ID, to identify the employee for internal and 
payroll purposes. Alphanumeric, 1 - 15 characters. 

The Employee Number is used for the Employee 
Number Login functionality and for security validation 
when a cashier does not have a high enough security 
level to complete a function such as applying a 
discount. 

Security Level 

Select the employee’s security level. The employee 
has access to all functions that have a security level 
less than or equal to the security level assigned. 

Can Cashier 
Select to allow the employee to perform cashier 
functions when in Sales mode. 

New Password 
Enter the password that the employee must use to 
clock in or out. Alphanumeric, 1 - 8 characters. 

Confirm New Password Enter the password again to confirm. 



Configuration Client Forms 

58 

Field/Button Allowable Value/Function 

Delete Select to delete the selected employee information. 

Security Ctrls 

Use to assign a security level to submenu items in the list. The Items in the list are 
reports or non-sales functions. These security levels correspond to the Security levels 
assigned to each employee. Only the entries in the Security Level column can be 
changed. Only employees with the assigned security level can view these reports or 
perform these non-sales functions. 

 

Select a security level from the drop-down list. 

Sales Functions Security 

Use to assign a security level to the following sales functions in the list:  

• Apply Updates (MUP) 

• Safe Drop Correction (SDC) 

• Refund (REF) 

• Void Ticket (VTI) 

• Void Line (VLI) 
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• Price Override (POR) 

• Discount (MDC) 

• Suspend (SUS)  

• No Sale (NSA) 

• Payout (POU) 

• Error Correct 

Only employees with the assigned security level can perform these functions.  

 

When the user clicks a security level and Apply All is selected, the value is applied to 
all the sales functions.  

The user can also configure any of the functions independently. Default value for 
Payout is 7 and Default value for Apply Updates is 7. Default value for all the other 
functions is 0. 0 indicates that the function does not require a security check and any 
employee can perform the function. 

Site Security 

The POS Pairing process establishes a trust relationship between the Commander and 
each Verifone POS Workstation and creates secure communication links. It is similar 
to where a cellphone is paired to a speaker or automobile dash display. 
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The POS workstation pairing process is strongly recommended by Verifone to be 
performed on the same day the system is Auto Upgraded. After an auto upgrade, each 
Verifone POS displays messages that the system needs to be paired. 

Note: Refer to the POS Pairing Feature Reference documentation for more 
information on this feature. The User Reference is available on Premier Portal. 

Pairing after the initial Auto Upgrade, Pairing Expired/Revoked 

If the POS displays the “Sec. Alert - Pairing Invalid” or the “Sec. Alert - Pairing 
Required” message, follow these steps to pair the Verifone POS Workstation with the 
Commander. The POS Workstation displays one of the two messages below at login to 
Sales or between each transaction in Sales. 

 

 

1. On the POS Workstation, navigate to CSR Func > Maintenance Menu. 
Press [Perform POS Pairing]. 
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2. A message asking to perform POS pairing displays, press [Yes].   

 

3. A message “Rebooting to start the pairing process...” will briefly display. The 
POS will reboot and then the “Pair POS” screen displays. 
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4. At Configuration Client and using the Manager credentials, navigate 
to Configuration Client > Security > Site Security. 

5. An OTP is required to complete the process. Press the [Generate OTP] button. 
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6. The “OTP has been generated. Please read it from the Commander Site 
Controller’s status display.” confirmation message displays. Press [Ok] to 
continue. 

 

7. Read the OTP digits from the Commander. Enter the four OTP digits into the 
text box and then press [OK]. 

 

8. The Site Security form opens. Press [Start Pairing Service]. 
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9. A confirmation message stating “Pairing service is started” displays. 
Press [OK] to continue. 

 

10. Go back to the POS Workstation. Press [Pair POS]. 
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11. A Pairing OTP dialog box displays on the POS. 

 

12. Navigate to Configuration Client > Security > Site Security. Press [Retrieve 
Pairing OTP]. 
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13. A “Pairing session OTP” dialog box displays. 

 

14. Go back to the POS workstation. Enter the 6-digit Pairing session OTP code 
from Configuration Client into the “Pairing” dialog box. 
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15. Press [OK]. The message “Processing, please wait...” displays and then after a 
moment, “Successfully Paired” displays. 
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16. Press [OK] to continue. A message “Pairing completed, preparing to start POS 
application...” displays. 

 

17. Repeat these steps if: 

• Pairing was not successful 
• The site has more than one POS Workstation 
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Pairing the POS Workstation after New Installation 

After a new installation, the POS Workstation displays the Pair POS screen below after 
it boots up. Follow steps 4 to 17 above.   

 

Revoke All Trust 

If a workstation needs to be removed for repair or sent to another store, use the 
following steps to Revoke All Trust from the Pairing Relationship. 

1. On the Site Security form at Configuration Client > Security > Site Security. 
2. An OTP is required to complete the process. Press the [Generate OTP] button. 
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3. The “OTP has been generated. Please read it from the Commander Site 
Controller’s status display.” confirmation message displays. Press [Ok] to 
continue. 

 

4. Read the OTP digits from the Commander, Enter the four OTP digits into the 
text box and then press [OK]. 

 

5.  The Site Security form opens. Press [Revoke All Trust]. 
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6. A confirmation message stating “This action will remove all prior pairing 
relationships. All POS Workstations will need to be paired again. Are you sure 
you want to continue?” displays. Press [Yes]. 

 

7. The “Processing request. Please Wait...” message displays before the 
successful message. Press [OK]. 

 

 

8. Follow the steps in “Pairing after the initial Auto Upgrade, Pairing Expired/ 
Revoked” section to pair the other POS Workstations. 

Security Log Server 

Syslog is a way for network devices to send event messages to a logging server – 
usually known as a Syslog server. The Syslog protocol is supported by a wide range of 
devices and can be used to log different types of events. For example, a router might 
send messages about users logging on to console sessions or a web-server might log 
access-denied events. 
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This form is used to report security and OS related events to the configured server. 
Enter the log server’s IP address in this form.  

A one-time password (OTP) is required to open and edit this form. Click Generate OTP 
and enter the OTP generated on the Commander Site Controller display to the One-
Time Password form.  

 

The following is how the security logs appear on the server display: 

 

My Profile 

Note: Refer to the Password Reset Feature Reference for more information on 
this feature. The Feature References is available on Premier Portal. 

Using this menu, a Config Client user can reset their own password without calling the 
Helpdesk.  The primary benefit of this feature is to reduce the number of calls 
generated to the Helpdesk. 
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Adding or Modifying Challenge Questions 

For the config client users to reset their own password, a set of challenge questions 
and answers should be added. The questions are chosen from a drop-down list. 

 

 

If users do not setup the challenge questions, every time they login to Config Client, 
they get the following reminder: 

 

Change Password 

After logging in, a user can change password using the Change Password menu that 
can be assessed from Security > My Profile.  
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Forgot Password  

“Forgot Password” link on login page of Config Client or Manager Workstation displays 
a prompt where user must enter the username and click Submit to start the process of 
resetting password.  

 

If the user doesn’t already have challenge questions set or if the username doesn’t 
exist, the server shows an error. 

 

If the challenge questions are set, any two of the questions are shown for the user to 
answer.  
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On answering the questions right, the user is prompted to enter a new password.  

 

 

Initial Setup 

Date Time 

The Date & Time Configuration form is used to verify or edit the date, time, and time 
zone on the Commander Site Controller. 
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Select the date, month and year from the drop-down list boxes. 

The displayed time is the current time. To change the time, select the time from the 
drop-down list boxes. 

Time Zone 

Use to select the time zone in which your site is located. 

NTP Server 

Enable to get the time from the Network Time Protocol (NTP) server instead of the 

system clock. This section can be used to configure the IP address of the NTP server. 

Registration 

The Registration form presents information that must be supplied to the Verifone 
Technical Support Center in order to obtain a Registration Key. 

Call the Verifone Technical Support Center at (888) 777-3536. The Support Center will 

process the registration while you are on the phone. 

Note: Registration is only done once, at the time of installation. 
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Registration 

Enter the Registration Key supplied by the Verifone Technical Support Center. 

View Feature Info 

The Feature Information form displays the options installed on the system. To view 
the entire list, select the last item and press the down arrow on your keyboard. Click 
Print to print the entire list. 

 

Maintenance Configuration 

Refer to Maintenance Configuration 

System Properties 

Use to select, update, and save System Properties. 

Detailed descriptions of the system properties can be found in the respective 
feature’s feature reference manuals.   
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Field/Button Allowable Value/Function 

System Property 

Name 
Displays the property name. 

Value Displays the property value. 

Save Click to save the selected Properties. 

System Properties Description 

The following is the list of system properties and their descriptions: 

Field Description 

allow.concurrent.scanner Allows two scanners to work 
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Field Description 

apply.upgrade.forcefully Opt-in for forced auto-upgrade 

auto.print.Pd.report Auto print reports 

Properties that control the daily message display 

DailyMsg.poll.interval The interval in which the system checks for daily 
messages. 

DailyMsg.scroll.interval The interval the message pauses before adding 
another line when the window must be scrolled 
to display all messages. 

DailyMsg.server.IP IP address of server hosting daily message text. 

DailyMsg.server.Port IP port to use on the server hosting daily 
message text.  

DailyMsg.server.URL URL to reach the daily message text files 

 

data.trans.hst.days Number of days to keep t-log 

database.plu.isgempromaster Ruby sales configuration 

disable.pinpad.cardreader Disable PIN pad card reader between 
transactions. 

DVR UDP Multicast properties 

Note: Refer to the Digital Video Recorder Feature Reference documentation for 
more information on this feature. The Feature Reference is available on Premier 
Portal. 

dvr.localIPPort DVR local port 

dvr.multicastEnable Enable multicast 

dvr.multicastHost DVR multicast host 
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Field Description 

dvr.multicastPort DVR multicast port 

dvr.ttl  

 

eps.needs.immediate.declined.re
ceipt 

EPS Needs Immediate Declined Receipt (Options 
= yes,no) 

E-Safe Properties 

Note: Refer to the Tidel Sentinel E-Safe Interface Feature Reference 
documentation for more information on this feature. The Feature Reference is 
available on Premier Portal. 

esafe.coin_denomination E-Safe - Coin Denominations 

esafe.note_denomination E-Safe - Note Denominations 

esafe.retryAttempts E-Safe connection retry attempts 

esafe.retryInterval.milliseconds E-Safe connection retry interval in milliseconds.  

esafe.socketTimeout.seconds E-Safe - Socket timeout in seconds 

 

event.monitor.history.limit How much event monitor history data is shown 

extPOS.config.depts External POS properties 

fcc.dcrs.test Test Gilbarco DCRs comma delimited 

force.InHouse.PayInOut Force In_House for Pay IN and pay OUT 

fuel.max.curr.limit Set limit for the maximum currency at pump 

fuelsys.tankmonitor.tankcapacity Enable Fuel Tank Monitoring 

include.cinit.activation.criteria Show Auto Upgrade notification 
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Field Description 

journalPrinter.enabled Enable journal printer 

journalPrinter.port Journal printer port 

Kitchen Printer Configuration 

Note: Refer to the Kitchen Printer Feature Reference documentation for more 
information on this feature. The Feature Reference is available on Premier 
Portal. 

kp.svc.list Kitchen printer service list 

kp.svc.POS use the exact text 

kp.svc.POS.CommID Indicates which COM port of the POS terminal 
the kitchen printer is on.  

kp.svc.POS.host Indicates which POS terminal the printer is on.  

 

loyalty.ppg.stack Enable Loyalty PPG stacking 

mobile.feature.enabled Enable Mobile Feature 

Note: Refer to the Mobile Payment Feature 
Reference documentation for more 
information on this feature. The Feature 
Reference is available on Premier Portal. 

Money Order Prompt 

Note: Refer to the Money Order Feature Reference documentation for more 
information on this feature. The Feature Reference is available on Premier 
Portal. 

mopayee.prompt Money order prompt 

mopayee.swb  
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Field Description 

moptr.maxVendorPayment Maximum amount for Money Order Vendor 
Payment.  

mws.response.time Manager Work Station Response Time 

naxml.config.pluHasCheckDigit NAXML input processing 

Note: Refer to the VIP NAXML Mix & Match 
Feature Reference documentation for more 
information on this feature. The Feature 
Reference is available on Premier Portal. 

pdclose.forcelogout.time.inMins AEOD force logout warning time in minutes 

promotions.enableNaxmlDeal Enable Naxml promotions.  

receipt.enterprise.footer.alignme
nt 

Receipt Footer Alignment (Options - LEFT, 
RIGHT, CENTER) 

receipt.enterprise.header.alignm
ent 

Receipt Header Alignment (Options - LEFT, 
RIGHT, CENTER) 

receipt.print.programName Print the promotion program name on receipt 

remote.server.hostname  

Remote Log Server properties 

remote.server.hostname Host where the logs are stored 

remote.server.logBuffer.size Log server buffer size 

remote.server.openRetry  

remote.server.port  

remote.server.prefix  

remote.server.socektTimeout.sec
ond 
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Field Description 

 

rsd.useTestHost Use RSD test host  

ruby.fuelsys.driveOffAlert  

ruby.fuelsys.driveOffRepeat  

safeDrop.calculator Calculator appears on screen during safe drop 

sales.foodorder.expire.minutes Expiry minutes for food order 

sales.print.zerovalueitem Prints receipts for zero value items 

standard.keybd.filename POS Keyboard file name 

Amber Alert 

sys.amber.alertCountUrl  

sys.amber.alertDataUrl  

sys.amber.compareUrl  

sys.amber.enable Enable amber alert 

sys.amber.pollFreqSecs  

 

ticket.reprint.includeDCRTrans Include DCR transactions in ticket reprint 

topaz.enablevirtualkeyboard.expr
esspanel 

Enable or disable virtual keyboard button on 
express panel 

topaz.safedrop.numbLines Number of blank lines on safe drop receipt 

topaz.sales.allowDismissalOfGroup
edItemMenu 

Grouped item menu configuration 
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Field Description 

topaz.sales.allowDismissalOfModifi
erMenu 

Grouped item menu configuration 

topaz.sales.print.printTaxLines Print separate tax lines on receipt 

topaz.sales.showPluModifiers Enable or disable display of plu modifier list 

upgrade.token.timeout Auto Upgrade - timeout value for token in 
seconds 

viper.custom.feecode Viper custom fee product codes 

Local Area Network Configuration 

Local Area Network Configuration provides UI for configuring the LAN. Use to 
configure Global Routes, Device Specific IP Configuration, Device specific Routes and 
DNS. 

 

VHQ Configuration 

The customers can choose from the following VHQ options:  

1. Sign a SOW - Verifone performs services to customer PIN pads through VHQ.   

2. VHQ Administered – Verifone does the estate management for a fee.  

3. VHQ Own Instance – Customers want to own their own instance and move all 
their PIN pads to their own instance. 
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The objective of having all Petro PIN pads on VHQ is the ability to remediate and 
resolve issues found in the field faster.  

Note: Refer to the VHQ User Reference documentation for more information on 
this feature. The User Reference is available on Premier Portal. 

POS sends following VHQ data to EPS: 

• Enable/Disable (VHQ) 
• VHQ Address 
• Customer ID 
• Store ID 
• Lane ID 
• Service ID 
• Customer Profile 
• Pinpad ID 

Enable/Disable VHQ, Customer ID and VHQ Address is configured through VHQ 
Configuration form.  

EPS sends the same information to PIN pad as part of the diagnostic message when the 
POS logs in. VHQ extracts the information from PIN pad. 

Inorder to view and update VHQ Configuration, new user role functions should be 
created to view and update “VHQ Configuration”.  

• vvhqconfiguration – View VHQ Configuration 

• uvhqconfiguration – Update VHQ configuration 

A person having the role “manager” have these (view and update) functions enabled 
by default. All other roles have view function enabled by default.  

Refer to Configure Roles for more information to configure roles.   
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After you enable VHQ, the form allows you to edit Customer ID and VHQ address.  

 

On save, the form validates customer ID and VHQ address. VHQ address can be a URL 
or an IP address. Customer ID can be Alphanumerical characters up to 64 characters. 
If validation is not successful, an error message is displayed.  

Service and Maintenance (SAM) 

Beginning with ViperPAY version 4.06.xx, an additional Service and Maintenance (SAM) 
feature will be available for Mx9xx Series PIN pads. The objective of having all Petro 
PIN pads connected with the Service and Maintenance feature is the ability to 
remediate and resolve issues found in the field faster.  The SAM feature is included as 
part of ASM entitlement for Commander locations and includes improved Verifone 
Helpdesk support functions, such as:   

• Review general configuration of the device, including network and system 
configuration.  

• Review PIN pad diagnostic logs.  
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• Correct some operating system and application issues.  

• Perform diagnostics remotely on the PIN pad, such as screen calibrations.   

The SAM feature can be enabled after each PIN pad has the ViperPAY application 
loaded/upgraded. Enablement is performed by selecting "Accept" on the Terms & 
Conditions prompt that appears after the PIN pad application is loaded/upgraded. The 
SAM feature is PIN pad specific, therefore the prompt will appear on all PIN pads once 
the application is loaded/upgraded. 

Rejecting the Terms & Conditions will disable SAM functionality. Verifone strongly 
encourages our customers to enable the Service and Maintenance feature.  

 

Should a customer reject the agreement after updating the ViperPAY version and 
want the Service and Maintenance feature later, they can enter into System Mode on 
the PIN pad, navigate to “Enable VHQ default” and change the value to 1.  They will 
then need to run the application from the PIN pad home screen and accept the Terms 
& Conditions prompt.  This must be completed for each PIN pad.    

Note: The above process is same when user changes from SAM to No SAM on PIN pad. 

Note: Some PIN pads have Accept and Reject soft keys. Use these keys for SAM 
enablement. 

Note: SAM is only available for PIN pads that are not a part of a client managed 
instance of VHQ. 

Commander Console 

The Commander Console is a cloud-based enterprise application on which the 
Commander Site Controller transactions and reports can be viewed. In order for 
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Commander Site Controller transactions and reports to be viewed on Commander 
Console, the Commander Console needs to be configured in Configuration Client.  

 

Field/Button Allowable Value/Function 

Enable Cloud Agent Select to enable Cloud Agent 

Commander Console 
URL Enter the Commander Console URL. 

Site ID The Site ID of the store 

Service ID Verifone commander Service ID. 7 characters 

Postal Code Enter the postal code of the site.  

Cloud Configuration Manager 

The Cloud Configuration Manager is a cloud-based enterprise application used to 
manage Commander Site Controller configuration settings for a site or group of sites. 
All Commander Site Controllers that are managed through Cloud Configuration 
Manager must have the Cloud Configuration Manager agent configured in 
Configuration Client. 

Note: Refer to the Cloud Configuration Manager documentation for information 
on this feature. 
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General 

 

Field/Button Allowable Value/Function 

Host URL The URL of Cloud Configuration Manager. 

Company Company name that was set up when requesting for 
Cloud Configuration Manager. 

Custom ID Leave it as blank 

Site ID The Site ID of the store 

Service ID  

CM Diagnostics 

Use CM Diagnostics to see if Commander site Controller is connected to the Cloud 
Configuration Manager.  

Cloud Connect 

The Verifone C-Site Management application allows to remotely configure data for the 
POS system through the web. A technician does not have to visit each location to 
make changes and updates. These updates can be done selectively or all at once for 
all the POS devices from the web application. 

Note: Refer to the Verifone C-Site Management User Reference documentation 
for more information on this feature. The User Reference is available on Premier 
Portal. 
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Store Operations 

Payment 

Currencies 

Use to define the common currency, one alternate currency, and the exchange rate of 
the alternate currency in relation to the common currency. 

 

Field/Button Allowable Value/Function 

Name 

Enter a descriptive name for the currency 
(alphanumeric, 1 - 14 characters). All transactions 
use this currency unless the [OTHER CURR] key is 
pressed. 

Each currency is selected separately. 

Delete Click to delete the selected currency. 

Symbol Select a symbol for each currency. The symbol 
appears on receipts. 

Amount 
Enter the rate at which the alternate currency is 
compared to the base currency (0.000000 - 
999.999999). 
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Fees 

Use to add an additional charge (for example, bottle deposits) to an item or 
department. The Fees tab can contain up to 99 different fees.  The current fees are 
listed on the left side of the form. 

  

Field/Button Allowable Value/Function 

Name Enter a descriptive name for the Fee (alphanumeric, 
1 - 9 characters). The name prints on receipts. 

Delete Select to delete the selected fee. 

Department From the drop-down menu, select the department to 
which fee transactions are charged for report totals. 

Fee is Refundable Select to indicate that the fee is refundable with the 
cost of the item if it is returned. 

Fee Type 

Percentage: Percentage Fee will be calculated as the 
configured percentage of base selling price. 

For example, if Percentage Fee is configured as 4.555 
and the same fee is applied to Item F with base 
selling price $9.98, the Fee applied will be 4.555 
percentage of 9.98. ie 9.98*4.555/100 = .45. 

Range/Amt: Fee calculation for sales will be updated 
to process by Range Amount. 
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Field/Button Allowable Value/Function 

Amount (1) Enter the amount of the first fee (0.00 – 9999.99). 

Range (1) Enter the ending dollar amount for items to which 
the first fee applies. 

Amount (2) Enter the amount of the second fee (0.00 – 9999.99). 

Range (2) Enter the ending dollar amount for items to which 
the second fee applies. 

Amount (3) Enter the amount of the third fee (0.00 – 9999.99). 

Range (3) Enter the ending dollar amount for items to which 
the third fee applies. 

Amount (4) Enter the amount of the fourth fee (0.00 – 9999.99). 

Range (4) Enter the ending dollar amount for items to which 
the fourth fee applies. 

Amount (5) 
Enter the amount of the fifth fee (0.00 – 9999.99). 
This fee is applied to all amounts higher than the 
range end for the fourth fee. 

Merchandise 

The Merchandise Manager form is used to add, delete, and restore categories and 
departments. The Product Code tab displays the current product codes. Product codes 
cannot be edited. 

Categories 

Use to define the categories for your site. The current categories are listed on the left 
side of the form. 

The maximum number of categories that can be configured by platform: 

• Ruby Ci - 9999 

• Commander Site Controller - 9999 
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Field/Button Allowable Value/Function 

Add Click to add a new category 

Number Enter a unique number for the category 

Name Enter a unique name for the category 

Product Code 

The Product Code tab contains view-only data and cannot be edited. The fields in this 
tab are Number, Name, Status and Fuel (Yes or No). 

Sales 

Sales Configuration 

The Sales Configuration form is used to set up the sales functions and the login/logout 
messages for the site. 

Note: All the Security Level configurations from this form has been moved to 
Security > POS Security > Sales Functions Security form. 
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Field/Button Allowable Value/Function 

Allow Amount 
Entry for Refund 

Allows amount entry for refund so that the cashier can give the 
amount entered as refund to the customer as a roundoff figure 
after taking the difference from the customer. 

 

Canadian GST Select if the site collects Canadian GST tax. Special prompts for 
Canadian GST appear in the Tax Rate File. 

Cardload 
Recharge Dept Select to assign the department number for cardload recharge. 

Cash Drawers 
Connected 

Enter the number of cash drawers connected to this register (1 - 
2). 

Cash Underrun 
Auto Refund 

If disabled, cashier must complete the underrun transaction by 
selecting a MOP. 

If enabled, when cashier claims the fuel sale, amount is 
automatically refunded. 
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Field/Button Allowable Value/Function 

Check Drawer 
Amount on Safe 
Drop 

Select to compare the amount of the MOP entered to the 
calculated amount currently in the drawer. 

Count Underrun 
Customers 

When a cashier completes a prepay underrun transaction, the 
underrun customer count is incremented in the Summary Report, 
Shift Report and Daily Report with the attribute “Underrun 
Customer”.  

Disable Error 
Correct Key 

“Error Correct” key is not displayed on the POS touch-screen 
when this parameter is enabled. 

Discount 
Denomination 

Refer to Discount Denominations for configuring discounts.  

Select so that when the cashier selects the discount key (hard 
key, soft key, or touch-to-modify menu), any configured 
discounts are displayed as part of the discount overlay. 

Discount Type – 
Pct or Amt 

Select the type of discount to apply when the [DISC] key is used. 

Percent — The discount is calculated as a percentage of the 
price and then subtracted from the price of the item. 

Amount — The discount is directly subtracted as a dollar amount 
from the price of the item. 

Display PLU not 
found Department 
List 

Select to set a department number to assign to PLUs that are 
not in the PLU department list. 

Drawer Alarm 
Timer 

Enter the number of seconds a cash drawer is allowed to remain 
open before an alarm is triggered (0 - 99). 

Note: “Drawer Open During Sale” must not be selected for the 
drawer alarm timer to work. 
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Field/Button Allowable Value/Function 

Drawer Open 
During Sale 

Select to allow the cash drawer to remain open during 
transactions. (If not selected, the cash drawer must be closed 
before the next transaction can be started.) 

Note: Make sure that “Drawer Open During Sale” is not selected 
if you are entering a value in “Drawer Alarm Timer”. 

Employee Number 
Login 

When this feature is enabled, a cashier can login to the register 
using their Employee Number instead of their cashier record. 
Employee number and password are configured in Security > 
POS Security > Employees.  

The employee number is unique to each employee. 

When this feature is enabled, all cashier related actions require 
Employee Number with corresponding password. Only the clock 
in/out functions can be used with alternative login. 

Note: After installation this parameter is disabled by default.   

Enable Managed 
Update 

Enable to provide an interim approval step during the PLU file 
update process and to allow updates to take effect within the 
POS system immediately upon approval. No restart required 
after approval.  

Enable Receipt 
Tax Detail 

Enable to print the tax details on the receipt. Even if this 
feature is disabled, if there is a taxable rebate in the 
transaction, the tax details are printed on the receipt.   

Enable Auto 
Settle Overrun 

Select to determine whether to apply a charge on a prepaid sale 
in case of an overrun. When enabled, the overrun amount should 
automatically be settled to “Drive Off” MOP to complete the 
transaction. 

Error Correction 
Security Level 

Select to set the security level required to perform an [ERROR 
CORR] on an item in a transaction. 

Error Message 
Prompt Timer 

Enter the length of time (in seconds) that error messages display 
(2 - 30). 
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Field/Button Allowable Value/Function 

Fixed Discount 
Rate 

If “Is Fixed Discount” is selected, enter the percent or amount 
(set in “Discount Type”) that is automatically applied when the 
[DISC] key is pressed. 

Force DOB on ID 
Check 

Select to force ID checks by displaying messages, beeping, and 
restricting sales until a birth date is entered, scanned, or 
swiped. 

Force No Sale 
Print 

Select to print “No Sale” on the receipt and the journal when 
the cashier presses [No Sale] in Sales mode. (If not selected, “No 
Sale” prints on the journal only.) 

Force Refund 
Print 

Select to print a refund receipt when the cashier performs a 
refund in the Sales mode. (If not selected, the refund prints on 
the journal only.) 

Force Void Line 
Print 

Select to print “Void Line” on the receipt and journal when the 
cashier voids a line in the Sales mode. 

Force Void 
Transaction Print 

Select to print “Void Ticket” on the receipt and journal when 
the cashier voids a ticket in the Sales mode. (If not selected, 
“Void Ticket” prints on the journal only.) 

Fuel Discount Enter the dollar amount per gallon discount that is applied when 
a fuel discount key is used (0.00 – 99.99). 

Fuel Discount 
Title 

To rename Fuel Discount with a descriptive name, enter up to 
30 characters. 

Idle Prompt 
Displays Due Sale 

Select to display “No Due Sales” when the terminal is idle, and 
no fuel transactions are due. Due fuel sales display if one or 
more fuel sales are due. (If not selected, “Ready for Sale” 
displays when the terminal is idle. Due fuel sales are viewed by 
pressing the [VIEW] key.) 

Is Cashier # 
Required for Each 
Sale 

Select to require the cashier/employee number and password 
before starting each sale. 
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Field/Button Allowable Value/Function 

Is Fixed Discount 

Select to automatically enter discounts (set in “Discount Type” 
as a percent or amount) for the amount entered in “Fixed 
Discount Rate” when the [DISC] key is pressed. (If not selected, 
all discounts must be entered as individual amounts.) 

Is Sub-total 
Required 

Select to require pressing the [TOTAL] key before the MOP is 
chosen. 

Is Total in Double 
Select to print the transaction total in double-wide characters 
on the receipt and journal. (If not selected, the transaction 
total will print in single-wide characters.) 

Maximum Till 
Transaction 
Amount 

Enter the maximum transaction amount.  

Note: Maximum amount is 9999.99. 

Maximum Amount 

Enter the maximum amount that any one department item may 
cost if ‘0’ is entered for Department > Max Amt. (0.00 – 
9999.99). 

Note: The value set in Department >Max Amt overrides any 
value set here. 

Maximum 
Discount 

Enter the maximum discount (either percent or dollar as set in 
“Discount Type”) that can be applied to an item when using the 
[DISC] key (0.00 – 99.99). 

Maximum 
Quantity 

Enter the maximum quantity of any one item that may be sold in 
one transaction (0.00 – 9999.99). 

Minimum Amount 

Enter the minimum amount that any one department item may 
cost if ‘0’ is entered for Department > Min Amt (0.00 – 9999.99). 

Note: If Department > Min Amt is not ‘0,’ then its value 
overrides the value set here. 

Minimum Discount 
Enter the minimum discount (either percent or dollar as set in 
“Discount Type”) that can be applied to an item when using the 
[DISC] key (0.00 – 99.99). 
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Field/Button Allowable Value/Function 

Money Order Low 
Enter the number of checks remaining before an alarm message 
indicates that the money order machine needs to have more 
checks loaded (0 - 99). 

One Cashier per 
Drawer 

Select to limit login to one cashier per cash drawer until totals 
are closed. This can be overridden by personnel with higher 
security levels than the cashier. If not selected, more than one 
cashier is allowed per cash drawer. 

Note: This feature is not supported. 

Open Drawer 
Cashier Close 

Select to close open drawer before another cashier can use the 
cash drawer.  

PLU Not Found 
Department 

Enter a department number to assign to PLUs that are not on the 
PLU File and are entered as a sale (0 - 9999). 

 0000 — Disables the PLU Not Found department. 

Note: The department number must also be assigned as the PLU 
Not Found department from Manager > Merchandise > 
Department. 

Prepaid Card 
Activate 
Department 

Enter the department number for prepaid card activation sales 
transactions. 

Prepaid Card 
Recharge 
Department 

Enter the department number for prepaid card recharge sales 
transactions. 

Prevent Modify 
Key Cycling 

Select to prevent cycling through the modifiers of a PLU. (If not 
selected, cycling through the modifiers of a PLU from the lowest 
priced modifier to the highest priced is allowed.) 

Print DOB on 
Journal  Select to print DOB on journal.  
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Field/Button Allowable Value/Function 

Print DOB on 
Receipt Select to print DOB on receipt. 

Print Receipt 

Select to print a receipt for every transaction (if not selected, a 
receipt will only print for No Sale, Pay In, Pay Out, Clock 
In/Clock Out, Void, Car Wash, POP Discounts, Credit 
Transactions, and when using the [Ticket Print] Key). 

Print UPC on 
Receipt 

When this feature is enabled, the actual UPC or PLU will be 
printed on the receipt, along with the description. 

Prompt Dine In Select to prompt dine in at food kiosk.  

Prompt Food 
Order Name Enable to prompt for entering customer name for food orders. 

Prompt Food 
Order Phone 
Number 

Enable to prompt for entering customer phone number for food 
orders. 

Prompt Loyalty 
for PLU Not Found 

When enabled, if a scanned barcode or manually entered 
number comes as “PLU Not Found”, the system asks the user if 
the number is a Loyalty Card.  

Receipt Print 
Program Name Receipt prints loyalty program name.  

Register Time-Out 
Timer 

Enter the number of minutes (001 – 999) after which an idle 
terminal automatically switches out of Sales mode. 

Entering 000 indicates that an idle terminal will not 
automatically switch out of Sales mode. 

Release Terminal 
During Close 

Select to allow the terminal to return immediately to Sales 
mode after a close shift or close daily is started. 
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Field/Button Allowable Value/Function 

Reminder to Use 
Imprinter 

Determines whether a message is displayed that reminds 
the cashier to use the imprinter after completing a 
transaction using the Manual Credit MOP. 

Reset Display on 
Drawer Close Idle sales message returns when the drawer closes. 

Reset Display on 
Time-out Idle sales message returns when the time-out elapses. 

Reset Display 
Time-out Value 

Enter the time (in seconds) before the idle sales message returns 
to the operator display after a transaction is complete. When 
“Reset Display on Time-out” is selected, a value must be 
entered here (2 – 3600). 

1 = 2 seconds 

0 = disables the option to reset display on time-out 

Stack manual 
Discount 

If enabled, multiple manual discounts can be applied on a line 
item. Cannot apply multiple discounts if item has NAXML 
discount applied to it. 

 

Store Number 
Enter the number or name that identifies the store. This 
information is printed on receipts and reports (alphanumeric, 1 - 
5 characters). 

Value Added Tax 
(VAT) 

Select if value added tax (VAT) is collected at the site. Special 
prompts for VAT appear in the Tax Rate File (U.S. and Canadian 
sites usually do not collect VAT). 

Sales Login/Logout Message 

Use to enter messages that are displayed when an employee logs in or out of Sales 
mode. 
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Field/Button Allowable Value/Function 

Log In - Show Log-In 
Message 

 Select to display the prompt when the user logs on 
to Sales. 

Lines 
Enter or edit the information displayed when Sales 
is entered. 

Log Out - Show Log-Out 
Message 

Select to display the prompt when the user logs out 
of Sales. 

Lines 
Enter or edit the information displayed when Sales 
is exited. 

Menu Keys 

Refer to Menu Key Configuration 

Register 

The Register Configuration form is used to set up banners, logos/slogans, soft keys, 
and copy registers for the site. 

Banner 

Use to define the message that appears on the customer display when sales 
transactions are not in process. 
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Field/Button Allowable Value/Function 

Register Select the register. 

Line 1 and Line 2 Enter the messages for lines 1 and 2 (alphanumeric, 
up to 80 characters). 

Rotate Select a rotation option — None, Line 1, Line 2, 
Both. 

Logos/Slogans 

Use to enter the information that prints in the header (logo) and footer (slogan) of 
receipts. 
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Field/Button Allowable Value/Function 

Register Select the register. 

Ticket Logo/Ticket 
Slogan 

Enter the information that appears on register 
receipts. 

Enabled Select to enable each logo and/or slogan. 

Mode Select Single- or Double-wide characters. 

Alignment Select Left, Right, or Center. 

Copy Registers 

Use to copy files from one register to another. 

 

Field/Button Allowable Value/Function 

Select Register - Source 
Register Select the register to copy. 

Destination Register Select the register to which you want to copy files. 

Select Files to Copy Select the files you want to copy: Banners, Soft 
Keys, Logos, Slogans. 
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Touch Screen 

The Touch Screen Configuration forms allow you to configure fuel keys, assign 
buttons, define the parked menu panel, and orient the touch screen. 

Note: Refer to the Base 53 and Higher feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Self Checkout 

Self Checkout (SCO) is a self-checkout POS application for C-Stores implemented on 
B53 and Higher UI.  

Note: Self Checkout will be disabled on future releases except for customers who 
have licensed it from Verifone separately. 

Note: Refer to the Self-Checkout feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Self Checkout (SCO) Monitoring  

Device monitoring is a feature to monitor configured devices from monitoring devices 
such as Cashier operated POS, Attendant handheld device or any remote machine. 
Self Checkout devices can be configured to be monitored through the Touch Screen 
configuration. 

Self Checkout Monitoring Buttons 

The following buttons represent self checkout device status: 

Icon Description 

  

 
  

Self Checkout device is Offline 
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Self Checkout device is in Non Sales mode 

  

 
  

Self checkout lane closed 

  

 
  

Self Checkout device is in Idle mode 

  

 
  

Customer checked in to the self checkout device 

  

 
  

Customer added items to cart on the self checkout device 

  

 
  

Customer requested help on the self checkout device 

  

 
  

Customer requested help; but, is proceeding with sale 
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Cashier logged in while self checkout device is in Idle mode. 

  

 
  

Cashier logged in to self checkout device in customer checked in 
mode 

  

 
  

Cashier logged in to self checkout device during sales 
  

  

 
  

Customer added age restricted item and called for cashier 
assistance 

Self Checkout Monitoring Configuration 

Note: Refer to the Base53 and Higher UI user reference documentation for 
information on how to configure the touchscreen UI. The User Reference is 
available on Premier Portal. 

1. From Store Operations > Touch Screen > Panel Configuration select Add Item to an 
Item Panel.  
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2. In the new row added, select Monitoring from the drop down.  

 

3. Select Self Checkout as the Device Type and select the device ID of the self checkout.  
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4. Go to Store Operations > Touch Screen > Screen Configuration and add the item panel 
containing the Self Checkout monitoring item to a screen panel.  

Note: SCO has to be logged in at least once before configuring for SCO 
monitoring; else the device id will not be listed. 

 

5. Go to Store Operations > Touch Screen > Register Configuration and assign the screen 
to a register. 
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House Account 

A House Account is a non-network, local store account that is set up with credit 
granted at the discretion of the site manager. House accounts require an account 
number, which prints on the receipt. Commander keeps and reports totals for House 
accounts but does not keep records of individual transactions or balances. Follow 
store policy to manually record transactions. 

Note: Refer to the In-House Accounts feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

“force.InHouse.PayInOut” in ConfigClient > Initial Setup > System Properties should 
be set to Yes to enables sites to assign In House Accounts with Pay In and Pay Out. 
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Field/Button Allowable Value/Function 

Add 
Click to add a new account. The account is 
automatically enabled unless you clear the Enabled 
check box. 

Delete Select to delete the selected account. 

Account Number 
Enter the account number 

(alphanumeric, 1 - 20 characters). 

Account Name (Optional) Enter the name of the customer. 
(alphanumeric 0 - 20 characters). 

Enabled Select to enable the account. 

Prompt for Sub Acc# Enable to prompt for sub account number. 

Trigger Function Select what triggers a "In-House Account? [Y/N]" 
prompt. 

Group Price Change 

Note: Refer to the Group Price Change feature reference documentation for 
information on this feature. The Feature Reference is available on The Feature 
Reference is available on Premier Portal. 
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Use to change the prices of multiple PLUs assigned to a selected department at the 
same time. 

 

To change a group of prices: 

1. In the department list, select the department that contains the products 
needing the price change. 

2. Click an adjustment type — Increase, Decrease, Make all prices the same. 

3. Click an adjustment option — Amount, Percent. 

4. Enter the adjustment amount as dollars and cents (0.00 - 9999.99) or percent 
(000.000 - 9999.99). 

5. Select the PLUs to be adjusted.  

• Click Select All to select every PLU in the department. 

• Select several adjacent PLUs by using SHIFT and click. 

• Remove selections by clicking Select None. 

6. Click OK. 

Managed Updates 

The Managed Updates feature provides an interim approval step during the PLU file 
update process and allows updates to take effect within the POS system immediately 
after approval. The business purpose behind the approval step is to allow store 
management to use a 3rd party system (SAP Retail Store) to identify, print and update 
shelf labels as needed for price changes prior to those changes being reflected within 
the POS system. 
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Enable Managed PLU Update 

From Store Operations > Sales > Sales Configuration, enable “Enable Managed 
Updates”. 

 

Managed Update Security Level 

In Store Operations > Sales > Sales Configuration > Managed Update Security Level, 
enter the security level of the manager who can apply the update. 

 

"Apply Updates" Touchscreen Button 

In Store Operations > Touch Screen > Panel Configuration, select “Add Item” and 
type as “Function”. Select “Apply Updates” to assign this function to a touch screen 
key or Topaz POS key for easy access to the function. 



Configuration Client Forms 

114 

 

Note: Refer to the Base 53 and Higher feature reference documentation for 
information on configuring the touch screen. The Feature Reference is available 
on The Feature Reference is available on Premier Portal. 

Pending Updates 

View Pending Managed Updates from Store Operations > Managed Updates. 

 

 

Fiscal Receipt  

This feature is available for LAC countries. In many LAC countries, controlled receipts 
(e.g. “Facturas”) are printed from the POS. The receipts typically include a controlled 
sequence number and other POS controlled data.  

After all MOPs are processed, the application would determine which of the five types 
of receipts to print.  
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The five types of receipts are: 

• Fiscal Sale  

• Fiscal Refund 

• Fuel Voucher 

• Non-Fiscal Network 

• Pump Test 

Transaction Processing of MOPs to Generate Receipts 

Pump Test 

If Pump Test MOP is used, the transaction generates a Pump Test Receipt. This will 
not require any data input. 

Fuel Voucher 

If Fuel Voucher MOP (with fuel voucher MOP code) is used, the transaction 
generates a Fuel Voucher Receipt. The Fuel Voucher MOP can be used only with 
Postpay Fuel and Manual Fuel line items. 

When this MOP is used, no split tender, no change and no refunds are allowed. 

This MOP requires 2 cashier prompts:  

a) For Fuel Voucher number (Alphanumeric 0-15 chars): “Enter [receipt type name] 
Number:“ 

b) For Customer number (Alphanumeric 0-15 chars): “Enter Customer Number:“ 

Note: More than one post pay fuel line can be allowed. 

Non-Fiscal Network 

If a Network MOP is used and the FEP returns the flag “FiscalReceipt” = FALSE, the 
application generates a Non-Fiscal Network Receipt. 

Fiscal Refund 

For a Fiscal Refund receipt, the system prompts for the original Fiscal Sale receipt 



Configuration Client Forms 

116 

number. 

Fiscal Sale 

If the transaction is none of the four previous receipt types, the system generates a 
Fiscal Sale Receipt. 

Site 

Use this form to configure site-level fiscal receipt configuration.  

 

Field/Button Allowable Value/Function 

Customer Tax ID 

Name Enter customer Tax ID Name; alpha-numeric string 
between 3-20 characters. 

Minimum Length Enter customer Tax ID Number; minimum length 
(numeric value between 0-20). 

Maximum Length Enter customer Tax ID Number; maximum length 
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Field/Button Allowable Value/Function 

(numeric value between 0-20). 

Check Digit Drop-down box with 2 values: ‘None’ and ‘Modulo 
11’. 

Tax ID Database 

Enable DB Click to enable Tax ID Database. 

Customer Name Use to prompt for customer name to be added to 
Tax ID DB. 

Customer Address  Use to prompt for customer address to be added to 
Tax ID DB. 

Warning Thresholds 

Sequence Number 

A countdown alarm that notifies the number of 
sequence numbers still available on the range 
defined for a specific authorization number. 
Numeric value between 1-3. Default = '100'. 

Authorization Days 
Number of days before the Ending Authorization 
Date expires. Numeric value up to 2 digits (00-99).  
Default Value is 15 days. 

Other Settings 

Merchant Tax ID Name Merchant Tax ID name.  

Use common Sequence 
Number # for All APTs  

If this parameter is enabled, all the APTs configured 
in a site have a common sequence number. Default 
= Enabled. 

Common APT Register 
ID 

Select the APT register ID to configure. Only this 
APT appears in the register selection field in the 
Register form.   

Print Currency Symbol If this parameter is enabled, the currency symbol is 
printed on every amount printed on the receipt. 
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Field/Button Allowable Value/Function 

Print Line Item Unit 
Price 

If this parameter is enabled, the unit price is 
printed after the quantity on every receipt printed 
and the header is printed as: “Qty/Unit P” 
(Quantity/Unit Price) and translated to Spanish as 
“Ctd./P. Unit.” (Cantidad/Precio Unitario).  

If this parameter is disabled, the header is printed 
as “Qty” and translated to Spanish as “Cant.”. 
Default value = disabled. This only applies to 
Honduras. 

 

English: 

0123456789012345678901234567890123456789 

Description       Qty/Unit P.   Amount 

 -----------       -----------   ------ 

Description           Qty      Amount 

-----------           ---      ------ 

Spanish: 

0123456789012345678901234567890123456789 

Descripcion      Ctd./P.Unit   Monto  

-----------      -----------   ------ 

Descripcion          Cant.      Monto 

-----------          ----      ------ 

 

Print Verbose Total If this parameter is enabled, the verbose total is 
printed on the receipt. Default = disabled. This only 



Commander Site Controller User Reference 

119 

Field/Button Allowable Value/Function 

applies to Honduras. 

Note: The maximum verbose total amount printed 
on the receipt matches the maximum total amount 
on the receipt. See the example of receipts in the 
next table for more information.  

Print Tax summary 
Table 

If this parameter is enabled, the Tax Summary 
Table is printed on the receipt. Default = disabled. 
This only applies to Honduras. 

This table has 4 columns: 

• Imp%: Tax rate 

• Base: Amount before Tax 

• Tax: Tax rate * Base 

• Total: Base + Tax 

Register 

This form is used to configure the different types of fiscal receipts. The different 
types of fiscal receipts that can be configured with this form are Fiscal Sale, Fiscal 
Refund, Fuel Voucher, Non-Fiscal Network and Pump Test.  
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Field/Button Allowable Value/Function 

Select Register Select the POS which is configured to print the 
fiscal receipts.  

Enable Fiscal Receipts Select to enable fiscal receipts. 

Add Select fiscal receipt to configure and click Add 

Receipt Type Configuration 

Note: These configuration fields are enabled or greyed out depending on the 
receipt being configured.  
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Field/Button Allowable Value/Function 
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Field/Button Allowable Value/Function 
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Field/Button Allowable Value/Function 

Name Name of the receipt type (e.g., “FACTURA”). 

Prefix/Serie 

Alphanumeric string between 0-15 characters. 
Default = Empty. 

Receipt Type Number: This is composed by a 
serie/prefix number (e.g., “8902”) and a sequence 
number (e.g., “00098214”). 

Begin Sequence  8-digit value between 00000001 – 99999999 (leading 
zeros not required for input). Default = “00000000”. 

End Sequence 8-digit value between 00000001 – 99999999 (leading 
zeros not required for input). Default = “00000000”. 

Update Next Sequence Select to update next sequence manually in case of 
a system failure.  

Next Sequence 8-digit value between 00000001 – 99999999 (leading 
zeros not required for input). Default = “00000000” 

Authorization Name 

Alphanumeric string value between 3-20 characters 
(including special characters). Default = 
“Autorizacion No:” (e.g., “Autorización DGI”). 

Note: Spanish special characters are not allowed. 

Authorization Number 
Alphanumeric string up to 40 characters (including 
special characters). Default = Empty (e.g., “AFC-
DGC-SCC-006-06-2011”). 

Starting Authorization 
Date Label 

Char string up to 30. Default = “Fecha Inicio de 
Emision". 

Starting Authorization 
Date 

The Authorization Number is valid from this date. 
Short Date Format string. This should be selected 
from a calendar representation. 

Ending Authorization 
Date Label 

Char string up to 30. Default = “Fecha Limite de 
Emision". 
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Field/Button Allowable Value/Function 

Ending Authorization 
Date 

Last valid day of the Authorization Number. Short 
Date Format string. This should be selected from a 
calendar representation. 

Merchant Tax ID Alphanumeric between 0-20 characters. Default = 
Empty. 

Prompt for Final 
Consumer 

Drop-down box with the following values:  

Disabled: Prompt for Tax ID # and if the <ENTER> 
key is pressed, then is a Final Consumer. 

Prompt Y/N: This option is to indicate if after 
enabling Prompt for Final Consumer, the prompt 
displayed should be: “Final Consumer? Yes/No”. 

Menu: This option is to indicate that after enabling 
Prompt for Final Consumer, the prompt displayed 
should be a menu: “1. Final Consumer. 2. Customer 
with Tax ID #”. 

Note: ‘Final Consumer’ is any customer that 
requires a ‘Fiscal Receipt’ but will not provide a 
Customer Tax ID #.  

Prompt for Customer 
Data 

Enable/disable prompts for Customer Data (Name, 
Tax ID Number). 

Prompt for Original 
Receipt 

Enable/disable prompting for Original Receipt 
Number. 

Prompt 

Prompt to get the original fiscal sale receipt 
number: Alphanumeric string value between 0-30 
characters (including special characters). Default = 
“No Factura Original: ”. 

Prompt for Fuel 
Voucher Number Enable/disable prompting for Fuel Voucher Number. 
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Fuel Flat Tax 

This form allows the configuration of two flat taxes per fuel grade. 

The flat tax is a fix amount per unit of measure (for example, 11 cents per gallon of a 
specific fuel product). Depending on the country, the format of this amount is defined 
as maximum 3 digits to the right and 4 to the left of the decimal point (e.g., 
‘XXXX.YYY’). 

Note: Guatemala has only one fuel flat tax per fuel grade. 

 

Field/Button Allowable Value/Function 

Fuel Flat Tax Name 
Tax name. Allows up to 10 characters. 

Note: Guatemala only needs 3 characters. 

Fuel Flat Tax Amount Tax amount. 

 

The POS prints receipts with the Flat Tax information. 
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Tax Exemption 

Use the form to configure tax exemption if a Tax Exemption MOP code is used. 

 

Field/Button Allowable Value/Function 

Tax Exemption Type 
Name 

This name is associated to the acronym of the 
government entity that is tax-exempt (e.g., “SAR” = 
“Servicio de Administración de Rentas” (Revenue 
Management Department).  

Alphanumeric, maximum 20 characters. 

Tax-Exempt Purchase 
Order # Prompt 

Alphanumeric, maximum 20 characters. (Description 
needed) 
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Field/Button Allowable Value/Function 

Tax-Exempt Customer # 
Prompt 

Alphanumeric, maximum 25 characters. (Description 
needed) 

Exempt Merchandise 
Sales Tax  

Select to exempt merchandise sales tax. This 
parameter is enabled by default. Greyed out in this 
screen in base 52. 

Exempt Fuel Sales Tax Select to exempt fuel sales tax. Greyed out in this 
screen in base 52. 

Exempt Fuel Flat Taxes Select to exempt fuel flat tax. Greyed out in this 
screen in base 52. 

System Properties 

The following system properties should be enabled for Honduras: 

• Print Tax-Exempt Total Line: If this is enabled, the system should print the line 
“Exento Imp.” + [tax-exempt total amount].  

• Print Discounts Line:  If this is enabled, the system should print the line 
“Descuentos y Rebajas ” + [sum of all amounts discounted].   

• Print Subtotal Line Label:  If this is enabled, the system should print the label 
“Subtotal Gravado” in the subtotal line  

• Print Line Before Total: If this is enabled, the system should print a line before 
the total amount 

Currency Selection 

Use this feature if the country is using a different currency than US dollar. 

In Commander Site Controller Configuration Client, the currency of the country should 
be selected from Payment Controller > EPS Configuration > EPS Global 
Configuration. 
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Charity Donations 

The charity donation feature enables a customer to donate certain amount to a 
charity.  

The system prompts customers during tendering process for charity donation. 
Customers are asked if they wish to make a charity donation.    

When the customer is using Cash as MOP there are two options that can be enabled 
from configuration client to be presented to the customers on the Pin pad: 

• Donate change amount (rest for charity) and is calculated as the difference 
between the amount due and the amount paid.  

• Round to next dollar amount which rounds off their transaction to the next 
whole dollar. The donation amount is the difference between the total amount 
of the purchase and the rounded dollar amount.  
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When the customer is using ‘Credit’ or ‘Debit’ cards as MOP, they will be presented 
with three preset contribution amounts configured in configuration client or two 
preset contribution amount and a round to next dollar amount.  

The chosen selection is shown on the receipt, where it reflects the contribution. Only 
one charity can be active for any site. 

The following configurations should be done before configuring the Charity Donations 
Configuration form: 

1. Create a department for charity with NACS code 971. Refer to the Department 
Sales topic in this document for more information on creating departments.  

2. For Cash MOP, “Tender Amount Required” parameter should be enabled. Refer 
to the Method of Payment topic in this document for more information.  

Charity Donations Configuration  

 

Field/Button Allowable Value/Function 

Enable Charity Donations 

Enable charity donations.  

Note: When Enable Charity Donations is 
selected, by default Prompt Indoor is 
selected and cannot be edited.  
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Field/Button Allowable Value/Function 

Department Select charity department. 

Cash 

Note: Cash is only available for indoor charity.  

Rest for charity 
Select if this option appears for cash 
payments. This donates the remaining 
amount for charity.   

Round to next dollar 

Select if this option appears for cash 
payments. Rounds off the transaction to the 
next whole dollar. The donation amount is 
the difference between the total amount of 
the purchase and the rounded dollar 
amount. 

Card 

Note: Card can be used for both Indoor and Outdoor charity. 

Prompt Outdoor 

Enable to show charity prompts for outdoor 
transactions.  

Note: DCRs must be initialized for 
changes to take effect. 

Preset Amount 1 Enter the preset amount option 1. 

Preset Amount 2 Enter the preset amount option 2. 

Preset Amount 3 

Either this option or “Round to next dollar” 
can be selected as the third option. 

Enter the preset amount option 3. 

Round to next dollar 

Either this option or “Preset Amount 3” can 
be selected as the third option. 

Select if this option appears for credit/debit 
card payments. Rounds off the transaction 
to the next whole dollar. The donation 
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Field/Button Allowable Value/Function 

amount is the difference between the total 
amount of the purchase and the rounded 
dollar amount. 

Charity Donation Receipts 

Outdoor Receipt 

 



Configuration Client Forms 

132 

Indoor Receipt 

 

Close Lane 

This is a Self Checkout feature.   

Note: Refer to the Self Checkout feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Promos and Discounts 

NAXML Deal 

Refer to NAXML Deal 
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POP Discount 

Note: Refer to the POP Discount feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Coupon Scanning Configuration 

The Coupon Family form is used to assign PLUs to a “family code” that appears on a 
coupon, even though the code does not appear in the PLU. After the code and PLU are 
associated in the Coupon Family form, the product with the associated PLU becomes 
eligible for the discount when the PLU and the coupon are scanned on the POS. 

For example, if a family code for cereal is 456 on a coupon, and the site’s PLUs for 
several cereals do not contain 456, those PLUs can be associated with the family code 
456 on the Coupon Family form. When the PLU for cereal and the coupon are scanned 
on the POS, the customer receives the discount. 

Note: Refer to the Coupon Scanning feature reference documentation for 
information on this feature. The Feature Reference is available on The Feature 
Reference is available on Premier Portal. 

Site Parameters 

 

Field/Button Allowable Value/Function 

Coupon Processing Level Select the coupon processing level. 

Allow Negative Transaction Totals Select to allow negative transaction totals. 
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Coupon Families 

 

Field/Button Allowable Value/Function 

Add Click to add coupons. 

Delete Select to delete the selected coupon and click Save. 

Code Enter the coupon code. The code must be three 
characters long. 

Description Enter the coupon description of the coupon family (30 
characters maximum). 

Add a PLU 

Enter a PLU/Modifier. Click Add to associate the PLU 
with the family code. 

Mod - Enter the modifier 

Add - Click to add PLU 

Remove PLU Click to remove the selected PLU. 

Discount Denominations 

This feature is used to configure various discounts which can be selected by the 
cashier during a sale. When the cashier selects the discount key (hard key, soft key, 
or touch-to-modify menu), any configured discounts are displayed as part of the 
discount overlay. 
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Note: This feature should be enabled in Configuration Client > Store Operations 
> Sales Configuration. 

 

Field/Button Allowable Value/Function 

Discounts Click to add discount name. A total of 16 discounts can 
be configured.  

Delete Select to delete the selected discount and click Save. 

Name Enter the discount name. 

Type 
• Percent 

• Amount 

Amount Enter the percentage or amount discount. 

Forecourt 

DCR 

Refer to Configuring Dispenser Card Readers 
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Fuel 

Refer to Fuel Configuration 

Fuel Prices 

The Pricing Manager form is used to set up fuel pricing, including tier pricing. Tier 
Two pricing can be set up at any time but does not take effect until the appropriate 
information is entered in the “Start Tier 2 Pricing” and “Number of Tier Hours” 
parameters in Fuel > Site Parameters > Fuel Site Parameters. 

Select the product, then double-click the Price text boxes and enter the price (0.000 - 
9.999). The price of all products changes to match the price entered in the top text 
box after ENTER is pressed. Prices can be edited if necessary. 

Note: When entering a price, take care when placing the decimal point. For 
example, to change a price to 1.159, enter it as written here. To change a price 
to 1.500, enter the trailing zeros. 

If you only change fuel prices, for the changes to take effect, initialize Fuel Prices by 
selecting: 

• Forecourt > Initialization > Fuel Prices  

If you change other fuel parameters as well as prices, you will need to initialize Fuel 
and DCRs for the changes to take effect.  To do this, select both of the following: 

• Forecourt > Initialization > Fuel 

• Forecourt > Initialization > DCRs 

Note:  Make sure that your fueling positions are not in use when initializing any 
Fuel Prices, Fuel, or DCRs. 
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DCR Keys 

Each DCR should be assigned to a DCR key configuration. If sites have a mix of DCRs 
with and without alphanumeric capabilities, sites would require to create 2 or more 
DCR key configurations.  

The configuration for DCRs that are alphanumeric should have the “Enable 
Alphanumeric” checked, and NOT checked for the DCRs that only accept number 
input.  

Use to configure DCR keys for the different DCR positions. 
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Field/Button Allowable Value/Function 

Add Click Add to configure new DCR Keys layout. 

Delete Select to delete the selected DCR Keys layout. 

Label Label the new DCR Keys layout. 

Enable 
Alphanumeric 

The configuration for DCRs that are alphanumeric should 
have the “Enable Alphanumeric” checked to use the 
alphanumeric keys layout. This field should NOT be 
checked for the DCRs that only accept number input. 

Assign Positions 

Click assign positions and select the DCR that can be 
used for entering alphanumeric characters. The DCRs 
that do not have alphanumeric capabilities are grayed 
out. 

#Rows Number of rows for the DCR Keys layout. 
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Field/Button Allowable Value/Function 

#Columns Number of columns for the DCR Keys layout. 

Assign Positions Select to assign the DCR Keys layout to the DCRs in the 
site. 

Note: Click on the keys to configure the values. 

DCR Idle Screen 

The DCR Idle Screen Configuration form is used to set up what displays on the DCR 
screen when not in use. 
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Field/Button Allowable Value/Function 

Add Click Add to configure new DCR idle screen. 

Delete Select to delete the selected DCR idle screen. 

Name Enter a name for the DCR idle screen. 

DCR Non-Graphic 
Idle Screen 

These are the text lines that the user would like to 
appear on a Non-Graphic DCR’s Idle Screen.  

 If it’s a 4-Line display DCR, then the 4 configured 
lines would appear on the screen on one-line 
each. 

 If it’s a 2-Line or Single-Line display DCR, then the 
4 lines could scroll one after the other in that 
order. 

Graphic Enabled 

Select if the DCR has a Graphic Keypad. If this field is 
disabled, the panel below would show the “DCR Non-
Graphic Idle Screen” configuration. If it is enabled, it 
would show the “DCR Graphic Idle Screen” configuration.  
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Field/Button Allowable Value/Function 

DCR Graphic Idle 
Screen 

If the “Graphics Enabled” is selected, the Graphic Idle 
Screen configuration opens. 

The Left and Right keys allow the user to configure what 
is displayed on each of the keys.  

The middle lines provide the user the option of 
displaying some lines in the middle for the top two rows 
and use the bottom 2 rows for the keys. If the Middle 
Text Line is configured, the keys on those lines are not 
displayed on the DCR. 

On clicking each of the key buttons, the following pop-
up to configure the key is displayed.  

 Softkey Type: Tags the key text to one of the 
pre-defined types. 

 Softkey Text: The text that is displayed for this 
key on the DCR. After the text is entered here, 
the text next to the button changes to reflect this 
text. 

Assign Positions Select to assign the DCR idle screen to the DCRs in the 
site. 

 

Outdoor TAVE 

The TAVE (Trans Amor Verifone Edition) system minimizes the flow of unencrypted 
payment card data within the POS system by performing end to end encryption. 
Payment card data is encrypted by TAVE enabled card readers both at the dispenser 
and inside the store. Card data is encrypted by these devices and passed to the First 
Data front-end processor in encrypted form for authorization. The First Data front-
end processor decrypts the payment card data and sends the data to the issuing bank. 
A token is linked to the authorization and sent back to the Verifone POS. The 
VeriFone POS stores this token and uses the token instead of unencrypted payment 
card data for all subsequent processing. 

Enable the feature at Config Client > Forecourt > DCR > Site Configuration > Enable 
Outdoor TAVE. 
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The Outdoor TAVE Config Client forms is limited to setting up and sending 
configuration commands to a DCR.  

The commands are: 

• Register DCR - Enables encryption on a TAVE capable DCR (GVR CRIND).  

• Advance DCR Key - Increments the DCR derived encryption key.  

• Update DCR Settings - Installs VeriShield Crypto Library (VCL) settings.  

Register DCR 

Enables encryption on a TAVE capable DCR (GVR CRIND). 

 

 

Advance DCR Key 

Increments the DCR derived encryption key. 
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Update DCR Settings 

Installs VeriShield Crypto Library (VCL) settings. 

 

 

Registration Status 

Shows the Outdoor TAVE registration status of the DCRs.  
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Cash Acceptor 

The Cash Acceptor Configuration form is used to set up and edit cash acceptors at the 
site. Site Information determines the behavior of all cash acceptors at a site. 
Attributes determines the behavior of a specific cash acceptor at a specific fueling 
point. 

Select the Cash Acceptor on the list on the bottom of the form, then select the value 
check boxes that are applicable for that Cash Acceptor. 
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Field/Button Allowable Value/Function 

Disable If 
Cheated 

Select to turn off a cash acceptor when someone tries to 
cheat it. 

Disable If Paper 
Low 

Select to turn off a cash acceptor if the receipt tape is 
running out. 

Disable If No 
Printer 

Select to turn off a cash acceptor if the printer is not 
working. 

Prompt ‘insert 
cash’ 

Select to have the phrase “OR INSERT CASH” appear at 
the end of the idle prompt. 

$1 Bill Enabled Select to allow acceptance of one-dollar bills. 

$2 Bill Enabled Select to allow acceptance of two-dollar bills. 

$5 Bill Enabled Select to allow acceptance of five-dollar bills. 

$10 Bill Enabled Select to allow acceptance of ten-dollar bills. 

$20 Bill Enabled Select to allow acceptance of twenty-dollar bills. 

$50 Bill Enabled Select to allow acceptance of fifty-dollar bills. 

$100 Bill Enabled Select to allow acceptance of one hundred-dollar bills. 

Bill Orientation 

This parameter does not apply to Tokheim dispensers. 

Select to require that bills are inserted face-up with the 
black-seal end first. 

(If not selected, bills can be inserted face-up in either 
direction.) 

Note: The black seal appears on the front of the bill to 
the left of the face. 

Timeout [Seconds 
10-99] 

Enter the time (in seconds) between when a customer 
inserts a bill and when the pump shuts off if no fuel has 
been pumped (10 - 99). 



Configuration Client Forms 

146 

Field/Button Allowable Value/Function 

Cash Acceptor 
Attributes - 

Cash Acceptor 

  

Select the number of the fueling point. 

Duplicate 
Acceptor 

Click to copy the current cash acceptor’s attributes to 
any number of other cash acceptors. In the Duplicating 
Acceptor form, select the cash acceptor(s) to which you 
want to copy and click Done Duplicating. 

Cash Acceptor In 
Dispenser 

Select to indicate that the fuel pump has a cash 
acceptor. 

Reset Printer 
Error 

Note: This parameter is not currently supported. 

Select to enable the printer after the cash acceptor has 
been disabled and brought back online. 

Print Totals Now 

Note: This parameter is not currently supported. 

Select to print the amount of money in the cash 
acceptor. 

 

Fuel Tax Exempt 

The Fuel Tax Exemption Configuration form allows taxes to be removed from a post-
pay fuel sale by setting up one to five fuel tax exemptions. Each exemption can either 
be setup by the Amount Per Gallon or the Tax File Entry that is setup in Store 
Operations > Payment > Tax Rates, or Both. 

The Fuel Tax Exempt Receipt Lines section is used to enter up to four lines of text 
that you want to print on the header of Fuel Tax Exemption receipts. 
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Field/Button Allowable Value/Function 

Fuel Tax Exempt 
Record Select a record number. 

Delete Select to delete the selected fuel tax exempt record. 

Name Enter a name for the fuel tax exemption. The name 
appears on receipts and reports. 

Amount Enter the dollar amount per gallon of tax (0.000 – 
99.000) 

Type 

Select the tax type to exempt: 

Amount Per Gallon – The dollar amount per gallon. 

Tax File Entry – Taxes applied in Store Operations > 
Payment > Tax Rates. 

Both – A combination of Amount Per Gallon and the tax 
rates entry that is setup in Store Operations > Payment > 
Tax Rates. 

Signature Line Select to print the receipt with a signature line to certify 
the customer’s eligibility for the tax exemption. 

Fuel Tax Receipt 
Lines (1 - 4) 

Enter up to four header lines for the fuel tax exemption 
receipt (alphanumeric, 1 - 10 characters). 
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Rapid Change Fuel Config 

Rapid Change Fuel configuration is configured from Forecourt > Rapid Change Fuel 
Config. 

This feature allows the cashier to change the pump’s service level and auto approval 
rapidly at the pump using the POS without having to change the fuel configuration 
using Commander Configuration Client or without manager intervention.  

 

To change the fuel configuration level from the POS, the cashier should access CSR 
Functions > Fuel Manager > Rapid Change Fuel Configuration. 

Unattended DCR 

Note: Refer to the Unattended Fueling feature reference documentation for 
information on this feature. The Feature Reference is available on The 
Feature Reference is available on Premier Portal. 

Allows a site to have the Forecourt run unattended while the C-Store is closed. 
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Field/Button Allowable Value/Function 

Unattended mode 

Enabled – Enable now 

Disabled – Disable 

Scheduled – Select and enter the start time and number 
of hours the site runs unattended in the next two 
parameters.  

The Scheduled option is the one that uses the Start Time 
and Number of hours. They should be ignored for the 
other two options.  

Start time Select the start time of the unattended mode.  

Number of hours Select the number of hours from the start time the 
unattended mode is enabled.  

Help message 1 Two configurable help messages of up to 80 characters 
that is displayed when HELP key is pressed during idle.  

Help message 2 Two configurable help messages of up to 80 characters 
that is displayed when HELP key is pressed during idle. 

Disable Cash 
Acceptor Use to disable the cash acceptor at the dispenser.  

Ignore eSign 
Offline 

Handles price changes if the Fuel Price Display 
(electronic sign for fuel prices) is offline. If the 
parameter is checked, the fuel prices will change if the 
sign is offline. If unchecked, the fuel prices will not 
change if the sign is offline. 

Cash Receipt 
Message  

Includes five configurable receipt lines of up to twenty 
characters each for cash acceptor underrun instructions. 

Devices 

Car Wash 

Refer to Car Wash Configuration 

Car Wash Paypoint 
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Note: Refer to the Car Wash Pay Point feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Tank Level Sensor 

The TLS Configuration form is used to set up and edit Tank Level Sensor Parameters. 

 

Field/Button Allowable Value/Function 

Low Limit Alarm Select to turn on the TLS low-limit alarm. 

Unit of Measure 
Select the unit of measure for which the TLS is 
configured — Gallons or Liters. (The unit of measure 
appears on the TLS reports.) 

Tank Variance Enter the number of gallons or liters that fuel tank totals 
can vary from the actual amount (0 - 999). 

Electronic Check 

The form is used to configure E-Check parameters. 
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Field/Button Allowable Value/Function 

Merchant 

Merchant ID 

Enter the merchant ID number assigned by the network. 
(alphanumeric up to 24 characters. Space and special 
characters are not allowed)  

Merchant Name 
Enter the merchant name. (alphanumeric up to 40 
character) (Space are allowed but not at start and end)  

Address 

Enter the Address to print at top of all receipt. 
(alphanumeric up to 40-character, special characters are 
allowed) (no restriction)  

City 

Enter the city to print at top of all receipt. 
(alphanumeric up to 30 character) (Space are allowed 
but not at start and end)  

State Enter the state code. (alphabetical up to 2 character)  

Zip 

Enter the zip code. (alphanumeric up to 10 characters , 
dash and space are allowed but not at starting and end 
positions)  

Merchant Phone Enter the phone number to print at the top of all receipt 
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Field/Button Allowable Value/Function 

(numeric 0-15).  

Processor Phone 
Enter the check approval host's phone number that prints 
on the receipt. (numeric 0-15) 

Transaction 

IP Address 
Enter the IP Address that the host uses for transaction 
approval request 

Port Number 

Enter the port number that the host uses for transaction 
approval request. (Non-Negative value with max 
999999999)  

Upload Check 
Image 

When an Electronic Check payment is processed, a copy 
of the check image is captured by default, temporarily 
stored on the Site Controller and then uploaded to the 
check image server. When disabled, the check image is 
not captured or uploaded.  

Image 

IP Address 
Enter the IP Address that the host uses for image 
uploading to copy the image of the check.  

Port Number 

Enter the port number that the host uses for image 
uploading to copy the image of the check. (Non-negative 
value with max 999999999)  

Trailer Line 1-4  

Enter the text of the first, second, third and the fourth 
line that prints on bottom of the receipt. (alphanumeric 
up to 40-character, Space are allowed but not in starting 
position)  

Misc 

Allowed Dual ID 
Swipe Prompt 

Select to prompt for a proof of identification from the 
check writer.  

Check Writer 
Name Prompt Select to prompt for the check writer's name.  
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Field/Button Allowable Value/Function 

Check Writer 
Address Prompt Select to prompt for the check writer's address.  

Check Writer 
Initials Prompt Select to prompt for the check writer's initials.  

Date Of Birth 
Prompt Select to prompt for the check writer's date of birth.  

Supplemental ID 
Prompt 

Select to prompt for a secondary proof of identification 
from the check writer.  

Offer Customer 
ECA 

Select to prompt the cashier to ask the check writer to 
accept the use of an electronic check.  

Limits 

Dual ID Floor 
Limit 

Enter the dollar limit at which the check writer must 
provide identification (0-999.99)  

Phone # Prompt 
Limit 

Enter the dollar limit at which the check writer must 
provide a phone number (0-999.99)  

Response 
Timeout 

Enter the time allowed to wait for a reply from the host 
(0-999)  

Close Period 

Select the period when the batch is closed. 

• Period 1(Close Shift) 

• Period 2 (Close Day) 

Electronic Safe 

Note: Refer to the Tidel Sentinel E-safe Interface feature reference 
documentation for information on this feature. The Feature Reference is 
available on Premier Portal. 

The Electronic Safe (E-Safe) is available for use at sites with Commander and the POS. 
An IP Connection to the safe hardware allows safe drop amounts to be retained and 
totaled to compare with the total amounts in the safe upon shift or day close. 

The reports available for the Electronic Safe are: 
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• E-Safe Cashier Report — A report that reconciles each cashier’s safe drop 
amounts with amounts recorded on the Electronic Safe. 

• E-Safe Day Report — (Generated at Shift or Day close) A report that reconciles 
all cashiers’ safe drop amounts with amounts recorded on the Electronic Safe 
for the period. 

• E-Safe Content Report — A report that is generated whenever the safe is 
opened.  This time-stamped report, that lists the actual contents of the safe, is 
stored on Commander and can be printed when required. 

 

Field/Button Allowable Value/Function 

Use E-Safe Only 

Select if all safes at the site are interfaced with the POS 
system. 

Do not select this parameter if safe drops will be made 
to a safe that is not interfaced with the POS system. 

Close Period 

Select the period when the Electronic safe is closed. 

1 – Period 1 (Close Shift) 

2 – Period 2 (Close Daily) 

Safe Type Select E-Safe manufacturer 
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Field/Button Allowable Value/Function 

Safe ID Mapping 

Employee — From the drop-down list, select an 
employee who can make safe drops to the Electronic 
Safe. 

Safe ID - Select the number of the Electronic Safe to be 
configured. 

Employee Safe ID — Enter the login ID that the selected 
employee uses to access the Electronic Safe. 

Add Click Add to add a new Electronic Safe number to be 
configured. 

Delete Select Delete to remove the selected Electronic Safe. 

Device Type 

Select the Device Type installed at the site. The 
following are the Tidel device types: 

• BCD: Bulk Coin Dispenser 

• BCD-R: Bulk Coin Dispenser and Recycler 

• BCND: Bulk Coin and Note Dispenser 

• SCD: Sentinel Control Device 

• Tidel Tube Vend 

Enable Select to enable the Electronic Safe. (The safe will not 
exchange data with the POS system unless it is enabled.) 

Description Enter a recognizable description of the Electronic Safe. 
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Field/Button Allowable Value/Function 

IP Information 

Safe IP — Enter the IP Address of the Electronic Safe. 

Safe Subnet — Enter the Subnet of the Electronic Safe. 

Safe Gateway — Enter the Gateway of the Electronic 
Safe. 

Safe Port — Enter the Port number of the Electronic 
Safe. 

Timeout (sec) Enter the communication timeout in seconds. 

Fuel Price Display 

The Fuel Price Display Configuration form is used to set up and edit the Fuel Price 
Display sign to suit the requirements of the site. 

After configuring or changing Fuel Price Display, initialize fuel prices for the changes 
to take effect.  To initialize fuel prices, select Forecourt > Initialization > Fuel 
Prices. 

Note:  Make sure that your fueling positions are not in use when initializing 
Fuel Prices. 
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Field/Button Allowable Value/Function 

Site Parameters 

Fuel Price Display 
Channel Select the fuel price display channel. 

Enable Channel Select to enable the Fuel Price Display feature. 

Delay Pump (0 – 300 
secs) 

Use to delay sending the price to the Pump.  

Note: Delay Pump and Delay Sign parameters are 
used to make the changed price appear 
simultaneously at both places if one network is 
slower than the other.  

Delay Sign (0 – 300 
secs) 

Use to delay sending the price to the Fuel Price 
Display. 

Note: Delay Pump and Delay Sign parameters are 
used to make the changed price appear 
simultaneously at both places if one network is 
slower than the other. 

Product Mapping 

Fuel Price Display 
ID [0-9] 

Select the ID number that maps to the fuel price line 
on the Electronic Sign and then select Enable. (Follow 
the Fuel Price Display sign manufacturer’s guidelines 
for IDs.) 

Note: The fuel prices that display is set in Forecourt > 
Fuel Prices. If tier pricing is in effect, the Fuel Price 
Display price is the current tier price. 

Enable Select to enable Fuel Price Display. 

Fuel Product [1-9] In the Fuel Product list, select only the fuel product(s) 
to be displayed for the fuel price display ID. 

Service Level Select the service level — Self, Full, Mini. 

Price Level Select the price level — Cash, Credit, Check. 

Implied Decimal [0- For most U.S. sites, select 3. For information, see the 
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Field/Button Allowable Value/Function 

5] Verifone bulletin for your Fuel Price Display sign. 

Fuel Price Display 
Text - Lines [0-9] 

Enter text to display on the Fuel Price Display sign 
(alphanumeric, up to 128 characters). HTML text 
attributes may be used. For information, see the 
Verifone bulletin for your Fuel Price Display sign. 

Delete Select to delete a line. 

Fuel Price Display Initialize 

Fuel Price Display Initialize should only be used after the sign has been repaired or if 
it is displaying pricing errors after losing power. In these cases, do the following: 

Devices > Initialization > Fuel Price Display 

Vending Machine 

Note: This feature is no longer supported. 

Attendant Payment Terminal 

Attendant Payment Terminal (APT) is a mini-POS used in the forecourt.  

Use Devices > Attendant Payment Terminal to configure APT. 

Note: Refer to Attendant Payment Terminal (APT) reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Global 

This form is used to enter the configuration that is valid for all APT terminals. 
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Field/Button Allowable Value/Function 

Login for Every 
Transaction 

Enable to login for every transaction. Default value = 
Disabled. 

Login Timeout (1-15 
minutes) The time a login lasts.  Default value = 10 min. 

Cash Receipt 
Required Enable to print cash receipts. Default value = Enabled. 

Preset Security 
Level 

Security level of the user who can login to the 
terminal. Default value = ‘0’. 

Enabled Payment 
Codes 

Click Edit button to select the payment codes 
supported. Default value = All Payment Codes 
enabled. 

Enabled 
Departments 

Click Edit to select the departments selected. Default 
value = All departments disabled. 

Terminal 

Use the form to enter each terminal detail. 
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Field/Button Allowable Value/Function 

Terminal ID Select the Terminal ID. The external POS terminal IDs and 
IPs are configured in Security > Manage devices.  

Receipt 
Header/Trailer  Enter details that will be printed on the receipt header and 

trailer.  

Parameters 

Fueling Stations 

Click to attach fueling positions to the APT. 

 

PINpad type Select if the PIN pad for making payments is internal 
or external. 

Allowed Operations Select the operations allowed using the APT 
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Vista Devices 

Note: Vista Devices CSC and CCW are not supported anymore. 

Carbon Commander Workstation (CCW) is a POS application for retail shops 
implemented on Carbon 10. The implementation leverages Commander Site 
Controller’s capabilities for item management, payment and communication. 
 
Use Devices > Vista Devices to configure CCW.  

Note: Refer to CCW reference documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Food Service 

Note: Refer to all the iOrder reference documentation for information on this 
feature. The Feature Reference is available on Premier Portal. 

The Food Service form is used to configure the iOrder Kiosk connection parameters. 

 

Field/Button Allowable Value/Function 

iOrder Configuration 

iOrder IP Enter the iOrder IP address  

iOrder Port Enter the iOrder Port 

Send POS Food Orders 
to KDS Enable to send food orders to kitchen display system 

Food Service Payment (Notify Kitchen) 
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Field/Button Allowable Value/Function 

Notify Electronically Enable to notify the kitchen electronically 

Notify via Receipt Enable to notify the kitchen via receipt 

Receipt Message Enter the receipt message 

Payment controller 

POS Configuration 

Refer to Configuring Network Functions 

Mobile Payment Configuration 

Note: Refer to the Mobile Payment feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

EPS Prepaid Configuration 

The EPS Prepaid Configuration form is used to configure prepaid cards, PIN-based 
products, and money transfer cards.   

• Prepaid card (Stored value card or SVC) – A cash value is placed on the card, 
which can then be used for purchases until the cash value is used up.  The card 
may be recharged with additional cash value. 

• PIN-based product – The customer buys the PIN-based product and uses the PIN 
(Personal Identification Number) printed on the receipt or card to activate the 
product.   

• Money transfer card – The customer presents the card and cash at the site, 
designates the payee by number, and the electronic payment is made. 
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1. Select the InComm in the Network Name dropdown menu. 

2. Check the Prepaid Enabled box. 

3. Click Add. 

4. Select the appropriate prepaid department from the Department dropdown 
list. 

5. Check the Enabled and/or Pre-Validate boxes. 

• The Enabled check box is used to enable or disable the prepaid 
department. 

• The Pre-Validate check box is used to specify whether an InComm Pre-
Authorization Request needs to be sent to the host when selling items 
from a prepaid department.  The Pre-Authorization Request is used to 
verify whether the actual transaction can be successfully completed 
before the payment is tendered. 

6. Click on Reprint Security Level column to set security levels for reprinting the 
receipt at the POS. 
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7. Three types of message prompts is displayed to cashier during prepaid card 
activation / recharge process: 

• Guideline message prompt: Guideline Prompt when enabled, prompts 
the cashier when a prepaid card activation item (ProdCode: 560 to 575) 
is added to the ticket. This message instructs the cashier to follow 
guidelines to avoid fraud. Default message for guideline prompt is 
“Please ensure you are following AML fraud guidelines by not selling 
more than $1900.00 in cards to one customer - The limit is $999.00 in 
the state of Arizona.” 

• Purchase message prompt: Purchase Prompt when enabled, prompts 
the cashier if PIN Activation item (ProdCode = 560) is added to the 
ticket. Purchase prompt appears after the Guideline Message Prompt if 
guideline prompt is enabled. Purchase prompt is to instruct the cashier 
not to give PIN numbers for prepaid cards over the phone. The Purchase 
prompt has YES and NO buttons. If cashier responds YES, then PIN 
Activation item can be added to the ticket. If cashier responds NO, then 
PIN Activation item is not allowed for sale and the item is removed from 
the ticket with an error message. Default message for purchase prompt 
is “Is this purchase being made by someone on site?” 

• Cancel message prompt: When cashier responds with a NO to the 
Purchase Prompt, the PIN Activation item is removed from the ticket and 
Cancel Prompt message (if enabled) is shown to the cashier. This prompt 
is to inform cashier that the item is being removed as it cannot be sold. 
Default message for Cancel Prompt is “PIN numbers are never to be 
given to anyone over the phone - NO EXCEPTIONS!” 

8. Click Save to save the configuration. 

Third Party Product Configuration 

Third Party Product Configuration feature provides the ability to support financial 
transaction services provided by the Cullinan Group. 

Note: Refer to all the Cullinan Feature Reference documentation for information 
on this feature. The Feature Reference is available on Premier Portal 
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EPS Configuration 

EPS Global Configuration 

Trigger Pull Configuration 

The Trigger Pull Function allows the host network to access the site any time for 
debug, support or application update. 

 

Field/Button Allowable Value/Function 

Merchant ID The Merchant ID is given to the store by the network 
and is part of the terminal identification number. 

Company ID The Company ID is given to the store by the network 
and is part of the terminal identification number. 

Terminal ID Terminal ID number. This number, supplied by the 
network is part of terminal identification number. 

Update Available 
Timeout (minutes) Timeout for Update Available prompt.  

Update Download 
Timeout (minutes) Timeout for update download.  
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Field/Button Allowable Value/Function 

Remove Pending 
Update on Manual 
Trigger Pull 

When this option is enabled, any pending updates are 
canceled prior to downloading the trigger file. 

Display Alarm on 
POS on Manual 
Trigger Pull 

When this option is enabled, any pending updates are 
canceled prior to downloading the trigger file. 

Update Location 

Service End Point This parameter holds the URL for the web service that 
provides the trigger files.  

Passcode This parameter holds the password required by the 
web service that provides the trigger files. 

Communication Options 

IP The communication is through an IP network. 

Dial Not applicable 

Full-Service Attendant Configuration 

Note: Refer to the Full-Service Attendant feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

FEP 

Use this tab to enable Full-Service Attendant (FSA) cards. 

 

1. Select FEP Enabled 
2. Click Save 
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FEP Card 

Use this tab to configure each FSA cards. 

 

Field/Button Allowable Value/Function 

Card Table Index The record number of the FSA card. This number cannot be 
changed after a card has been saved. 

Card Abbreviation Enter card Abbreviation. 

Card Name The name of the FSA card. 

Lower ISO Enter the Lower ISO of the card; given by the card provider. 

Upper ISO Enter the upper ISO of the card; given by the card provider. 

Pan Length Enter the Pan Length of the card; given by the card 
provider. 

Card Enabled Select to accept the FSA card at the DCR. 
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InComm Configuration 

Note: Refer to the InComm Configuration feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

FEP 

 

1. Check FEP Enabled.  

2. Enter Terminal ID. 

3. Enter Dealer ID. 

4. Enter IP Address (XXX.XXX.XX.XX). 

5. Enter Port Number (XXXX). 

6. Enter Store ID. 

7. Enter Gift Receipt Printing Option: Never, Always, Prompt Cashier 

8. Enable Fallback (Y/N): The EPS prompts the enabling or disabling of 
Fallback Processing. Fallback involves a stand-in approval of activations 
in the event of network connectivity failure with the InComm host. After 
connectivity is established, the stored transactions are sent to the host 
when a response is received or a Daily Close is performed. Timeout 
reversal will be always supported.  
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9. Enter Fallback Transaction Limit. 

10. Enter Fallback Dollar Limit ($0-9999).  

11. Enter SAF Retry Interval (1-15 Minutes). 

12. Enter SAF Retry Limit. 

Note: Zero means retry indefinitely. 

13. Click Save to save the configuration.  

FEP Card 

 

1. Click Add 

2. Enter Card Abbreviation 

3. Enter Card Name 

4. Enter Lower ISO 

5. Enter Upper ISO 

6. Enter Pan Length 

7. Enter Send Track 1 Option: Dont Send, Send Primary, Send Secondary 

8. Check Card Enabled to enable the card 

9. Check Refund Allowed to allow refund on the card 
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10. Click Save to save the configuration 

Payware Fleet Configuration 

This form is used to enable and configure Payware Fleet Card transactions.  

FEP 

 

Field/Button Allowable Value/Function 

Network 

FEP Enabled Select to enable the network. 

Dealer ID Enter the merchant ID number (alphanumeric, up to 11 
characters). 

Terminal ID Enter the terminal ID 

Acquirer ID Enter the acquirer ID 

Communication Options 

Mode Select the physical connection. 

IP Address/ Domain 
Name Enter IP address. 
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Field/Button Allowable Value/Function 

Port Enter port number. 

Enable SSL Select to enable secure communication. 

FEP Parameters 

Brand Enter brand code. 

Transport Protocol 
Data Unit 

Enter TPDU (Transport protocol data unit). The default 
value is “6000010000”. 

Net International ID Read-only value used for troubleshooting.  

NACS to Payware Product Mapping 

ID Auto generated 

NACS Code Enter NACS code 

Product Name Auto generated on save depending on the NACS Code 
entered.  

PW Host Code Map the Payware host code to NACS code 
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FEP Card 

 

Field/Button Allowable Value/Function 

Card Abbreviation Enter the abbreviated proprietary card name. 

Card Name Enter the proprietary card name. 

Lower ISO 

Enter the lower beginning digits that identify the 
proprietary card. 

Note: If only one number is provided, add a ‘0’ to the 
end. For example, XXXXXX0. 

Upper ISO 

Enter the upper beginning digits that identify the 
proprietary card. 

Note: If only one number is provided, add a ‘9’ to the 
end. For example, XXXXXX9. 

PAN Length Enter the total number of digits embossed on the card. 



Commander Site Controller User Reference 

173 

Field/Button Allowable Value/Function 

Card Enabled Select to enable the selected proprietary card. 

Manual Entry 
Allowed 

Select to allow the account number to be entered 
manually. 

Card Limits 

Print Customer 
Name Select to print customer name. 

Fiscal Receipt 
Enable Select to enable fiscal receipt. 

Signature on 
Financial Advice 

This parameter only applies to indoor prepay 
transactions. If enabled, the prepay receipt is not be 
printed at the time of prepay. A prompt instructs 
consumer to go inside for the receipt after fueling. 

Max Value for Pump 
Auth Enter the maximum value for pump authorization.  

Driver ID Prompt 
Enable Select to enable driver ID prompt.  

Driver ID Max 
Length Enter driver ID maximum length; 1-12 

Driver ID Min Length Enter minimum length for Driver ID; 0-12. 0 means 
optional  

Vehicle ID Prompt 
Enable Select to enable vehicle ID prompt. 

Vehicle ID Max 
Length Enter vehicle ID maximum length; 1-8.  

Vehicle ID Min 
Length 

Enter vehicle ID minimum length; 0-8. 0 means 
optional. 

Odometer Prompt Select to enable odometer prompt.  
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Field/Button Allowable Value/Function 

Enable 

Odometer Max 
Length 

Odometer min len = 0-6, max len = 1-6, Min default =0 
(0 min means optional), Max default = 6 

Odometer Min 
Length 

Odometer min len = 0-6, max len = 1-6, Min default =0 
(0 min means optional), Max default = 6 

PAN Mask Configuration 

Starting Visible 
Characters 

Specify the PAN masked in receipts.  More than first 6 
or last 4 digits can’t be exposed.   

Ending Visible 
Characters 

Specify the PAN masked in receipts.  More than first 6 
or last 4 digits can’t be exposed.   

Loyalty Configuration 

This form is used to enable and configure Loyalty Cards. 

Note: Refer to the Loyalty Sales feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Punch Card Configuration 

Note: This feature is yet to be implemented.  

Proprietary Fleet Configuration 

Note: Refer to the Proprietary Fleet Configuration feature reference 
documentation for information on this feature. The Feature Reference is 
available on Premier Portal. 
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FEP 

 

Field/Button Allowable Value/Function 

FEP Enabled Select to enable the proprietary network. 

Dealer ID Enter the merchant ID number assigned by Mannatec 
(alphanumeric, up to 11 characters). 

Communication Options 

Mode Select the communication mode; whether IP or Serial. 

Serial Mode – Communication Options 

Serial Port Select the Serial Port that is being used. 

Baud Rate Select the baud rate used by Mannatec. 
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Field/Button Allowable Value/Function 

Bits Select the Bits. 

Parity Select the Parity. 

Stop Bit Select the Stop Bit. 

IP Mode – Communication Options 

IP Address/ Domain 
Name Enter IP Address or domain name. 

Port Enter port number.  

Enable SSL Select to enable SSL. 

FEP Parameters 

Select the list of prompts that appears for the user to 
verify themselves. If the check box is enabled for a 
prompt, then the prompt data that the user gives is 
printed on the Receipt. 
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FEP Card 

 

Field/Button Allowable Value/Function 

Card Abbreviation Enter the abbreviated proprietary card name. 

Card Name Enter the proprietary card name. 

Lower ISO 

Enter the lower beginning digits that identify the 
proprietary card. 

Note: If only one number is provided, add a ‘0’ to the 
end. For example, XXXXXX0. 

Upper ISO 

Enter the upper beginning digits that identify the 
proprietary card. 

Note: If only one number is provided, add a ‘9’ to the 
end. For example, XXXXXX9. 

PAN Length Enter the total number of digits embossed on the card. 

Card Enabled Select to enable the selected proprietary card. 
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Field/Button Allowable Value/Function 

Accept 
Manual/Scanned 
Entry 

Select to allow the account number to be entered 
manually or scanned instead of swipe. 

DCR Auth 
(Authorization) 
Amount 

Enter the maximum credit transaction dollar amount 
allowed at the DCR for this proprietary card. 

Note: If the amount reaches the DCR limit, the pump 
automatically shuts off. 

EZ - Receipt Configuration 

This feature enables everyday customers to opt for getting receipts emailed instead 
of printed after a transaction. 

Note: Refer to the EZ – Receipt feature reference documentation for more 
information on this feature. The Feature Reference is available on Premier 
Portal. 

 

Field/Button Allowable Value/Function 

EZ – Receipt 
Enabled Select to enable EZ - Receipt 

Send EZ- Receipt 
Prompts to Cashier 

Select to get the EZ-Receipt Prompt on the POS in 
addition to the PIN pad.  
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Reporting 

Report Configuration 

Refer to Report Configuration 

Cashier Tracking 

Refer to Cashier Tracking 

Close Car Wash Paypoint Period 

Refer to Close Car Wash Paypoint Period 

Site Asset Data 

Refer to Site Asset Data 

Close Day Now 

Refer to Close Day Now 

Mobile Food Order Report 

Note: Refer to the Mobile Food Order Feature Reference for more information on 
the feature. The Feature Reference is available on Premier Portal. 

Tools 

Rule Manager 

Use to configure rules that automatically comply with corporate policies, laws, and 
regulations, to limit the number of and amount of certain products that can be sold 
over a period to a customer. 

To open Rule Manager, click Tools > Rule Manager. 
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Rule Manager allows you to: 

• Activate/deactivate a rule 

• Reorder rules (move up, move down) 

• Modify a rule 

• Create a copy of a rule, rename it, and modify it 

• Create a new rule 

• Delete a rule 

• Set up fast food orders on POS. See “Fast Food Orders on POS.” 

Activating or Deactivating a Rule 

To make a rule active or inactive 

• To activate a rule — Click the “Active” check box in front of the rule and click 
Save. 

• To deactivate a rule — Clear the “Active” check box in front of the rule and 
click Save. 
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Creating a Rule 

1. In Rule Manager, click Add. 

2. Enter a name for the rule.  

3. Enter a description (optional).  

4. Enter Register number. 

5. Select the scope of the rule: 

• Transaction — The rule is evaluated at the time of sale. 

• Line Item — The rule is evaluated when the item is entered as a line 
item. 

4. Select the item that triggers the rule to be evaluated. Depending on the rule 
you are modifying, select one of the following: 

• PLU  

• Department 

• Payment 

• Transaction Begin 

• Transaction End 
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5. Add conditions for the rule. Select the condition type from the drop-down list 
box. 

 

6. Select the operator to apply to the rule.  

Operator types “equal to, not equal to, and like” appear for “PLU, 
Department, Product Code, and MOP” Condition Types.  

Operator types “equal to, not equal to, greater than, less than, greater than or 
equal to, and less than or equal to” appear for “Quantity and Amount” 
Condition Types. 

 

7. Click “Edit” in Set Conditions section to select the PLUs or Departments or 
MOPs.  
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Or add the quantity or amount for Condition Types, “Quantity” and “Amount”.  

 

8. Click Edit in Available Actions section to determine the actions that occur when 
the rule is triggered, and the condition evaluates to true. 

 

9. The available actions are: 

• Alert Cashier: When the rule is triggered, alert the cashier.   

• Apply Blue Law: When the rule is triggered, apply a blue law. 
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Note: Blue Laws are set up in Store Operations > Restrictions > Blue 
Laws.  

• Apply ID Check: When the rule is triggered, apply an ID check. 

• Apply Min.Security Level Check: When the rule is triggered, check if the 
cashier has the minimum-security level to perform the transaction.  

• Journal Event: When the rule is triggered, journal the event with a 
message.  

• Veto: When the rule is triggered, prevent the transaction from taking 
place. For example, prevent a credit card MOP from being used when 
lottery is in the transaction.  

• Enter/Select POS Kitchen Printer: When the rule is triggered, send the 
transaction to the selected kitchen printer.  

• Send to Kitchen Display System via iOrder: When the rule is triggered, 
send the transaction to the Kitchen Display System (KDS).  

• Add Receipt Message: When the rule is triggered, add a message on the 
receipt.  

• Change Receipt Header: When the rule is triggered, change the receipt 
header.    

• Add Item: When the rule is triggered, the selected menu key is 
displayed.  

• Restricted Department: Select to add a restricted department.  
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10.  Click Set Attributes to set actions for the selected action type. 

 

 

11. Click Close 

12. In Rule Manager, click Save. 

Modifying a Rule 

Rules can be modified to change: 

• whether they act on a line item or a transaction, 
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• which event triggers the rule, 

• which conditions are in effect for the rule, 

• which actions occur when the rule is triggered. 

In Rule Manager, select the rule that you want to modify and click Modify. 

Copying a Rule 

The copy feature can be used to create the basis for a new rule. 

To copy a rule and rename it: 

1. In Rule Manager, select the rule. 

2. Click Copy. The copy is added to the end of the rule list, with _0 appended to 
the end of the original name. 

Deleting a Rule 

To delete a rule 

1. In Rule Manager, select the rule to be deleted. 

2. Click Delete. The rule is deleted. 

Fast Food Orders on POS 

Note: Refer to the POS to iOrder Feature Reference documentation for more 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Note: Refer to the Kitchen Printer Feature Reference documentation for more 
information on this feature. The Feature Reference is available on Premier 
Portal. 

A kitchen printer can be installed, and the Rule Wizard can be used to create a rule 
that sends selected PLUs from the POS to the specific kitchen printer and prints a 
receipt. 

1. Create a new rule. See “Creating a New Rule.” 

2. Follow the procedure to create the rule. See “Creating a Rule.” Set the 
following attributes for the rule:  
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• Scope of the rule — Select Transaction. 

• Trigger for the rule — Select Transaction End. 

• Conditions — Enter PLUs for the rule and select “Like” as the operator to 
apply to the rule. 

• Action — Select Send to Kitchen Printer and click Add. 

• Further define Action — Select or enter the name of the specific kitchen 
printer. 

3. Activate the rule. “See Activating or Deactivating a Rule.” 

4. See “Store Operations > Menu Keys” to make the rule part of an Order Menu. 

Entering customer name for food orders taken at POS 

1. In Tools > Managed Modules: 

1.  Select Kitchen Printer Service as kp.svc.POS 

2. Set System Hosting Kitchen Printer to 'sitecontroller' 

3. Click on Advanced Settings  

4. Select connection port and save 

5. Check Enable Kitchen Printer Service and save 

6. Click Tools->Refresh Configuration 

2. In Tools > Rule manager, create new rule  

1. Select Scope as “Transaction” 

2. Select Trigger Type as “Transaction End” 

3. Select Condition Type as “Department” and Operator Type as “like” 

4. Select the food department 

5. In Available Actions, select “Enter/Select POS Kitchen Printer” 

6. In Set Attributes form, Select Kitchen Printer as “kp.svc.POS” 
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7. Reboot Commander Site Controller 

3. In Store Operations > Sales > Sales Configuration: 

1. Select “Prompt Food Order Name” 

2. Select “Prompt Food Order Phone Number” 

Managed Modules 

Managed Modules is an interface for assigning port numbers and configuring 
communication parameters for hardware modules connected to the POS or Site 
Controller.  The configuration changes do not require a reboot of the Site Controller 
or the POS. Based on the device type selected, the default communication settings 
are populated.  

For any changes to be reflected in the system, select “Tools > Refresh 
Configuration” from Configuration Client and logout and login back to the POS.  

Changes to Fuel Driver and DCR Driver modules need driver initialization from 
“Forecourt > Initialization > DCR/Fuel Driver”. 

Changes to Car Wash module need a DCR initialization from “Forecourt > 
Initialization > DCR”.  

Current Configuration 

The current configuration tab is used for viewing, adding or editing the port and 
communication parameters of each hardware module. 

 

Host Name 

Select the host to which the hardware module is connected. The host can be the site 
controller, or each POS controlled bfy the site controller.  

POS 

Use to add the port and enable the hardware module connected to each POS. Select 
the POS from the Host Name drop-down list. In order to switch ports, disable the 
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device you want to move, as well as the device you want to move it to. Otherwise the 
Port Name drop-down only shows the port the device is already assigned to. 

Note: Most of these modules have feature references. Refer to the feature 
reference documentation for information on these modules. The Feature 
Reference is available on Premier Portal. 

Select Module 

Check Scanner 

Use to add the port and enable check scanner.  

 

Coin Dispenser 

Use to add the port and enable coin dispenser. 

 

DVR Logging Types 

The Digital Video Recorder (DVR) feature provides a DVR interface to the Point of 
Sales (POS) System to detect and deter attendant fraud. The DVR broadcasts certain 
transactions performed on the POS terminal and displays these events with video 
images recorded at the time the events occurred. This provides video images of 
attendant actions coupled with a journal of events as recorded by the POS terminal. 

Note: Refer to the Digital Video Recorder Implementation Guide for information 
on this feature. The Feature Reference is available on Premier Portal.  
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The “DVR Logging Type” configuration allows selecting types or classes of DVR events 
to be recorded. 

 

DVR Journal 

Use this form to add the port and enable DVR device. 
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PIN Entry Device 

Use to add the port and enable PIN Entry Device. 

 

Customer Display 

Use to add the port and enable Customer Display of C18 POS. 

On the back of the main C18 display are two USB ports located just below where the 
main display is mounted to the "handle bar".   Connect the C18 Customer Display 
cable to one of the USB ports.  

Note: Refer to the C18 Customer Display Installation guide for more information. 
The document is available on Premier Portal. 

Reboot the C18 system and wait for the main display to show "C18    Press Enter or 
touch screen to log in". 

 

1. De-select Enable Device 

2. For "Port Name", select USB Display.  

Note: If "USB Display" is not shown in the list, make sure to connect the C18 
Customer Display and reboot the POS. 

3. Click ‘Save'. 
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4. Select the "Enable Device" checkbox and Click "Save" again. 

5. Restart POS 

When the application starts, Register Closed is displayed on the Customer Display. 

After logging in to 'Sales', the phrase "Thank You" should be scrolling across the 
Customer Display. 

Scanner 

Use to add the port and enable scanner. 

 

Secondary Scanner 

Use to add the port and enable secondary scanner. 

 

Receipt Printer 

Use to add the port and enable Receipt Printer. 
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Drive Thru Configuration 

Use to add the port and enable drive through configuration. 

 

Controller 

Use to add or edit the port and communication parameters of each hardware module 
connected to the site controller. Select the site controller from the Host Name drop-
down list. 

Note: Most of these modules have feature references. Refer to the feature 
reference documentation for information on these modules. The Feature 
Reference is available on Premier Portal. 

Select Module 

Auxiliary Forecourt 

Note: Refer to the Auxilliary Forecourt feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Use to configure Auxilliary Forecourt devices like Aux Pos, Petro Vend and Wetstock 
Management Devices.  
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1. Click Advanced Settings next to Auxiliary Forecourt Channel 1 

 

2. Select Enable to enable Channel 1 

3. Select the Device Type: Aux Pos, Petro Vend or Wetstock Management 

4. Assigns the Commander Site Controller serial port to be used for the Channel 

5. Click Advanced Settings of Fueling Positions if the Device Type is Petro Vend. 
A Petro Vend device on a channel can control 16 fueling positions.  
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6. Click Save on the Channel 1 Fueling Positions to go back to the Auxiliary 
Forecourt Channel 1 Configuration form.  

7. Click Advanced Settings of Emulated PCTs if the Device Type is Petro Vend. 

 

8. Select PCT 1 for Channel 1 Petro Vend Configuration.  

Car Wash 

Note: Refer to the Car Wash topic in this document for information on this 
feature.  

 

1. From the Select Module list, select Car Wash 
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2. Select Device Type 

3. Click Advanced Settings 

 

4. Select the Serial Port 

DCR Driver 

Note: Refer to the Dispenser Car Reader topic in this document for information 
on this feature.  
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1. From the Select Module list, select DCR Driver 

2. Select to enable DCR Control 

3. Click Advanced Settings next to DCR Channel 01 

 

a. Click Enable Channel. 

b. Select IP Enabled for outside EMV DCRs 

c. Select Port name for serial port DCRs. 

d. Select DCR Family type. 

e. If debit encryption is to be used, click Advanced Settings 

 

a. Select Debit Encrypt Type 

DSM: Select if using a Dresser/Wayne DUKPT Security Module 
(DSM). 

DUKPT: Select for all US sites not using a GSM or DSM. 

GSM: Select if using a Gilbarco Security Module (GSM). 

MS: Select only for non-US sites using Master Session encryption. 
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NONE: Select if not configuring for Debit (no encryption). 

b. Click Save 

e. Click Save on DCR Channel 01 window 

Note: In feature Set 19 or higher for Wayne, there is an option to enable 
Enhanced CAT used for Secure CAT DCRs. This setting would only be used 
at Exxon Mobil sites that have Secure CAT DCRs (legacy or Dual CATs with 
injected secure messages). For both Wayne and SPP, if debit is used at the 
DCRs for the site a Debit Encrypt Type other than NONE must be selected 
(failure to do so will result in the keypad not functioning properly). 

4. Set up additional DCR channels as required using previous steps. 

5. Click Advanced Settings at DCR Positions to configure the appropriate channel 
for each DCR. 

 

a. For each DCR, specify the channel to which it is assigned.  

b. Click Save. 

DVR Configuration 

The Digital Video Recorder (DVR) feature provides a DVR interface to the Point of 
Sales (POS) System to detect and deter attendant fraud. The DVR broadcasts certain 
transactions performed on the POS terminal and displays these events with video 
images recorded at the time the events occurred. This provides video images of 
attendant actions coupled with a journal of events as recorded by the POS terminal. 

Note: Refer to the Digital Video Recorder Implementation Guide for information 
on this feature. The Feature Reference is available on Premier Portal. 
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1. Select the DVR mode: mode of communication for the DVR interface. The 
values are: 

a. Multicast: multicast communication is enabled. This is the default 
value. 

b. Serial:  serial communication is enabled 

c. Both: serial and multi cast communications are enabled 

d. Disabled: configures the system to not generate DVR events 

2. Multicast IP Address: The default Multicast IP Address is populated 

3. Multicast Port Number: The default Multicast Port Number is populated 

4. Local UDP port connations are to use: the fully qualified IP address and the 
multicast address. For example, 230.0.0.1:14001   

5. Number of upstream hops allowed for multicast packet: The DVR “Multicast” 
uses the “Multicast UDP Datagram” broadcasting mechanism to send DVR event 
info.  According to the IETF standard regarding “Multicast UDP Datagram”, the 
default ‘hop’ (or Time-To-Live - TTL) is ‘1’.  The TTL value is used by routers 
that when they receive a datagram, they decrement the TTL value.  If the TTL 
is still is greater than ‘0’, the datagram is forwarded to the router’s upstream 
LAN port (WAN).   The IETF cautions about using a TTL value grater than 1 for 
multicast UDP datagram in that they do not want the Internet flooded with 
these multicast datagrams and only allows use of the TTL value greater than 1 
if the routers are kept within an internal network. 
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6. We supply the ability to specify a value greater than 1 for those customers who 
have DVR monitoring equipment not in the “VFI Zone” and need to UDP 
datagram to forward ‘upstream’. 

7. Click Advanced Settings to select port 

 

1. Select port 

2. Select baud rate 

3. “Use Extended Protocol Mode” selects whether the DVR events send 
prepended byte codes normally used by journal printers.  Unselecting 
this entity does not send the byte codes.  Enable this value for 
backwards compatibility of legacy DVR equipment. 

For any changes to be reflected in the system, select “Tools -> Refresh 
Configuration” from Config Client. 

DVR Logging Types 

The “DVR Logging Type” configuration allows selecting types or classes of DVR events 
to be recorded. 

For any changes to be reflected in the system, select “Tools -> Refresh 
Configuration” from Config Client. 
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Fuel Driver 

Note: Refer to the Fuel Manager and Fuel Sales topics in this document for 
information on this feature.  
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1. Enable SPI when running Smart Pump Interface (SPI) at the site.  

2. Click Advanced Settings to configure Fuel Channel 01 

 

a. Click to Enable Channel. 

b.  Assigns the Commander Site Controller serial port to be used for the 
Channel.  

c.  Select Dispenser type. 

d.  Specify Total fueling positions on this channel. 

e.  The maximum and minimum delay for communication. 

Note: Maximum and Minimum Delay are used with Non-Modular Highline 
pumps only. 
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Fuel Price Display 

Note: Refer to the Fuel Price Sign Communication document for information on 
this feature. The document is available on Premier Portal. 

 

Click Advanced Settings to select port. 

 

Fuel RFID Configuration 

Note: Refer to the ORPAK AVI/RFID Fueling System feature reference 
documentation for information on this feature. The Feature Reference is 
available on Premier Portal. 

 Enter the RFID configuration details. 
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GSM 

 

Click Advanced Settings for each GSM (Gilbarco Security Module) port to assign 
the port. 

 

Kitchen Printer Service 

Note: Refer to the Kitchen Printer feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

 

1. Click to Enable Kitchen Printer Service 

2. Select the port for connection 
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MNSP VPN Management Service 

Verifone POS systems establishes or enables on-demand secure connections through 
the Managed Network Service Provider (MNSP) router. This enables the Verifone 
support personnel to interact with the POS systems through a VPN connection.  New 
PCI requirements do not allow continuous, persistent connections outside of the VFI 
Zone and that if connections are to be made, they must be initiated by the customer 
using Maintenance > Help Desk Diagnostics from the POS. 

Use this form to configure the MNSP VPN configuration.  

 

Money Order Feature 

 

1. Select to enable money order feature 

2. Reset Totals on Period Close is enabled by default and resets totals on the 
money order device when a period is closed by the cashier. 
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3. Select Device Terminal Type: MoneyGram Delta Network, Western Union ICE, 
or Western Union T7E. 

4. Click Advanced Settings to enter the communication parameters. 

MoneyGram Delta Network 

 

a. Select the Port 

b. Enter Terminal Id 

Western Union ICE6000 

 

a. Enter the money order terminal’s IP address 

b. Enter the Terminal Id of the money order device 

c. Enter the forwarding IP address for the money order terminal.  Typically 
the WAN side IP address of the Verifone zone router at the site should be 
entered.  

Note: The WAN side IP address of the Verifone zone router is the 
forwarding IP address that should be used for the standard money order 
device configuration where the device resides on the store LAN.  
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Western Union T7E 

 

Select the Port 

Speedpass 

 

1. Click Advance Settings of Wayne Device 1 

 

a. Click to Enable 

b. Trac Controller Address for device1 is HEX 95 
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c. Select Port 

d. Begin DCR #: 1 

e. End DCR #: 1- 32 

2. Click Advance Settings of Wayne Device 2 

a. Click to Enable 

b. Trac Controller Address for device2 is HEX 96 

c. Select Port 

d. Begin DCR #: 33 

e. End DCR #: 33 - 64 

3. Click Advance Settings of Gilbarco Device 1 

  

Click to enable DCR Positions. 

Tank 
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BIR (Business Inventory Reconciliation) E-DIM is an expansion card in the TLS box that 
receives transaction data from Commander fuel sales for reconciliation. 

1. Select Tank Model as EDIM 

2. Click Advance Settings 

 

3. Change Serial Port name to Port to be used, all other settings should be left 
default. 

Tank Level Sensor 

 

1. Select Device Type 

2. Click Advanced Settings to select port 
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Receipt Printer 

Use to add the port and enable Receipt Printer. 

 

Order Confirmation System 

Note: Refer to the Outside Confirmation Board feature reference documentation 
for information on this feature. The Feature Reference is available on Premier 
Portal.  

Use to configure the order confirmation system.  

 

• If the "Enable OCS" is selected, de-select and press [Save]. 

• For "OCS Type", select Delphi Systems OCS Ethernet 

• Select [Advanced Settings]. 

• For "Device Network Address”, enter above IP for the device. 

• For "Device Network Port”, enter above listening port for the device. 

• The “Order Confirmation System" settings should now be displayed 

• Select the Enable OCS and press [Save]. 
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Pending Configuration 

Feature not available. 

System Resources 

System Resources tab shows a list of the module names and the ports to which the 
modules and Channels are assigned. 

 

Refresh Configuration 

After any changes are made to Car Wash, POP, or Network parameters including 
Loyalty, the command “Tools > Refresh Configuration” needs to be executed for the 
new settings to be applied to fuel and DCRs. 

After changes are made to DCR parameters, the command “Tools > Refresh 
Configuration” is executed for the new settings to be applied to DCRs.  

Changes to the Receipt Header/Trailer parameters also require a DCR download.  

All the DCR position attributes except Pay At Pump, Push To Start Button, Grade 
Select Button, and Lever On Pump require a Initialize DCR Driver in addition to 
“Tools > Refresh Configuration”. 

Ping Utility 

Use to ping the devices in the LAN to check the communication status. Enter the IP 
address of the device and click Ping 
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Image Upload 

Users can import their own images and logos from Tools > Image Upload. 
 
 Note: Refer to the Self Checkout User Reference documentation for information 
on this feature. The Feature Reference is available on Premier Portal. 

Event Manager 

Enhanced System Monitoring feature provides a mechanism for retailers to remotely 
monitor certain events that occur at the site. Data required to monitor the site 
remotely is collected from all the registers at the site and sent to a configured 
remote server.  

Note: This document does not cover information on how to configure the server 
to receive events and view events. This section only covers the configuration 
done through the Configuration Client. 

Events that can be monitored are of two types: 

• Real Time Events: A Real Time Event triggers notification to the remote server 
only when there is an occurrence of a specific activity at the site. 

• Scheduled Events: Unlike Real Time Events, Scheduled Events trigger 
notification to the remote server periodically. We can configure the desired 
frequency rate at which the remote server should receive notifications. 

Event Configuration 
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Field/Button Allowable Value/Function 

Name An alias to the server. This should be unique. 

URL The URL to reach the remote server. 

Enable Event Check “Enable Event” to register for the event. A target 
server can be registered for multiple events. 

Event Type 

The following are the event types: 

• APP_START: Select to get notification when 
applications are started on each register including 
Commander Site Controller.  

• PERIPHERAL_STATUS: Get notification on the 
status of peripherals like scanner, PIN pad etc on 
each register. 

• FUEL_INIT: An event is triggered when fuel gets 
initialized.  

• PERIOD_CLOSE: An event is triggered on period 
close.   

• FUNDS_AUDIT: Get notification when funds are 
audited.  

• MWS_MGRACCEPTED: Get notification when the 
totals are accepted by manager on the Manager 
Workstation.  

• SALES_MONITOR:  All Sales transactions are sent 
to the server at certain frequency of time.  

• OTP_GENERATED – When OTP Generated is 
enabled, Commander Site Controller transmits the 
one-time password (OTP) that is requested within 
Configuration Client for specific secure actions, 
especially EPS Global Configuration, to the 
specified server URL. Enabling this function allows 
the OTP to be retrieved from the server rather 
than requiring the site to provide the OTP.  



Configuration Client Forms 

214 

Field/Button Allowable Value/Function 

Note: Verifone does not dictate how 
communication for the listening server is 
configured or set up. The server must be listening 
for the event to be collected at the time the 
Commander creates the event. The Commander 
does not retry or verify if the listening server 
received the message. It only functions to 
broadcast the one-time password.  

Note: This event can be used in conjunction with 
Verifone’s TSA Program. Contact your Sales 
Account Manager for more information on TSA. 

 

Certain events provide flexibility to receive a mapped 
user’s secure token (Cookie) as part of event 
notification. 

This secure token can be used by the remote machine to 
fetch the data further from the site by executing CGI 
commands. 

Notification 
Frequency 

This is applicable only for Scheduled event (Sales 
monitor). User can select the desired frequency rate 
listed. 

Test Event 
Registration 

The Test button is used to resend the last occurred 
event data (real time event) and snapshot of current 
system data (scheduled event). 

Reboot Commander 

This option reboots commander site controller.  

 

After the user selects “Yes”, an OTP is required to complete the process.  
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Helpdesk Diagnostics 

This menu is accessible from Configuration Client and POS. 

This menu provides diagnostic information. The diagnostics information can be used 
by both the Helpdesk as well as site users. 

The screens provide overall Online/Offline/Mixed status for configured devices in 
each section. 

• Online = Device(s) is/are connected and functioning 
• Offline – Device(s) is/are not connected or functioning 
• Mixed – One or more devices is not connected or functioning. 

There is a visual indicator (e.g. green/orange/red) along with the textual status. 

General Status 

The General Status screen reports the general status of the system.  

General Status reports overall Online/Offline/Mixed status of: 

• Controller (Commander) 

• Zone Router  

• Secure Services  

• Electronic Check, if configured 

• Electronic Safe, if configured 

• Food Services, if configured 

• Configured Registers 

• Configured Register Printers 

• Configured Register Scanners 

• Configured Pinpads 
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Forecourt Status 

This screen reports the last Online/Offline status and Offline time of all configured: 

• Pumps 

• DCRs 

• Car Wash 

• Car Wash Paypoint 

• Tanks connected to a Tank Level Sensor 

• Fuel Price Display 

• Vending Machine 

• Cash Acceptor 
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POS Status 

The POS status screen reports the following: 

• The Online/Offline status and time of all configured registers along with their 
ID. 

• The register as the device name (e.g. Topaz, Ruby2). 

• The detailed status and time of all configured printers. 

• Primary Scanners that are connected to a configured register and if they are 
enabled or disabled. 

• The detailed status and Offline time of all configured Electronic Check 
services. 

• The detailed status and Offline time of all configured Electronic Safes. 

• The overall status and Offline time of Commander Core Services. 

• The overall status and Offline time of EZR (connectivity from Commander 
devices to EZR). 

• The MAC address of EZR. 

• The overall status and Offline time of Secure Services (connectivity from 
Commander to online support). 

o The status and Offline time of connectivity to Cybera Support  

o The status and Offline time of connectivity to VRSD 
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Payment Status 

Reports Online/Offline status and time of all configured Feps, listed by Fep name.  
These include all configured Payment, Lottery, and Loyalty Feps, as well as Mobile. 
 
Reports the following information (if supported) for the Feps:  

• Last Batch Closed 

• Current Batch Number 

• Current Batch Count 

• IP Address 

• Last Transaction Date 

• Current Net Amount 

• Current Terminal Batch 

• Store and Forward count 

 

MNSP Status 

Shows the MNSP Status.  
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Help 

About 

The About screen in the Help tab displays the versions of the software that the system 
is running. 

   

Support 

This screen contains the service ID entered during installation and the help desk phoe 
number.  

The help desk phone number can be edited on configuration client from Initial Setup 
> Maintenance Configuration > Telephone & Postal Code.  
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Auto Upgrade and VRSD 
Overview 

The Auto Upgrade feature allows a site to initiate a complete software upgrade 
without requiring the presence or expertise of a technician (VASC) or intervention 
from the Verifone HelpDesk. 

The software is transferred to the system either by using the Auto_Upgrade.jar 
program or by an automated remote software download. Verifone Remote Software 
Download (VRSD) is the name for Verifone's implementation of the automated remote 
software download. 

Note: Refer to the Auto Upgrade feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal.  
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Car Wash 
Overview 

Car Wash feature is used to buy a Car Wash by different methods, at the POS, at the 
dispenser or at the car wash controller (if the site has the option available). When a 
customer purchases a car wash the system that is used for the purchase is forced to 
print a receipt because it prints the Car Wash code on the receipt. Car Wash code is 
entered at the Car Wash Controller when the customer decides to redeem the code 
for the Car Wash. 

When Car Wash is integrated with Commander™ Site Controller the following is some 
information on how this works: 

• Car Wash “items” must be sold as PLUs. 

• Car Wash items can be sold at POS or at dispenser where consumer is led 
through the required steps for purchase. 

• Car Wash code (for redeeming the car wash) prints on the receipt and so ticket 
printing is forced. 

• The PLU Promotions feature may be used to automatically discount Car Wash 
when the configured requirements for fuel purchased in the same transaction 
are met. 

Using Car Wash 

Transactions with Car Wash purchases print the Car Wash code on the receipt 
and so will always force a ticket print. 

Car Wash sales may be configured to offer a promotional price based on 
characteristics of the transaction.  

Note: This is an example of an automated discount and requires no special 
handling by the cashier. 

A Car Wash sale is a PLU sale and can be sold at the POS by the following 
methods: 

• The PLU number 

• A PLU soft key set up with a Car Wash PLU 
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• A menu key set up with Car Wash PLUs 

Note: A Car wash cannot be sold as a department sale. Car wash items can also 
be sold through a dispenser card reader. 

Car Wash Sale at the Dispenser 

Prompts for the customer to purchase one (or not) and to select a type appear 
before or after the customer begins fueling, depending on the POS settings. The 
following exceptions may occur: 

• Car Wash Disabled: The DCRs do not display the car wash prompt. 

• Cash Acceptor Sales: With cash acceptors, the car wash prompt is 
always displayed before fueling. 

• POS/Car Wash Controller Not Communicating: The DCRs display the 
prompt "CAR WASH UNAVAILABLE". 

The steps involved to sell or decline a sale of a car wash are as follows: 

Note: The steps indicated depends on the type of fuel dispenser, the POS 
settings, and the type of DCR. A receipt always prints if a customer purchases a 
car wash at the DCR. 

1. The car wash sale prompt appears if it is set for the beginning of the 
sale, otherwise, go to step 2  

 Touch [YES] to buy a car wash and choose from a list of wash 
options 

 Touch [NO] to refuse a car wash 

2. The car wash sale prompt appears if set to display at the end of the sale 
and the customer has not already purchased a car wash.  

Note: If the site has cash acceptors the car wash prompt will be at the 
beginning of the sale. Otherwise go to step 4. 

 Touch [YES] to buy a car wash and then choose from a list of 
wash options 

 Touch [NO] to refuse a car wash 

3. The DCR processes the receipt  
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 If the customer purchased a car wash, a receipt prints 

 If no car wash is purchased, standard receipt procedures occur 

Car Wash Sale at the POS 

Car wash items are sold in the same way as any other PLU at the POS. 

1. Enter Car Wash sale using one of the methods defined in “Using PLU 
Sales” section 

2. Press [TOTAL] to see amount due with car wash discount (if any) applied 

Note: If the car wash is not working at the time the customer made the 
purchase you will see one of the following messages appear on the screen: 

 “CAR WASH DOWN. CODE AVAILABLE PROCEED WITH SALE?”, 
answer “Y” if customer wants a rain check with car wash code or 
“N” if customer decides not to purchase the car wash. 

 “CAR WASH DOWN. CODE UNAVAILABLE PROCEED WITH SALE?”, 
answer “Y” if the customer wants to proceed with the sale and 
willing to return to get a code at a later date or “N” if customer 
decides against the car wash purchase. 

3. The POS processes the receipt 

 If the customer purchased a car wash, a receipt prints 

 If no car wash is purchased, standard receipt procedures occur 

Car Wash Receipt 

When a car wash is entered into a transaction, the POS prints a car wash code 
on the receipt. The customer can then use this code to run the car wash. When 
more than one car wash is sold on a ticket, a code prints for each one. Because 
each car wash sold must have a code to go with it, enter each car wash sale 
separately. The [QTY] key cannot be used. 
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Descr.        qty      amount 

 --            ---     ------ 

SUPER WASH      1       12.00 

DELUXE WASH     1       10.00 

                      ---------- 

     Sub Total          22.00 

           Tax           1.54 

              TOTAL     23.54 

             CASH  $    25.00 

         Change    $      1.46  

Your 5 digit Car Wash code(s) 

SUPER WASH       30940 

DELUXE WASH      14220 

Good thru THU 01/10/13 

  

  

Sample Car wash 
Receipt 

Configuring Car Wash 

Use Devices > Car Wash to configure car wash. 

 The Car Wash Configuration form is used to set up and edit car wash functions. See 
Store Operations > Restrictions > PLU Promotions to set up car wash promotions. 

Use Tools > Managed Modules > Car_Wash_Configuration to assign port and configure 
the communication parameters for Car Wash. 

Note: After any changes are made to Car Wash, POP, or Network parameters 
including Loyalty, the command “Tools > Refresh Configuration” needs to be 
executed for the new settings to be applied to fuel and DCRs. 
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Car Wash Configuration 

 

Field/Button Allowable Value/Function 

Enable Car Wash Select to enable car wash. 

Car Wash 

Department 

Select the car wash department. 

Days Car Wash 
Code is Valid 

Enter the number of days a car wash code is valid.  

A zero value denotes non-expiring card wash code. An expiration 
message is not printed on the receipt if the value is zero. 

Display Order (by 
Expense) 

Select ‘None,’ ‘Ascending,’ or ‘Descending’ (according to price) 
to establish the order in which car washes appear on the DCR 
display. 

Car Wash DCR Attributes 

Prompt at 
Beginning of Sale 

Select to prompt for a car wash before the customer begins 
fueling. 

Prompt at End of 
Sale 

Select to prompt for a car wash after the customer has finished 
fueling. 
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Field/Button Allowable Value/Function 

Menu Presentation Select to display the car wash prompt in menu form. 

The customer can choose a car wash item by keying the item 
number and pressing [ENTER] on the DCR keypad.  

(If not selected, the car wash prompt displays in a series of 
Yes/No questions.) 

Car Wash Key Setup 

PLU Enter the PLU number of the car wash. 

Modifier Enter the modifier for the PLU. 

 

If the PLU is valid, a small yellow index card appears. If the PLU 
cannot be validated, a black ‘X’ appears. 

Outdoor Select the car washes that can be purchased at the DCR. 

Valid Dates 

The receipt contains a code the customer can use to start a car wash. The last date 
that the code can be used follows the code. This date depends on the type of car 
wash controller and the site’s policy. 

 Discounts 

Car wash discounts are set up as promotional items. This means that if the customer 
purchases a car wash and has met the criteria for the promotional price, then the 
correct price is automatically applied after the cashier presses [TOTAL]. 

Note: Until the cashier press [TOTAL], the Operator Display and the Customer 
Display show the running total with the undiscounted price for the car wash. 

If the discount is set for the same price as the car wash item and the purchase 
requirements are met, then the car wash is free. The customer must request the car 
wash and the cashier must enter it into the transaction. The car wash promotion 
prints on the receipt and on the journal. 

Whether or not a car wash discount is available depends on three conditions: 
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• The type of discount that has been set up. 

• Whether the customer prepays or postpays for the fuel. 

• When the customer requests the discount. 

The following table displays how these conditions affect one another: 

Discount Type Prepay Sale Postpay Sale 

Minimum Quantity 
Purchase No discount Discount available 

Minimum Dollar Purchase 
of Specific Fuel Product No discount Discount available 

Minimum Dollar Purchase 
of Any Fuel Product 

Discount available if a 
customer purchases at least 
the minimum dollar amount 
set up in the PLU Promotion 
File and requests a discount 
before fueling. 

Discount available 

Reporting 

The Car Wash Report summarizes car wash sale activity and totals.  

    CAR WASH REPORT 

 DESCRIPTION           AMOUNT 

------------------------------ 

     COIN               1.00 

     TOKEN              2.00 

     USED               4 

------------------------------ 

Sample Car Wash 
Report 
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Report Details 

• COIN: The total amount collected at the coin box outside the car wash. 

• TOKEN: The total dollar value of tokens collected at the coin box outside the 
car wash. 

• USED: The total amount of car washes. 

Troubleshooting 

  #  Message  Description/Action 

E1174 NO CAR WASH COMM The POS and car wash controller are not 
communicating. Check that the controller is plugged in 
and connected to the correct POS COM port. 

E1170 CARWASH QTY SALE 
NOT ALLOWED 

Car washes can be sold only one at a time. 

E1171 NO CAR WASH KEY 

DEFINED FOR PLU 

A key for this car wash item must be defined. Set up a 
car wash PLU 

E1210 CAR WASH DOWN. 
CODE AVAILABLE 

The POS is not communicating with the car wash 
controller but can still provide a car wash code. The 
code is valid for a specified time. 

E1211 CAR WASH CODE 
UNAVAILABLE 

The POS is communicating with the car wash controller 
and no car wash code is available. The servicer should 
investigate the problem. 

E3033 ERROR IN CARWASH 
SETUP 

The car wash parameters have not been set up 
correctly and the Discount Type prompt displays in the 
PLU Promotion File function. Check the car wash 
parameters. 

E4003 INVALID CAR WASH 
DEPARTMENT 

A car wash department in the Car Wash function has 
been specified and the number entered has no 
department setup. Check the department number and 
re-enter the information. 

E4004 INVALID DAY Displays if the Car Wash Controller returns an invalid 
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  #  Message  Description/Action 

day. 

E4005 
Either 
may 
appear 

INVALID INPUT Entered an invalid value. Wait for the prompt to clear 
and enter the correct information. 

ERROR DISABLING 
CAR WASH 

An attempt was made to disable the car wash but was 
unsuccessful. Check the connections. Call the servicer 
if the connections are good. 

E4006 ERROR ENABLING 
CAR WASH 

An attempt was made to enable the car wash but was 
unsuccessful. Check the connections. Call the servicer 
if the connections are good. 

E4007 PLU ALREADY USED Attempted to assign a PLU to a car wash but it has 
already been assigned. Assign another PLU. 

E4008 NO OPEN PLUS 
ALLOWED 

Attempted to assign an open PLU to a car wash. This is 
not allowed.  

E4009 UNABLE TO READ 
CAR WASH FILE 

Attempted to assign a PLU to a car wash but the car 
wash key file cannot be read. Have the servicer 
investigate. 

E4010 ONLY CAR WASH 
ITEMS ALLOWED 

Attempted to assign a PLU to a car wash when the PLU 
has not been assigned to a car wash department. 
Assign the PLU to a car wash department then assign 
the PLU to a car wash. 

E4011 C/W PORT 
CONFLICT 

Alarm Line Only: Another device has been assigned to 
the car wash port. Check for correct port assignments. 

E4012 CAR WASH 
COMMUNICATION 
ERROR 

Alarm Line Only: The POS was unable to communicate 
with the car wash device. The servicer should 
investigate. 
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Car Wash Pay Point 
Overview 

This feature supports up to 4 Car Wash PayPoints; allowing customers to pay for a car 
wash at the car wash itself with cash or card.  Cash payment is handled at the 
paypoint and credit/debit payment is handled through the POS card processing 
network. All sales made using this feature are made available to the system for 
reporting. 

Note: Refer to the Car Wash Pay Point feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal.
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Cash Acceptors 
Overview 

Cash Acceptors can be used to allow customers to purchase fuel using cash at the 
DCRs. This is for cash acceptors that are internal to the dispenser. 

The cash sales are reported along with the outside sales on the POS system. 

Using Cash Acceptors 

1. To begin a transaction, insert a bill in the Cash Acceptor 

2. Continue to insert bills until the desired amount of fuel to be purchased 
is reached 

3. Press [Enter] 

4. Dispense Fuel 

5. The standard receipt procedures occur 

Configuring Cash Acceptors 

The Cash Acceptor Configuration form is used to set up and edit cash acceptors at the 
site. Site Information determines the behavior of all cash acceptors at a site. 
Attributes determines the behavior of a specific cash acceptor at a specific fueling 
point. 
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Field/Button Allowable Value/Function 

Disable If 
Cheated 

Select to turn off a cash acceptor when someone tries to 
cheat it. 

Disable If Paper 
Low 

Select to turn off a cash acceptor if the receipt tape is 
running out. 

Disable If No 
Printer 

Select to turn off a cash acceptor if the printer is not 
working. 

Prompt ‘insert 
cash’ 

Select to have the phrase “OR INSERT CASH” appear at 
the end of the idle prompt. 

$1 Bill Enabled Select to allow acceptance of one-dollar bills. 

$2 Bill Enabled Select to allow acceptance of two-dollar bills. 

$5 Bill Enabled Select to allow acceptance of five-dollar bills. 

$10 Bill Enabled Select to allow acceptance of ten-dollar bills. 

$20 Bill Enabled Select to allow acceptance of twenty-dollar bills. 

$50 Bill Enabled Select to allow acceptance of fifty-dollar bills. 

$100 Bill Enabled Select to allow acceptance of one hundred-dollar bills. 

Bill Orientation 

This parameter does not apply to Tokheim dispensers. 

Select to require that bills are inserted face-up with the 
black-seal end first. 

(If not selected, bills can be inserted face-up in either 
direction.) 

Note: The black seal appears on the front of the bill to 
the left of the face. 

Timeout 

[Seconds 10-99] 

Enter the time (in seconds) between when a customer 
inserts a bill and when the pump shuts off if no fuel has 
been pumped (10 - 99). 
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Field/Button Allowable Value/Function 

Cash Acceptor 
Attributes - 

Cash Acceptor 

  

Select the number of the fueling point. 

Duplicate 
Acceptor 

Click to copy the current cash acceptor’s attributes to 
any number of other cash acceptors. In the Duplicating 
Acceptor form, select the cash acceptor(s) to which you 
want to copy and click Done Duplicating. 

Cash Acceptor In 
Dispenser 

Select to indicate that the fuel pump has a cash 
acceptor. 

Reset Printer 
Error 

Note: This parameter is not currently supported. 

Select to enable the printer after the cash acceptor has 
been disabled and brought back online. 

Print Totals Now 

Note: This parameter is not currently supported. 

Select to print the amount of money in the cash 
acceptor. 
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Cash/Credit Pricing 
Overview 

Cash/Credit Pricing is used to allow a site to sell fuel at different fuel price levels 
based on whether the sale is paid by Cash or Credit (e.g. sites will often set the credit 
fuel price higher than the cash fuel price to offset the credit transactions fees for the 
site).  

If the site is using different fuel prices for cash and credit, they must disable (or 
uncheck) the Ignore MOP Conflict setting in Fuel Configuration > Site Params. 

The price level for each card type can be configured in the Payment Controller > EPS 
Configuration > <Primary FEP>  FEPCard - Cash Credit Pricing by Card Type 
configuration screen.  

If no configuration is done for the price level by card type, debit and prepaid cards 
default to cash fuel price level and all other card types default to credit fuel price 
level. 

Using Cash/Credit Pricing 

Prepay Transactions 

Amount Prepay: If the transaction is tendered by cash, the customer dispenses 
fuel at the cash fuel price level at the pump.  If the transaction is paid by 
credit, the customer dispenses fuel at the fuel price level configured for the 
card type (e.g. debit cards can either be configured at cash or credit price 
level). 

Volume Prepay: For volume prepays, the cashier must select a fuel grade and a 
fuel price level when they ring up the fuel prepay. If the transaction is tendered 
by cash, the MOP entered must match the fuel price level selected by the 
cashier. If the transaction is paid by credit, the price level configured for the 
card type must match the fuel price level selected by the cashier.  If there is a 
price level conflict, then an error message appears indicating "MOP Conflict".  

Postpay Transactions 

When the Ignore MOP Conflict parameter is enabled (or checked), sales can be 
tendered using any MOP regardless of the original fuel price level of the sale. 
 When this parameter is not enabled (or not checked) and if the transaction is 
tendered by cash, the MOP entered must match the fuel price level. If the 
transaction is paid by credit, the price level configured for the card type must 
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match the fuel price level.  If there is a price level conflict then an error 
message appears indicating "MOP Conflict".  

DCR Transactions 

Transactions initiated at the dispenser card reader are authorized at the fuel 
price level that has been configured for the card type that is used. 

Configuring Cash/Credit Pricing 

If the site is using different fuel prices for cash and credit, disable (or uncheck) the 
Ignore MOP Conflict setting in Forecourt > Fuel > Site Parameters. 

 

Configure cash and credit price amount for each fuel product  service levels in 
Forecourt >  Fuel Prices  form. 
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Price Tier allows credit cards to be setup for cash pricing for fuel. Configure Price 
Tier in Payment Controller > EPS Configuration > <Primary FEP> > FEPCard Type 
form.  

 

Troubleshooting 

If the site is using Cash/Credit pricing and did not ensure the Ignore MOP Conflict 
parameter is disabled (or unchecked), customers are able to select cash price level at 
the pump and pay with credit MOP for postpay transactions. This would result in the 
customer receiving the lower cash price even though they are paying by credit. 
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Combined Discounts 
Overview 

Discounts can be applied in varying ways to the transaction and are distinguished at 
the following levels:  

  Price Per Gallon (PPG) Discounts: These discounts reduce the price of fuel at 
the dispenser prior to fueling. 

  Line Item Discounts: These discounts are amount discounts that apply against 
an individual line item for a transaction. 

  Ticket Level Discounts: These discounts are amount discounts that apply to 
the entire transaction. 

Discounts Categories 

 Local: Local discounts are configured and applied on the POS system. 
 Host: Host discounts are applied by the loyalty or payment host. 

Local Discounts 

POP Discount (PPG and Fuel Line Item): Only one POP discount allowed per 
transaction.  

VIP NAXML Discounts (Line Item): Multiple VIP NAXML discounts may be applied per 
transaction.  

Car Wash Promotions (Carwash Line Item): Only one Car Wash promotion allowed 
per transaction. 

Special Discount (MOP Ticket Level): Only one Special discount allowed per 
transaction. 

Manual Discount (Line Item): Multiple Manual discounts may be applied per 
transaction. 

Host Discounts 

EPS Loyalty Discount (PPG, Ticket Level, and Line Item): Multiple EPS Loyalty 
discounts may be applied per transaction.  
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Payment Host Discounts (PPG, Ticket Level, and Line Item): Multiple Payment Host 
discounts may be applied per transaction. 

Using Combined Discounts 

• Multiple ticket level discounts may be applied in a single transaction.  

• A line Item may receive multiple discounts depending on order of the 
discounts within the transaction and loyalty host response.  

• Depending on configuration, multiple PPG discounts can be combined in a 
single transaction as a stacked PPG. This means that the multiple PPG 
discounts may be combined to a single PPG discount in fuel price. The 
combined discount cannot lower the price per gallon at the dispenser to 
lower than the minimum Price Per Unit (PPU) setting in Fuel 
Configuration. 

• When combining Payment Host and EPS Loyalty discounts, the Payment 
Host discounts have a higher precedence than EPS Loyalty discounts. 

Configuring Combined Discounts 

Inorder for the discount to be applied, the discount feature must be enabled and 
configured. Refer to the configuring section of the appropriate topic for further 
details. 

The "EPS PPG precedes POS PPG" parameter can be found in Payment Controller > 
POS configuration > POS > Loyalty. When this parameter is enabled, EPS Loyalty PPG 
discounts are applied before considering any POS PPG discounts. When this parameter 
is disabled, POS PPG discounts are applied before considering any EPS Loyalty PPG 
discounts.  
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Corrections 
Overview 

Use any of the following correction functions to remove, cancel, modify, or change 
line items in a transaction or to void the entire transaction: 

• ERROR CORR - Removes most recently entered line item or payment method 
when amount due > 0. 

• VOID LINE - Removes any non-fuel line item in the transaction. 

• VOID TICKET - Cancels the entire transaction. 

• PRICE OVER - Modifies unit price of a line item. 

• Change Qty - Modifies the quantity of a line item. 

• Allow Food Stamp - Allows the item that is entered to be purchased with food 
stamps. 

Note: After a loyalty card has been swiped, [VOID LINE] or [ERROR CORR] 
cannot be used, [VOID TICKET] must be used instead. 

Using Corrections 

Utilizing the various correction keys is dependent on if the cashier who is logged in 
has the required security level to perform the function. 

Error Correct 

Press [ERROR CORR] to remove last entry or partial payment entered in a 
transaction 

Note: [ERROR CORR] does not work if [CREDIT] has been pressed. 

Void Line 

1. Touch the line item to be voided, touch [VOID LINE]; if prompted, key 
User ID and password 

2. Key the line item exactly as it was first entered, and the line item 
negating the voided line is added to the transaction 
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Or 

1. Press [VOID LINE], and if prompted, key the User ID and password 

2. Key the line item exactly as it was first entered, and the line item 
negating the voided line is added to the transaction 

Void Ticket 

1. Press [VOID TICKET], and if prompted, key the User ID and password 

2. Entire ticket is voided and the system is ready to begin a new 
transaction 

Price Override 

1. Immediately after a line item has been added to the ticket, key new unit 
price 

2. Press [PRICE OVER] to change the unit price of that particular item 
and to recalculate the line item 

Or 

1. Touch the line item, and key the new single-unit price 

2. Press [PRICE OVER] to change the unit price of that particular item and 
to recalculate the line item 

Change Quantity 

1. Touch the line item to be changed, and key the new quantity 

2. Touch Change Qty to recalculate the line item using the new quantity 

Allow Food Stamps for Item 

This function processes an item not configured as food stamp eligible as though 
it is eligible for payment with food stamps.  It should be used in only accordance 
with store policies and procedures. 

1. Press [ALLOW FOOD STAMP] 

2. Key item 
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3. Tender Sale with Food Stamps MOP alone or in combination with another 
MOP 

Configuring Corrections 

Corrective functions may be customized through available options found in Store 
Operation > Sales. 

Securing Corrective Functions 

To secure corrective functions, enter a security value greater than zero for the 
appropriate function in "Sales Configuration." This forces a prompt for user ID and 
password and requires the security level of that user to meet or exceed the security 
level of the function. 

The following corrective functions may be configured to require ID and password 
entry:  

• Error Correct 

• Void Line 

• Void Transaction 

• Price Override 

Forcing Receipt Print for Corrective Functions 

The following functions may be configured to force a receipt print when used: 

• Void Transaction 

• Void Line 

Reporting 

The Corrections information is available in the “Memo Items” section of the following 
reports: 

• Summary Report 

• Cashier Report 
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 ERR/CORRECTS     1    2.54 

 VOID LINES       1    0.69 

 VOID TICKETS (+) 2    1.25 

 VOID TICKETS (-) 2    6.00 

Sample Cashier 
Summary Report 

Report Details 

• ERR/CORRECTS: Number of times and total amount caused by using the 
[ERROR CORR]. 

• VOID LINES: Number of times and total amount caused by using [VOID LINE]. 
This does not include lines voided as part of a void ticket. 

• VOID TICKETS: Number of times and total amount caused by using the [VOID 
TICKET] key. This includes a line for positive amounts and a line for negative 
amounts. 

Troubleshooting 

# Message Description / Action 

E1119  OPER. NOT 
ALLOWED 

If you try to void an item that is not in the transaction 
or do not enter the item exactly as it was originally 
entered, then the message 

“E1119: OPER. NOT ALLOWED” displays briefly. 

E1106 
USE VOID 
LINE/VOID 
TICKET 

Attempted to use [ERROR CORR] to remove more than 
the last item from the current transaction. Use [VOID 
LINE] to remove additional items from the transaction 
or [VOID TICKET] to remove the entire ticket. 

E1200 USE VOID 
TICKET 

[VOID LINE] cannot be used in this transaction, use 
[VOID TICKET]. 

E1297 
FUNC NOT 
VALID AFTER 
LOYALTY 

Attempted to enter disallowed functions after a 
loyalty card has been swiped (assuming a discount is 
given). For example, void line or error correct are not 
allowed after a loyalty packet has been sent. You must 
either void the ticket or complete the sale. 
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Department Sales 
Overview 

A department is a group of similar items. For example, a dairy department might 
include items like milk, butter, eggs, and ice cream. 

A department item is sold in one of the following ways: 

• [Department] soft key: A specific key set up for a specific department. 

• [OTHER DEPT] key: A specific key set up to accept sales to any defined 
department number. 

The maximum number of departments that can be configured by platform: 

• Ruby Ci - 9999 

• Commander Site controller – 9999 

Do not use departments 9990-9999: 

• 9990 - Loyalty (invisible department) 

• 9991 - Loyalty (invisible department) 

• 9992 – Fees (invisible in new applications) 

• 9998 – Manual fuel deposit – not invisible but required to ring up a manual fuel 
sale that doesn’t set the dispenser. This must not be altered or changed. 

• 9999 – Fuel Deposit (invisible) this department is read only because it’s the 
holding department for prepay fuel sales. It cannot be modified or changed. 

Using Department Sales 

Following are the types of Department Sales: 

• Basic Department Sale 

• Department Sale with Fee (Money Order) 

• Department Sale with ID Check 
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• Department Sale with Fractional Quantity 

• Department Sale with At-For Pricing 

Basic Department Sale 

1. Key <amount> of the item 

2. Do one of the following: 

 Touch department 

 Press department key 

 Press [OTHER DEPT] and then press appropriate department in 
the Other Department list 

Department Sale with Fee (Money Order) 

Money orders are typically sold using department keys. It is common to charge a 
fee for each money order sold. This fee is typically configured to be added 
automatically. 

Note: No more than five money orders can be sold during a single transaction. 
1. Key <amount> (for example: [1][0][0][0] = $10.00) 

2. Touch [MONEY ORDER] soft key 

Or 

1. Press [OTHER DEPT] and touch Money Order in the Other Department 
list 

2. Key <payee> or touch [OK] for a blank name 

3. Touch [OK] or press [ENTER] to complete manually and add money 
order sale to the transaction along with any applicable configured fee 

Department Sale with ID Check 

Departments with alcohol and tobacco products are usually set up with age 
verification. Purchase of these products is the same as with other departments 
with the exception of the age verification feature. The system displays a 
message alerting the cashier that an ID check is required. 
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The system rejects further entries until the date of birth is entered. Once 
entered, the system determines if the customer is old enough to purchase the 
item and either adds it to the transaction or displays a message. 

1. Touch or scan a product requiring ID checking 

2. Do one of the following: 

 Key birth date (mm/dd/yy) and touch [OK] or press [ENTER] 

 Swipe the magnetic stripe on the driver's license 

 Scan the 2D barcode on the driver's license 

The system either adds item to transaction or displays a message that purchase 
is not allowed. 

Department Sale with Fractional Quantity 

Department items can be sold in fractional quantity. 

1. Key quantity to be sold (for example: [5] [0] = 1/2 pound) 

2. Press [QTY] or enter the department item 

3. Do one of the following: 

 Key a PLU on the keyboard and press [ENTER] 

 Touch a PLU soft key 

 Scan the barcode 

Department Sale with At-For Pricing 

Pricing for some department items is based on purchase of a particular quantity; 
for example, 3 candy bars for $ 1.00. This is known as At-For Pricing (@/ 
pricing). 

Note: At-For Pricing cannot be used with items sold in fractional quantities. 

1. Key quantity being sold and press [QTY] 

2. Key number of items on which the price is based (for example, if the 
item sells three for $1.00, then key [3]) 
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3. Press [QTY] and key the base price (for example, key [1][0][0]) 

4. Do one of the following 

 Touch the department 

 Press the department key 

 Press [OTHER DEPT] and then touch the department in the Other 
Department list 

Recap: To ring up one unit of item that sells 3 for $ 1.00 - Press [3][QTY] [3] 
[QTY][1][0][0] this will look on screen like 3@3/100, then department.  

Configuring Department Sales 

Use Department section under Store Operations > Merchandise > Departments to 
define the departments.  

Merchandise Configuration 

 

Field / Button Allowable Value/Function 
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Field / Button Allowable Value/Function 

Number Enter the new department number (1 - 9999). 

Delete Click to delete the selected department. 

Add Click to add a new department. 

Name Enter a description (alphanumeric, 1 - 16). 

Min Amt Enter the department’s minimum allowable dollar amount for 
a line item sale (0.00 – 9999.99). 

Max Amt Enter the department’s maximum allowable dollar amount for 
a line item sale (0.00 – 9999.99). 

Product Code 

Select the name assigned to the product code (set by the 
network) that categorizes the products sold. 

Note: If a PLU and a department have different codes, the 
product code assigned to the PLU overrides but only if the 
product code in the PLU File ≠ 0. 

Category  

If categories are used, select the category.  

Note: Categories are set up in Store Operations > 
Merchandise > Category. 

Fee 

If a fee automatically applies to sales in this department, 
select the fee. 

Note: Fees are set up in Store Operations > Payment > 
Fees. 

ID Check 

If the department requires an ID check for purchase, click the 
Edit button. 

In the ID Check form, select the appropriate ID Check. Click 
Done. 

Note: ID Checks are set up in Store Operations > 
Restrictions > ID Check. 
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Field / Button Allowable Value/Function 

Taxes 

If a tax is added when items in the department are sold, click 
Edit and select the appropriate tax. 

Note: Taxes are set up in Store Operations > Payment > 
Tax Rates 

Blue Laws 

If the sale of an item in the department is restricted on a 
designated day(s), click Edit and select the appropriate Blue 
Law. 

Note: Blue Laws are set up in Store Operations > 
Restrictions > Blue Laws 

Fuel Tax 
Exemption 

Select the Fuel Tax Exemption that applies to the 
department. 

Notes: 

• This parameter does not appear unless a Fuel Tax 
Exemption record has been set up in Forecourt > Fuel 
Tax Exemption. 

• Applies to fuel departments only. 

Transaction 
Quantity Limit 

Determines the quantity limit per transaction. 

This parameter is used to restrict bulk quantity purchase of 
certain items. This field accepts non-negative decimal 
number to allow for fractional quantity. Default value is 0.00 
and means that there is no restrictions on the total purchase 
quantity in a transaction. 

Allow Food 
Stamps 

Select if food stamps may be used to purchase items in this 
department. 
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Field / Button Allowable Value/Function 

Allow Special 
Discount 

Select if the items in this department may have a special 
discount applied to them (for example, a Senior Citizen 
Discount). 

Note: If this parameter is selected, then Special Discount 
MOP should be set up in Store Operations > Payment > MOP 
with Special Discount MOP Code. 

Allow 
Fractional 
Quantity 

Select if items in this department are to be sold in fractional 
quantities. 

Note: If this parameter is selected, all quantities entered in 
department sales for this department are read as decimals. 
For example, if the quantity is 1¾ lbs of turkey, key [1] [7] 
[5]. If this parameter is not selected, all quantities entered 
are read as whole numbers. 

Negative 
Department 

Select if transaction amounts are subtracted from receipt and 
report totals. 

Fuel 
Department 

Select to define the department as a fuel department. 

Note: If this parameter is selected, then do not select “Mark 
as Negative.” 

Money Order 
Department 

Select to define the department as a money order 
department. 

Note: If this parameter is selected, then do not select "Mark 
as Negative." 
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Field / Button Allowable Value/Function 

Prompt Serial 
Number 

Some items that Convenience Stores sell need to have their 
serial number printed on the receipt.  When such an item is 
scanned/entered, the POS needs to prompt the cashier to 
enter the product’s serial number. 

Enable to prompt for serial number to be printed on the 
receipt. Cashier can either enter the serial number or bypass 
the prompt to complete the transaction. Serial number can 
be entered via screen keys, hard keys, or scanned via 
scanner. 

Prohibit 
Discount 

Select to prohibit discounts configured to be applied by 
pressing the discount key.  

 Prohibit Discount does not affect PLU Promo, NAXML Promo 
(Combo/MixMatch), or Loyalty line item discounts. 

Reporting 

The Department Report reflects sales-related totals and counts on a department by 
department basis. 

  DEPARTMENT REPORT  

 DEPT# DESCRIPTION CUST ITEMS %OF SALES 

     GROSS REFUNDS DISCOUNTS NET SALES 

 --------------------------------------- 

 9001 BAKERY     2    2.00      2.83% 

       11.00  0.00    0.00       11.00 

 9004 TAX GROC     5    6.00    2.46% 

       10.26  0.00    0.70        9.56 

 9005 DAIRY        2    2.00    1.31% 

        5.58  0.00    0.50        5.08 

Sample Department 
Report for All 
Departments  
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 9006 N/TAX GROC   3    1.00    3.48% 

       15.50  2.00    0.00       13.50 

 9030 MONEY ORDER  2    2.00    30.96% 

      120.00  0.00    0.00       120.00 

 9031 M.O. FEE     2    3.00   .  81% 

        3.00  0.00    0.00      0.22 

 9032 BOTTLE DEPOS 1    7.00     0.33% 

        1.30  0.00    0.00       1.30 

 9033 BOTTLE RETUR 1  -2.00     -0.08% 

       -0.30  0.00    0.00       -0.30 

 9040 UNLD.        2   2.00     25.80% 

      100.00  0.00    0.00       100.00 

 9041 MID          1    1.00    12.96% 

      50.24   0.00    0.00       50.24 

 9042 PREM.        1    1.00    11.86% 

      50.00   0.00    4.02       45.98 

 9050 PLU NOT FOUN 1   1.00     0.32% 

       1.25   0.00    0.00       1.25 

 9060 MISC         8   12.00    2.11% 

      32.98    0.69   4.95       8.20 

 --------------------------------------- 

 NEG DEPTS             -2.00 

      -0.30    0.00   0.00      -0.30 

 OTHER DEPTS          66.00 
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     400.81    2.69   10.17    387.95 

 ------------------------------------- 

 TOTAL                64.00     100.00% 

     400.51    2.69   10.17     387.65 

Report Details 

• DEPT#: Four-digit identification of the product as it appears in the Department 
File. 

• DESCRIPTION: Description of the product as it appears in the Department File. 

• CUST: Number of transactions that included one or more items from this 
department. 

• ITEMS: Quantity sold of this item. 

• %OF SALES: Total Sales for this department divided by Total Sales (all 
departments). 

• GROSS: Total dollar amount collected for sales of a department. 

• REFUNDS: Total dollar amount refunded for items returned in a department. 

• DISCOUNTS: Total dollar amount discounted for items sold in a department. 
This total includes both automated and manual discount types: 

o Use of the [DISC], [DISC%], and [DISC AMT] keys 

o Combo, mix ’n match, fuel, and promotional discounts 

o POP discounts 

• NET SALES: Total dollar amount of items sold in a department after refunds 
and discounts have been applied. 

• NEG DEPTS: The totals for departments marked as negative departments. 

• OTHER DEPTS: The totals for other department sales not marked as negative 
departments (typically, most departments fall into this group). 
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• TOTAL: Total department sales after negative department total is subtracted 
from other (standard) departments. 

Troubleshooting 

 #  Message  Description/Action 

E1115 INVALID DEPARTMENT 

The department entered in Department 
Setup function in Car Wash Manager mode 
does not exist. Define the department in 
the Department File or choose another 
department 

E1116 AMOUNT TOO LARGE 
The dollar amount entered is larger than 
the maximum allowed for this department 
or MOP. 

E1121 DISCOUNT TOO SMALL The discount entered is less than the set 
minimum amount. 

E1122 DISCOUNT TOO LARGE The discount entered is more than the set 
maximum amount. 

E1131 AMOUNT TOO SMALL 
The dollar amount entered is less than the 
minimum set up for the department or 
MOP. 

E1140 AMOUNT REQUIRED A dollar amount must be entered. 

E1141 PURCH. NOT ALLOWED  

The customer cannot purchase this item 
because either (1) the date of birth entered 
for the ID check does not meet the age 
requirements or (2) a Blue Law restriction 
has been set up for this item or department 
at this time on this day. 

E1145 CASH ONLY ALLOWED Only cash is allowed in this transaction. 

E1201  NO AT-FOR SALES 
W/FRACTIONAL QTY 

At-for pricing cannot be used for items that 
can be sold in fractional quantities. 

E6720  DEPARTMENT INVALID The department number was determined to 
be invalid. 
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 #  Message  Description/Action 

E7056  DEPARTMENT NOT FOUND User has attempted to configure an invalid 
department for the Loyalty program. 

E7057  DEPARTMENT ALREADY 
PART OF LOYALTY 

User has attempted to configure the same 
department more than once in the Loyalty 
file. 

  



255 

Dispenser Card Readers 
Overview 

Dispenser Card Readers (DCRs) give customers the option of paying at the dispenser. 
DCRs read the magnetic stripe of credit, debit, and similar cards, sends the 
information to a credit network, and controls dispensing fuel based on the network’s 
response. 

Dispenser Types 

Although different manufacturers refer to card readers by various trade names, 
Verifone uses DCR (Dispenser Card Reader) as a generic term for all of them. 

Manufacturers Card Reader Name 

Bennett Dispenser Card Terminal (DCT) 

Dresser/Wayne Dispenser Card Processing Terminal (DCPT) 

Gilbarco CRIND®: Card Reader IN Dispenser 

Tokheim Dispenser Payment Terminal (DPT) 

Using Dispenser Card Readers 

Dispenser Card Reader (DCR) Card Fuel Sale 

Below are some common functions that are related to DCR sales: 

 Approve DCR Transaction: Some states require cashier intervention 
before fueling can begin. 

 View Fueling Point: A small yellow triangle indicates that the network 
has returned a message or customer has requested help. In either case, 
fueling position should be viewed to clear the message. 

 Reprint DCR Transaction: Occasionally, customers come to the counter 
to request a DCR receipt (paper ran out). 

This function reprints DCR and completed prepay transaction receipts. 

Touch <fueling point> [VIEW], touch [Reprint DCR TRAN] and select the 
transaction to print. 
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The most recent transaction is always at the top of the list and 
highlighted. 

During a DCR transaction, a small card icon appears in the background of the 
graphic for that fueling position as shown below: 

POS Icon Description 

 

DCR Calling: Customer swipes the credit card and the card 
appears on button. 

 

DCR Approved: Image changes into a nozzle ready to dispense 
fuel. 

 

DCR Dispensing: Nozzle moves and fuel "drips" to show fueling. 

 

Idle: Fueling point returns to Idle upon completion of DCR sale. 

 

Help: Help is requested or there is a network message that 
should be viewed.  View pump to clear the icon. 

DCR Sales Sequence Table 

The sales sequences for DCR transactions for all dispensers the POS supports are in 
the tables below. These tables show how the configuration can change the customer 
experience at the pump. Consider the following in all tables:  

 If the POS is in the idle state, the fueling point number remains lit and the 
icons are dark. 

 If the POS is sending data to the DCRs, a “LOADING” message replaces the 
current prompt until the transmission is complete. 

 Card types cause different prompts to appear: 
 Debit cards: If a customer inserts a debit card without first pressing the 

[DEBIT] key, “DEBIT OR CREDIT?” appears on the display. After a card 
has been identified as a debit card, the display prompts with “ENTER 
PIN.” 

 Fleet cards: Different Fleet cards prompt the customer for information 
such as odometer reading, vehicle identification number, etc. 

 Stored Value Cards: Also known as prepaid cards, these cards usually 
display the balance that remains on the card.  
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DCR Sales Examples 

The following DCR sales examples are mentioned the DCR sales sequences table:  

 DCR Sale Using a Card 
 DCR Sale Using a POP Discount Code 
 Pay Inside Sale Using a POP Discount 
 Postpay Inside Sale 
 Prepay Inside Sale 
 Card Rejected with Hot Pump Enabled 
 Card Rejected with Hot Pump Disabled 
 Card Not Removed 
 POP Discount Code Rejected 

 DCR Sale Using a Card 

                                               DCR Sale Using a Card 

User/DCR Action                     POS Action                                 DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a 
card. 

Fueling point number icon 
flashes. 

REMOVE CARD RAPIDLY 
Schlumberger: PLEASE 
REMOVE THE CARD 
Displays for 5 seconds. 

Customer removes 
card. If customer does 
not remove card, see 
“Card Not Removed” 
table. 

POS performs local validation of 
card. ONE MOMENT PLEASE 

Customer waits. POS requests card 
authorization. 

  

 “Hot DCR pump” in Fuel Manager > DCR Configuration is set to ‘Y’. 
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                                               DCR Sale Using a Card 

User/DCR Action                     POS Action                                 DCR Prompt 

Credit or debit card: 
The customer waits. 

POS approves pump before 
authorization is received. Car 
icon lights. If authorization is 
then rejected, see “Card 
Rejected with Hot DCR Pump 
Enabled.” Card rejection 
information is noted on the 
journal. 

Start Fueling Prompt 

 “Hot DCR pump” is set to ‘N’. 

Credit or debit card: 
The customer waits. 

POS approves pump after 
receiving authorization. If 
authorization is rejected, see 
“Card Rejected with Hot DCR 
Pump Disabled.” Card rejection 
information is noted on the 
journal. 

Start Fueling Prompt 

Customer removes 
nozzle and dispenses 
fuel. 

POS sounds a tone to indicate 
fueling has started. Nozzle icon 
lights. 

Promotional Message 

If “Always print receipt” parameter in DCR Site Parameters in Fuel Manager mode is 
set to ‘N’. 

Customer completes 
fueling and replaces 
nozzle. Customer 
responds ‘Yes’ to 
“RECEIPT?” 

Fueling point number icon 
flashes. Ruby beeps to indicate 
fueling is complete. 

RECEIPT (YES/NO)? 
followed by PRINTING 
RECEIPT followed by 
RECEIPT IS READY Displays 
for 5 seconds - beeps. 

  

Customer completes 
fueling and replaces 
nozzle. 
Customer responds 
‘No’. 

Fueling point number icon 
flashes. POS beeps to indicate 
fueling is complete. 

RECEIPT (YES/NO)? 
THANK YOU 

If “Always print receipt” is set to ‘Y’. 
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                                               DCR Sale Using a Card 

User/DCR Action                     POS Action                                 DCR Prompt 

Customer completes 
fueling and replaces 
nozzle. Customer 
waits. 

Fueling point number icon 
flashes. POS beeps to indicate 
fueling is complete. 

PRINTING RECEIPT 
followed by RECEIPT IS 
READY THANK YOU, 
displays for 5 seconds - 
beeps. 

DCR returns to idle 
state. Idle state. Idle Prompt 

DCR Sale Using a POP Discount Code  

DCR Sale Using a POP Discount Code 

User/DCR Action                        POS Action                                DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a 
card. 

Fueling point number icon flashes. REMOVE CARD RAPIDLY 
Schlumberger: PLEASE 
REMOVE THE CARD 
Displays for 5 seconds. 

Customer removes 
card. If customer 
does not remove 
card, see “Card Not 
Removed” table. 

POS performs local validation of 
card. 

ONE MOMENT PLEASE 

Customer waits. POS requests card authorization.   

 “Hot DCR pump” in Fuel Manager > DCR Configuration is set to ‘Y’; “POP Discount 
Enable” and “POP Discount Code Enable” in Manager > Configuration > Sales Config 
are set to ‘Y’. 

Customer enters ‘Y’ 
or ‘N’. 

  POP CODE? Y/N 
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DCR Sale Using a POP Discount Code 

User/DCR Action                        POS Action                                DCR Prompt 

If customer enters 
‘Y’, prompt to enter 
the POP code 
appears. 

  ENTER DATA 

Customer enters 7-
digit POP Code. 

POS approves code before 
prompting for card. If code is 
rejected, see “POP Code Rejected” 
table. 

  

Credit or debit 
card: The customer 
waits. 

POS approves pump before 
authorization is received. Car icon 
lights. If authorization is then 
rejected, see “Card Rejected with 
Hot DCR Pump Enabled.” Card 
rejection information is noted on 
the journal. 

Start Fueling Prompt 

“Hot DCR pump” is set to ‘N’. 

Credit or debit 
card: The customer 
waits. 

POS approves pump after receiving 
authorization. If authorization is 
rejected, see “Card Rejected with 
Hot DCR Pump Disabled.” Card 
rejection information is noted on 
the journal. 

Start Fueling Prompt 

Customer removes 
nozzle and 
dispenses fuel. 

POS sounds a tone to indicate 
fueling has started. Nozzle icon 
lights. 

Promotional Message 

If “Always print receipt” parameter in DCR Site Parameters in Fuel Manager mode is 
set to ‘N’. 
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DCR Sale Using a POP Discount Code 

User/DCR Action                        POS Action                                DCR Prompt 

Customer completes 
fueling and replaces 
nozzle. Customer 
responds ‘Yes’ to 
“RECEIPT?” 

Fueling point number icon flashes. 
POS beeps to indicate that fueling 
is complete. 

RECEIPT (YES/NO)? 
followed by PRINTING 
RECEIPT followed by 
RECEIPT IS READY 
Displays for 5 seconds - 
beeps. 

Customer completes 
fueling and replaces 
nozzle. 

Customer responds 
‘No’. 

Fueling point number icon flashes. 
POS beeps to indicate fueling is 
complete. 

RECEIPT (YES/NO)? 

THANK YOU 

If “Always print receipt” is set to ‘Y’ 

Customer completes 
fueling and replaces 
nozzle. Customer 
waits. 

Fueling point number icon flashes. 
POS beeps to indicate fueling is 
complete. 

PRINTING RECEIPT 
followed by RECEIPT IS 
READY THANK YOU 
displays for 5 seconds - 
beeps. 

DCR returns to idle 
state. 

Idle state. Idle Prompt 

 Pay Inside Sale Using a POP Discount 

Pay Inside Sale Using POP Discount 

User/DCR Action                          POS Action                                   DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer selects any PAY 
INSIDE option (PAY INSIDE 
CASH, PAY INSIDE 
CREDIT). 

Car icon flashes and POS beeps 
repeatedly. 

ONE MOMENT PLEASE 
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Pay Inside Sale Using POP Discount 

User/DCR Action                          POS Action                                   DCR Prompt 

Customer waits. Cashier approves pump. Nozzle 
icon lights. 

Start Fueling Prompt 

Customer dispenses fuel. POS sounds a tone to indicate 
that fueling has started. 

Promotional Message 

Customer completes 
fueling and replaces 
nozzle. 

Dollar icon lights. POS beeps to 
indicate fueling is complete. 

PLEASE PAY CASHIER 
Displays for 20 seconds 
- beeps 3 times. 

Customer goes inside to 
pay. 

If codes are enabled, cashier 
processes POP discount code or 
coupon at the POS when fuel 
sale is tendered. 

Idle Prompt 

DCR returns to idle state. Idle state. Idle Prompt 

 Postpay Inside Sale 

Postpay Inside Sale 

User/DCR Action                            POS Action                               DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer removes nozzle. Car icon flashes and POS 
beeps repeatedly. 

  

ONE MOMENT PLEASE 

Customer waits. Cashier approves pump. 
Nozzle icon lights. 

Start Fueling Prompt 

Customer dispenses fuel. POS sounds a tone to 
indicate fueling has started. 

  

Promotional Message 
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Postpay Inside Sale 

User/DCR Action                            POS Action                               DCR Prompt 

Customer completes fueling 
and replaces nozzle. 
Dollar icon lights. 

POS beeps to indicate fueling 
is complete. 

PLEASE PAY CASHIER 
Displays for 20 seconds - 
beeps 3 times 

DCR returns to idle state. Idle state. Idle Prompt 

 Prepay Inside Sale 

Prepay Inside Sale 

User/DCR Action                                POS Action                                 DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer prepays inside. Car icon lights. Pump is 
approved. 

Start Fueling 
Prompt 

Customer inserts card at an 
already prepaid pump. (This 
applies to systems without a 
[CASH] key and the “Handle Up 
Calling” set to ‘N’, “Full Service 
Preset at Pump” set to ‘Y’ and 
“Autocollect” set to ‘0’.) 

  CARD NOT READ 
Displays for 5 
seconds - beeps 3 
times. 

Customer removes nozzle and 
follows start fueling instructions, 
and begins to dispense fuel. 

Nozzle icon lights. POS 
sounds a tone to indicate 
fueling has started. 

Promotional 
Message 

Customer completes fueling and 
replaces nozzle. 

Nozzle icon turns off. POS 
beeps to indicate fueling is 
complete. 

  

Customer has dispensed less than 
prepaid amount. 

Dollar icon lights. POS beeps 
to indicate fueling is 
complete. 

SEE CASHIER 
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Prepay Inside Sale 

User/DCR Action                                POS Action                                 DCR Prompt 

Customer has dispensed more 
than prepaid amount. 

Dollar icon lights. POS beeps 
to indicate fueling is 
complete. 

SEE CASHIER 

Customer has dispensed prepaid 
amount. 

POS beeps to indicate fueling 
is complete. 

Idle Prompt 

DCR returns to idle state. Idle state. Idle Prompt 

 Card Rejected with Hot Pump Enabled 

Card Rejected with Hot Pump Enabled 

User/DCR Action                         POS Action                             DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a 
card. 

Fueling point number icon 
flashes. 

REMOVE CARD RAPIDLY 
Schlumberger: PLEASE 
REMOVE THE CARD 
Displays for 5 seconds. 

Customer removes 
card. If customer does 
not remove card, see 
“Card Not Removed” 
table. 

POS validates card. ONE MOMENT PLEASE 

Customer waits. POS requests authorization for 
card and approves pump. 

Start Fueling Prompt 

Customer removes 
nozzle dispenses fuel. 

Nozzle icon lights. POS sounds 
a tone to indicate fueling has 
started. 

Promotional Message 

Card is rejected. Fueling point number, car, and 
nozzle icons flash. Pump is 
stopped. Card rejection 
information is noted on the 

PLEASE SEE ATTENDANT 
Displays until cashier 
views message inside. DCR 
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Card Rejected with Hot Pump Enabled 

User/DCR Action                         POS Action                             DCR Prompt 

journal. beeps 3 times. 

Customer replaces 
nozzle. 

Dollar icon lights. POS beeps 
to indicate fueling is 
complete. 

PLEASE SEE ATTENDANT 
Displays for 20 seconds - 
beeps 3 times. 

DCR returns to idle 
state. 

Idle state. Idle Prompt 

 Card Rejected with Hot Pump Disabled 

Card Rejected with Hot Pump Disabled 

User/DCR Action                      POS Action                                   DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a 
card. 

Fueling point number icon flashes. REMOVE CARD RAPIDLY 

Schlumberger: 

PLEASE REMOVE THE CARD 

Displays for 5 seconds. 

Customer removes 
card. 

If customer does 
not remove card, 
see “Card Not 

Removed” table. 

POS validates card. ONE MOMENT PLEASE 

Card is rejected. Fueling point number, car, and 
nozzle icons flash. Card rejection 
information is noted on the 
journal. 

PLEASE SEE ATTENDANT 

Displays until cashier views 
message inside. DCR beeps 
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Card Rejected with Hot Pump Disabled 

User/DCR Action                      POS Action                                   DCR Prompt 

3 times. 
   
DCR returns to idle 
state. 

Idle state. Idle Prompt 

 Card Not Removed 

Card Not Removed 

User/DCR Action                 POS Action                    DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a 
card. 

Fueling point number 
icon flashes. 

REMOVE CARD RAPIDLY Displays for 
5 seconds. 

Customer does not 
remove card. 

Fueling point number 
icon flashes. 

PLEASE REMOVE CARD Displays for 
10 seconds - beeps 3 times. 

DCR returns to idle 
state. 

Idle state. Idle Prompt 

Note: In addition to message alert beeps, DCR beeps once per second while card is 
in reader. 

POP Discount Code Rejected 

POP Discount Code Rejected 

User/DCR Action                            POS Action                                  DCR Prompt 

POP Code is rejected. Fueling point number icon flashes. 
POP Code rejection information is 
noted on the journal. 

INVALID CODE 
CONTINUE Y/N 

If customer enters ‘Y’, 2nd 
prompt for code entry 

  ENTER DATA 
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POP Discount Code Rejected 

User/DCR Action                            POS Action                                  DCR Prompt 

appears. 

If customer enters invalid 
entry, 3rd prompt for code 
entry appears. 

Fueling point number icon flashes. 
POP Code rejection information is 
noted on the journal. 

INVALID CODE 
CONTINUE Y/N 

If 3rd attempt fails, 
transaction is cancelled. 

  INVALID CODE 
TRANS 
CANCELLED 

DCR returns to idle state. Idle state. Idle Prompt 

Bad Card Read 

Bad Card Read 

User/DCR Action                              POS Action                           DCR Prompt 

DCR is in idle state. Idle state. Idle Prompt 

Customer inserts a card. Fueling point number 
icon flashes. 

REMOVE CARD RAPIDLY 
Displays for 5 seconds. 

Card is unreadable or was 
inserted incorrectly. 

Fueling point number 
icon flashes. 

REENTER CARD Displays for 
20 seconds - beeps 3 times. 

Customer has made three 
unsuccessful attempts to 
insert card. 

Fueling point number, 
car, and nozzle icons 
flash. 

PLEASE SEE ATTENDANT 
Displays for 20 seconds. 

Card has expired. Fueling point number, 
car, and nozzle icons 
flash. 

EXPIRED CARD Displays for 
20 seconds - beeps 3 times. 

Additional DCR Prompts 

 The following additional DCR prompts may appear:  
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Additional DCR Prompts 

User/DCR Action                               POS Action                                        Prompt 

Customer presses [HELP] 
key. 

Fueling point 
number, car, and 
nozzle icons flash. 

No prompt displays, but message is 
sent inside. 

Customer presses 
[CANCEL] before 
dispensing fuel. 

  TRANSACTION CANCELED Displays for 
10 seconds - beeps 3 times. 

Customer inserts a fleet 
card. 

  ENTER DRIVER NO ENTER UNIT NO 

ENTER ODOMETER 

Customer inserts a 
Proprietary card or debit 
card. 

  One of the following prompts 
displays: 

• ENTER USER ID 

• ENTER DATA 

• ENTER PIN 

The customer then keys the 
identifying number. 

Customer inserts a 
Proprietary card. 

Card declined by 
Proprietary 
network. 

CARD LOCKED OUT 

Customer enters 
incorrect PIN, data, or 
user ID information for a 
Proprietary card. 

Prompts customer 
to enter correct 
information. 

One of the following prompts 
display: INVALID USER ID INVALID 
DATA INVALID PIN The customer is 
then directed to: PLEASE SEE 
CASHIER 

Configuring Dispenser Card Readers 

The DCR Configuration form is used to define general operating procedures for 
dispenser card readers (DCRs) at the site. 

Use Forecourt > DCR to configure DCRs. 
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Use Tools > Managed Modules > DCR_Driver_Configuration to assign port and 
configure the communication parameters for DCR. 

Note: Fuel Manager / Fuel / Site Parameters provides additional parameters required 
for successful fuel operations. Refer to the Configuring Fuel Manager section in the 
Fuel Manager topic for details on configuring site parameters related to DCRs. 

Note: After changes are made to DCR parameters, the command “Tools > Refresh 
Configuration” can typically be executed for the new settings to be applied to DCRs.  

The Receipt Header/Trailer parameters also require a DCR download.  

All the DCR position attributes except Pay At Pump, Push To Start Button, Grade 
Select Button, and Lever On Pump require to initialize DCR driver. 

DCR 

Site Configuration 

Use to set up the operation of all DCRs at a site. If these are the last changes you 
make before exiting Fuel Manager, use both of the following commands: 

 Forecourt > Initialization > DCR 

 

Field/Button Allowable Value/Function 

Approve All Sales Select to require the cashier to approve all outside sales. 
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Field/Button Allowable Value/Function 

Always Print 
Receipt 

Select to automatically print a receipt at the pump after every 
DCR sale. (If not selected, the customer is prompted “Receipt 
Y/N?” and must choose whether to print the receipt.) 

Low Paper Alarm Select to alert the cashier when the DCR is low on receipt paper. 

Receipt Prompt 
Before Sale 

Select to prompt the customer about a receipt prior to dispensing 
fuel. 

Receipt Prompt 
After Sale 

Select to prompt the customer about a receipt after dispensing 
fuel. 

Prompt Prepay 
Receipt Outside 

Select to allow a customer to be prompted for a receipt at the 
DCR after prepaying inside. 

Send Preset 
Amount to Host 

Select to send preset amount to host. 

Allow fill-up with 
Preset 

Enable to fill-up gas with the preset amount.  

Armed Forces 
Restriction 

Select to display the Armed Forces prompt “Are you authorized 
[Y/N]?” prior to dispensing. 

Handle Up Help 
Message [0-99] 

Enter the length of time (in seconds) until a help message displays 
on the terminal to alert the cashier that the handle on the DCR is 
raised and an MOP has not been selected during the specified time 
(0 - 99). 

Error Prompt 
Time [5-300] 

Enter the length of time (in seconds) that DCR errors display for 
the customer (5 - 300). 

Info Prompt Time 
[5-300] 

Enter the length of time (in seconds) that the last message on the 
DCR displays for the customer (5 - 300). 

User Prompt Time 
[5-300] 

Enter the length of time (in seconds) that the user input prompt 
displays for the customer (5 - 300). 
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Field/Button Allowable Value/Function 

Enable Keypress 
Beep 

This parameter applies to Dresser/Wayne and Tokheim DCRs. 

 Select to enable the beep when the customer presses keys on the 
DCR keypad. 

Enable Attention 
Beep 

This parameter applies to Dresser/Wayne, Gilbarco, 
Schlumberger, and Tokheim DCRs. 

 Select to enable the beep to get the customer’s attention. 

Enable Mistake 
Beep 

This parameter applies to Dresser/Wayne, Gilbarco, and 
Schlumberger DCRs. 

 Select to enable the beep when the customer makes a mistake. 

Graphics Pay 
Inside 
Cash/Credit 
Prompts 

Select to enable graphics pay inside cash/credit prompts. 

Audible Help 
message on POS 

Enable to hear audio help message on POS.  

Enable Outdoor 
Tave 

The TAVE (Trans Amor Verifone Edition) system minimizes the 
flow of unencrypted payment card data within the POS system by 
performing end to end encryption. Payment card data is 
encrypted by TAVE enabled card readers both at the dispenser and 
inside the store. Card data is encrypted by these devices and 
passed to the First Data front-end processor in encrypted form for 
authorization. The First Data front-end processor decrypts the 
payment card data and sends the data to the issuing bank. A token 
is linked to the authorization and sent back to the Verifone POS. 
The VeriFone POS stores this token and uses the token instead of 
unencrypted payment card data for all subsequent processing. 

Select to enable Tave feature. 

DCR Position Attributes 

Use to set up the operation of a specific DCR at a site.  
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If these are the last changes you make before exiting Fuel Manager, use both of the 
following commands: 

 Forecourt > Initialization > DCR 

 

 

Field/Button Allowable Value/Function 

Select DCR Position 

Position Select the DCR to be configured. 
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Field/Button Allowable Value/Function 

Select Duplicate Position 

Duplicate Select the DCR to be copied and click Duplicate this Position. 
Select the DCR to which you want to copy the information. When 
copying is complete, click Done Duplicating. 

EMV Parameters 

Enable EMV Select to enable outside EMV. 

IP Address Enter outside EMV IP address. 

Port Enter port number. 

Other Parameters 

Pay At Pump Select if the pump has a DCR and if it is available for use by the 
customer. 

Push To Start 
Button 

Select if the dispenser has a Start button that must be pressed to 
begin fueling. This parameter ensures that the correct instructions 
are displayed on the DCR. 

Grade Select 
Button 

Select to make the customer select a type of fuel product by 
pressing a corresponding button at a dispenser that dispenses 
multiple fuel products from a single hose. 

Lever On Pump Select to make the DCR display instructions for starting to fuel 
from a dispenser with a lever. (If not selected, the DCR displays 
instructions for starting to fuel from a dispenser without a lever.) 

Enable Scanner Select if a barcode scanner is installed at the DCR. 

Enable Debit Select to enable debit payment. 

Menu Capable Select to enable menus. 
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Field/Button Allowable Value/Function 

NFC Mode • Contactless Disabled: Select to disable contactless payment. 

• Contactless MSD Enabled: Select to enable contactless 
payments for MSD cards.  

• Contactless EMV Enabled: Select to enable contactless 
payment for EMV cards.   

Enable Graphic 
Support 

Select if graphics are supported by the DCR. 

Graphic Keypad Select if a graphic keypad is installed at the DCR. 

Graphic Printer This parameter applies to Tokeim DCRs only. Select if the printer 
prints graphics. 

Enable Scanner Select if a barcode scanner is installed at the DCR. 

Primary Graphic 
Side [0-64] 

Gilbarco only. Enter the number of one DCR on each pump as the 
primary DCR. 

Note: One controller operates the graphics for both sides of a 
pump. Select only one side of each pump as primary. 

Graphic Display Select the display type supported — Monochrome, Color, ROM, 
Monochrome + ROM, None. 

Graphic Screen 
Size 

Select 5 inches or 10 inches. 

Graphic Text 
Lines 

Select 2 Lines or Full Screen (multiple lines). 

Receipt Header/Trailer 

Use to define the messages printed on the header and trailer of the DCR receipt.   

If these are the last changes you make before exiting Fuel Manager, use both of the 
following commands: 

 Forecourt > Initialization > DCR 
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Field/Button Allowable Value/Function 

Receipt 
Header 

The message that prints on the first five lines of the DCR receipt. 
Enter the message on each line and select the alignment — Left, 
Right, Center. 

Receipt 
Trailer 

The message that prints on the last five lines of the DCR receipt. Enter 
the message on each line and select the alignment — Left, Right, 
Center. 

DCR Display 

Use to enter the DCR promotional message that appears on the DCR display while the 
customer pumps fuel. 

If these are the last changes you make before exiting Fuel Manager, use both of the 
following commands: 

 Forecourt > Initialization > Fuel 

 Forecourt > Initialization > DCR 
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Reporting 

DCR Statistical Report 

Reports fuel sales at dispenser card readers only. 

       DCR STATISTICAL RPT  

 #CUST   VOLUME  AMOUNT  %FP  %DCR  %FUEL 

 --------------------------------------- 

 DCR #01 

   1     8.921  10.00   69.7 51.1 38.6 

 DCR #02 

   1     8.526   9.56   82.7 48.9 36.9 

 ---------------------------------------- 

 ALL DCRS 

   2     17.447  19.56            75.5  

SAMPLE DCR 
STATISTICAL 
REPORT 

Report Details: 

• #CUST: The number of customers at a DCR. 

• VOLUME: The amount of fuel dispensed at a DCR. 

• AMOUNT: The sale amount of fuel dispensed at a DCR. 

• %FP: The total percent of DCR activity at a specific fueling point. 

• %DCR: The percent of all dispenser card reader sales dispensed at a specific DCR. 

• %FUEL: The percent of all fuel sales dispensed at a specific DCR. 
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Troubleshooting 

      #  Message  Description/Action 

  CARD IN READER  A customer left a card in a DCR. 

  CARDSCAN 0 LOADED (Schlumberger) Broadcast loading of all DCRs 
(CARDSCANs) has concluded. The ‘0’ means ‘all.’ 

  DEBIT MODULE NOT 
PRESENT Debit is not available at a DCR. 

E1156 INVALID RECEIPT 
INFO 

Attempted to do a ticket reprint or ticket recall 
on a DCR/ fuel transaction and the POS found 
the ticket data invalid. Call servicer for 
assistance. 

E1212 NO DCR RECEIPT 
AVAILABLE 

Attempted to print a DCR receipt inside and 
there are none available. 

E5002 INVALID DCR 
NUMBER 

Attempted to disable or download to a DCR and 
entered an invalid DCR number. Enter the 
correct value between 1 and 32. 
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Discounts 
Overview 

Automated Discounts are discounts that the system applies automatically during a 
sale. 

Using Discounts 

Discounts can broadly be divided into two types, automated and manual. 
Automated discounts are applied by the system based on characteristics of the 
transaction.  

Manual discount unlike automatic discount requires specific actions by the 
cashier. Examples include any discount using a discount key or entering a 
discount amount. 

For detailed information, see the respective topics for each of the following 
discounts: 

• Combined Discounts 

• Loyalty Sales 

• Manual Discounts 

• NAXML Promotions 

• PLU Promotions 

• POP Discount 

• Special Discount 
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Fuel Manager 
Overview 

Fuel Manager mode contains functions that define fuel control and sales conditions. 
Available options depend on user’s security level. Refer “Fuel Sales” topic for 
additional information. 

Using Fuel Manager 

Navigate to CSR Func > Fuel Manager from the POS (While in Sales, CSR Func can be 
located on the right-hand side bottom corner of the screen on Topaz and bottom of 
the screen on Ruby 2) to access the following Fuel Manager functions: 

• Initialize Fuel 

• Download Fuel Prices 

• Download to DCRs 

• Clear Pump on Hold 

• Reset Controller 

• Fuel Price Configuration 

• Toggle Fuel Site Pause 

• Initialize Site Sign 

Initialize Fuel 

1. Touch [Initialize Fuel] 

2. Touch [YES] to initialize 

System Message on POS indicates pumps are being initialized. 

Download Fuel Prices 

1. Touch [Download Fuel Prices] 

2. Touch [YES] to continue the download 
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System Message on POS indicates prices are being sent to pumps. 

Download to DCRs 

1. Touch [Download to DCRs] 

2. Enter <DCR number> to download to a single DCR or Enter 0 to download to all 
DCRs 

3. Touch [OK] or press [ENTER] to continue 

System Message on POS indicates DCRs are being downloaded. 

Clear Pump on Hold 

1. Touch [Clear Pump on Hold] 

2. Key <pump number> 

3. Touch [YES] or press [ENTER] to continue 

Fuel sale is unclaimed and available to be tendered. 

Note: This function is available only from the POS register. 

Reset Controller 

1. Touch [Reset Controller] 

2. Touch [YES] or press [ENTER] to continue 

System Message on POS will indicate “Reset” and then indicate pumps are being 
initialized. 

Note: This function is for use with Tokheim dispensers only. This function resets 
the Tokheim fuel controller. No fuel can be dispensed while the controller is 
resetting. This function is available only from the POS register.  

Fuel Price Configuration 

1. Touch [Fuel Price Configuration] 

2. In the Fuel Price Configuration list, touch a product 

3. In the Fuel Price Configuration list, touch a price level 
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4. Key the new price and touch [OK] 

5. Do one of the following: 

 Touch [Previous Menu] twice to return to the Fuel Price Configuration 
list 

 Touch [Save Changes] to return to the Fuel Manager menu 

6. The fuel prices have been changed in the POS system only and the Fuel Prices 
Download function must be completed to update the prices at the dispensers (the 
Fuel Initialization function also sends the updated fuel prices to the dispensers). 

Toggle Fuel Site Pause 

This function is used to temporarily disable all fuel and DCR sales at the site. 
 Normal sales operations resume once this function is performed again. 

After fuel site pause has been enabled, the cashier or customer attempting a 
fuel or DCR sale receives a message indicating that the sale is not allowed. 

Note: This function is only available from the POS register. 

1. Touch [Toggle Fuel Site Pause] 

2. Confirm Toggle of Site Pause by selecting Yes or No at the prompt as indicated 
below: 

 If site pause is disabled, the prompt asks if you want to “Enable Fuel 
Site Pause”. 

1. Touch [YES] to prevent new fuel sales 

2. POS displays message that “Fuel Site Pause is Enabled”  

Fuel cannot be dispensed at the site. 

 If site pause is disabled, the prompt asks if you want to “Disable Fuel Site 
Pause”. 

1. Touch [YES] to open the site back up for fuel sales 

2. POS displays message that “Fuel Site Pause is Disabled” 

Fuel can now be dispensed at the site. 
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Note: New fuel sales cannot be approved while the pumps are paused. 
Pumps currently dispensing fuel are not interrupted. 

Note: Disable fuel will perform a “Fuel Site Pause” function. When Disable 
fuel is enabled it will prevent both new DCR and prepay fuel transactions 
from starting.  Although new fuel sales cannot be approved while the 
pumps are paused, pumps currently dispensing fuel are not interrupted. 
The functionality does NOT wait until all fuel positions are idle before the 
Close Day can begin. 

Initialize Site Sign 

1. Touch [Initialize Site Sign] 

2. Touch [YES] to initialize fuel sign 

System Message on POS indicates Site Sign is being initialized 

Configuring Fuel Manager 

Use Forecourt > Fuel to configure fuel manager functions. 

Use Tools > Managed Modules > Fuel_Driver_Configuration to assign ports and 
configure the communication parameters for Fuel Driver.  

See Fuel_Driver_Configuration in Managed Modules section for information on 
configuring the Fuel Driver. 

Note: The Fuel Sales and Dispenser Card Reader topics in this document include 
additional parameters that are required provides additional parameters 
required for successful fuel operations with card readers. 

Fuel Configuration 

Site Parameters 

Use to define operating procedures for all pumps at the site. If these are the last 
changes you make before exiting Fuel Manager, use both of the following commands: 

 Forecourt > Initialization > Fuel 

 Forecourt > Initialization > DCR 

For all Global sites (including U.S.), Commander fuel configuration needs to be in sync 
with the configuration on the pump. Depending on the local currency, sites use a 
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variety of decimal point settings for the ‘PPU Decimal Position’ and ‘Total Decimal 
Position’. In addition, for Gilbarco pumps, many sites also require the enabling of ‘Six 
Digits Gilbarco Mode’. 

Note: Prior to changing the ‘PPU Decimal Position’ in Commander, the current prices 
need to be changed to a whole number. For example, a default price of 1.234 should 
be changed to 1.000. If this is not done, then the validation of fuel prices will fail and 
the new configuration will not be properly set. After the ‘PPU Decimal Position’ is set, 
then the fuel prices can be changed to the current prices at the site. 

In addition, the ‘Currency Limit’ for each fueling position needs to be a valid number 
within the range in the table below. 

‘PPU Decimal 
Position’ 

Configuration 

PPU Display Range 

3 (U.S. default) X.XXX 0.001 – 9.999 

2 XX.XX 00.01 – 99.99 

1 XXX.X 000.1 – 999.1 

0 XXXX 0001 - 9999 

 

‘Total Decimal 
Position’ 

Configuration 

Total Amount Display 
5-digit Display 
(U.S. and other) 

Total Amount Display 
6-digit Display 

2 (U.S. default) XXX.XX (000.01 – 999.99) XXXX.XX (0000.01 – 9999.99) 

1 XXXX.X (0000.1 – 9999.9) XXXXX.X (00000.1 – 99999.9) 

0 XXXXX  (00001 – 99999) XXXXXX  (000001 – 999999) 
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Field/Button Allowable Value/Function 

Unit of Measure Select Gallons (USG) or Liters. 

Halt Mode Note: This parameter applies to Tokheim dispensers. All 
others automatically use the soft halt. 

Select one of the following: 

Hard Halt — A fuel sale that is stopped with the [STOP] key 
on the terminal cannot be restarted with the [APPROVE] 
key.  It will become due when the nozzle is replaced (or the 
lever put down) at the dispenser. 

Soft Halt — A fuel sale that is stopped with the [STOP] key 
on the terminal can be restarted with the [APPROVE] key, 
as long as the nozzle was not replaced (or the lever put 
down) at the dispenser. 
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Field/Button Allowable Value/Function 

PPU Decimal Position 
[0-3] 

Select a value to define the position of the decimal point 
whenever a fuel price is displayed on the terminal or 
printed (0 - 3). 

Note: For sites in the US, this value should be set to 3. 

Total Decimal 

Position [0-2] 

Select a value to define the position of the decimal point on 
the pump’s total sales display (0 - 2). 

Note: Terminal receipts and displays always use two 
decimal point positions for fuel sale amounts. 

0 — The terminal appends .00 to all fuel sale amounts. 

1 — The terminal appends .x0 to all fuel sale amounts. 

Note: For sites in the US, this should be set to 2. 

Autodisapproval Delay 
[0-10] 

Select the number of minutes of inactivity that must pass 
before a pump is automatically disapproved (0.0 - 10.0 
minutes, in half minute increments). 

For example, entering 7.5 will result in automatic 
disapproval after 7 minutes and 30 seconds. 

Note: This parameter works with ‘Autodisapproval’ in Pump 
Configuration- Pump Attributes. 

Multi-Grade Timeout Enter the minutes before the pump timeout after fueling 
the first grade in a multi-grade transaction. 

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Ignore MOP Conflict When this parameter is checked, sales can be tendered 
using any MOP regardless of the original fuel price level of 
the sale.  When this parameter is not checked, the MOP 
entered must match the fuel price level and if it does not 
an error message will be given indicating MOP conflict. 
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Field/Button Allowable Value/Function 

Force .9 cents Per 
Gallon 

Select to force the last digit of the fuel price to 9 on the 
price entered at Fuel > Fuel Prices. For example, if price 
entered is $3.47/gallon, the price is forced to be 
$3.479/gallon 

Approve All 

Enabled 

Select to allow the cashier to press [APPROVE] to approve 
all calling pumps. (If not selected, the cashier must identify 
the pump that is requesting approval, press that pump 
number, and then press [APPROVE]. 

Recall Autocollect 
Inside 

Select to allow autocollect sales to be recalled on the 
terminal if an attendant is collecting fuel sale payments 
outside. 

Gilbarco Six Digits 
Money Display 

This is a site-wide parameter used with Gilbarco pumps at 
some non-US sites that require 6 digits as opposed to 5 for 
the money display.  This is required for some non-US 
countries that have currencies that require large money 
amount values.  Note that the pumps must also be 
programmed to run in 6 digit money display mode. 

Require Attendant Card Enable for the enhanced FSA feature. 

Note: Refer to the Full Service Attendant feature 
reference documentation for information on this 
feature. The Feature Reference is available on Premier 
Portal.  

Offline Fuel Prompt - 
Number of Seconds 

Enter the number of seconds before the offline fuel prompt 
is displayed. 
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Field/Button Allowable Value/Function 

Real Time Sales Data – 
Notification Frequency 
(milliseconds) 

This parameter controls how often fuel sales data (total 
sales amount) is updated on the fueling point icons, while 
fueling is in progress.  

This allows the user to watch the fuel sale amount roll off, 
in real-time. The number represents the amount of time (in 
milliseconds) between each update.  

A default value of 0, disables this feature. The minimum 
allowable value is 500, resulting in a reporting interval of 
two times per second. Configured values between 1 and 499 
will automatically apply 500 millisecond intervals to the 
icons.  

A value of 2000 or greater will reduce load on the system 
making it more responsive. 

Tier2 Schedule 
Settings - Start Tier 2 
Pricing 

Select the time (using the 24-hour clock) that tier 2 pricing 
begins (0 - 23). 

Number of Tier Hours Select the number of hours that Tier 2 prices will be in 
effect, starting at the time set in “Start Tier 2 Pricing”. Set 
values between 0 and 24 to use Tier 2 Pricing. 

The following special values can also be used: 

0 — Tier 2 prices are not used. 

24 — Tier 2 prices are always used. 

Postpay Schedule 
Settings - Start Postpay 
Allowed 

Select the time (using the 24-hour clock) that postpay fuel 
sales begin (0 - 23). 
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Field/Button Allowable Value/Function 

Number of Postpay 
Hours 

Select the number of hours that postpay fuel sales are 
allowed, starting at the time set in “Start Postpay Allowed”. 
 Set values between 0 and 24. 

The following special values can also be used: 

0 — Postpay fuel sales are not allowed. 

24 — Postpay fuel sales are always allowed. 

Manual Approval 
Schedule Settings - 
Start Manual Approval 
Required 

Select the time (using the 24-hour clock) after which every 
fuel sale must be approved by the cashier (0 - 23). 

Number Manual 
Approval Hours  

Select the number of hours that manual approval is 
required, starting at the time set in “Start Manual Approval 
Required” (0 - 24). 

0 — Manual approval is not required at any time. 

24 — Manual approval is always required. 

Grade Restriction – 
Enforce Prompting 
Inside 

Select to display the grade restriction prompt that lists 
allowable grade selections inside at the POS. 

Prompt Restriction 
Outside 

Select to display the grade restriction prompt that lists 
allowable grade selections on the DCR. 

Fuel Tanks 

Use to define the tank names and designate which tanks are manifolded. 

If these are the last changes you make before exiting Fuel Manager, use both of the 
following commands: 

 Forecourt > Initialization > Fuel 

 Forecourt > Initialization > DCR 
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Field/Button Allowable Value/Function 

Name The tank name (alphanumeric, up to six characters). 

Manifold Tank The primary tank for each fuel product. The primary tank is 
manifolded to itself; the secondary tank is manifolded to the 
primary tank. 

Fuel Product ID The NAXML Fuel Product ID (four digits). 

Fuel Products 

Use to define product names and tank blending parameters. Click a text box to enter, 
edit, or select a value. 

If these are the last changes you make before exiting Fuel Manager, use both of the 
following commands: 

 Forecourt > Initialization > Fuel 

 Forecourt > Initialization > DCR 
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Field/Button Allowable Value/Function 

Secondary Product Select to fuel a primary product as a secondary product 
with a different name.  

For example, Tractor and Reefer are dispensed from the 
diesel hose and is Diesel but named as Tractor and 
Reefer. 

Tank and Price for the secondary products is same as 
Primary product. Secondary Product has its own product 
code. 

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Product Name Enter the product name (alphanumeric, up to six 
characters). 
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Primary Product When a product is enabled as secondary, select the 
primary product that is used as the secondary product.  

For Example, Tractor and Reefer are dispensed from the 
diesel hose and is diesel but named as Tractor and 
Reefer. 

Tank and Price for the secondary products is same as 
Primary product. Secondary Product has its own product 
code. 

The advantage of using the primary product as a 
secondary product with a different name is that the 
product when used as a secondary product can save tax 
or/and can be eligible for a discount. 

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Low Feed Tank From the drop-down menu, select the primary tank. 

Low Feed 
Percentage 

Enter a percent (0 - 100). 

Service Level 1 
Product Code 

From the drop-down menu, select the product code for 
service level 1. 

  

Service Level 2 
Product Code 

From the drop-down menu, select the product code for 
service level 2. 

Department From the drop-down menu, select the department. 

Fuel Grade ID It is a ‘1 - 4’ digit-value that maps Verifone product sysIDs 
to a NAXML equivalent. It is used as part of generating the 
NAXML POSJournal. 

Fueling Positions 

Use to define the attributes and hose assignments of each pump. If these are the last 
changes you make before exiting Fuel Manager, use both of the following commands: 
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 Forecourt > Initialization > Fuel 

 Forecourt > Initialization > DCR 

 

Field/Button Allowable Value/Function 

Position Select the fueling point. 

Duplicate Fueling 
Position 

Select a group of fueling positions from the Position list 
to mark for duplication. Select the position from the 
Duplicate Fueling Position drop-down menu to set the 
position to be duplicated. Click Duplicate. 

Allow Access Select to allow the pump to be accessed by the terminal. 

Default MOP Select Cash, Credit, or Check as the default MOP for this 
pump. 
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Field/Button Allowable Value/Function 

Default Service 
Level 

Select Self, Full, or Mini as the default service level. 

Blend Type Type of the blend to use in fueling positions. Select 
None, MECH, ELEC, VARI, SC82, or FIX of the blend 
type. 

Slow Flow Offset Determines the point at which the pump will slow the 
fuel as it approaches a preset amount (2 - 9999). Enter 
the slow flow amount without leading zeros. 

Hose Product 
Settings – 

Hose 1 Product 
Hose 2 Product 
Hose 3 Product 
Hose 4 Product 
Hose 5 Product 
Hose 6 Product 

Hose 7 Product 

  

  

Assign a fuel product to be dispensed from each hose for 
each pump that has been set up. One to seven hoses can 
be defined for each pump. Assign 'NONE' to hoses that do 
not exist or are not used. 

Fueling Limit 
Settings: 

  

Currency Limit 

  

  

Volume Limit 

  

  

Minimum PPU 

  

  

 

Enter the maximum amount that the pump dispenses in 
one sale (0.00 - 999.99). 

  

Enter the maximum volume that the pump dispenses in 
one sale (0.00 - 999.999). 

  

This is the minimum Price Per Unit that the dispenser will 
be allowed to drop to (typically due to a discount). 



Fuel Manager 

294 

Field/Button Allowable Value/Function 

  

Auto Collect 

 

Select to disable Auto Collect or to allow an employee 
outside to collect cash or any type of MOP payment 
directly from the customer at the pump. 

None: Disabled. Payments are only collected inside at 
the terminal. 

Cash: Only cash payments may be collected at this pump. 

All: Any type of MOP payment may be collected at this 
pump. 

Options 

Preset Prepay Select to allow preset/prepay fuel sales at the pump. 

The default value is checked. 

Preset Postpay Select to allow preset/postpay sales at the pump. 

The default value is checked. 

Stacking Select to allow one fuel sale to remain uncollected while 
a second fuel sale is dispensed and completed. 

The default value is checked. 

First In First Out Select to ensure that the first sale that becomes due on 
this pump is cashed out first. 

 (If not selected, either sale may be cashed out first.) 

Note: “Stacking” must also be selected. 

Full Service Preset Select to allow a customer or attendant to preset an 
amount outside at the DCR before fueling. 

Handle Up Calling Select to make the pump call for approval to dispense 
fuel when the customer lifts the handle. 
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Field/Button Allowable Value/Function 

Auto Approval Select to allow automatic approval for dispensing. 

If not selected, the pump must be approved by the 
cashier by pressing the [APPROVE] key. 

Note: The first sale must be cashed out before another 
sale can be autoapproved. 

Note: Select this parameter if using Autocollect. 

Auto Disapproval  Select to disapprove a dispenser if it remains inactive for 
the period of time set in “Delay Autodisapproval” on Fuel 
> Site Parameters > Fuel Site Parameters. 

(If not selected, the pump remains approved until 
manually changed.) 

Note: In DCR transactions, the pump disapproves after a 
maximum of three minutes regardless of this setting or 
that of “Delay Autodisapproval.” Prepaid sales never 
time out. 

DCR In Dispenser Select if the dispenser has a card reader. 

View Buzzer Off In a postpay situation, the customer lifts the handle, 
leaves the nozzle off the pump, and comes inside to pay. 
Select to allow the [VIEW] key to stop the beeping at the 
terminal. 

Note: If not selected, the beeping continues until the 
customer has paid. 

Commercial Select to convert a fueling position to commercial. Select 
for each pump that needs to be enabled as commercial.  

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 
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Field/Button Allowable Value/Function 

Ignore Pump Error Select to allow a pump to resume service after an 
authorization failure. The terminal continues to approve 
the transaction on the pump without the cashier pressing 
[APPROVE]. 

If not selected, a cashier must press [APPROVE] to start 
the next transaction on the pump after an authorization 
failure. 

For this feature to work, do the following: 

 Select “Autoapproval.” 

 Set “Auto Collect” to ‘All.’ 

 Set “Default Service Level” to ‘Full.’ 

Pay At Pump Only Select if customers are required to pay outside at the 
DCR and may not pay inside. 

If not selected, customers are able to pay outside at the 
DCR as well as inside. 

Prepay Only Select if only prepaid fuel sales are allowed. 

If not selected, fuel sales can be paid for either before or 
after the customer dispenses fuel. 

Multi Product 
Settings 

 

Allow Multiple 
Products 

 

 
Configure Fueling 
Order 
 

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

To enable a fueling position to dispense multiple 
products in a in single transaction, the pump should be 
enabled for multi-grade fueling. 

 

Click Configure Fueling Orders to configure the order in 
which the multi-grade fuel products appear on DCR menu 
and on the fuel selection menu during preauthorization of 
the card. 
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Field/Button Allowable Value/Function 

The Host Product Settings section in the Fuel 
Configuration form only allows Primary Products to be 
assigned to hoses. 

Fueling Orders form helps configure primary and 
secondary products dispensing order. 

 

Configure the order in which the products are to be 
presented to the customer to choose.   

If you assign two products to the same prompt order, it 
will allow either or both.   

The example below would prompt “UNLD1, UNLD2 or 
Both”, then “UNLD3 Y/N”, and finally “UNLD4, UNLD5, or 
Both”. 

Fuel Blend types 

Fuel Blend types will display the available blending types in the POS system. 

 

This option is for viewing only, no configuration is allowed. 
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Fuel MOPs 

Fuel MOPs displays the available fuel method of payments defined in the POS system. 

 

This option is for viewing only, no configuration is allowed. 

Fuel Service Levels 

Fuel Service Levels displays the available levels of service for the site. 

 

This option is for viewing only, no configuration is allowed. 

Reporting 

 Refer to the Reports topic for Fuel and DCR reports. 
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Fuel Sales 
Overview 

A fuel sale can be part of any sales transaction allowed either inside at the terminal 
or outside at the Dispenser Card Reader (DCR). 

Using Fuel Sales 

The following are the Fuel Sales functions: 

• Prepay Fuel Sale by Amount 

• Prepay Fuel Sale by Volume 

• Prepay Fuel Sale with Merchandise 

• Fuel Prepay Move 

• Preset Fuel Sale by Dollar Amount 

• Preset Fuel Sale by Volume 

• Rest In Gas 

• Postpay Fuel Sale 

• Postpay Fuel Tax Exemption or Addition 

• Manual Fuel Sale 

• Fuel Discount with Fuel Disc Key 

• Clear Reserve and Place in Idle 

• Pump Test 

• Fuel Ticket Print 

• DCR Ticket Print 

• Fuel Convert 

• Approve One Calling Pump 
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• Approve All Calling Pumps 

• Disapprove a Pump 

• Restarting a Stopped Pump 

• Stop/Disapprove 

• Stop One Pump 

• Stop All Pumps 

• View Fuel Sales 

• View Due Fuel Sales 

• View Pump Status 

• Other Fuel 

Fuel Control Buttons 

The icons on the buttons for stop pump, help requested, calling pump and drive-off 
blink. The amounts with + sign are for customers owing money and amounts with - 
sign are for money owed to customer. The following fuel buttons represent a pump's 
status:  

Icon Description Icon Description 

 

Idle Pump 
 

Reserved Pump 

 

Pump Calling 
 

Offline Pump 

 

Pump Ready 
 

Fueling 

 

Stacked Postpay Sale 
 

Sale Amount 

 

Authorizing: Customer has swiped 
card at DCR 

 

Stopped Pump 

 

Authorised Credit Card/DCR Sale: 
DCR ready to dispense 

 

Network Message or 
Help Requested 

 

Prepaid Sale 
 

Fueling: DCR fuel 
sale in progress 
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Colored Text on Fuel Buttons 

Colored text on fuel buttons represents the following:  

• Red - Critical events happening at the pump. Watch pump and take 
immediate action. 

• Yellow - Watch pump and take action. 

• Green - Normal events happening at the pump. Watch pump; no 
action required. 

• Black and Gray - Light and dark themes; no action required by the 
cashier. 

Note: To access [OTHER FUEL] functions in Ruby2, a soft key needs to be 
programmed. Refer to store manager to program soft keys. 

Prepay Fuel Sale by Amount 

The customer pays amount for the fuel before dispensing. The fuel is entered 
for a specific dollar amount. The sale must be tendered before the system 
approves the pump. The pump stops when the dollar amount is reached or when 
the tank is full. 

1. Press [PREPAY] and key pump number 

2. Press [ENTER] 

3. Key <amount> and select MOP to continue or tender the transaction 

Or 

1. Key <pump number> and press [PREPAY] 

2. Key <amount> and select MOP to continue or tender the transaction 

Prepay Fuel Sale by Volume 

The customer specifies the fuel product and volume and then pays for the fuel 
before dispensing. The sale must be tendered before the system approves the 
pump. The pump stops when the specified volume is reached. 

1. Press [PREPAY] and key pump number 
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2. Press [ENTER] and then press [QTY] 

3. Key the volume including two decimal points and press [ENTER] 

4. In the Fuel Products list, select the fuel product and tender the 
transaction 

Or 

1. Key <pump number> and press [PREPAY] 

2. Press [QTY] 

3. Key the volume including two decimal points and press [ENTER] 

4. In the Fuel Products list, select the fuel product and tender the 
transaction 

Prepay Fuel Sale with Merchandise 

The network pre-authorizes a card for a fuel purchase and just charges the 
customer for the amount actually dispensed. 

1. Key <pump number> and press [PREPAY] 

2. Key <amount> 

3. Touch [CREDIT] and swipe the card through the card reader 

4. If prompted with the fuel products list, touch the product 

Fuel Prepay Move 

This function moves a preset or prepay fuel sale that has not been dispensed from 
the original pump number to a new pump number. 

To perform this function there must be an undispensed prepay on the selected 
pump for the move. 

1. Press [OTHER FUEL] and then select Fueling Point Move 

2. In the overlay, enter the pump number to move from 

3. In the overlay, enter the pump number to move to 

The prepay transaction moves to the chosen pump number. 
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Fuel Preset 

A preset fuel sale occurs when the Preset Fuel function is used to approve a fuel 
sale for a specific dollar amount or volume. If the approval is by volume, specify 
the fuel product. The pump automatically stops dispensing when the dollar 
amount or volume is reached or the tank is full. The sale is paid after the fuel is 
dispensed. 

Preset Fuel Sale by Dollar Amount 

A preset fuel sale by dollar amount occurs when the Preset Fuel function is used 
to approve a fuel sale for a specific dollar amount. The pump automatically 
stops dispensing when the specified dollar amount is reached. 

1. Press [FUEL PRESET] and key <pump number> and touch [OK] 

2. Key <amount> and touch [OK] to authorize pump for fueling up to the 
preset dollar amount. 

3. Touch <pump number> to add the sale into the transaction and press 
method of payment (MOP) 

Preset Fuel Sale by Volume 

A preset fuel sale by volume occurs when the Preset Fuel function is used to 
approve a fuel sale for a specific volume and specify the fuel product. The pump 
automatically stops dispensing when the volume is reached, or the tank is full. 
The sale is paid after the fuel is dispensed. 

1. Press [FUEL PRESET], key <pump number>, and touch [OK] 

2. Press [QTY] and key volume of the fuel to be dispensed (including two 
decimal places) and touch [OK] 

3. If prompted with the Fuel Products list, touch the fuel product 

4. The customer dispenses fuel up to the preset volume 

5. Touch <pump number> to add the sale into the transaction 

6. Press method of payment (MOP) 
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Rest in Gas 

This feature allows a customer to make instore purchases, present cash for 
payment and request that the clerk put the “Rest In Gas.” The system 
calculates the change due and uses that amount to prepay the pump. 

1. Ring up merchandise 

2. Key <amount> 

3. Press [REST IN GAS]. The system prompts for pump number 

4. Key <pump number> and press [ENTER] for the system to set prepay for 
the calculated amount on the selected pump 

Postpay Fuel Sale 

In a postpay fuel sale, the sale comes due inside after the customer dispenses 
fuel. 

Note: If fueling point has uncollected sales or stacked sale, in Step 1, a 
separate fuel detail overlay will be displayed, touch the appropriate fuel sale 
box to bring the sale into transaction. 

1. Touch the appropriate fuel icon or press <pump number> and [FUEL] to 
bring sale into the transaction and press [TOTAL] 

2. Tender the sale and touch the correct method of payment (MOP) 

Postpay Fuel Tax Exemption or Addition 

This function allows the ability to add a fuel tax to a fuel type that is displaying 
a “tax free” price at the pump. The automatic adjustment is available only for 
postpay fuel sales or allows the cashier to remove taxes, or portions of a tax, 
from a fuel sale. 

Note: Available for postpay fuel sales only. 

1. Touch pump number and Fuel Tax Exemption or Fuel Tax Addition 

2. In the Fuel Tax Exemption or Addition list, touch the correct exemption 
or addition 

Fuel Tax Exemption and Fuel Tax Addition can be accessed in one or the 
following ways: 
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 Press softkey 

 Use Other Fuel Functions 

 Touch pump number and then the line item 

Manual Fuel Sale 

Use the [MANUAL FUEL] key to manually enter a fuel sale into the system. This is 
typically used for the dispensers that are not connected to the system. 

1. Key fuel sale price and touch [MANUAL FUEL] 

2. Key <pump number> and press [ENTER] 

3. In the Fuel Products list, touch the name of the fuel product or key 
<fuel product number> and press [ENTER] 

Fuel Discount with Fuel Disc Key 

The Fuel Discount with Fuel Discount key discounts fuel purchases by a fixed 
dollar amount per gallon. The cashier can indicate the number of gallons/liters 
to be discounted or the discount can be applied to the whole fuel amount. 

Note: Fuel discounts can be used in postpay fuel sales. Fuel dispensed at a POP 
discount rate is not eligible to receive a discount using the [FUEL DISC] key. 

1. Touch <pump number> and the discount is applied to the total fuel 
dispensed: Touch or press [FUEL DISC] 

2. Key number of gallons to which discount should be applied or press 
[ENTER] to apply discount to total volume dispensed 

Clear Reserve and Place in Idle 

The Clear Reserve function removes the “Reserved” state from a prepay pump. 
This may happen when fuel communications are temporarily interrupted and 
then re-established. 

In a prepaid fuel sale, clear that is in the “Reserved” state that does not have to 
be dispensed. 

1. Touch <pump number> and press [PREPAY] 

2. Press [STOP] and [OK] to change prepay fuel sale status to Due Sale or 
Refund 
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3. To clear pump:  

1. Touch <pump number> and press [TOTAL] 

2. Touch the method of payment (MOP) originally used for 
prepay transaction 

Clear Reserve Using Clear Reserve Button 

1. Select pump number from the fuel panel 

2. Select ‘CLEAR RESERVE’ button 

Pump Test 

Note: The pump test applies to fuel sales only. 

The Pump Test is a payment type that accepts postpay fuel sales only. The fuel 
is dispensed normally and then tendered with the “Pump Test” MOP. 

A receipt prints with the words "PUMP TEST" at the bottom 

1. Touch <pump number> and press [TOTAL] 

2. Touch [PUMP TEST] or press [OTHER MOP] and then touch Pump Test in 
Other MOP list 

Fuel Ticket Print 

This function reprints postpay fuel transaction receipts.  

1. Press [TICKET PRINT] 

2. Choose a transaction to print 

To search for transaction receipts containing fuel, follow these steps: 

1. Press [TICKET PRINT] 

2. In the overlay, press [ADVANCED OPTIONS] 

3. In the Advanced Options - Multi Select Allowed menu, select Fuel Only 

4. Press [SHOW LIST] to display a list of Filtered by Fuel Only 
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5. Choose a transaction to print 

DCR Ticket Print 

Reprints DCR and completed prepay transaction receipts. 

1. Key the pump number 

2. Press [VIEW] 

3. Touch [Reprint DCR Tran] 

4. Choose a transaction to print 

Fuel Convert 

If a customer dispenses fuel at one price level but wants to pay in the other 
price level, then use Fuel Convert function to switch. 

1. Touch the pump number 

2. Select the transaction to be converted by touching the desired current 
or stacked sale. 

3. Touch [Fuel Convert] 

4. If the customer wants to purchase merchandise, key the item(s) 

5. Enter the customer’s method of payment 

Approve One Calling Pump 

1. Select the pump number. 

2. Press [APPROVE]. 

Approve All Calling Pumps 

Press [APPROVE]. 

Whether a fueling point can be approved before a customer can dispense fuel 
depends on the following operating conditions: 



Fuel Sales 

308 

 Automatic Approval: If “Autoapproval” is enabled for a specific pump 
number, the pump does not need to be approved before a customer can 
dispense fuel. 

 Approve Specific Pump: In all cases, a specific pump can be approved if 
the pump number is keyed before [APPROVE]. Two messages display 
briefly: 

  nn APPROVING 

  nn APPROVED 
 Approve All Pumps: If enabled, all fueling points requesting approval can 

be approved at the same time by pressing the [APPROVE] key. If not 
enabled, a specific pump can still be approved by keying the pump 
number before pressing [APPROVE]. Two messages display briefly: 

  APPROVING CALLING PUMPS 

  CALLING PUMPS APPROVED 
Note: If a pump is approved while the cash drawer is open, the change for that 
transaction continues to display. The journal records pump approvals. 

Disapprove a Pump 

Disapprove a pump that is approved but has not started dispensing. 

Select the pump number and press [STOP]. 

Restarting a Stopped Pump 

1. Select the pump number. 

2. Press [APPROVE]. 

A pump can be restarted if the system is set up to allow a pump restart or if the 
pump is stopped from the POS ([STOP] key) and one of the following is true: 

 The transaction at the pump has not ended. 

 The pump is a Dresser®/Wayne® brand. 

The following two messages display briefly when approving a pump that has timed-
out or been stopped (also called re-approving or restarting) (‘nn’= the pump 
number): 

  nn RESTARTING 
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  nn RESTARTED 

Stop/Disapprove 

The [STOP] key does one of the following: 

 Stops fuel dispensing at a specific pump or all pumps. 

 Disapproves one pump or all approved pumps that have not started 
dispensing. 

The following two messages display briefly if a pump is stopped (‘nn’= pump 
number): 

  nn STOPPING 

  nn STOPPED 
The following two messages display briefly when all pumps are stopped: 

  STOPPING ALL PUMPS 

  ALL PUMPS STOPPED 

Stop One Pump 

1. Select the pump number. 

2. Press [STOP]. 

Stop All Pumps 

Press [STOP]. 

View Fuel Sales 

The View function displays the status of the current fuel sales. The information 
that displays depends on the pump manufacturer. Some pumps send information as 
the fuel is dispensed. Other pumps send information only after dispensing is 
finished, and display only the fueling point, current/stacked indicator, and pump 
status while fuel is being dispensed.  

There are two types of view: due sales and fuel sales. 
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View Due Fuel Sales 

1. Press [VIEW]. All fuel sales that are due appear. 

2. Press [EXIT]. 

The pump number, status (‘C’ = current, ‘S’ = stacked), and dollar 
amount due display. Up to eight sales are listed. If there are more than 
eight sales, a down arrow in the bottom left corner of the display 
indicates there are more. Press [VIEW] to see the rest of the sales. 

If no sales are due, “NO DUE SALES” displays until another sales function 
is run. 

View Pump Status 

Check the fuel sale state or the pump state of the current or second (stacked) 
sale. 

1. Key the pump number. 

2. Press [VIEW]. The > points at the current sale. 

3. Press [VIEW] again. The > points at the stacked sale.  

4. Press [VIEW] again. The pump status and detailed fuel sale information 
for the current sale appears. 

5. Press [VIEW] again. The pump status and detailed fuel sale information 
for the stacked sale appears. 

6. Press [VIEW] to repeat the cycle (steps 2 through 5). 

 

Pump Status 

Status Description 

AUTHORIZED The pump is approved, but dispensing has not started. 

CALLING The customer has lifted the handle and is requesting 
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Pump Status 

Status Description 

approval to dispense fuel. 

FUELING Fuel is being dispensed. 

IDLE The pump is not in use. 

LOW PAPER The receipt paper in the dispenser card reader is low. 

OFFLINE The pump controller is not communicating with the 
dispenser. 

RESERVED The pump is being prepaid and is locked until the 
transaction is complete. 

STOPPED A cashier has stopped the pump by pressing [STOP]. 

 

Fuel Sale Status 

Status Description 

BUSY The pump is in use (but not necessarily actively 
fueling). 

DUE The customer has finished dispensing and the sale or 
refund is due. 

HOLD This sale has already been included in a transaction on 
another Ruby terminal or on the current ticket. 

SOLD This fuel sale has already been collected. 
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Other Fuel 

The Other Fuel function is a soft key and contains a menu of the following 
functions: 

 Fueling Point Move 

 Convert Fuel MOP 

 Fuel Discount 

 Fuel Preset 

 Manual POP Discount 

 Fuel Tax Exemption 

 Fuel Tax Addition 

Fueling Point Move 

This function moves a preset or prepay fuel sale that has not been dispensed 
from the original pump number to a new pump number. 

The following message prints on the journal (‘n1’ = the original pump; ‘n2’=the 
pump to which the sale moves): 

FP MOVE FROM PUMP# n1 TO PUMP# n2 

1. Touch [FP MOVE] 

2. Enter the current pump number and select OK 

3. Enter the new pump number and select OK  

Or 

1. Press [OTHER FUEL] 

2. Select the Move Fuel Point function 

3. Key the current pump number 

4. Key the new pump number and then select OK  
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Convert Fuel MOP 

The Fuel Convert function switches the price level of the fuel line item from 
cash to credit or credit to cash. 

The final price for the fuel in the transaction will be based on the new price 
level.  

1. Touch the pump number 

2. Select the transaction to be converted by touching the desired current 
or stacked sale 

3. Press [Other Fuel] and select Convert Fuel MOP  

4. If the customer wants to purchase merchandise, add the item(s) 

5. Tender and complete the sale 

Fuel Discount 

The Fuel Discount function discounts fuel purchases by a fixed dollar amount per 
gallon. The cashier indicates the number of gallons/liters to be discounted or 
the discount may apply to the whole fuel amount. 

Fuel discounts can be used in preset or postpay fuel sales. 

The Fuel Discount function may be set up as either a separate [FUEL DISC] key 
or as a menu choice under the [OTHER FUEL] key. 

1. Bring the fuel sale up on the display 

2. Do one of the following:  

• If the discount applies to part of the fuel dispensed, key the 
amount (gallons/liters) and press [FUEL DISC] key 

• If the discount applies to the whole amount of fuel dispensed, 
just press [FUEL DISC] 

Or 

1. Press [OTHER FUEL], press Fuel Discount, and then press [ENTER] 

2. Do one of the following:  
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• If the discount applies to part of the fuel dispensed, key the 
amount (gallons/liters) and press [ENTER] 

• If the discount applies to the entire amount of fuel dispensed, 
press [ENTER] 

Fuel Preset 

A preset fuel sale occurs when the Preset Fuel function is used to approve a fuel 
sale for a specific dollar amount or volume. If the approval is by volume, specify 
the fuel product. The pump automatically stops dispensing when the dollar 
amount or volume is reached, or the tank is full. The sale is paid after the fuel is 
dispensed. 

Preset Fuel Sale by Dollar Amount 

1. Press [OTHER FUEL], press Preset Fuel function, and then press 
[ENTER] 

2. Key the pump number and press [ENTER] 

3. Key the dollar amount 

4. Press [ENTER] or the method of payment 

OR 

1. Key the pump number and press [FUEL PRESET] 

2. Key the dollar amount and then press [ENTER] or the method of 
payment 

The customer dispenses fuel before paying. 

Preset Fuel Sale by Volume 

1. Press [OTHER FUEL] and then press Preset Fuel function 

2. Press [ENTER] and key the pump number and then press [ENTER] 

3. Press [QTY] and key the volume of fuel to be dispensed (including two 
decimal places) 

4. Press [ENTER] or the method of payment and press the fuel product to 
be purchased and then press [ENTER] 
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OR 

1. Key the pump number, press [FUEL PRESET], and then press [QTY] 

2. Key the volume of fuel to be dispensed (including two decimal places) 

3. Press [ENTER] or the method of payment and then press the fuel 
product to be purchased and then press [ENTER] 

Manual POP Discount 

This is an option that can provide either a coupon or free POP code (with Basic + 
Code program type).  The cashier has the option of offering the award to 
customers at their discretion; perhaps to an especially loyal customer or to a 
customer who has experienced some perceived inconvenience. 

1. Touch [OTHER FUEL] 

2. In the Other Fuel Functions menu, select [Manual POP Discount] 

3. In POP Award menu, touch [Generate Code] or [Generate Coupon] 

4. The code or coupon prints 

Fuel Tax Exemption 

This function allows the ability to exempt a fuel tax to a fuel type that is 
displaying a “tax free” price at the pump. 

Note: The automatic adjustment is only available for postpay fuel sales. 

1. Key the pump number, press [FUEL], and then press [OTHER FUEL] 

2. Press Fuel Tax Exemption and press [ENTER] 

3. Select the fuel tax exemption from the menu 

4. Press [ENTER] 

Fuel Tax Addition 

This function allows the ability to add a fuel tax to a fuel type that is displaying 
a “tax free” price at the pump. 

Note: The automatic adjustment is only available for postpay fuel sales. 
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1. Key the pump number, press [FUEL], and then press [OTHER FUEL] 

2. Press Fuel Tax Addition and press [ENTER] 

3. Select the fuel tax addition from the menu 

4. Press [ENTER] 

Configuring Fuel Sales 

See the "Configuring Fuel Manager" section in the Fuel Manager topic for configuration 
details. 

For Configuring Pump Test, see "Configuring MOP" section of the Methods of Payment 
topic.  

Reporting 

See the Reports topic for various reports related to Fuel Sales.  

Troubleshooting 

#  Message  Description/Action 

E1274 FUEL PRICE NOT 
SETUP 

Entered a sale for a fuel product that does not 
have a price set up in the system. 

E1142 INVALID ENTRY 
An invalid selection is made when a fuel tax 
exemption is attempted. The fuel tax menu re-
displays and the user can reenter the selection. 

E1259 FUEL TAXES 
UNDEFINED 

No fuel tax exemptions have been defined in the 
Fuel Tax Exemption File. 

E5008  FPD SIGN OFFLINE  Fuel Price Sign Controller is not responding to 
controller. 

E5009  FPD POLL ERROR 

Communications between the controller and the 
Fuel Price Sign Controller are working, but the 
Fuel Price Sign Controller indicates that a sign 
position is offline. There is a problem with a 
particular sign or signs. 
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#  Message  Description/Action 

E1260 EXEMPTION MUST 
BE BEFORE % DISC 

Attempted to apply a fuel tax exemption on 
discounted fuel. Apply the tax exemption first, 
then apply the fuel discount. 

E1266 FUEL TAX ALREADY 
ADDED 

Attempted to add a fuel tax using the Fuel Tax 
Addition function and the fuel department for 
that item already has a fuel tax assigned to it. 

E1273 
FUEL TAX NOT 
ALLOWED WITH % 
DISC  

A discount using the [DISC] key is attempted on 
an item that has a fuel tax exemption applied or 
a fuel tax exemption is attempted on an item 
that already has a discount applied. 
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Loyalty Sales (EPS) 
Overview 

Loyalty programs come in all shapes and sizes. They can offer on-the-spot discounts or 
future savings through incentives as coupons or points toward future purchases. 

EPS loyalty sales allow the processing and redemption of loyalty transactions, both 
inside at the POS and outside at the dispenser card readers (DCR). These loyalty 
transactions are processed through the electronic payment system (EPS). 

The EPS Loyalty Front End Processor (FEP) functionality include using the PCATS POS-
Loyalty Host Specification, Price-per-unit Discounting, Transactions-level Discounting, 
and Item Level Discounting. 

Note: Refer to the Loyalty Sales feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 
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Maintenance 
Overview 

This section contains general system and terminal functions and settings. The system 
will display functions based on the security level of the user. 

Using Maintenance 

Navigate to CSR Func > Maintenance from the POS (While in Sales, CSR Func can be 
located on the right-hand side bottom corner of the screen on Topaz and bottom of 
the screen on Ruby2) to access the following Maintenance functions: 

• Adjust Volume 

• Adjust Brightness 

• System Messages 

• Device Configuration 

Adjust Volume 

1. Touch [Adjust Volume] 

2. Touch the number for the correct volume [0 - 10] 

3. A chime sounds to indicate the volume 

4. Touch [OK] to save the volume 

Adjust Brightness 

1. Touch [Adjust Brightness] 

2. Touch the number for the correct brightness [0 - 10] 

3. The brightness changes when a number is touched 

4. Touch [OK] to save the brightness 

System Messages 

1. Touch [System Messages] 
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2. The System Messages list displays 

3. Touch down arrow to scroll and review the messages 

Device Configuration Menu 

1. Touch [Device Configuration] 

2. Touch the appropriate entry or key the entry number of the device to 
configure 

3. Press [ENTER] 

Configuring Maintenance 

Use Initial Setup to update general terminal information and maintain the system 
software and hardware. 

Configuration under “Maintenance” is limited to Site Registration, a function that can 
also be performed at the POS.  Additional functions not available through the POS are 
included here. 

Registration 

The Registration form presents information that must be supplied to the Verifone 
Technical Support Center in order to obtain a Registration Key. Call the Verifone 
Technical Support Center at (888) 777-3536. The Support Center will process the 
registration while you are on the phone. 

Note: Registration is only done once, at the time of installation. Registration is 
required any time site information for key components changes like application, 
version, etc. 



Commander Site Controller User Reference 

321 

 

Functions 

Field/Button Allowable Value/Function 

Registration Key Enter the Registration Key supplied by the Verifone 
Technical Support Center. 

Maintenance Configuration 

The Maintenance Configuration form is used to reset the Fuel and Register running 
totals, and to enter the telephone and postal code information for the site. 

Totalizers 

Use after installing new software. Before installing new software, close all cashiers 
and run the next period report. Enter the totals so that they are not lost. 

For example, if the software is reinstalled at midnight, run the Close Daily report just 
before the installation. Do not perform any transactions until after the software is 
installed and the running totals are entered. 
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Functions 

Field/Button Allowable Value/Function 

Fuel Totalizers -
Fueling Point 

Select the fueling point for which you want to set the running 
totals. 
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Hose #n Enter the dollar and volume totals for each hose on the fueling 
point. 

Register Totalizers -
Register 

Select the register for which you want to set totals. 

Sales / Grand Enter the Sales and Grand totals for each period. The periods 
that display depend on your setup. 

Note: Setting totalizers after an upgrade is optional. 

Telephone & Postal Code 

Use to enter the telephone number (area code first) and postal code for the site. 

  



324 

Manual Discounts 
Overview 

Manual discount unlike automatic discount requires specific actions by the cashier. 
Examples include any discount using a discount key or entering a discount amount. 

Using Manual Discounts 

Use the following Manual Discount functions to give: 

 Fixed Discount 

 Percent Discount 

 Amount Discount 

  Note: To access [Disc] function on Ruby2, a soft key needs to be programmed. Refer 
to store manager to program soft keys. 

Fixed Discount 

1. After entering the product, press [DISC] 

The system applies the discount to the line item 

Percent Discount 

1. After entering the product, key the percent discount including two 
decimal places, for example: [1][0][0][0] = 10% Discount 

2. Press [DISC %] 

The system applies the discount percentage to the line item. 

Amount Discount 

1. After entering the product, key the dollars and cents discount, for 
example: [1][0] =  0.10 discount 

2. Press [DISC] 

The system applies the discount amount to the line item. 
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Configuring Manual Discounts  

Parameter Path Value Description 

Discount 
Security Level 

Store Operations > 
Sales > Sales 
Configuration 

0 - 9 

The security level 1 - 9, an 
employee must have in order 
to use the [DISC] key and 
approve discounts. 

0 - Discounts do not require a 
security check. 

Discount Type 
Store Operations > 
Sales > Sales 
Configuration 

Percent, 
Amount 

Percent -The discount is 
calculated as a percentage of 
the price and then subtracted 
from the price of the item.  

Amount -The discount is 
directly subtracted as a dollar 
amount from the price of the 
item. 

Fixed Discount 
Rate 

Store Operations > 
Sales > Sales 
Configuration 

Numeric 

Percent or amount (set in 
“Discount Type”) is 
automatically applied when 
the [DISC] key is pressed. 

Is Fixed 
Discount 

Store Operations > 
Sales > Sales 
Configuration 

Yes, No 

Automatically enter discounts 
(set in “Discount Type” as a 
percent or amount) for the 
amount entered in “Fixed 
Discount Rate” when the 
[DISC] key is pressed. If not 
selected, all discounts must 
be entered as individual 
amounts. 

Maximum 
Discount 

Store Operations > 
Sales > Sales 
Configuration 

0.00 – 
99.99 

Maximum discount (either 
percent or dollar as set in 
“Discount Type”) that can be 
applied to an item when using 
the [DISC] key. 
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Parameter Path Value Description 

Minimum 
Discount 

Store Operations > 
Sales > Sales 
Configuration 

0.00 – 
99.99 

Minimum discount (either 
percent or dollar as set in 
“Discount Type”) that can be 
applied to an item when using 
the [DISC] key. 

Reporting 

                    MEMO ITEMS     

  

 Discounts      6      7.41     

 Sample Memo Items showing number and 
amount of discounts. 

Aggregate discount totals appear in 
Memo Item section of the following 
reports: 

• Cashier Report 

• Summary Report 

Discount totals by Department are 
represented in the Department Report. 

Report Details 

• DISCOUNTS: Number of times and total amount of discounts. This includes 
discounts from: 

o Use of the [DISC], [DISC%], and [DISC AMT] keys 
o Combo, mix ’n match, fuel, and promotional discounts 

Troubleshooting 

      #  Message  Description/Action 

E1121 DISCOUNT TOO 
SMALL  

The discount entered is less than the set 
minimum amount. 

E1122 DISCOUNT TOO 
LARGE 

The discount entered is more than the set 
maximum amount. 
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      #  Message  Description/Action 

E1273 
FUEL TAX NOT 
ALLOWED WITH % 
DISC 

A discount using the [DISC] key is attempted on 
an item that has a fuel tax exemption applied or 
a fuel tax exemption is attempted on an item 
that already has a discount applied. 
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Menus 
Overview 

A menu is a group of PLUs displayed at the same time. There are several types of 
menus: 

• Ruby: Displays 6 items in an overlay menu and menu clears after 1 selection. 

• Expanded: (also known as single-select) displays items in a 4x4 grid and menu 
clears after 1 selection.  

• Multi-Select:displays items in a 4x4 grid and remains displayed until you touch 
the “Done” button. 

• Parked Menu: displays each menu item on individual buttons of the parked 
menu panel so that a single touch adds the item to the transaction.  The menu 
remains displayed through multiple transactions until clerk selects another 
menu configured as “parked”.  

• Menu Chain: The menu name appears on the POS screen and when selected by 
the cashier, leads to the other menus in the chain. 

Using Menus 

Ruby Menu 

1. Touch or press the appropriate [MENU KEY] 

2. From the overlay, touch the desired item or key entry number and press 
[ENTER] to add item to the transaction. 

Expanded Menu 

1. Touch or press the appropriate [MENU KEY] 

2. Touch the desired item or key entry number and press [ENTER] to add 
item to the transaction. 

Multi-Select Menu 

1. Touch or press the appropriate [MENU KEY] 

2. Touch the desired item or key entry number and press [ENTER] 
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3. Repeat step 2 to sell additional items 

4. Touch [DONE] 

Parked Menu 

1. Touch or press an appropriate [MENU KEY] configured as parked. 

2. Touch the appropriate button from the parked menu panel to add item 
to transaction (all buttons in the parked menu pane will be the same 
color. 

3. When items from another parked menu are desired, touch the 
appropriate [MENU KEY] and continue sales 

Menu Chain 

1. Touch or press the appropriate [MENU KEY] 

2. Do one of the following: 

1. Touch the desired item or key entry number and press [ENTER] to 
go to next menu type 

2. Touch Next to go to next menu type 

3. Repeat step 2 to sell additional items 

4. Touch [Dismiss], to come out of the menu chain 

Configuring Menus 

Menu Key Configuration 

Use Store Operations > Menu Key to configure menu keys.  

The Menu Key Configuration form allows you to add PLU items to menus.  

Note: Menus designated as parked or expanded may have up to 50 menu items. 

Other menus may have one to six items. 
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Field/Button Allowable Value/Function 

Select Menu Select an open menu key number. (Up to 100 maximum 
menu keys.) 

Delete Select to delete the selected menu key. 

Name Displays the name of the menu selected by number. (The 
name may be edited.) 

Type 
Select from the following: 

Ruby Menu -Six items (PLUs) per menu are allowed. 
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Field/Button Allowable Value/Function 

Expanded Menu - Items display on the expanded menu of 
the Topaz screen. Up to 50 items per menu are allowed. 

Multi-Select Menu - The menu stays open on the Topaz 
screen, allowing multiple selections. 

Menu Chain - The menu appears on the POS screen (or as a 
key) and when selected by the cashier, leads to the other 
menus in the chain. 

Parked 
Select to allow the menu items to display on the parked 
menu panel of the POS screen. (This option is not available 
for Menu Chain Types.) 

Order Menu 

Available when Menu Chain type is selected. 

After a rule is created for fast food on the POS, the PLUs 
that are added can become part of an Order Menu so that 
the transaction produces a receipt like an iOrder receipt. 

To use this feature, do the following: 

1. Create a rule (see “Rule Manager > Fast Food 
Orders on POS”) and enter the PLUs to be evaluated 
as part of the rule. 

2. Open Menu Keys Configuration form and select the 
menu and select Menu Chain as the type. 

3. Select the menu from the menu drop-down list. 
Click Add. The menu is added to the Menu Items list. 

4. Repeat to add more menus to the menu chain. Click 
Save. 

Note: Refer to the Food Service Order User Reference 
for more information on this feature. The Feature 
Reference is available on Premier Portal. 

Add 
Click Add to add the PLU that was entered or the menu 
that was selected from the drop-down list to the Menu 
Items list. 
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Field/Button Allowable Value/Function 

Modify 

Use to exchange an item in the Menu Items list for another 
PLU or menu. 

1. In the Menu Items list, double click the PLU or menu 
to be replaced. The selected item appears above 
the Add button. 

2. Enter another PLU or select another menu from the 
drop-down list and click Modify. The selected item 
replaces the original in the Menu Items list. 

Remove Click Remove to delete the selected PLU or menu from the 
Menu Items list. 
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Messages and Troubleshooting 
General Messages 

This section contains general messages that may appear on the Operator Display but 
are not numbered. 
If more than one message occurs at a time, the messages take turns displaying briefly. 
Messages are listed in alphabetical order. Information contained in parentheses is a 
variable and changes depending on the circumstances. 
  

        General Messages                Message Description/Action 

(#) RECEIPT(S) PENDING The indicated number of transactions (#) are 
suspended. 

ACCEPTED The entry made for either the Set Store Telephone 
Number or Set Store Postal Code function was 
accepted into the system. 

CARD IN READER A customer left a card in a DCR. 

CARDSCAN 0 LOADED (Schlumberger) Broadcast loading of all DCRs 
(CARDSCANs) has concluded. The ‘0’ means ‘all.’ 

CASSETTE FULL A cash acceptor cassette is full and needs to be 
emptied before this message clears. 

COMBO#nn INVALID! The cashier attempted to sell a combo that does not 
exist. 

COMM FAILURE Check the phone cord connections (Dial) or PES 
connections (VSAT); retry contacting the network; if 
communication failures are consistent and repeated 
and you have verified the connections, contact the 
Verifone Technical Support Center. 

DEBIT MODULE NOT 
PRESENT 

Debit is not available at a DCR. 

DROP (method of 
payment) 

The cash drawer contains more than the maximum 
allowed for the method of payment indicated. Make 
a large enough safe drop to reduce the amount in 
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        General Messages                Message Description/Action 

the drawer to below the maximum allowed. 

FUEL COMMS ERROR The POS lost communication with the fuel controller 
through which it controls the dispensers. Check the 
connections. If the connections are good and 
communication cannot be reestablished, contact the 
Verifone Technical Support Center. 

GSM OFFLINE Check the connections to and from the Gilbarco 
Security Module (GSM). If connections are good but 
the GSM is still offline, contact the Verifone 
Technical Support Center. 

HOST UNAVAILABLE Check the phone cord connections (Dial) or PES 
connections (VSAT); retry contacting the network; if 
communication failures are consistent and repeated 
and you have verified the connections, contact the 
Verifone Technical Support Center. 

INVALID CHARACTERS Either the telephone number was not entered 
correctly in the Set Store Telephone Number 
function or the postal code was not entered 
correctly in the Set Store Postal Code function. Use 
0 - 9 only. Do not use separators. 

Invalid input The PLU/modifier combination entered for the car 
wash key does not exist. Define this department in 
the PLU File first or choose another department. 

INVALID TIME OF 
TRANSACTION 

The time for the original transaction was entered 
incorrectly for a Fleet card refund. 

KEYPAD ERROR: rp1 Return PIN Failure: Invalid master key type or range. 
Call the Verifone Technical Support Center. The 
helpdesk should contact a servicer. 

KEYPAD ERROR: rp2 Return PIN Failure: Key not loaded. Call the 
Verifone Technical Support Center. The helpdesk 
should contact a servicer. 

KEYPAD ERROR: rp3 Return PIN Termination: [CANCEL] key pressed. No 
action required. The transaction times out and 
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        General Messages                Message Description/Action 

returns to idle. 

KEYPAD ERROR: rp4 Return PIN Termination: [CLEAR] key pressed twice. 
No action required. The transaction times out and 
returns to idle. 

KEYPAD ERROR: rp5 Return PIN Termination: Delay between entering pin 
numbers is too long. No action required. The 
transaction times out and returns to idle. 

KEYPAD ERROR: rp6 Return PIN Failure: Incompatible with encryption 
mode. Call the Verifone Technical Support Center. 
The help desk should contact a servicer. 

KEYPAD ERROR: rp7 Return PIN Termination: First key time out expired. 
No action required. The transaction times out and 
returns to idle. 

KEYPAD ERROR: rs1 Return String Failure: Invalid display buffer or 
display range. Call the Verifone Technical Support 
Center. The help desk should contact engineering. 

KEYPAD ERROR: rs2 Return String: Undefined error. Call the Verifone 
Technical Support Center. The help desk should 
contact engineering. 

KEYPAD ERROR: rs3 Return String Termination: [CANCEL] key pressed. 
No action required. The transaction times out and 
returns to idle. 

KEYPAD ERROR: rs4 Return String Termination: [CLEAR] key pressed 
twice. No action required. The transaction times out 
and returns to idle. 

KEYPAD ERROR: rs5 Return String Termination: Delay between entering 
pin numbers is too long. No action required. The 
transaction times out and returns to idle. 

KEYPAD ERROR: rs6 Return String: Undefined error. Call the Verifone 
Technical Support Center. The help desk should 
contact engineering. 
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        General Messages                Message Description/Action 

KEYPAD ERROR: rs7 Return String Termination: First key time out 
expired. No action required. The transaction times 
out and returns to idle. 

LOADING 0 CARDSCAN (Schlumberger) Broadcast loading of all DCRs 
(CARDSCANs) has begun. The ‘0’ means ‘all.’ 

MAIL PENDING or MAIL 
WAITING 

The network has sent mail to the terminal. Use the 
Mail function in Network Manager mode to read your 
mail. 

Max number exceeded You tried to perform either a pay out or a pay in and 
have reached the maximum number of times 
allowed for this period, which is 25. 

MONEY ORDER PRINTER 
UNAVAILABLE. EXITING 
PAY OUT 

The POS is not communicating with the money order 
printer. Check the communications link between the 
two machines. 

NETWORK SUSPENDED 
TRANSACTION 

The controller is retrieving a network suspended 
transaction from a workstation. 

NO CAR WASH COMM The server and car wash controller are not 
communicating. Check that the controller is plugged 
in and connected to the correct COM port. 

NO CASHIER REPORT 
AVAILABLE 

There are no cashier reports available for printing. 
This occurs in the Print Cashier Report function in 
Reports mode. 

NO CHANGES MADE The [ENTER]key was pressed before data was 
entered in the Registration Information function. 

NO COMM DSR The POS has detected a loss of connection to the 
ISDN, VSAT, or T3POS network hardware. 

NO SALES SINCE LAST 
SHIFT, OK(Y/N)? 

No sales have occurred since the last Close Period 
report was run. This occurs in Close Shift, Daily, 
Monthly, and Yearly report functions in Reports 
mode. 
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        General Messages                Message Description/Action 

PDL UPDATE PENDING The Parameter Download has been requested, but 
the parameters have not been updated. After the 
Close Daily, the parameters can update. 

PRINTER COVER OPEN The printer cover is not completely closed. Close the 
cover. 

RECEIPT BLOCKED The POS cannot communicate with the receipt 
printer. Make sure that the printer is online and that 
all connections are securely in place. 

RECEIPT PAPER LOW The paper in the receipt printer is getting low. Add 
new paper. 

Refused No voice auth 
phone number PRESS 
ENTER KEY TO CONTINUE 

A voice authorization number for the tendered 
credit card was not provided during the parameter 
download. The customer must use a different 
method of payment. 

SUSPENDED TRANSACTION A transaction is currently suspended. 

SYSTEM NOT REGISTERED The application has not been registered within eight 
hours of installation. 

UNKNOWN CARD SEE CC 
GUIDE/ACCEPT CARD? 

The network does not recognize the credit card. See 
the store’s credit card guide for information on card 
acceptance or denial. 

Numbered Messages 

This section contains numbered messages. Messages are grouped by related 
functional area and listed in ascending order. There are four types of messages: 

• Most of the messages appear on the first line of the Operator Display. 
Many appear momentarily then disappear. 

• Messages that have “Alarm Line Only” at the beginning of the 
description appear on the bottom line of the Operator Display. Someone 
such as a manager or servicer, must take some action to clear the 
message. 

• Messages that have “DCR Message” at the beginning of the description 
display on the DCR and do not display on the POS. 
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                                  Numbered Messages Related To Sales 

                       Message                                               Description/Action 

E1101 INVALID CASHIER # The cashier number entered is incorrect. Re-
key the number. 

E1102 INVALID PASSWORD The password entered is incorrect. Re-key 
the information, 

E1103  INVALID DRAWER # Entered a drawer number that has not been 
set up. Key the drawer number again. 

E1104 MOP INVALID/NOT 
ALLOWED 

Used an MOP soft key that no longer exists. 
Choose another MOP. 

E1105 LAN UNAVAILABLE, 
CHECK CABLE 

The POS cannot process a network 
transaction. Check for loose connections on 
the back of the POS. 

E1106 USE VOID LINE/VOID 
TICKET 

Attempted to use [ERROR CORR] to remove 
more than the last item from the current 
transaction. Use [VOID LINE] to remove 
additional items from the transaction or 
[VOID TICKET] to remove the entire ticket. 

E1107 INVALID KEY PRESSED The wrong key was pressed during a 
transaction. Wait for the error to clear and 
press the correct key. 

E1108 INVALID QUANTITY The quantity entered is less than minimum or 
greater than the maximum allowed. 

E1109 PRESET NOT USED The soft key has not been defined or the PLU 
no longer exists. 

E1110 PLU TOO LONG PLU entered has too many digits. Key the 
correct PLU. 

E1111 INVALID PLU PLU entered does not exist. Key the correct 
PLU. 

E1112 ART. NOT FOR SALE Article not for sale. 
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E1113 NO REFUND ALLOWED No refund is allowed on this PLU or in this 
department. 

E1114 INVALID BARCODE Barcode is not recognized for this 
transaction. 

E1115 INVALID DEPARTMENT 

The department entered in Department 
Setup function in Car Wash Manager mode 
does not exist. Define the department in the 
Department File or choose another 
department. 

E1116 AMOUNT TOO LARGE 
The dollar amount entered is larger than the 
maximum allowed for this department or 
MOP. 

E1118 NO SPLIT TENDER ON 
FUEL Only one MOP allowed for fuel purchases. 

E1119 OPER. NOT ALLOWED The attempted operation is not allowed. 

E1120 DO NOT OVERRIDE MOP 
AMOUNT 

Cannot override the minimum or maximum 
allowable amount for an MOP. 

E1121 DISCOUNT TOO SMALL The discount entered is less than the set 
minimum amount. 

E1122 DISCOUNT TOO LARGE The discount entered is more than the set 
maximum amount. 

E1123 INVALID NUMBER OF 
GALLONS (LITERS) 

Fuel discount is not valid for the gallons 
(liters) entered. 

E1124 PAYROLL RECORD FULL Print a Payroll Report. 

E1125 INVALID CHOICE, TRY 
AGAIN 

The item number entered is not available on 
the menu. 

E1126 MUST CLOCK OUT FIRST Employee attempted to clock in but has not 
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clocked out yet. 

E1127 MUST CLOCK IN FIRST Employee attempted to clock out, but had 
not clocked in yet. 

E1128 FINISH TRANSACTION 
The sale MUST BE completed because no 
more line items can be added to the 
transaction. 

E1129 NO FUEL DEPARTMENT Fuel department needs to be set up. 

E1130 MOP CONFLICT 

Customer dispensed fuel at one MOP price 
level and attempted to pay with an MOP 
associated with a different price level when 
the “Ignore MOP conflict” parameter is set to 
‘N’ in Fuel Manager > DCR Configuration. 

E1131 AMOUNT TOO SMALL The dollar amount entered is less than the 
minimum set up for the department or MOP. 

E1132 SUB-TOTAL REQUIRED Must press [TOTAL]before choosing an MOP. 

E1134 PENDING TRANSACTION Cannot complete function because a 
transaction is pending. 

E1135 DROP MONEY FIRST 
The amount of money in the drawer exceeds 
the limit set in the MOP File function. 
Perform a Safe Drop. 

E1136 INVALID CATEGORY NR 
‘NR’ = number - The item entered does not 
have a valid category. Enter a valid category 
number. 

E1137 NO FEE/CHARGES DEPT. Fee/Charges department must be set up. 

E1138 INVALID MOP AMOUNT 
The dollar amount entered is not allowed by 
the selected MOP. This can occur if a dollar 
amount is entered and credit selected 
because credit only takes the balance of the 



Commander Site Controller User Reference 

341 

                                  Numbered Messages Related To Sales 

                       Message                                               Description/Action 

sale. 

E1139 INVALID AMOUNT 
ENTERED 

MOP may not require an amount or the 
amount entered is less than the minimum or 
more than the maximum amount allowed for 
the MOP. 

E1140 AMOUNT REQUIRED A dollar amount must be entered. 

E1141 PURCH. NOT ALLOWED 

The customer cannot purchase this item 
because either (1) the date of birth entered 
for the ID check does not meet the age 
requirements or (2) a Blue Law restriction 
has been set up for this item or department 
at this time on this day. 

E1142 INVALID ENTRY 

An invalid selection is made when a fuel tax 
exemption is attempted. The fuel tax menu 
redisplays and the user can re-enter the 
selection. 

E1143 INVALID DATE, CHECK 
FORMAT 

Dates MUST BE entered as six digits in the 
format MMDDYY (month/day/year). 

E1144 INVALID MODIFIER The modifier entered is incorrect. Select 
another modifier. 

E1145 CASH ONLY ALLOWED Only cash is allowed in this transaction. 

E1150 REFUND NOT ALLOWED 
ON CREDIT SALE 

A credit card purchase cannot be refunded in 
cash. 

E1151 TICKET TOTALS ZERO - 
Press CASH 

Although the total on the ticket is zero, press 
[CASH]to complete the transaction. 

E1152 NEGATIVE CHECK 
AMOUNT NOT ALLOWED  A check cannot have a negative amount. 

E1153 TOTAL OVER LIMIT The transaction amount is more than the 
network allows on this card. Credit card 
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parameters may require an update from a 
parameter download. 

E1155 NO PENDING 
TRANSACTIONS 

Appears if the View Pending Transactions 
function is selected and there are no 
suspended transactions. 

E1156 INVALID RECEIPT INFO 

Attempted to do a ticket reprint or ticket 
recall on a DCR/ fuel transaction and the POS 
found the ticket data invalid. Call servicer 
for assistance. 

E1157 UNABLE TO SUSPEND 
Sale cannot be suspended. Perhaps the 
maximum number of suspended sales have 
been exceeded. 

E1158 REPRINT NOT POSSIBLE 

The DCR has a stacked sale and the cashier 
attempted to reprint the receipt for sale #1. 
Because the POS keeps only the last DCR 
transaction, a receipt for the first sale 
cannot be reprinted. 

E1159 INVALID RECEIPT 
NUMBER 

No fuel receipts available for printing at this 
pump. 

E1160 MAXIMUM PENDING 
TRANS. EXCEEDED 

Too many transactions are suspended. Only 
one credit transaction can be suspended at a 
time. 

E1161 NO SAVED RECEIPTS No receipts are available for printing. 

E1162 NEED TO SETTLE 
PENDING TRANS. 

Attempted to close a shift while a network 
transaction is suspended. Settle the pending 
transaction and then close the shift. 

E1163 NO CHANGE ALLOWED “Change Allowed” is set to ‘No’ for this MOP. 

E1164 REFUND NOT ALLOWED “Refund Allowed” is set to ‘No’. 
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E1165 FUNCTION NOT 
SUPPORTED 

Attempted to use a function that is not 
available or not enabled. 

E1166 INVALID FUEL 
TRANSACTION 

The fuel transaction no longer exists in the 
system. 

E1167 SOFT KEY NOT DEFINED The soft key is not defined in the Soft Key 
File. 

E1168 SALE REQUIRED The attempted function requires an item to 
be sold. 

E1169 INVALID KEY SEQUENCE The order of keystrokes pressed is invalid. 
Try another sequence. 

E1170 CARWASH QTY SALE NOT 
ALLOWED Car washes can be sold only one at a time. 

E1171 NO CAR WASH KEY 
DEFINED FOR PLU 

A key for this car wash item must be defined. 
Set up a car wash PLU in Car Wash Manager > 
Car Wash Key Setup. 

E1172 CAR WASH KEY NOT 
PROGRAMMED 

Attempted to sell a car wash that does not 
exist on the car wash controller. Call the 
servicer to set up the car wash controller. 

E1173 CAR WASH COMM ERROR 

The POS and car wash controller are not 
communicating. The car wash code is not 
received from the controller. If the 
noncommunication just started or just 
ended, it may take a minute for the alarm to 
turn on or off. 

E1175 LAN COMMS ERROR The workstation is not communicating with 
the controller. Check the LAN connections. 

E1176 MOP NOT ALLOWED 
WITH CASHBACK 

Selected MOP is not configured for cashback. 
Either cancel the cashback or use another 
MOP. 
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E1178 CAR WASH PARM FILE 
READ ERROR 

A car wash code is requested from the device 
and an error is detected while trying to read 
the car wash file. Call servicer. 

E1181 SAFE DROP NOT 
ALLOWED FOR MOP 

The MOP used disables Safe Drop in the MOP 
File. 

E1186 INVALID PUMP NUMBER 
The pump number has not been entered 
correctly or does not exist. Check that the 
number is correct and re-enter it. 

E1187 NETWORK SUSPENDED 
TRANSACTION 

Attempted to recall a network transaction 
from a different POS than the one on which 
the transaction was suspended. Use the same 
POS to recall the transaction. 

E1188 MOP APPLIED BEFORE 
A special discount has already been applied 
to the transaction; only one special discount 
is allowed. 

E1189 NO ELIGIBLE ITEM 
A special discount cannot be applied because 
no items in the transaction are set up to 
receive a special discount. 

E1190 MUST BE FIRST MOP 
The special discount MOP must be entered 
first. Use [ERROR CORR] to remove the other 
MOPs, then apply the special discount MOP. 

E1192 REFILL COIN DISP 

The number of coins in the dispenser are 
running low. Refill the dispenser within four 
transactions of the appearance of this 
message or the coin dispenser becomes 
unavailable. 

E1193 CHECK COIN DISP 
The coin dispenser is unavailable because of 
a communication error or because the coins 
have run out. 

E1194 NOT ENOUGH MONEY IN The POS does not have sufficient funds in the 
cash drawer for the MOP entered for a safe 
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DRAWER drop amount. 

E1195 NOT ALLOWED FOR AMT 
0.00 

$0.00 is not allowed for a safe drop amount. 
Specify an amount more than $0.00. 

E1196 BLUE LAW RESTRICTION 
A Blue Law restriction is set up for this item 
or department, preventing its sale during a 
certain time of the day. 

E1197 INVALID PRICE 
This item does not have a unit price assigned 
to it in the PLU File function in Manager 
mode. 

E1200  USE VOID TICKET [VOID LINE] cannot be used in this 
transaction. Use [VOID TICKET]. 

E1201 NO AT-FOR SALES W/ 
FRACTIONAL QTY 

At-for pricing cannot be used for items that 
can be sold in fractional quantities. 

E1202 No MOPs available The [OTHER MOP]key is pressed and there are 
no MOPs assigned. Choose another MOP. 

E1203 TERMINAL FULL, CLOSE 
DAY 

One of the following occurred: The maximum 
number of batches per day is reached. The 
maximum number of transactions in a batch 
is reached. The batch is set to close with the 
Close Daily. Perform a Close Daily to reset 
the batches. 

E1204 TERMINAL FULL, CLOSE 
SHIFT 

The maximum number of transactions in a 
batch is reached and the close period is set 
to Close Shift. Perform a Close Shift. 

E1206 PAYROLL RECORD FULL The POS stored as many clock in/outs as it 
can hold. Run the Payroll Report function. 

E1207 INVALID CHOICE, TRY 
AGAIN 

A number other than 1 or 2 is entered. When 
clocking in or out enter the correct value. 
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E1208 MUST CLOCK OUT FIRST Must clock out before trying to clock in. 

E1209 MUST CLOCK IN FIRST Must clock in before trying to clock out. 

E1210 CAR WASH DOWN. CODE 
AVAILABLE 

The POS is not communicating with the car 
wash controller but can still provide a car 
wash code. The code is valid for a specified 
time. 

E1211 CAR WASH CODE 
UNAVAILABLE 

The POS is not communicating with the car 
wash controller and no car wash code is 
available. The servicer should investigate the 
problem. 

E1212 NO DCR RECEIPT 
AVAILABLE 

Attempted to print a DCR receipt inside and 
there are none available. 

E1213 MANUAL CREDIT NOT 
ALLOWED 

The Manual Credit MOP is not allowed in this 
transaction. Choose another MOP. 

E1214 ONLY FUEL ALLOWED ON 
PREPAY CREDIT 

Non-fuel items are not allowed in the same 
transaction as a credit fuel prepay when the 
“Enable Fast Credit” parameter is set to ‘Y’ 
in Manager > Sales Config. 

E1215 RECEIPT PRINTER 
UNAVAILABLE 

Communication with the receipt printer is 
not established in Sales mode. Check the 
connections on the back of the POS and make 
sure the printer is online. 

E1216 LICENSE TRACK 2 EMPTY 

The driver's license reader failed to read the 
magnetic stripe information. Run the ID 
check again or enter the information 
manually. 

E1217 LICENSE NOT 
SUPPORTED 

Driver’s license was swiped/scanned and 
format is not recognized. Manually enter the 
information. 
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E1218 LICENSE EXPIRED Driver’s license swiped/scanned has expired. 
Manually enter the information. 

E1219 LICENSE EXPIRATION 
DATE ERROR 

The driver’s license just swiped/scanned has 
expiration date information errors. Run the 
ID check again or enter the information 
manually. 

E1220 LICENSE BIRTH DATE 
INVALID 

The driver’s license just swiped/scanned has 
invalid birth date information. Run the ID 
check again or enter the information 
manually. 

E1222 UNEXPECTED EASYID 
ERROR 

An unknown error occurred while trying to 
process a driver’s license. Enter the 
information manually. 

E1223 SCANNER NOT PDF417 
DATA 

The scanned driver’s license data is not in 
the proper format. Enter the data manually. 

E1234 SCANNER DATA EMPTY 

The scanner did not successfully read any 
data from the driver’s license. Try to scan 
the driver’s license again or enter the 
information manually. 

E1235 
MONEY ORDER PRINTER 
UNAVAILABLE. 
CONTINUE Y/N? 

The money order just sold cannot be printed 
because the POS is unable to communicate 
with the money order printer. The money 
order must be entered and printed locally on 
the money order terminal. 

E1237 NO MONEY ORDER 
PURCHASE FOR MOP 

An MOP, with the “Allow Money Order 
Purchase” parameter set to ‘N’, was used. To 
purchase a money order. select another MOP. 

E1238 TOO MANY MONEY 
ORDERS IN SALE 

Attempted to sell more money orders on the 
current ticket than allowed. End the current 
transaction. Start a new transaction for the 
rest of the money orders. 
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E1239 
MONEY ORDER PRINTER 
UNAVAILABLE EXITING 
PAY OUT 

A money order pay out was attempted and 
the POS was unable to communicate with the 
money order printer. The money order pay 
out must be entered and printed locally on 
the money order terminal. 

E1240 COMBO#xx DISABLED 

Attempted to sell a combo that was outside 
the established effective time period. The 
combo cannot be sold until the time period is 
updated in Manager mode. The items can be 
sold separately at no discount. 

E1241 COMBO#xx INVALID 

The combo is no longer defined. The combo 
cannot be sold until it is redefined in 
Manager mode. The items can be sold 
separately at no discount. 

E1242 GET TRK 2 ERROR 
The POS could not find track 2 data on the 
driver’s license just swiped. Enter the 
information manually. 

E1243 TRK 2 READ FAIL 
The POS could not read track 2 data on the 
driver’s license just swiped. Enter the 
information manually. 

E1244 POP CODE REJECT – 
INVALID CODE 

POP Code provided and rejected – code does 
not meet requirements of internally defined 
algorithm. 

E1245 POP CODE REJECT – 
EXPIRED CODE 

POP Code provided and rejected as expired 
code based on when code was generated and 
the configuration setting of “number of days 
POP Code valid” in Sales Config. 

E1246 POP CODE REJECT – 
PREV REDEEMED 

POP Code provided and rejected – same code 
has been flagged as previously redeemed. 

E1247 POP CODE REJECT – 
INVALID DISC 

POP Code provided and rejected because a 
discount has already been applied to the fuel 
purchase. (POP cannot apply to an already 
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discounted fuel purchase.) 

E1248 INVALID ENTRY – 
CONFIGURED FOR DEAL 

Attempted to configure a PLU for a POP 
Discount that was already configured for 
Deal. 

E1249 SPLIT TENDER NOT 
ALLOWED 

Attempted to split a transaction between two 
or more MOPs, which is not allowed. 

E1250 ONLY FUEL PRODUCTS 
ARE ALLOWED 

An MOP that allows only fuel products to be 
purchased has been chosen. 

E1251 ONLY POST PAY FUEL IS 
ALLOWED 

An MOP that allows only post pay fuel 
products has been chosen. 

E1253 OPERATOR #<999> IS 
ACTIVE 

Attempted to log on to SALES while another 
cashier is logged on to that register. Security 
override is not allowed. 

E1254 MEMBER ID CARD 
REJECTED 

Membership card scanned for POP discount is 
not valid. 

E1255 
OPERATOR#<nnn>IS 
ACTIVE LOGIN 
OVERRIDE? [Y/N] 

Attempted to log on to SALES while another 
cashier is logged on to that register. Security 
allows override. 

E1256 INSUFFICENT AMT. NEED 
$X.XX 

Prepaid card does not have sufficient funds 
for the purchase. 

E1257 MUST PRESS CREDIT 

Part of the Auto-Refund feature. A credit 
card was used to pay for the initial prepay 
transaction and cashier tries to refund the 
underrun amount to any MOP other than 
credit. 

E1258 NO MERCHANDISE WITH 
PREPAY UNDERRUN 

In an automatic Prepay Underrun, no 
merchandise is permitted to be in the same 
transaction when the MOP is credit-based. 
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E1259 FUEL TAXES UNDEFINED No fuel tax exemptions have been defined in 
the Fuel Tax Exemption File. 

E1260 EXEMPTION MUST BE 
BEFORE % DISC 

Attempted to apply a fuel tax exemption on 
discounted fuel. Apply the tax exemption 
first, then apply the fuel discount. 

E1261 MEMBER ID REJECT - 
ALREADY APPLIED 

Displays when the Member ID card is 
presented and a discount has already been 
applied to the transaction. 

E1262 BIRTHDATE ENTRY 
REQUIRED 

Requires a valid DOB entry. The [ENTER] key 
cannot be used to bypass this operation. 

E1263 ITEM REJECT - 
BIRTHDATE ENTRY REQ'D 

Attempted to continue the transaction 
without responding to the ID check prompt 
with a valid DOB entry. 

E1264 ITEM REJECT - CASHIER 
ENTRY REQ'D 

Attempted to continue the transaction 
without responding to the POS. The error 
message requires a response. 

E1265 (POP Discount Message) 
ALREADY APPLIED 

Attempted to apply a POP Discount at the 
POS when a POP Discount has already been 
applied at the DCR. 

E1266 FUEL TAX ALREADY 
ADDED 

Attempted to add a fuel tax using the Fuel 
Tax Addition function and the fuel 
department for that item already has a fuel 
tax assigned to it. 

E1267 INVALID STATE 
ABBREVIATION A wrong state abbreviation was entered. 

E1268 CANNOT CYCLE 
THROUGH MODIFIERS 

Attempted to loop through modifiers by 
pressing the modify key. 

E1269 CASH DRAWER OPEN Cash drawer is left open longer than the time 
allowed. 



Commander Site Controller User Reference 

351 

                                  Numbered Messages Related To Sales 

                       Message                                               Description/Action 

E1270 MAX. PREPAID CARDS 
REACHED 

Reached the maximum number of prepaid 
cards that can be activated/recharged on 
one ticket. Start a new ticket. 

E1271 CASHBACK AMOUNT 
EXCEEDS LIMIT 

Cashback request exceeds the limit set on 
the POS or by the network. 

E1272 ONE LINE ITEM PER FUEL 
GRADE 

A network sale has more than one line item 
of the same fuel grade. 

E1273 FUEL TAX NOT ALLOWED 
WITH % DISC 

A discount using the [DISC] key is attempted 
on an item that has a fuel tax exemption 
applied or a fuel tax exemption is attempted 
on an item that already has a discount 
applied. 

E1274 FUEL PRICE NOT SETUP Entered a sale for a fuel product that does 
not have a price set up in the POS. 

E1275 CHECK SCAN CONTAINS 
ERRORS 

A scanned check contains an unreadable 
element. Retry. 

E1277 PREPAID CARD NOT 
ALLOWED 

The prepaid card function is not supported or 
enabled. 

E1279 SECURITY CODE INVALID Entered invalid security code. Retry. 

E1280 INVALID ZIP CODE Zip code entered is invalid. Check the zip 
code and re-enter. 

E1281 INVALID ZIP LENGTH Zip code entry is less than five digits. 

E1282 INVALID ZIP ENTERED 
Zip code entry failed either because the code 
entered is invalid, or the number of retries 
has been exceeded. 

E1283 SUSPEND WITH FUEL 
INVALID 

Attempted to suspend a transaction with a 
prepaid fuel sale, which is not allowed. 
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E1284 EXCEEDS SITE SALE 
MAXIMUM 

The purchase amount is greater than the 
maximum allowed by the network. 

E1285 GIFT CARD AMOUNT TOO 
HIGH 

The amount being applied to the card is 
higher than the maximum amount allowed. 

E1286 GIFT CARD AMOUNT TOO 
LOW 

The amount being applied to the card is 
lower than the minimum amount allowed. 

E1287 GIFT CARD CANNOT BE 
ACTIVATED 

The Gift Card is not set up for activations 
/recharges. 

E1288 COMM OFFLINE: NO GIFT 
CARD FUNC 

Attempted to activate/recharge a Gift Card 
when the network is offline. 

E1289 NON GIFT CARD ITEM ON 
TICKET 

Gift card functionality is not valid for at least 
one item in the transaction. 

E1290 CARD IS NOT A GIFT 
CARD 

Attempted to activate/recharge a non-Gift 
Card. 

E1291 MANUAL ENTRY NOT 
ALLOWED 

Manual entry is not allowed for this Gift 
Card. 

E1292 TOO MANY GIFT CARDS 
ON TICKET 

Attempted to activate/recharge more Gift 
Cards than the network allows. 

E1293 GIFT CARD ALREADY 
SWIPED 

Attempted to activate/recharge a Gift Card 
that is already in the transaction. 

E1294 NO MOP CONFIGURED 
FOR SAFE DROP 

Attempted to perform safe drop using 
[OTHER MOP] key, but there are no MOPs 
configured to allow safe drop. 

E1295 MENU NOT DEFINED 
Attempted to use a menu assigned to 
softkey, but menu is not defined in Menu 
File. 

E1296 NO MULTIPLE PPG DISC Only one price per gallon discount is allowed 
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IN SALE per sale. 

E1297 FUNC NOT VALID AFTER 
LOYALTY 

Attempted to enter disallowed functions 
after a loyalty card has been swiped 
(assuming a discount is given). For example, 
void line or error correct are not allowed 
after a loyalty packet has been sent. You 
must either void the ticket or complete the 
sale. 

E1298 INVALID SAFE DROP 
TICKET NUMBER 

Entered an invalid number when prompted 
for the original safe drop ticket number. 

E1300 SAFE DROP ALREADY 
CORRECTED 

Attempted a safe drop correction on a safe 
drop that has already been corrected. Only 
one correction is allowed. 

  

                            Numbered Messages Related To Reports 

      #                           Message                                      Description/Action 

E2001 ABORT PRINTING NOT 
ALLOWED 

Attempted to stop printing the Close Yearly 
report. Printing this report cannot be 
aborted. 

E2002 NO CASHIER REPORT 
AVAILABLE 

The Print Cashier Report function has been 
selected and there is no data to print. 
Choose another report or function. 

E2003 NOT AVAILABLE ON THIS 
REGISTER 

Attempted to close or print a period report 
or a flash report from a workstation 
terminal. These reports can be printed only 
from a controller terminal. 

E2004 INVALID INPUT 

One of the following operations was 
performed: 

• An invalid cashier number was 
entered or an invalid key was 
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pressed when trying to close a 
cashier. 

• An invalid number was entered to 
list the PLU or department data. 

• An invalid choice was entered 
when prompted to print a current 
or close a Payroll Report. 

• An invalid cashier number was 
input for the Payroll Report. Enter 
the correct information. 

E2005 CASHIER NOT OPEN 
Attempted to run the Close Cashier Totals 
function in Reports mode and the specified 
cashier has not logged in. 

E2006 INVALID EMPLOYEE 
NUMBER 

Logged in with an invalid ID and attempted 
to use the Close Cashier functions. Re-enter 
the correct number. 

E2007  INVALID CASHIER 
REPORT AMOUNT 

Entered 0.00 for an MOP amount when 
printing a Cashier Report and the “Allow 
$0.00 Entry” parameter is set to ‘N’ in the 
MOP File. Re-enter the information. 

E2008 NO REPORTS AVAILABLE 

The selected period report has not been 
closed yet. Run the close period report first. 
This occurs in the Print Shift, Daily, and 
Monthly report functions in Reports mode. 

E2009 ACCESS DENIED 

Attempted to print a report or close a period 
with a security level lower than that set in 
Manager > Security Control > Report 
Functions. Get a password from the 
Verifone Technical Support Center. 

E2010 UNABLE TO OPEN TANK 
MONITOR PORT 

Selected the Tank Monitor Report for 
printing but the appropriate COM port could 
not be opened. Check for loose connections 
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in the back of the POS. 

E2011 NO RESPONSE FROM 
TANK MONITOR 

Selected Tank Monitor Report for printing 
but the POS did not receive a response from 
the TLS. A servicer should check the 
communications between the TLS and the 
server. 

E2012 ERR CLSING MO PRD 
The period could not be closed on the money 
order device. See the money order terminal 
documentation for instructions. 

E2014 DUE SALES PENDING 
The AEOD begins with due sales on the 
register and “Wait for no due sales” is 
enabled. 

E2015 FUEL PUMPS NOT IDLE 
The AEOD begins with fuel pumps in use and 
“Fuel idle wait time (minutes)” is not equal 
to zero. 

  

                            Numbered Messages Related To Manager 

...#                      Message                                               Description/Action 

E3001 PASSWORD NOT 
CHANGED 

When the password was changed either no 
password was entered or the original 
password was entered incorrectly. Correctly 
enter the information. 

E3003 RECORD ALREADY EXISTS Attempted to add a new record to a file and 
the record already exists. 

E3004 INVALID INPUT 
In the Manager mode, an incorrect key was 
pressed or value entered. Enter the correct 
value or press the correct key. 

E3005 ACCESS DENIED Attempted to enter the System Config 
function but did not have the proper 
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security level. 

E3006 BAD RECORD NUMBER The selected record number does not exist. 
Choose another record number. 

E3007 BAD WRITE TO FILE 
The file record could not be changed. 
Review the site’s procedures or consult with 
the servicer. 

E3008 BAD DELETE 
The file record could not be deleted. Review 
the site’s procedures or consult with the 
servicer. 

E3009 BAD ADD 
A new file record could not be added. 
Review the site’s procedures or consult with 
the servicer. 

E3010 NOT ALLOWED TO 
MODIFY 

Attempted to modify a file record that 
cannot be changed. The record is for display 
purposes only. 

E3011 ERROR CANCELING 
PRINTER JOBS 

The Flush Printer Queue function was chosen 
and the specified printer could not be 
cancelled. Check for loose connections in 
the back of the POS. 

E3012 IOCFG.DAT NOT FOUND 

The Display I/O Configuration, File 
Information, or Version Information function 
was chosen and the IOCfg.dat file could not 
be found. Have the servicer investigate this 
error. 

E3013 INVALID FILE NUMBER 
An invalid file number was specified when in 
the Create Files function. Specify the 
correct file number. 

E3014 CREATION FAILED 

Attempted to recreate a file using the 
Create Files function and the file could not 
be recreated. Check the procedure and 
follow correctly. 
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E3015 <printer name> ENABLE 
FAILED 

The Enable Printer function was chosen and 
the printer could not be enabled. Check the 
printer and connections in the back of the 
POS. 

E3016 <printer name> DISABLE 
FAILED 

The Enable Printer function was chosen and 
the printer could not be disabled. Check the 
printer and connections in the back of the 
POS. 

E3017 DEVICE NOT AVAILABLE 
The file system device chosen in the Start 
Debugger function is not available. Check for 
loose connections in the back of the POS. 

E3018 NON-COMPATIBLE LDM 

Attempted to start a load module and the 
LDM file specified was not compatible with 
other LDMs in the system. This message also 
displays when either the Start Debugger or 
Execute Load Module function is chosen. The 
servicer should investigate. 

E3019 READ-ONLY FILE SYSTEM Attempted to start a load module and the 
medium that holds the LDM file is read-only. 

E3022 OUT OF MEMORY 

Attempted to start a load module and the 
medium that holds the LDM file does not 
have enough memory. If this continues to 
happen call the servicer. 

E3023 RESOURCE IS BUSY Attempted to start a load module that is 
already in use. 

E3024 NOT ENOUGH MEMORY 

Attempted to start a load module and the 
medium that holds the LDM file does not 
have enough memory. If this continues to 
happen call the servicer. 

E3025 CHECKSUM ERROR 
Attempted to start a load module and a 
checksum test fails. The servicer should 
investigate. 
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E3026 INVALID LDM HEADER 
Attempted to start a load module and its 
header is invalid. The servicer should 
investigate. 

E3027 
NO LOAD MODULES 
FOUND ON THIS FILE 
SYSTEM 

Attempted to start a load module and the 
medium specified does not contain any 
LDMs. The servicer should investigate and 
reinstall the application, if necessary. 

E3028 FILE NOT FOUND 
Attempted to start a load module but it 
cannot be found on the medium specified. 
The servicer should investigate. 

E3029 *** Failed!! Error Number 
<error #> *** 

Attempted to start a load module and an 
unknown error was encountered. The 
servicer should investigate. 

E3030 SOFT KEY FILE RESET 
ERROR 

The Reset Soft Key File function was chosen 
and the soft key file could not be reset. Try 
the action again. If this continues to happen 
call the servicer. 

E3032 MODEM RESET FAILED 

The Reset Modem function could not be 
reset. Check for loose connections on the 
back of the POS. Call the servicer if 
connections are good. 

E3033 ERROR IN CARWASH 
SETUP 

The car wash parameters have not been set 
up correctly and the Discount Type prompt 
displays in the PLU Promotion File function. 
Check the car wash parameters. 

E3037 INVALID KEY PRESS The original Cprintf file could not be 
accessed. Have the servicer investigate. 

E3048 COULD NOT COPY ALL OF 
THE FILE 

The Copy Cprintf File function was chosen 
and the entire file could not be copied. Have 
the servicer investigate. 

E3049 COULD NOT OPEN The Copy Cprintf File function was chosen 
but the destination file could not be opened. 
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CPRINTF FILE COPY Have the servicer investigate. 

E3050 NO MENUS HAVE BEEN 
DEFINED 

Attempted to set up a menu soft key but no 
menus are defined. Set up menus in the 
Menu File function. 

E3051 NOT AVAILABLE ON THIS 
REGISTER 

Attempted to perform an action that is 
allowed only on the controller. Move to a 
controller station to perform the action. 

E3052 ITEM ALREADY EXISTS IN 
ANOTHER MIX. 

The PLU entered has already been assigned 
to a mix. Enter another PLU. 

  

                            Numbered Messages Related To Fuel 

      #                Message                           Description/Action 

E5001 INVALID INPUT 
Entered an invalid value. Wait for the 
prompt to clear and enter the correct 
information. 

E5002 INVALID DCR NUMBER 
Attempted to disable or download to a DCR 
and entered an invalid DCR number. Enter 
the correct value between 1 and 32. 

E5003 NO PUMPS DEFINED 
Attempted to set up dispenser hoses before 
the pumps were set up. Set up the pumps 
and then set up the dispenser hoses. 

E5004 ERROR PRODUCT INIT The Tokheim dispenser could not be 
initialized. Servicer should investigate. 

E5005 ERROR GRADE INIT 

The dispenser’s grade configuration could 
not be performed. Dresser/Wayne dispensers 
only. The servicer should investigate a setup 
problem. 

E5006 ERROR BLEND INIT The dispenser’s blend configuration could 
not be performed. Allied and Gilbarco 
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dispensers only. The servicer should 
investigate a setup problem 

E5007 FPD ERROR <variable 
text> 

A Fuel Price Sign Controller error (described 
in <variable text>) has occurred. The error 
may relate to the controller or an individual 
sign. 

E5008 FPD SIGN OFFLINE Fuel Price Sign Controller is not responding. 

E5009 FPD POLL ERROR 

Communications between the server and the 
Fuel Price Sign Controller are working, but 
the Fuel Price Sign Controller indicates that 
a sign position is offline. There is a problem 
with a particular sign or signs. 

  

                            Numbered Messages Related To Car wash 

      #                        Message                                            Description/Action 

E4003 INVALID CAR WASH 
DEPARTMENT 

A car wash department in the Car Wash 
function has been specified and the number 
entered has no department setup. Check the 
department number and re-enter the 
information. 

E4004 INVALID DAY 
Displays if the system call to gmtime returns 
an invalid day. Have the servicer 
investigate. 

E4005 
Either 
may 
appear 

INVALID INPUT 
Entered an invalid value. Wait for the 
prompt to clear and enter the correct 
information. 

ERROR DISABLING CAR 
WASH 

An attempt was made to disable the car 
wash but was unsuccessful. Check the 
connections. Call the servicer if the 
connections are good. 
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E4006 ERROR ENABLING CAR 
WASH 

An attempt was made to enable the car 
wash but was unsuccessful. Check the 
connections. Call the servicer if the 
connections are good. 

E4007 PLU ALREADY USED 
Attempted to assign a PLU to a car wash but 
it has already been assigned. Assign another 
PLU. 

E4008 NO OPEN PLUS ALLOWED 
Attempted to assign an open PLU to a car 
wash. This is not allowed. Assign another 
PLU. 

E4009 UNABLE TO READ CAR 
WASH FILE 

Attempted to assign a PLU to a car wash but 
the car wash key file cannot be read. Have 
the servicer investigate. 

E4010 ONLY CAR WASH ITEMS 
ALLOWED 

Attempted to assign a PLU to a car wash 
when the PLU has not been assigned to a car 
wash department. Assign the PLU to a car 
wash department then assign the PLU to a 
car wash. 

E4011 C/W PORT CONFLICT 
Alarm Line Only: Another device has been 
assigned to the car wash port. Check for 
correct port assignments. 

E4012 CAR WASH 
COMMUNICATION ERROR 

Alarm Line Only: The POS was unable to 
communicate with the car wash device. The 
servicer should investigate. 

  

                            Numbered Messages Related To Network Manager 

      #                         Message                                         Description/Action 

E6001 RECORD ALREADY EXISTS Attempted to add a new record to a file and 
the record already exists. 
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E6002 BAD RECORD NUMBER The record number selected does not exist. 
Try another record number. 

E6003 BAD WRITE TO FILE 
The file record could not be changed. 
Review the site’s procedures or consult with 
the servicer. 

E6004 BAD DELETE 
The file record could not be deleted. Review 
the site’s procedures or consult with the 
servicer. 

E6005 BAD ADD 
The new file record could not be added. 
Review the site’s procedures or consult with 
the servicer. 

E6006 

HIDDEN INFORMATION IS 
NOT SET UP PRESS [EXIT] 
AND CALL THE HELP 
DESK 

Security does not allow access. Call the 
Verifone Technical Support Center. 

E6007 MUST END DAY BEFORE 
CHANGING FILE 

Attempted to change the merchant ID, 
batch, or sequence number and a batch was 
open. Perform a Close Daily then make the 
changes. 

E6008 NOT AVAILABLE ON THIS 
REGISTER 

Attempted to access a field that cannot be 
changed on this POS. 

E6009 COMM FAILED 

Communication with the host has been lost 
after good initial connection. Check 
connections and make sure that no other 
device is using the same phone line. If 
problems continue, have the servicer 
investigate the error. 

E6010 MODEM ERROR 
Modem is not responding. Check the 
connections. If they are good, have the 
servicer investigate the error. 

E6011 NO COMM WITH HOST No carrier was detected within the required 
amount of time. Try again later. If the 
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problems continue, have the servicer 
investigate the error. 

E6012 NO DIAL TONE 
Phone line voltage detected but no dial 
tone. Check the phone connection or have 
the servicer investigate the error. 

E6013 WAIT LINE BUSY 

Host phone number received a busy signal. 
Wait and try again. Check the phone 
connection or have the servicer investigate 
the error. 

E6014 NO ANSWER 
Host phone number rang but host did not 
answer. Check the phone connection or have 
the servicer investigate the error. 

E6015 LINE UNAVAILABLE 
No phone line voltage detected. Check the 
phone connection or have the servicer 
investigate the error. 

E6016 NO COMM DSR 
No DSR signal detected from VSAT device. 
Check the cable connections or have the 
servicer investigate the error. 

E6017 NO MODEM No DSR from modem device. Have the 
servicer investigate the error. 

E6018 MODEM RESET FAILURE Modem failure during reset sequence. Have 
the servicer investigate the error. 

E6019 MODEM NOT RESET Modem did not reset. Have the servicer 
investigate the error 
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E6701 MTEC COMMS ERROR 

The POS could not communicate with the 
Mannatec device. Check the connections. If 
they are good, have the servicer investigate 
the error. 

E6702 MODEM ERROR 
The Mannatec modem is not responding. 
Check the connections. If they are good, 
have the servicer investigate the error. 

E6703 NO COMM WITH HOST 

No carrier was detected within the required 
amount of time. Try again later. If the 
problems continue, have the servicer 
investigate the error. 

E6704 NO DIAL TONE 
The Mannatec modem did not detect a dial 
tone. Check the phone connection or have 
the servicer investigate the error. 

E6705 WAIT LINE BUSY 
The Mannatec modem line is busy. Wait and 
try again. Check the phone connection or 
have the servicer investigate the error. 

E6706 NO ANSWER 
The Mannatec network did not answer the 
phone. Check the phone connection or have 
the servicer investigate the error. 

E6707 LINE UNAVAILABLE 
The Mannatec modem could not detect the 
phone line. Check the phone connection or 
have the servicer investigate the error. 

E6708 MODEM RESET FAILED The Mannatec modem could not be reset. 
Have the servicer investigate the error. 

E6709 MODEM NOT RESET The Mannatec modem was not reset. Have 
the servicer investigate the error. 

E6710 UNKNOWN NTWRK 
RESPONSE 

The Mannatec device is returning an 
unrecognized error or response. Have the 
proprietary card provider investigate the 
error. 
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E6711 PIN TRIES EXCEEDED The number of PIN tries has been exceeded. 

E6712 REJECT Transaction was rejected. 

E6713 ODOMETER INVALID The odometer reading was invalid. Enter the 
correct odometer reading. 

E6714 DRIVER ID INVALID A driver’s ID was determined to be invalid. 

E6715 VEHICLE ID INVALID A vehicle’s ID was determined to be invalid. 

E6716 INVALID USER ID - PLEASE 
RETRY 

The network returned a user ID error. The 
customer is allowed to re-enter the user ID. 

E6717 LICENSE INVALID The license was determined to be invalid. 

E6718 JOB NUMBER INVALID The job number was determined to be 
invalid. 

E6719 DATA INVALID Misc data entry was determined to be 
invalid. 

E6720 DEPARTMENT INVALID The department number was determined to 
be invalid. 

E6721 USER ID TRIES EXCEEDED The number of user ID tries has been 
exceeded. 

E6722 INVALID PRODUCT FOR 
CARD TYPE 

The customer tried to purchase a restricted 
item. 

  

                              Numbered Messages Related To Application 

       #                   Message                                             Description/Action 

E7001 
CHECK <printer name> 
PRINTER DISABLE 
PRINTER? (Y/N) 

At startup, the POS could not access the specified 
printer. Check for loose connections on the back 
of the POS. 
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E7002 
<printer name> PRINTER 
BLOCKED DISABLE 
PRINTER? (Y/N) 

At startup, the POS could not access the specified 
printer. Check for loose connections on the back 
of the POS. 

E7003 PRINTER MECH FAILURE 
DISABLE PRINTER? (Y/N) 

At startup, the POS detected that a printer was 
experiencing a mechanical failure. Have the 
servicer investigate the error. If this stops sales 
from being run, see “Troubleshooting.” 

E7004 PRINTER COMMS ERROR 
DISABLE PRINTER? (Y/N) 

At startup, the POS could not communicate with 
the specified printer. Check the connections. If 
they are good, have the servicer investigate the 
error. If this stops sales from being run, see 
“Troubleshooting.” 

E7005 PRINTER UNAVAILABLE 

The printer is not available. Check the 
connections. Make certain that the correct printer 
was installed in the software. Call your servicer if 
the problem cannot be corrected. If this stops 
sales from being run, see “Troubleshooting.” 

E7006 INVALID INPUT An invalid value was entered. Wait for the prompt 
to clear then enter the correct information. 

E7007 PLU TOT FILE FULL - 
RECORD LOST 

Journal Only: Prints when an item is sold and the 
PLU total file does not have room to store the 
information. Close the current period. This makes 
room in the PLU File. 

E7008 DEP TOT FILE FULL - 
RECORD LOST 

Journal Only: Printed when an item is sold and 
the department total file no longer has room to 
store the information about the sale of the item. 
Close the current period. This makes room in the 
department file. 

E7009 CAT TOT FILE FULL - 
RECORD LOST 

Journal Only: Printed when an item is sold and 
the category total file no longer has room to store 
the information about the sale of the item. Close 
the current period. This makes room in the 
category file. 
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E7010 PLU EXCEPT FILE FULL - 
RECORD LOST 

Journal Only: Printed when an item is sold using 
price override, PLU not found, or is not scannable 
and the PLU exception file no longer has room to 
store the information about the sale of the item. 
Close the current period. This makes room in the 
PLU exception file. 

E7011 SAFE DROP FILE FULL - 
RECORD LOST 

The safe drop prints on the journal, but cannot be 
saved because it exceeds the maximum safe drops 
that can be stored. To make room, close the 
current period. 

E7012 ACCESS DENIED 

User does not have a high enough security level to 
access a menu item or a Verifone password is 
needed. Have someone with a higher security 
level access these menu items. 

E7013 INVALID SECURITY LEVEL 
A security level that is less than 0 or greater than 
9 was entered. Wait for the prompt to clear then 
enter the proper security level. 

E7014 
LAN COMMS ERROR 
UNABLE TO DOWNLD 
<filename> 

The controller was trying to download a file to a 
workstation and the LAN cable was not 
connected. Check for loose connections on the 
back of the POS. 

 E7020 
Continue Sales [Y/N] ? 
UNABLE TO DOWNLD <file 
name> 

An error occurred downloading a file from the 
controller to the workstation. Check the journal 
for more detail and see the site’s procedures for 
handling this situation. 

E7021 

DOWNLD <file name> 
FAILED <file name> 
DOESN'T EXIST SALES 
ABORTED 

The controller was trying to download a file to a 
workstation and the file could not be found. See 
the site’s procedures for handling this situation. 

E7024 INVALID INPUT Entered an invalid date or time. Enter the 
information in the proper format. 
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E7025 FILE CREATE ERROR: <file 
index> 

Attempted to create a file using the Create Files 
function and the file could not be created. See 
the site’s procedures for handling this situation. 

E7026 BAD MONTH 
A number less than 1 or greater than 12 was 
entered for a month. Enter the correct 
information. 

E7027 BAD YEAR An invalid year was entered. Re-key the year. 

E7028 BAD DAY 

A number less than 1 or greater than the 
maximum for the specified month (and year for 
leap years) was entered for a day. Enter the 
correct information. 

E7029 BAD SECONDS 
A number less than 0 or greater than 59 was 
entered for seconds. Enter the correct 
information. 

E7030 BAD MINUTES 
A number less than 0 or greater than 59 was 
entered for minutes. Enter the correct 
information. 

E7031 BAD HOUR A number less than 0 or greater than 23 was 
entered for hours. Enter the correct information. 

E7032 HLP DSK UPLD CPRNT 

Alarm Line Only: The Backup Print Log function 
was chosen. This alarm displays until the 
Cprintf.bak file is removed from the system by 
the Verifone Technical Support Center. 

E7033 
CRT ERR <return 
code>,<error code>:<file 
media>/<file name> 

At startup, one of the ‘.dat’ files could not be 
opened. See the site’s procedures for handling 
this situation. 

E7035 NEEDS TO BE HIGHER 
THAN #PENDING 

Entered a number for the maximum number of 
saved transactions that was lower than the 
maximum number of pending transactions. Enter 
the correct information. 
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E7036 NEEDS TO BE LOWER 
THAN #SAVED 

The number entered was greater than the 
maximum number of pending or saved 
transactions. Re-enter the information. 

E7037 VALUE BETWEEN 1 AND 50 

A number less than 1 or greater than 50 was 
entered for either the number of saved or the 
number of pending transactions. Enter the proper 
value. 

E7040 M. O. CHECKS LOW 

Alarm Line Only: The printer is running out of 
money order checks and needs to be reloaded 
soon. The appearance of this message is set with 
the “Money Order Low check Limit” parameter in 
Manager > Configuration > Sales Configuration. 
Refill the printer with money order checks. 

E7041 M. O. COMM ERROR 

Alarm Line Only: Communications have been lost 
between the POS and the money order terminals. 
Check connections between the two devices. This 
message clears when communication is re-
established and a money order transaction is 
successfully sent to the terminal. 

E7042 MONEY ORDER AMOUNT 
TOO LARGE 

A money order was sold for more than is allowed 
by the money order terminal. Change the 
maximum money order amount or sell two 
separate money orders totalling the necessary 
amount. 

E7043 TLS COMMS ERROR 
Alarm Line Only: The POS cannot establish 
communications with the TLS controller. Have the 
servicer investigate the error. 

E7044 TLS PORT ERROR 
Alarm Line Only: A problem occurred opening the 
TLS COM port. Have the servicer investigate the 
error. 

E7045 ERROR TANK INVENT 
Alarm Line Only: The POS was unable to receive 
inventory data from the TLS controller. Have the 
servicer investigate the error. 
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E7047 INVALID TAG VERSION Keyfob version is not compatible with software. 

E7048 CANNOT PASSWORD 
PROTECT THIS TAG 

User has attempted to password a tag that is not 
activated for payment. 

E7049 CANNOT DEACTIVATE 
DEALER TAG 

User has presented a Dealer tag to the deactivate 
function on the POS and this is not permitted. 

E7050 PLU NOT FOUND User attempted to configure a PLU that does not 
exist for one of the CRM programs. 

E7052 NEGATIVE DEPARTMENT 
NOT ALLOWED 

User attempted to configure a negative 
department for loyalty. 

E7053 PLU CANNOT ALSO BE IN A 
MIX 

CRM programs do not operate with PLU items also 
configured for Mix ‘n Match. 

E7054 PLU CANNOT ALSO BE IN A 
COMBO 

CRM programs do not operate with PLU items also 
configured for combo. 

E7055 PLU ALREADY A PART OF 
EPC 

User has to enter a single PLU number more than 
once in the EPC configuration file. 

E7056 DEPARTMENT NOT FOUND User has attempted to configure an invalid 
department for the Loyalty program. 

E7057 DEPARTMENT ALREADY 
PART OF LOYALTY 

User has attempted to configure the same 
department more than once in the Loyalty file. 

E7059 TANK n LOW PRODUCT 
Alarm Line Only: A TLS connected to the POS 
indicates that tank has gone below the low-fuel 
limit. 

E7060 TANK DELIVERY Alarm Line Only: TLS has detected that a delivery 
is being received by the tank. 

E7061 ERROR TANK CLEAR Alarm Line Only: An error occurred during an 
attempt to clear the status of a tank. 
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E7062 VALUE BETWEEN 2 AND 50 Applies to the number of saved transactions. 

  
 

                            Numbered Messages Related To Network 

       #                         Message                                           Description/Action 

E8001 NO BATCH AVAILABLE Attempted to print a batch detail report and 
there are no batches to print. 

E8002 INVALID RESTRIC. CODE! 
TRY AGAIN 

Entered an invalid Voyager restriction code. Enter 
a valid code. 

E8003 MERCHANDISE OVER CREDIT 
LIMIT CONTINUE? (Y/N) 

The sale amount is greater than the amount 
allowed for the credit transaction. Override the 
error. A split tender transaction can be set up with 
part of the amount paid with a different tender 
type. 

  

E8004 PRODUCT NOT ALLOWED 
WITH THIS CARD 

An item purchased is not allowed by the credit 
card. Use an alternate MOP.   

E8005 NUMBER OF TRIES EXCEEDED 
The customer has unsuccessfully entered PIN data 
more than the number of times allowed. Have the 
customer select another MOP or credit card. 

  

E8006 ODOMETER INVALID The odometer reading for a Donlen card was 
invalid. Enter the correct odometer reading.   

E8007 BAD DATE 
An invalid credit card expiration date has been 
entered. Enter the expiration date information in a 
four-digit format (mmyy). 

  

E8010 INVALID DATE An invalid date was entered. Enter date 
information in the proper format.   

E8011 INVALID BATCH NUMBER An invalid batch number was entered. Enter a 
number between 1 and 99.   
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E8012 ACCOUNT NUMBER ERROR 
Less than 13 digits were entered for a credit card 
number when doing manual credit. Enter the 
correct card number. 

  

Errors E8013 through E8030 may be followed by one of the following messages. TOTAL 
TOO LARGE, OR NEGATIVE FUEL AMT TOO LARGE, OR NEGATIVE NON_FUEL AMT TOO 
LARGE, OR NEGATIVE INVALID PRODUCT FOR CARD TYPE MISSING AUTH CODE REJECT 
DUPLICATE TRANSACTION DO NOT ACCEPT 

  

E8013 TERMINAL DISABLED (See 
messages above) 

The terminal is not allowed on the network. Have 
the servicer investigate the error.   

E8014 
BAD CARD - <auth. code> 
(See messages before 
E8013) 

The credit card was denied. Use another MOP or 
credit card.   

E8015 
INVALID CARD - <auth. 
code> (See messages before 
E8013) 

The account or credit card was invalid. Use 
another MOP or credit card.   

E8016 
EXP CARD - <auth. code> 
(See messages before 
E8013) 

The credit card has expired. Use another MOP or 
credit card.   

E8017 
INVALID DATA - <auth. 
code> (See messages before 
E8013) 

The data the POS sent to the network had a format 
error and could not be reconciled. Have the 
servicer investigate the error. 

  

E8018 
DUPLICATE TRANSACTION - 
<auth. code> (See messages 
before E8013) 

The POS has sent two authorization requests for 
the same transaction. Have the servicer 
investigate the error. 

  

E8019 
HOST UNAVAILABLE - <auth. 
code> (See messages before 
E8013) 

The POS cannot establish communications with the 
network. Try the connection again at a later time.   

E8020 
NO RESPONSE FROM HOST - 
<auth. code> (See messages 
before E8013) 

The POS has successfully connected to the network 
but did not receive a response for its request. See 
the site’s procedures for handling this situation. 
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E8021 
HOST FAIL - <auth. code> 
(See messages before 
E8013) 

The network indicates that it is down and unable 
to process the POS request. See the site’s 
procedures for handling this situation. 

  

E8022 
PHONE LINE DOWN - <auth. 
code> (See messages before 
E8013) 

The POS cannot detect a phone connection. See 
the site’s procedures for handling this situation.   

E8023 
DISCONNECT - <auth. code> 
(See messages before 
E8013) 

The POS detects that the network terminated the 
connection. See site’s procedures for handling this 
situation. 

  

E8024 
HOST COMM DENIED - <auth. 
code> (See messages before 
E8013) 

The POS detected a network communication 
failure. See the site’s procedures for handling this 
situation. 

  

E8025 
TOTAL OVER LIMIT - <auth. 
code> (See messages before 
E8013) 

The transaction exceeds the card's credit limit. 
Choose another MOP or credit card. 

E8026 

DEBIT NETWORK 
UNAVAILABLE - <auth. 
code> (See messages before 
E8013) 

The POS has detected one of the following 
conditions: 

·         A debit card network error 

·         An inquiry balance not available 

·         An unexpected interchange response 

See the site’s procedures for handling these 
situations. 

E8027 DRIVER ID INVALID (See 
messages before E8013) A driver’s ID was determined to be invalid. 

E8028 INV VEHICLE (See messages 
before E8013) A vehicle’s ID was determined to be invalid. 

E8029 PIN ERROR - PLEASE RETRY 
(See messages before 

DCR message: Displayed when the network returns 
a PIN encryption error. The customer must re-
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                            Numbered Messages Related To Network 

       #                         Message                                           Description/Action 

E8013) enter the PIN. 

PIN ERROR <handling code> 
(See messages before 
E8013) 

A DCR message displayed on the POS when the 
network returns a PIN encryption error. The 
customer must re-enter the PIN. 

E8030 
TRANSACTION DENIED - 
<auth. code> (See messages 
before E8013) 

The transaction is denied for a reason other than 
those described in the previous error messages 
above. See procedures for handling this situation. 

E8031 CARD ALLOWS ONLY FUEL 
PRODUCTS 

The customer tried to purchase nonfuel products 
with a credit card that allows fuel purchases only. 
Ask the customer for another MOP. 

E8032 INVALID WEX APPROVAL 
NUMBER 

The approval number entered for a voice 
authorization is not valid. Re-enter the approval 
number in a six-digit format. 

E8036 INVALID PRODUCT OR CARD 
INFO 

The customer tried to purchase an item that is not 
allowed by the credit card being used or incorrect 
entered data was entered (vehicle number, driver 
ID, odometer, etc.). 

E8037 CARD HAS THREE PRODUCT 
LIMIT 

The customer tried to purchase more than three 
products with a credit card that allows purchase of 
only three. 

E8038 CARD HAS ONE FUEL 
PRODUCT LIMIT 

The customer tried to purchase more than one fuel 
product with a credit card that allows the 
purchase of only one. 

E8039 CARD HAS TWO PRODUCT 
LIMIT PLUS TAX 

The customer tried to purchase more than two 
products with a credit card that allows the 
purchase of only two. 

E8040 CARD HAS TWO FUEL 
PRODUCT LIMIT 

The customer tried to purchase more than two fuel 
products with a credit card that allows the 
purchase of only two. 
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                            Numbered Messages Related To Network 

       #                         Message                                           Description/Action 

E8041 CARD HAS FOUR PRODUCT 
LIMIT 

The customer tried to purchase more than four 
products with a credit card that allows the 
purchase of only four. 

E8042 DATA ERROR <auth code> 
The data the POS sent to the network had a format 
error that could not be reconciled. Have the 
servicer investigate the error. 

E8043 LIMIT REJCT <auth code> 
The network denied the transaction because the 
amount or products exceeds the card’s limits. Ask 
the customer for another MOP. 

E8044 INV ACCOUNT <auth. code> 
The network returns a response that the account 
or card is invalid. Ask the customer for another 
MOP. 

E8045 INV FUEL TYPE 
The customer tried to purchase a fuel type that 
was not allowed by the credit card being used. Ask 
the customer for another MOP. 

E8046 FLT NO AUTH <auth. code> 
The customer tried to purchase a non-fuel product 
that is not allowed by the credit card being used 
(Fleet card). Ask the customer for another MOP. 

E8047 INVALID PIN - PLEASE RETRY DCR message: The network returned a PIN error. 
The customer is allowed to re-enter the PIN. 

  PIN REJECT <auth code> 
A DCR message displayed on the POS when the 
network returns a PIN error. The customer must 
re-enter the PIN. 

E8048 INV FLEET FUNC 
The customer tried to perform a fleet function not 
allowed by the card being used. Ask the customer 
for another MOP. 

E8049 INV PRODUCT <auth code> The network rejected the card because the 
product cannot be purchased with this credit card. 

E8050 INDOOR PAYMENT The customer must pay inside. 
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                            Numbered Messages Related To Network 

       #                         Message                                           Description/Action 

E8051 HOST ERROR 
An unrecognized response was received from the 
network. See the site’s procedures for handling 
this situation. 

E8052 NETWORK REJECT The DCR system is unable to process the 
transaction. Ask the customer for another MOP. 

E8053 BK CD RJCT <auth. code> The network rejected the credit card. Ask the 
customer for another MOP. 

E8054 RETRIES XCDED The customer has unsuccessfully tried to enter PIN 
data more times than allowed. 

E8055 INVALID USER ID - PLEASE 
RETRY The customer has tried to enter an invalid user ID. 

E8056 INVALID USER ID - TRIES 
EXCEEDED 

The customer has unsuccessfully tried to enter 
user ID data more times than allowed. 

E8057 INV DRIVER The driver’s ID was invalid. 

E8058 FREQUENT USER Denial due to credit card velocity security 
restrictions. 

E8059 CARD ENTRY ABORTED Card entry or expiration date entry was 
interrupted. Retry. 

E8060 INVALID FUEL SELECTED 
Customer attempted to purchase a fuel type not 
allowed on the credit card. Ask the customer for 
another MOP. 

E8061 CHARGE TO INVALID 
Customer attempted to use a card that had an 
invalid or empty value at the “ENTER CHARGE TO” 
prompt on the PINpad. 

E8062 PRE-AUTH NOT ALLOWED 
FOR EBT CARDS Cannot pre-authorize EBT cards. 

E8063 SEQUENCE NUMBER MUST BE A manually entered EBT card sequence number is 
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                            Numbered Messages Related To Network 

       #                         Message                                           Description/Action 

3 DIGITS not valid. 

E8064 EBT UNAVAILABLE Network is unable to get authorization from EBT 
host. Retry. 

E8065 
UNABLE TO READ CHECK 
<ENTER> TO TRY AGAIN; 
<EXIT> TO CANCEL 

A check was sent through the Magnetic Ink 
Character Recognition reader, but the POS was 
unable to obtain the information from the reader. 

E8066 UNABLE TO PROCESS CHECK Two additional attempts to process the check 
through the reader have failed. 

E8067 CHECK AUTHORIZATION 
UNAVAILABLE 

Network is unable to get authorization from the 
check vendor. 

E8068 DECLINED VELOCITY 
The check is not accepted because the customer 
has written too many checks in the designated 
time period. 

E8069 MUST SETUP EBT MERCHANT 
ID FIRST 

Attempted to use EBT before entering a valid 
eight-digit EBT Merchant ID. 

E8070 HUB INVALID Hubometer entry is invalid for this fleet card. 

E8071 TRAILER ID INVALID Trailer ID is invalid for this fleet card. 

 
  

                           Miscellaneous Numbered Messages 

       #                     Message                                              Description/Action 

E9001 PRINTER OFFLINE 
Alarm Line Only: The POS printer is offline. 
Check the connections or press the online button 
on the printer to correct. 

E9002 PRINTER COMMS ERR 
Alarm Line Only: The POS and the printer are not 
connected. Check connections on the back of the 
POS and the printer. 
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                           Miscellaneous Numbered Messages 

       #                     Message                                              Description/Action 

E9003 PRINTER COVER OPEN Alarm Line Only: The printer cover is open. Close 
the printer cover to resume operation. 

E9004 PRINTER MECH FAIL 
Alarm Line Only: The printer has experienced a 
mechanical failure. Call the servicer. See 
“Troubleshooting,” if this prohibits sales. 

E9005 DUP STATION ID <dup. 
station ID> 

Alarm Line Only: The LAN has detected more 
than one POS with the same station ID on the 
LAN. Call the servicer to investigate. 

E9006 LAN IO CONFIG ERR 
Alarm Line Only: The LAN LDM could not access 
the Iocfg.dat. See the site’s procedures for 
handling this situation. 

E9007 LAN DRVR ERR (<error #>) 
Alarm Line Only: The LAN device driver could not 
be opened. Have the servicer investigate the 
error. 

E9008  LAN <device name> ERR 
(<error #>) 

Alarm Line Only: The LAN device driver could not 
be opened. Have the servicer investigate the 
error. 

E9009  NO SYS KEY FOUND 
Alarm Line Only: The application’s version 
number could not be extracted from the 
Appcfg.dat file. 

E9010  LAN COMMS ERROR 
Alarm Line Only: The workstation and controller 
could not communicate. Check LAN connections 
or one of the POS may be down. 

E9011 LAN COMMS BLOCKED Alarm Line Only: LAN communications are 
blocked. Have the servicer investigate the error. 

E9012 TERM %d LAN BLCKD Alarm Line Only: LAN communications are 
blocked. Have the servicer investigate the error. 

E9013 <printer name> DISABLED Alarm Line Only: The named printer has been 
disabled. 
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                           Miscellaneous Numbered Messages 

       #                     Message                                              Description/Action 

E9014 <printer name> BLOCKED Alarm Line Only: The named printer is blocked. 
Check the position of the paper rolls. 

E9015 <printer name> PAPER 
LOW 

Alarm Line Only: The amount of paper in the 
named printer is low. Refill the paper in the 
named printer. 

E9016 RECEIPT UNAUTH The printer connected to the POS is not an 
authorized printer. 

E9018 TCP ERROR 
The TCP interface on the register or server failed 
to start. Call the Verifone Technical Support 
Center. 

03 DO NOT ACCEPT The POS received a denial return code from the 
network when processing a Donlen credit card. 

Troubleshooting 

This section contains general situations that may occur and the steps to take to 
change them. 
In some cases, the manager may need to perform procedures restricted to certain 
security levels. 
Troubleshooting procedures are divided by function. 

• Car Wash 
• Fuel Sales 
• Installation Information 
• Printer 
• Product Sales 
• Workstation 

Car Wash 

Code Does Not Print 

If a car wash code does not print on the receipt and the “CAR WASH CODE 
UNAVAILABLE” message was not displayed, check the following items: 

·         The car wash department number is set up in the Department Setup function 
in Car Wash Manager mode. 
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·          The car wash item is set up in the Car Wash Key Setup function in Car Wash 
Manager mode. 

Fuel Sales 

Cannot Clear a Fuel Sale  

If a fuel sale cannot be cleared from the POS, check the status of the pump using the 
[VIEW] key. If the pump status is “HOLD,” then the sale may already be on the ticket, 
or it may be on another POS at the site. If the sale cannot be found and removed 
using standard transaction methods, call the Verifone Technical Support Center. The 
representative can provide a one-time password to access the Clear Pumps on Hold 
function in Fuel Manager mode. 

Installation Information 

Retrieving Installation Information 

Troubleshooting the system may require contacting an agent at the Verifone 
Technical Support Center who asks for the system’s installation information. 
The Print Installation Information function lists: 

• Registration Information 
• Application Configuration 
• Software Configuration 
• Hardware Configuration 
• I/O Configurations 
• System Upgrades since the original application was installed 

 Print Installation Information function appears in maintenance menu. 

Printer 

Printer Communication Errors 

If the printer is not printing, is offline, or has lost communication with the POS, check 
the following items: 

• Make sure the printer is online. 
For example, if the printer was recently opened to check or replace the 
tape, put the printer back online by pressing the [ON LINE] or [Ready] 
button. 

• Make sure all cables between the POS and the printer are secure. 
• If there is a multi-station printer, reset the printer. 

1. Open the cover of the printer. 
2. Locate the reset button inside, to the right. It is labeled “RESET.” 
3. Press the reset button briefly with a pencil or pen. 
4. Close the cover. 
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5. Press [ON LINE]. 
• If there is an Epson TM-U950 printer, reset the printer. 

1. Locate the black reset button on the back of the printer, located 
on the blue connector. 

2. Press and release the reset button. 
3. Press [ON LINE]. 

Product Sales 

PLU Not Found 

The “PLU Not Found” message could occur in the following cases: 
• After keying a number, pressed [ENTER] instead of pressing a department or 

MOP. Press [ERROR CORR] to correct the entry. 
• Keyed a PLU number that should exist but does not: 

–        If a PLU number is keyed incorrectly, key it again and press [ENTER]. 
–        If a PLU number is valid but has not been defined in the POS, key the 

price of the item and press [ENTER]. PLUs entered this way are reported 
in the PLU Exception Report. 
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Methods of Payment 
Overview 

Method of Payment (also known as "MOP") are used to complete transactions. Methods 
of Payment identify the amount and type of payment to the system and based on that 
payment type, allows the system to apply the appropriate MOP-specific rules and 
restrictions. 

As a result, MOP behavior on your system may vary due to its specific configuration 
settings (minimum amounts, whether the amount must be entered, etc). 

Using Methods of Payment 

Examples of MOP include: 

• Cash Payment 

• Check Payment 

• Credit Card Payment 

• Debit Card Payment 

• In-House Payment 

• Lottery Ticket Cash-In 

• Lotto Ticket Cash-In 

• Food Stamps Payment - Electronic 

• Coupon Payment/Redemption (Standard) 

• Coupon Payment/Redemption (Non Tax) 

• Drive Off 

In general, completion of a transaction follows this process: 

1. Press [TOTAL] (if required) 

2. Key <amount> (if required) 
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3. Key the appropriate MOP 

4. If total amount tendered < amount due, system apples the payment, 
recalculates the remaining amount due and displays to customer and 
clerk 

5. If total amount tendered >= amount due, system applies the payment, 
completes the transaction and calculates any change that may be due 
back to the customer 

Cash Payment 

1. Press [TOTAL] if required 

2. Key <amount tendered> if required 

3. Touch or press [CASH] 

Note: Several quick keys may have been configured on your workstation to 
save keystrokes when accepting CASH payment. 

The quick keys include: 

 Next Dollar: Assumes the next dollar amount (customer presents 
$17 for a sale totaling $16.54) 

 Exact Change: Assumes amount presented = amount due 

 $1, $5, $10, $20, $50: Assumes customer presented the indicated 
bill denomination 

Check Payment 

1. Press [TOTAL] if required 

2. Key the face value of the check 

3. Touch [CHECK] 

Note: Change can only be given if the MOP is configured to allow change. 

Credit Card Payment 

1. Press [TOTAL] if required 
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2. Touch or press [CREDIT] 

3. Follow directions on the screen 

4. On completion, present receipt for signature if prompted 

Debit Card Payment 

1. Press [TOTAL] if required 

2. Touch or press [DEBIT] 

3. If cashback is configured, additional prompts are displayed 

4. Follow directions on the screen 

In-House Payment 

1. Press [TOTAL] if required 

2. Touch or press [IN-HOUSE] 

3. If a list of In-House accounts are displayed, select the appropriate In-
House account number from the list or enter the account number 

Lottery Ticket Cash-In 

1. Key the dollar amount of the winning ticket 

2. Touch [LOTTERY] 

Note: When configured for "Allow without Sale", permits for cash in 
without purchase. 

Note: Typically used for cashing in winning scratch out tickets. 

Lotto Ticket Cash-In 

1. Key the dollar amount of the winning ticket 

2. Touch [LOTTO] 

Note: When configured for "Allow without Sale", permits for cash in 
without purchase. 
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Note: Typically used for cashing in winning online tickets. 

Food Stamps Payment - Electronic (EBT Food Stamps, EBT Cash 
Benefits) 

MOPS for EBT, EBT_FS and Manual_EBT_CB must be created using the built in EBT MOP 
codes to accept these methods of payment.  

1. Press [TOTAL] 

2. Press [Credit] 

After MOP entries are configured as EBT Food Stamp and/or EBT Cash Benefits, 
pressing the Credit button allows a cashier to accept the EBT card without asking the 
customer if they are using an EBT card.  When the card is read by the PIN pad and 
identified by the EPS, EPS reports back to the POS which MOP type it is (credit, debit, 
EBT food stamp, EBT cash). 

Follow the instructions on PIN pad to complete the transactions.  

Considerations 

• Used with EBT Cards and paper coupons that can be used only to purchase food 
stamp eligible items. With paper coupons, a maximum of $.99 can be given back as 
cash change. Any change tendered over $1 must be in Food Stamps change. 

• EBT Cash Benefit allows purchase of non-food stamp eligible items. 

• Tax is not applied to the amount paid for by food stamps. The tax amount that 
prints on the receipt displays the tax amount after the tax credit has been 
deducted. The tax credit amount the customer did not have to pay also prints on 
the receipt. 

• If food stamps are tendered for less than the eligible amount and the food-stamp 
items are taxable, a “Tax Credit” appears on the receipt. The credit is the 
difference between the total tax due on the items and the tax charged on the 
taxable items not paid for with food stamps. For example, if an amount of $16.17 
is qualified for payment with food stamps, of which 10.55 is taxable at a tax rate 
of 7%, then $0.74 tax is due on the $10.55. If the customer tenders $10.00 in food 
stamps leaving a balance of $6.17, of which $0.55 is taxable. The Tax Credit is 
$0.70 (7% of $10.00) and the tax the customer owes is $0.04 (7% of $0.55). 
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Go to Tax Report from Flash Reports to get information on Taxable Sales and Non-Tax 
Sales.  

 

From Verifone’s Site Report Navigator access the End of Day Report. This Report has 
Tax Forgiven Amount section under Cash Controls and gives information on taxes that 
were credited back due to EBT/Foodstamps/Non-tax Coupons. 
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Coupon Payment/Redemption (Standard) 

1. Press [TOTAL] 

2. Scan the coupon or key the dollar amount of the coupon and touch 
[COUPON] 

Note: Coupons must be scanned only at the end of the transaction. Tax 
due is not reduced because of applying this coupon. 

Coupon Payment/Redemption (Non-Tax) 

1. Press [TOTAL] 

2. Scan the coupon or key the dollar amount of the coupon and touch 
[COUPON] 

Note: Coupons must be scanned only at the end of the transaction. Tax due 
may be reduced because of applying this coupon. 

Drive Off 

1. Select the unpaid fuel transaction 

2. Press [TOTAL] if required 

3. Touch [DRIVE OFF] 

4. Write a description of the vehicle and any additional information on the 
receipt and save it according to store policy 
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Configuring Methods of Payment 

Payment Management 

Use Store Operations > Payment > MOP to configure MOPs. 

 

Function Name Description 

Name Enter the name of the MOP. This name appears on receipts 
and reports. 

Delete Click to delete the selected MOP. 

MOP Code Select the MOP code that determines how the MOP should 
function within the system. The MOP codes are predefined as 
detailed below and may vary based on the network 
configuration: 

0 - Cash (The first MOP name that uses this code should be 
Cash.) 

1 - Credit: Use for credit cards sent through a credit card 
network. In some reports, this MOP may appear as 
“CHARGES” or by card name. 

2 - Debit: Use for debit cards sent through a credit card 
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Function Name Description 

network. Do not select the “Tender amount required”. In 
reports, this MOP appears as a “DEBIT” item. 

3 - Manual Credit: Use for credit cards not sent through a 
credit card network. A voice authorization, imprinting, or 
other procedure may be required to process the card. The 
“Tender amount required” parameter should not be enabled. 

4 - Manual Debit: Use for debit cards not sent through a 
credit or debit card network. A voice authorization, 
imprinting, or other procedure may be required to process 
the card. The “Tender amount required” parameter should 
not be enabled. 

5 - Lotto: Use for winning lotto tickets tendered as MOPs. 

6 - Check: Use for checks. If customers are not permitted to 
write checks for more than the amount of purchase, do not 
enable “Change allowed”. 

7 – Tax_Coupon: Use for product coupons as MOPs. The 
“Change allowed” parameter should not be enabled. 

8 - $1 Cash (Automatically expects a one-dollar bill as 
payment and calculates change based on that. The 
applicable amount is expected for codes 9 through 12.) 

9 - $5 Cash 

10 - $10 Cash 

11 - $20 Cash 

12 - $50 Cash 

13 - Food Stamp: Use for paper food stamps only. Amounts 
must be entered as whole dollars for this MOP. The “Change 
allowed” parameter should be enabled. The “Tender amount 
required” parameter should be disabled. 

14 - Drive Off: Use to set up an MOP for clearing fuel sales 
for customers that drive off without paying for dispensed 
fuel. The “Change allowed” parameter should be disabled. 
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Function Name Description 

15 - Special Discount: A special discount works as an MOP. 
This is a percentage based discount applied against PLUs and 
department sales configured as Special Discount eligible. The 
cashier determines when to apply it.  The Dept File and PLU 
File functions have “Special Discount [Y/N]” parameters 
which enable the discount for specific departments or PLUs. 
The “Special Discount (P)” parameter sets the percentage 
rate of the discount. These amounts do not appear with 
promotions in the “DISCOUNTS” item in the Summary Report. 

16 - Manual FS: Electronic, non-paper food stamps. Amounts 
for this MOP can be entered as dollars and cents. This is 
usually used with food stamp transactions performed with a 
standalone EBT terminal. The “Tender amount required” 
parameter and the “Allowed without sale” parameter should 
be disabled. 

17 - Lottery: Use for scratch-off lottery tickets tendered as 
MOPs. 

18 - In-House: Store credit extended to local customers and 
set up outside the network and the POS. The POS provides 
receipts for transactions and reports sales on the Cashier and 
Summary reports. 

 “Enter Account Number” displays when the [In House] key is 
used for a transaction. An alpha-numeric account number, 
up to ten digits, MUST be entered. 

When the customer comes in to pay on the account, press 
[Pay In], at which time you are prompted “House Account? 
[Y/N].” Enter ‘Y’ and the prompt, “Enter Amount” displays. 

After entering an amount and pressing [ENTER], the prompt, 
“Enter House Acct#” displays. 

19 - Pump Test: The Pump Test MOP closes out a sale where 
the store pumps a test amount of fuel into a container and it 
is rung up as a sale. When the fuel is returned to the tank, 
the sale is actually treated as a No Sale. Pump Test MOP can 
only be used on post-pay fuel sales. 

20 - EBT Food Stamp: Electronic, non-paper food stamps. 
Amounts for this MOP can be entered as dollars and cents. 
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Function Name Description 

The “Tender amount required” parameter and the “Allowed 
without sale” parameter should be disabled. 

21 - EBT Cash Benefit: Electronic, non-paper cash benefit. 
Amounts for this MOP can be entered as dollars and cents. 
The “Tender amount required” parameter and the “Allowed 
without sale” parameter should be disabled. 

22 - Manual EBT CB: Manual non-paper cash benefit. Amounts 
for this MOP can be entered as dollars and cents. This is 
usually used with food stamp transactions performed with a 
standalone EBT terminal. The “Tender amount required” 
parameter and the “Allowed without sale” parameter should 
be disabled. 

Note: EBT Food Stamp and EBT Cash Benefit MOPs are 
used when EBT is processed through 
commander/Viper/EPS (e.g. WINCOR in case of Shell). 
The primary FEP (or a separate FEP in future) on 
Viper authorize the EBT transactions for POS.  

When Commander/Viper/EPS (e.g. WINCOR in case of 
Shell) does not process EBT transactions, the site will 
process the transactions through a standalone EBT 
terminal and then tender the transactions in VFI POS 
using the Manual EBT CB or Manual FS MOPs. These 
MOPs follow the same rules as their electronic 
counterpart.  

Unlike Credit/Debit, it is possible to enter an amount 
for EBT transactions and request a specific amount 
from the host for the EBT purchase. In case of FS (EBT 
FS or Manual FS), POS validates that this amount 
meets the food stamp eligible items in the 
transaction. 

23 - ECheck: Standalone electronic check processing. The 
balance of the ticket amount is sent to the host for approval.  

24 - Stored Value Card: Stored Value Card is a prepaid MOP. 

25 - Manual Entry: With this MOP is selected, account 
number is manually entered and is processed similar to 



Methods of Payment 

392 

Function Name Description 

credit cards.  

26 - Force Post: This MOP is used for entering transactions 
that were processed when the host was offline. 

27 - Post Entry 

28 - Mobile: Used for mobile payment. See the Mobile 
payment feature document for more information. 

29- Unattended Refund 

30 - Non-Tax Coupon: Use for product coupons as MOPs. Tax 
due may be reduced because of applying this coupon. 

31 – Fuel_Voucher: Used for fuel vouchers (paper) only. The 
parameter "Allow Change" should be disabled. 

32 – Tax_Exempt_Voucher: When applied, the MOP will 
reduce the amount due based on which taxes are configured 
to be exempt.  Multiple types of tax exemption can be 
configured, and the appropriate prompts will be presented 
to the cashier based on the configuration. 

33 – Fleet_Check: Fleet Checks can be exchanged for cash or 
be used as MOP in a transaction. The parameters “Allow 
Without Sale”, “Allow Change” and “Allow Refund” should 
be enabled. 

Note: Refer to the Fleet Cards feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Min. Amount Enter the minimum amount accepted for this MOP (0.00 – 
9999.99. 

If MOP Code = Special Discount, the percentage discount is 
entered here. For 10%, enter 10.00 

Max. Amount Enter the maximum amount accepted for this MOP (0.00 – 
9999.99). 
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Function Name Description 

Limit Enter the amount of this MOP that alerts the cashier to make 
a safe drop (0.00 – 9999.99). 

0.00 — This MOP does not require a safe drop. 

Note: The setting for “Force Safe Drop” determines if a safe 
drop reminder is displayed or if a safe drop is required once 
the calculated drawer total for this MOP reaches this Limit. 

#Additional 
Receipts 

If additional receipts are required for this MOP, select the 
number of receipts. 

Note: Force Ticket Print must be selected to make this 
parameter available. 

Tender Code Used to assign the NACS tender code to Verifone MOPs. Helps 
to create the NAXML POS Journal from the transaction log 
without manually looking up or mapping the tenders. The 
recommended value is the default values for each MOP. 
Inorder to select a new value from the list or enter a new 
value other than from the list, delete the default value first. 

Tender Sub 
Code 

Used to assign the NACS tender sub code to Verifone MOPs. 
Helps to create the NAXML POS Journal from the transaction 
log without manually looking up or mapping the tenders. The 
recommended value is the default values for each MOP. 
Inorder to select a new value from the list or enter a new 
value other than from the list, delete the default value first. 

Force Safe Drop Select (if the Limit value is not 0.00) to display a safe drop 
message. A safe drop must occur before additional sales 
transactions can be performed using that payment type. 

Open Drawer on 
Sale 

Select to open the cash drawer when a transaction includes 
this payment type. 

Tender Amount 
Required 

Requires clerk to enter the amount before selecting this 
MOP. 

Cashier Report 
Prompt 

Prompts cashier to enter the actual (counted) drawer 
amount for this MOP when printing cashier report. 
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Function Name Description 

Allow Zero 
Entry 

Allows zero entry response when entering actual (counted) 
drawer amount for this MOP when printing cashier report. 

Allow Without 
Sale 

Permits acceptance without purchase. Examples: Cashing in 
a winning lotto ticket or permitting a check to be cashed 
without purchase. 

Allow Refund Permits Refund transaction to be tendered to this MOP. 

Allow Change Allows change from this MOP to be given to customer when 
they present amount > amount due. Example: If checks can 
be written for more than amount of purchase. 

Allow Safe Drop Allows a safe drop for this MOP. 

Allow Money 
Order Purchase 

Permits purchase of money order with this MOP 

Force Ticket 
Print 

Forces receipt to be printed for any transaction that includes 
this MOP.  

Reporting 

                     MOP SALES     

CARD BASED 

     CREDIT     2           50.76 

CASH 

   DOLLAR      18          165.90 

   ARGENTINA    1            7.87 

DRIVE OFF       1           50.00 

INHOUSE         1           10.00 

PUMP TEST       1            1.00 

    

  

Sample MOP 
SALES and  MOP 
CANCEL/REFUNDS 
in Cashier 
Report. 

  

MOP totals are 
represented in 
Summary and 
Cashier 
Reports. 
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                ------------------- 

TOTAL MOP SALES             275.53  

                       MOP CANCEL/REFUNDS 

CASH            2        2.74                   

                                                                               -------------------- 

TOTAL MOP CANCEL/REFUNDS   ( 2.74) 

• MOP SALES: Summary of sales by method of payment (MOP). 

Note: If a foreign currency has been set up in the Currency File that 
currency appears in the CASH section. 

• MOP CANCEL/REFUNDS: Summary of cancelled or refunded transactions. The 
total is displayed in parentheses because the number is negative. 

Troubleshooting 

      #  Message  Description/Action 

E1104 MOP INVALID/NOT 
ALLOWED 

Used an MOP that no longer exists. Choose 
another MOP. 

E1116 AMOUNT TOO 
LARGE 

The dollar amount entered is larger than the 
maximum allowed for this department or MOP. 

E1118 NO SPLIT TENDER 
ON FUEL Only one MOP allowed for fuel purchase. 

E1120 DO NOT OVERRIDE 
MOP AMOUNT 

Cannot override the minimum or maximum 
allowable amount for an MOP. 

E1130 MOP CONFLICT 
Customer dispensed fuel at one MOP price level 
and attempted to pay with an MOP associated 
with a different price level. 

E1131 AMOUNT TOO 
SMALL 

The dollar amount entered is less than the 
minimum set up for the MOP. 
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      #  Message  Description/Action 

E1132 SUB-TOTAL 
REQUIRED Must press [TOTAL] before choosing an MOP. 

E1135 DROP MONEY FIRST 
The amount of money in the drawer exceeds the 
limit set in the MOP File function. Perform a Safe 
Drop. 

E1138 INVALID MOP 
AMOUNT 

The dollar amount entered is not allowed by the 
selected MOP. This can occur if a dollar amount is 
entered and credit selected because credit only 
takes the balance of the sale. 

E1139 INVALID AMOUNT 
ENTERED 

MOP may not require an amount or the amount 
entered is less than the minimum or more than 
the maximum amount allowed for the MOP. 

E1163 NO CHANGE 
ALLOWED “Change Allowed” is set to ‘No’ for this MOP. 

E1176 
MOP NOT 
ALLOWED WITH 
CASHBACK 

Selected MOP is not configured for cashback. 
Either cancel the cashback or use another MOP. 

E1181 SAFE DROP NOT 
ALLOWED FOR MOP This MOP is not enabled for Safe Drop.  

E1188 MOP APPLIED 
BEFORE 

A special discount has already been applied to the 
transaction; only one special discount is allowed. 

E1190 MUST BE FIRST 
MOP 

The special discount MOP must be entered first. 
Use [ERROR CORR] to remove the other MOPs, 
then apply the special discount MOP. 

E1213 MANUAL CREDIT 
NOT ALLOWED 

The Manual Credit MOP is not allowed in this 
transaction. Choose another MOP. 

E1237 
NO MONEY ORDER 
PURCHASE FOR 
MOP 

An MOP with the “Allow Money Order Purchase” 
parameter set to ‘N’, was used. To purchase a 
money order. select another MOP. 

E1250 ONLY FUEL 
PRODUCTS ARE An MOP that allows only fuel products to be 
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      #  Message  Description/Action 

ALLOWED purchased has been chosen. 

E1251 ONLY POST PAY 
FUEL IS ALLOWED This MOP  allows only post pay fuel products. 

E1257 MUST PRESS 
CREDIT 

Part of the Auto-Refund feature. A credit card 
was used to pay for the initial prepay transaction 
and cashier tries to refund the underrun amount 
to any MOP other than credit. 

E1258 
NO MERCHANDISE 
WITH PREPAY 
UNDERRUN 

In an automatic Prepay Underrun, no merchandise 
is permitted to be in the same transaction when 
the MOP is credit-based. 

E2007 INVALID CASHIER 
REPORT AMOUNT 

Entered 0.00 for an MOP amount when printing a 
Cashier Report and the “Allow $0.00 Entry” 
parameter is set to ‘N’ in the MOP File.  
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Mobile Payments 
Overview 

Mobile Payment feature enables mobile payment, loyalty, delivery and transaction 
processing using a consumer’s smartphone, EM sites, a third party FEP vendor, and a 
third-party mobile host (MPPA). 

 Note: Refer to the Mobile Payments feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal.
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NAXML Deal 
Overview 

Enhanced Mix/Match or NAXML Deal refers to a feature that offers automatic 
discounts when a certain quantity and/or combination of items are sold in the same 
transaction. These items may be entered via scan, PLU#, PLU key/button or may be 
assigned to a menu but all the items in the “deal” must exist in the PLU file (“price 
book”). 

Note: Refer to the NAXML Deal feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Using NAXML Deal 

Enhanced Mix/Match or NAXML Deal requires no special handling on the part of 
the cashier.  As items are added or removed from the transaction, the system 
automatically calculates any applicable discounts. 

Handling of Refunds of items involved in a NAXML deal is subject to store 
policies and procedures. 

 NAXML Deal supports both NAXML Combos and NAXML Mix/Match. Both features 
work from item lists but while NAXML Combos allows items from multiple lists, 
NAXML Mix/Match requires items from a single list.  NAXML Mix/Match is also 
known as “package pricing”. 

                 WELCOME TO OUR STORE    
Description.      Qty     Amount  
 ----------.      ---     ------    

T  CHEESEBURGER     1       2.00 

       Lunch Combo         -0.30 

T  FRENCH FRIES     1       1.20 

       Lunch Combo         -0.30 

T  ICED TEA         1       1.10 

       Lunch Combo         -0.10 

    

  

Sample Customer Receipt 
with a combo and a Non-
combo Item 
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   NACHOS           1       1.49 

                         -------- 

            Sub Total       5.09 

                  Tax       0.37 

                                   TOTAL  5.46 

                                           CASH $    10.00 

               Change $    -4.54 

  

  

Configuring NAXML Deal 

Use Promos and Discounts > NAXML Deal to configure NAXML deal.  

Deals are formed in the following ways: 

• As PLU items are entered into a transaction, the system checks first for NAXML 
Mix/Matches, then for NAXML Combos. 

• NAXML Mix/Match qualifies promotions based on quantity of items. 

• When an item qualifies in multiple NAXML Combos, the system matches up the 
higher priority Combo. 

NAXML Deal 

Item List Maintenance 

This form is used to assign PLUs or Department Items to an Item List.  Item Lists 
define items participating in the promotion defined using Combo and in Mix&Match 
tabs.  A typical item list contains items that are of a similar type or price. 
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Note: Some options in the figure may change depending on the Parameters 
selected. 

Field/Button Allowable Value/Function 

Item List ID 

Add 

Select the “Add New” button to create an entry with an Item ID which 
is equal to the highest numbered Item ID + 1. The Item ID field can be 
edited. Saved Item lists display their Item ID and description in the 
Item List window. 

Item List ID 
This number is system-defined and is used to locate the appropriate 
Item List.  Saved Item lists display their Item ID and description in the 
bottom left window. 

Description 

Give the item list a name specific enough to pick it out correctly from 
all the item list names shown at the bottom left side of the form. 
Although the system allows more, it is recommended that ItemList 
descriptions be 17 characters or less.  
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Field/Button Allowable Value/Function 

List Type: PLU 

Select PLU list type if: 

 Items for promotion exist in different departments 
  Items for promotion exist in the same department along with 

items that will not be in the promotion (or you expect to add 
items to that department which won’t be in the 
promotion)             

Note: As new items are added to the promotion, the list must 
be updated with the new items.  

List Type: 
Department 

Select Department list only if every item assigned to that department 
should be included in the list and every item that is assigned to the 
department in the future will also be in the promotion. 

Note: Any items that are assigned to that department are 
automatically included in the promotion. 

Delete From the list on the bottom of the Item List ID form select the list 
item you wish to delete, check the “Delete” box and “Save”. 

Item List 

Add New 

Use this function to add entries to an Item List. 

For PLU type lists: 

1. Enter the PLU number 
2. Enter the Modifier 
3. Click “Add New” 

For Department type lists:  

1. Select the appropriate Department 
2. Click “Add New” 

The entry will be displayed in the Item List. 

Remove 

Use this function to delete entries from an existing item 
list.  Highlight the appropriate entry and click “Remove”.  Entry will 
be deleted from the displayed list.  Entries must be removed one at a 
time. 
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Field/Button Allowable Value/Function 

Save Use this function to save any additions or changes to Item Lists. 

Combo Maintenance 

Combo Maintenance is used to define promotions that allow items from multiple item 
lists.  A particular combo may contain both PLU and Department list types. 

A typical example of a combo might require the purchase of a sandwich, a side and a 
medium fountain drink.  Configuration would require three lists to be created; one to 
list all the sandwiches in the promotion, one to list the sides and another for the 
medium fountain drink. 

 

Note: Some options in the figure may change depending on the parameters 
selected. 
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Field  

  
Allowable Value/Function 

Add 

Select the “Add New” button to create an entry with a Combo ID which 
is equal to the highest numbered Combo ID + 1. The Combo ID field can 
be edited. Saved Combos display their Combo ID and description in the 
bottom left window. 

Combo ID This number is system-defined and is used to locate the appropriate 
Combo. 

Description 
Enter a description for this combo to identify it from among all the 
combos listed at the bottom of the form. This description is used for 
printing on receipt and POS display.  

Start Date 
Time 

This field is used to define the date and time the promotion starts. You 
can either type in the information or use the drop down arrows or 
select from a calendar representation. 

Note: The system explicitly allows you to save a promotion whose 
start date is less than its end date.  Such a promotion is seen by the 
system as “inactive”.  This is advantageous when the same promotion 
is run for a month and then again several months later. 

End Date 
Time 

This field is used to define the date and time the promotion ends. You 
can either type in this information or use the drop down arrows or 
select from a calendar representation. 

Week day 
availability 

This part of the configuration allows you to run promotions within the 
start and end date parameters defined above but that are effective 
only during a specific time frame on specific days of the week; perhaps 
to increase sales volume during an otherwise slow sales period. 

An active day with zero start and end times denotes a promotion that 
is effective for the entire day.  
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Field  

  
Allowable Value/Function 

Priority 

To configure promotions in a particular order of priority. The priority 
setting allows certain promotions to take precedence over others that 
share many of the same items. Priority of promotions is particularly 
useful when programs give discounts as more items are added in 
combination. 

 For example: 

• Promo1 – Discount for soda and chips (priority = low) 
• Promo2 – Discount for soda, chips, and sandwich (priority = 

medium) 
• Promo3 – Discount for soda, chips, sandwich, and salad. (priority 

= high) 

Without the ability to set priority, promo 2 and 3 will never be 
realized, as the soda and chips will always form Promo1. 

Default setting is medium. Any promotion that does not specifically 
identify the priority will be assumed “medium” by the system. 

Delete From the list on the bottom of the Item List ID form select the list item 
you wish to delete, check the “Delete” box and “Save”. 

Combo Item 
List 

Click Edit to add items to a selected or new combo. Select items from 
the Item List and click Done.  

Item List Qty Enter the quantity of each item taking part in the combo. 

Save Use this function to save any additions or changes to Item Lists. 

Price By Combo: Select to assign the price of the combo  

Price Enter the price of the combo 

Weighted The discount is distributed across the items forming the combo 
weighted by the item price of the items.  
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Field  

  
Allowable Value/Function 

Percentage 
Select to control the discount distribution for the items of the combo. 
For example, one item in the combo can attribute for 60% discount and 
the other for 40% of the discount.    

Price By Combo Items: Select to individually assign the price of combo items 

New Price Select to enter a new price for the combo item. 

Disc by 
amount Select to enter a discount amount for the combo item. 

Disc by 
percent Select to enter a discount percent for the combo item 

Trigger item Select to make the combo item a trigger to form the combo. 

Mix&Match Maintenance 

NAXML Mix & Match always determines a best buy case. 
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Note: Some options in the figure may change depending on the parameters 
selected. 

Field/Button Allowable Value/Function 

Mix Match ID List 

Add New 

Select the “Add New” button to create an entry with an Item ID which 
is equal to the highest numbered Item ID + 1. The Item ID field can be 
edited. Saved Item lists display their Item ID and description in the 
bottom left window. 

Mix Match ID This number is system-defined and is used to locate the appropriate 
Mix Match. 

Description 
Enter a description for this mix and match to identify it from among all 
the mix and matches listed at the bottom of the form. This description 
also appears on the receipts and POS display.  

Start Date 
Time 

This field is used to define the date and time the promotion starts. You 
can either type in the information or use the drop-down arrows or 
select from a calendar representation. 

End Date 
Time 

This field is used to define the date and time the promotion ends. You 
can either type in this information or use the drop-down arrows or 
select from a calendar representation. 

Week day 
availability 

This part of the configuration allows you to run promotions within the 
start and end date parameters defined above but that are effective 
only during a specific time frame on specific days of the week; perhaps 
to increase sales volume during an otherwise slow sales period. 

An active day with zero start and end times denotes a promotion that 
is effective for the entire day. 

Delete From the list select the mix and match item you wish to delete, check 
the “Delete” box and “Save”. 

Save Use this function to save any additions or changes to Item Lists. 

Mix Match Item List and Entries 
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Field/Button Allowable Value/Function 

Packaging 
Price 
configuration: 
Add New 

Click the “Add New” button to create  mix and match packages for the 
new or selected mix and match item. 

A number of packages can be included for each mix and match item. 

Item List A drop-down list of all the configured item lists to select before 
clicking Add New.  

Quantity Enter the total quantity of the contents in the selected item list that forms 
the package. 

Total Package 
Price Select to enter a new price for the package. 

Amount Off 
Package Price Select to enter the amount off the total package price. 

Percent Off 
Package Price Select to enter the percent off the  total package price. 

Reporting 

Deal Report 

The deal report is available as period reports and flash reports. The Deal Flash Report 
calculates all combo and mix ’n match sales that occur from the  beginning of the 
current period up to the time the flash report prints. 

This report shows Combo and Mix/Match sales for each NAXML promotion. 

    DEAL REPORT  

  COMBO DEALS 

  C#     DESCRIPTION 

  #CUST    #COMBOS    TOTAL SALES 

------------------------ ---------- 

  O1  SANDWICH 

Sample Deal Report 
(The number of combos 
and mix-n-matches 
sold) 
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      5      5        10.00 

MIX-N-MATCH DEALS 

  M#     DESCRIPTION 

  #CUST    #MATCHES   TOTAL SALES 

----------------------------------- 

  O1  LUNCH 

     3      3         9.00 

----------------------------------- 

     8      8        19.00  

Report Details 

Combo Deals 

C#: Combo number as it appears in the Deal File. 

DESCRIPTION: Name of the combo as it appears in the Deal File. 

#CUST: Number of customers (separate completed transactions) who bought combos. 

#COMBOS: The number of combos sold. 

TOTAL SALES: The total sales in dollars of combo deals. 

Mix-N-Match Deals 

M#: Match number as it appears in the Match File. 

DESCRIPTION: Name of the Match as it appears in the Match File. 

#CUST: Number of customers (separate completed transactions) who bought matches. 

#MATCH: The number of matches sold. 

TOTAL SALES: The total sales in dollars of mix-n-match deals. 
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Totals for all Deals 

#CUST: Number of customers (separate completed transactions) who bought combos 
and matches. 

#COMBO / #MATCH: The total number of combos and matches sold. 

TOTAL SALES: The total sales in dollars of combo and mix-n-match deals. 

  



411 

Network Functions 
Overview 

Using Network Functions 

Navigate to CSR Func > Network Menu from the POS (While in Sales, CSR Func can 
be located on the right-hand side bottom corner of the screen on Topaz and bottom 
of the screen on Ruby 2) to access the following Network functions: 

• Pre-Authorization  

• Network Mail 

• Comm Statistics  

• Print Network Log 

• Batch Details Menu  

• Prepaid Functions Menu 

• EBT Voucher Clear  

• Parameter Download 

Pre-authorization 

The Pre-authorization function authorizes a given credit card amount and 
displays the available prepaid card balance before a sales transaction. 

1. Touch Pre-Authorization 

2. When the overlay appears, swipe the card through the card reader 

3. In the overlay, key estimated total sale in even dollars (for example: $20 
is entered as [2] [0]) 

4. Touch [OK] or press [ENTER] 

5. When the approval number appears, touch [OK] 
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Network Mail 

The Network Mail function displays all mail messages from the network since 
mail was last printed. The messages are cleared after printing. If there are no 
messages waiting, the terminal dials out for mail. 

Note: This function may not be available in all applications. 

Touch Network Mail 

• Mail is present - Mail Report Prints 

• No Mail is present - NO MORE MAIL displays 

Comm Statistics 

The Communication Statistics function prints a report of all communication with 
the network. The statistics are cleared after the report prints. 

Touch Network Comm Statistics to print communications statistics report 

Print Network Log 

The Print Network Log function prints a report of up to the last 200 network 
communication records. This function also clears the network log and allows you 
to print by category. The most recent transaction prints first. 

Note: This function may not be available in all applications. 

1. Touch Print Network Log 

2. In the Network Log menu, touch one of the following:  

• Print All 

• Print Batch Transactions 

• Print Batch Summary 

• Print By Date 

• Clear Log 
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Batch Details Menu 

The Batch Details Menu prints current, pending, Out of Balance, and In Balance 
batch reports. 

Note: This function may not be available in all applications. 

1. Press [NETWORK FUNC] and touch Batch Details Menu 

2. In the Batch Detail Menu, touch one of the following to print:  

• Batch Details Current - Current open batch 

• Batch Details Pending - Closed but not settled batch 

• Batch Details Out of Balance - Batch out of balance 

• Batch Details In Balance - Closed batch in which totals agree with 
the host's totals 

Prepaid Functions Menu 

The Prepaid Functions Menu is used to configure prepaid cards, PIN-based 
products, and money transfer cards. 

Note: This function may not be available in all applications. 

1. Touch Prepaid Functions Menu 

2. In the Prepaid Functions menu, touch one of the following:  

• Card Activation 

• Card Recharge 

• Balance Inquiry 

• Card Deactivation 

Card Balance Inquiry 

The Balance Inquiry function requests the balance of a prepaid card and then 
prints a receipt from the terminal. 

Note: This function may not be available in all applications. 
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1. Touch Card Balance Inquiry 

2. Follow instruction on the PIN pad 

EBT Voucher Clear 

The EBT Voucher Clear is used to send an EBT transaction to the host that was 
performed in either of the following: 

• If the point-of-sale or site is down 

• If the host is offline during an EBT transaction 

Note: This function may not be available in all applications. 

1. Touch EBT Function Menu 

2. In the EBT Functions menu, touch EBT Balance Inquiry 

3. In the overlay, touch or press [ENTER] if the account is for food stamps; 
touch if account is for cash benefits 

4. In the overlay, touch or press [ENTER] if the transaction is a sale; touch 
if the transaction is a refund 

5. Key <purchase amount> and press [ENTER] 

6. Key <approval number> from the voucher and press [ENTER] 

7. Key <voucher number> and press [ENTER] 

8. Swipe card or key account number 

Parameter Download 

The Parameter Download function downloads information from the network to 
the terminal. 

Note: This function may not be available in all applications. 

Touch Parameter Download to display parameter download progress. 

Configuring Network Functions 

The Network Configuration form is used to define network sales and communications.  



Commander Site Controller User Reference 

415 

Note: After any changes are made to Car Wash, POP, or Network parameters 
including Loyalty, the command “Tools > Refresh Configuration” needs to be 
executed for the new settings to be applied to fuel and DCRs. 

POS Configuration  

IFSF 

Use Payment Controller > POS Configuration > IFSF to configure EPS communication 
protocol and POS configuration parameters. 

Note: To reflect the IFSF configuration changes, a Tools > Refresh Configuration is 
mandatory. 

 



Network Functions 

416 

 

Field/Button Allowable Value/Function 

VFI POS-POP Configuration 

POS ID  The POS workstation number. 

POP ID Enter the POP (PINpad) number assigned to each 
POS. The default is usually correct. 

Secondary POP Configuration 

Note: Refer to the P400 Implementation Guide for more information on this 
feature. The Feature Reference is available on Premier Portal. 

POP ID Enter secondary POP ID. 

Name Name of the secondary POP. 

Lane ID  Lane ID where the secondary POP is placed.  

Enabled Select to enable secondary POP.  

IFSF Configuration 

EPS IP Address IP address of EPS. 

Device Request Default 
Timer 

The amount of time before a timeout if a timeout 
is not included in the message from the POS to the 
EPS. The default should not be changed. 

POS Refresh Timer  

The amount of time that the POS waits before 
timing out if no message is received from the EPS.  

The default should not be changed. 
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Field/Button Allowable Value/Function 

Request Timeout 
Enter the amount of time the Topaz waits for a 
response to a request to the EPS (numeric, 100 - 
5000). 

Connection Timeout 

The amount of time the POS waits to establish a 
connection to the EPS. 

The default should not be changed. 

Response Timeout 
Enter the amount of time the Topaz waits for a 
network transaction to complete (numeric, 100 - 
999) 

Max Repetition  
Enter the maximum number of times the Topaz 
should try to connect to the network after a 
communication failure (numeric, 1-9). 

Device Waiting Port 

The port number at which the POS receives 
messages from the EPS. The number must match 
the EPS Device Request port number. 

The default should not be changed. 

Unsolicited Request Waiting 
Port 

Unsolicited Request Waiting message port. 

The default should not be changed. 

SSL Configuration 

SSL Mode Disabled Select to disable SSL Mode 

Service Waiting SSL Port Enter the service waiting SSL port number 

Card Waiting SSL Port Enter the card waiting SSL port number 

Device Waiting SSL Port Enter the device waiting SSL port number 

Device Request SSL Port Enter the device request SSL port number 

Unsolicited Request Waiting Enter the device request SSL port number  
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Field/Button Allowable Value/Function 

SSL Port 

Secondary EPS Configuration  

Select EPS Select secondary EPS  

Enable Select to enable  

EPS IP Address Enter the secondary EPS IP address  

Service Waiting Port Enter the service waiting port number  

Card Waiting Port Enter the card waiting port number  

Device Waiting Port Enter the device waiting port number  

POS 
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Field/Button Allowable Value/Function 

Batch 

Batch Close Period 

Select the period when the batch is closed. 

 Day – Period 2 (Close Daily) 

Shift – Period 1 (Close Shift) 

Loyalty 

Loyalty Enabled Check to enable loyalty. 

Multiple Loyalty 
Discounts in same 
Transaction 

Select to enable multiple loyalty discounts in the same 
transaction. 

Auth on Total Check to send an authorization request to the loyalty 
network when the [TOTAL KEY] is pressed. 

Force Cash Receipt Select to determine whether a receipt is printed for 
every cash transaction. 

Misc 

Message display 
duration (Secs) Enter a number to display network message in seconds. 

Print Customer copy Select to print customer copy of receipt. 

EPS Configuration 

EPS Global Configuration 

EPS 

Use EPS Global Configuration form under Payment Controller > EPS Configuration > 
EPS Global Configuration to configure EPS Global Configuration - EPS parameters. 



Network Functions 

420 

 

Field/Button Allowable Value/Function 

Dealer 

Site ID Displays the identification number of the site (ready 
only). 

Site Name 
Enter the name to print at the top of all receipts 
(alphanumeric and special characters, up to 23 
characters). 

Address Line 1 
Enter the street address to print at the top of all 
receipts (alphanumeric and special characters, up to 
18 characters). 

City 
Enter the city to print at the top of all receipts 
(alphanumeric and special characters, up to 20 
characters). 

State Enter the state to print at the top of all receipts 
(alphanumeric and special characters, up to 2 
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Field/Button Allowable Value/Function 

characters). 

Postal Code 
Enter the postal code to print at the top of all 
receipts (alphanumeric and special characters, up to 
20 characters). 

Country Enter the name of the country. 

Phone Number Enter the store phone number (numeric, up to 16 
characters). 

Locale 

Currency Name 

Select the currency name.  

This configuration should match the configuration on 
the POS. 

If EPS currency code does not match the POS 
transaction currency code, then the transaction is 
rejected by EPS. 

ISO Currency Code Non-editable field 

Numeric Currency Code Non-editable field 

Currency Symbol Symbol of the selected currency 

Date Format Select the date format 

Language Select the language 

Signature Capture 

Note: Refer to the Signature Capture feature reference documentation for 
information on this feature. The Feature Reference is available on 
Premier Portal. 

Signature Capture Enabled Check to enable signature capture. 
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Field/Button Allowable Value/Function 

Cashier Verify Signature Check to prompt cashier to verify the signature. 

Print Signature on Receipts Check to print signature on all receipts. 

Misc 

Store and Forward Limit Enter a number to define a number of store and 
forward (fallback) transactions. 

Data Storage Time (In Days) Displays the number of days the EPS stores the data. 

Security Day Count Displays the number of days to maximize security. 

Clear Velocity Days Displays the number of hours the velocity awaits to 
clear an entry. 

Network Last Required Check to enable split tender or requires that the 
network transaction is last. 

Report Masking Enabled 
Check to mask credit card account numbers and 
expiration dates in the reports by printing numbers as 
asterisks except for the last four digits. 

Online Velocity Check 
Required 

Check to enable velocity for online and offline 
transactions. 

Support Outside Cashier 
Messages Select to enable cashier messages at DCR. 

Cashback 

Cashback Enabled Check to enable cashback. 

Cashback Fee Check to enable cashback fee. 

Time Synchronization 

Controller Select the controller type for system time. 

Select FEP From the drop-down menu, select the FEP type. 
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POP 

Use EPS Global Configuration form under Payment Controller > EPS Configuration > 
EPS Global Configuration to configure EPS Global Configuration - POP parameters. 

 

Field/Button Allowable Value/Function 

POP Configuration 

Add Click to add POP. 

POP ID Displays POP ID of the corresponding Workstation ID. 

Model Displays POP model. 

IP Address Displays the IP Address, which is used to connect to the 
FEP. 

Port Displays the port that is used to connect to the FEP. 

Connect with SSL Select to enable to connect with SSL 

Secure Port Displays the secure port that is used to connect to the 
FEP. 

Signature Capture Select to enable Signature Capture. 
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Field/Button Allowable Value/Function 

Enabled Note: Refer to the Signature Capture feature 
reference documentation for information on 
this feature. The Feature Reference is 
available on Premier Portal. 

Line Item Display 
Enabled Select to enable Line Item Display. 

Line Item Display Port Displays the port used by the Line Item Display. 

Delete POP Click to delete the selected POP ID. 

Secondary POP Configuration 

Note: Refer to the P400 Implementation Guide for more information on this 
feature. The Feature Reference is available on Premier Portal. 

Add Click to add POP. 

POP ID Displays POP ID of the corresponding Workstation ID. 

Model Select POP model. 

IP Address Displays the IP Address, which is used to connect to the 
FEP. 

Port Displays the port that is used to connect to the FEP. 

Connect with SSL Select to enable to connect with SSL 

Secure Port Displays the secure port that is used to connect to the 
FEP. 

Signature Capture 
Enabled 

Select to enable Signature Capture. 

Note: Refer to the Signature Capture feature 
reference documentation for information on 
this feature. The Feature Reference is 
available on Premier Portal. 
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PINPAD Message 

Use to configure the idle and swipe messages that appears on the PINPAD. 

 

EMV Configuration 

Note: Refer to the EMV feature reference documentation for information on this 
feature. The Feature References are available on Premier Portal. There are two 
feature references for EMV, “Inside EMV Feature Reference” and “Outside EMV 
Feature Reference”. Refer to both the feature reference documents to 
understand this feature.  

EMV is the new standard for credit card processing. It describes a transaction between 
a chip card and an EMV-enabled terminal. EMV transactions are much more secure 
than magnetic-stripe-card transactions.  

To run EMV transactions at a site, EMV must be enabled from the Config Client in the 
EMV Configuration form, then both the Viper (EPS) and the PIN pads (POPs) need to 
be configured with a required set of EMV configurations. Some distributions enable 
EMV by default but check this setting before proceeding on to EMV configuration. 

  The EMV configurations include: 

• Certification Authority Public Keys 

• EMV Terminal Parameters  

• Set of supported AIDs and their associated parameters 

To process EMV chip cards, The EPS system must have all three of those 
configurations.  Depending on the Acquiring host and supporting software (FEP) the 
configuration data may be populated using: 
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• A PDL download containing the necessary EMV configuration from the host  

• Pre-populated data based on host specifications 

• Custom table downloads from Verifone table partners 

Refer to your specific FEP documentation to determine which method is used.  
The EMV Feature Reference Manual also has more details on the configuration. 

After the EMV configuration has been configured successfully on the EPS system, the 
EPS system pushes the appropriate EMV configurations into the POPs as required.  
Usually this configuration push to the POPs is transparent to the user but it is prudent 
to check for any reported errors in pushing the configuration by referring to the “POP 
Configuration Status” in the EMV Initialization form (Screen Shot Illustrated below).  

EMV based transactions may allow stand-in processing to approve transactions even if 
the online payment host is offline and not available. 

EMV data in a transaction allows the system to consider many conditions when making 
a decision to stand in for a transaction. The system still uses the traditional Magnetic 
Swipe Read (MSR) data points, but additional EMV data allow for much finer decision 
points for consideration.  

It is important to check that the EMV Standin Parameters are correctly configured. 
Each FEP has different Standin configuration. Refer to your specific FEP 
documentation for FEP specific Standin values.     

The system also supports manual push of the EMV configuration to specific POPs if 
required.  One example of when this might be required is if a POP is replaced. 

Quick Chip Configuration 

An EMV Quick Chip (QC) transaction is a faster way to perform EMV transactions.  In a 
QC flow, the chip read, AID selection, 1st Gen AC, EMV completion and card removal 
can all be done prior to the total amount is entered. 

EMV Quick Chip increases payment transaction speed at the POS by changing the POS 
flow. This means that merchants can begin the authorization process before obtaining 
the final total amount. The consumer can also insert the payment card and key in the 
PIN while cashier is still totaling items for purchase. Final total is the last piece of 
data to be sent for authorization.  
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Field/Button Allowable Value/Function 

Amount 

This is a place holder amount used for recognizing if the 
card can be used for Quick Chip (QC) transaction. When 
the card is inserted the place holder amount is send as a 
code to the issuer for recognizing the card for QC 
transaction.  

Quick Chip Setting Select to enable the feature for the card. This is enabled 
by default. 

LINQ3 Lottery Configuration 

Note: This feature is no more supported.  

Note: Refer to the “Linq3’s Play at the Pump (PATP) Lottery” feature reference 
documentation for information on this feature. The Feature Reference is 
available on Premier Portal. 

Linq3’s Play at the Pump (PATP) Lottery feature is an integrated lottery solution that 
offers customers the convenience of lottery ticket purchases while fueling and paying 
at the gas pump. 

The PATP feature delivers lottery sales to the forecourt at the Dispenser Card Reader 
(DCR) and integrates Verifone’s VIPER Electronic Payment System (EPS). 
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Commander interfaces with the Linq3 Lottery host.  The host is responsible for receipt 
prompting, reporting and tracking data, and payment collection. 

Configure LINQ3 Lottery in Configuration Client, using Payment Controller > EPS 
Configuration > Linq3 Lottery Configuration. 

 

Field/Button Allowable Value/Function 

FEP Enabled Enables the Linq3 Lottery feature. 

Site ID Sets the Linq3 Lottery ID which is identical to the 
Verifone Service ID. 

Pump Auth Timeout Sets the timeout value for the pump authorization (e.g. 
60 seconds). 

Mode Set the communication mode to IP communication. 

Domain Name Enter the [IP Address] of the Linq3 host for lottery 
communications. 

Port Enter the [Port] of the Linq3 host for lottery 
communications. 

Reporting 
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Comm Statistics 

 ******COMMUNICATION STATISTICS****** 

**************************************** 

 UNIT#: 00140080294 TID: 02 

 VERS: X.XX.XX 

 DATE: 01/25/13 TIME: 17:46 

**************************************** 

                     PRIMARY SECONDARY 

 TOTAL CALLS            002      000 

 NO RESPONSE            000      000 

 LOST CARRIER           000      000 

 AVG CONNECT TIME       020      000 

 AVG RESPONSE TIME      003      000 

 AVG CALL SET-UP TIME   009      000 

 FALLBACK TRANSACTIONS 

 - CODE 57              000      000 

 - OTHER                000      000 

 TIMER ACTIVATED  000 

**************************************** 

SAMPLE 
COMMUNICATION 
STATISTICS 
REPORT 

 

 

 

Troubleshooting 
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# Message Description/Action 

E8061 CHARGE TO INVALID 

Customer attempted to use a card that 
had an invalid or empty value at the 
“ENTER CHARGE TO” prompt on the 
PINpad. 

E8062 PRE-AUTH NOT ALLOWED 
FOR EBT CARDS Cannot pre-authorize EBT cards. 

E8064 EBT UNAVAILABLE Network is unable to get authorization 
from EBT host. Retry 

E8067 CHECK AUTHORIZATION 
UNAVAILABLE 

Network is unable to get authorization 
from the check vendor. 

E8069 MUST SETUP EBT 
MERCHANT ID FIRST 

Attempted to use EBT before entering a 
valid eight-digit EBT Merchant ID. 
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Other Sales Functions 
Overview 

This section includes the sales functions that are not covered by any of the other 
sections. 

Using Other Sales Functions 

The following are the other sales functions: 

• Add Tip 

• Allow Food Stamps for Item 

• Gift Card Purchase 

• Gift Card Recharge 

• Kiosk Order 

• Kiosk Order Purge 

• Modify 

• No Sale 

• Other Department 

• Other MOPs 

• Other Functions 

• Price Check 

• Price Check Enhancement 

• Repeat last item 

• Split tender 

• Ticket Print 

• Total 
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Add Tip 

At present we do not have the ability to add a tip. Enhancements will be made 
in upcoming software releases for the "Add Tip" feature.   

As a workaround, follow this process: 

1. Create a TIP department.  

2. When the customer comes to register to pay for a ticket, before 
tendering the transaction, ask if customer wishes to add a tip to the 
amount. 

3. Add the tip amount to the transaction using the TIP department key.  

This method of adding a tip to the order only allows dollar amounts and not 
percentages. 

Allow Food Stamps for Item 

This function processes an item not configured as food stamp eligible as though 
it is eligible for payment with food stamps.  It should be used in only accordance 
with store policies and procedures. 

1. Press [ALLOW FOOD STAMP] 

2. Key item 

3. Tender Sale with Food Stamps MOP alone or in combination with another 
MOP 

Gift Card Purchase 

Allows the purchase of a Gift Card. 

1. Press [Gift Card Purchase] 

Note: Soft keys can be assigned to Gift Card Purchase and Gift Card Recharge 
functions found in the Functions drop-down list from the Soft Key configuration tab.  

Different networks perform Gift Card Purchase and Gift Card Recharge functions 
differently. Shell for example, creates Gift Card Purchase and Gift Card Recharge 
PLUs and then use these PLUs for gift card purchase and recharge. Some Networks 
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create Gift Card Purchase and Gift Card Recharge departments instead of PLUs and 
use these departments for gift card purchase and recharge. 

Refer to Soft Key, PLU Sales and Department Sales chapters in this document for 
more information. 

Gift Card Recharge 

Allows the recharge of a Gift Card.  

1. Press [Gift Card Recharge] 

Note: Soft keys can be assigned to Gift Card Purchase and Gift Card Recharge 
functions found in the Functions drop-down list from the Soft Key configuration tab.  

Different networks perform Gift Card Purchase and Gift Card Recharge functions 
differently. Shell for example, creates Gift Card Purchase and Gift Card Recharge 
PLUs and then use these PLUs for gift card purchase and recharge. Some Networks 
create Gift Card Purchase and Gift Card Recharge departments instead of PLUs and 
use these departments for gift card purchase and recharge. 

Refer to Soft Key, PLU Sales and Department Sales chapters in this 
document for more information. 

Kiosk Order 

This function is used only with Verifone’s integrated iOrder food service 
subsystem.  

Note: Refer to all the iOrder reference documents for information on this 
feature. The Feature Reference documents are available on Premier 
Portal. 

1. Press [Kiosk Order] 

2. View list of pending food service orders and select the order to bring 
into the current transaction 

Kiosk Order Purge 

This function is used only with Verifone’s integrated iOrder food service 
subsystem.  
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Note: Refer to all the iOrder reference documents for information on this 
feature. The Feature Reference documents are available on Premier 
Portal. 

1. Press [Kiosk Order Purge] 

2. View list of pending food service orders and select the one to purge 

Modify 

This function is used with products where different sizes are identified with the 
same PLU or barcode. 

1. Enter item (PLU, scan, menu, etc) 

2. Press [MODIFY] until the correct size appears in the ticket window 

3. Continue in the transaction 

No Sale 

This function is used to open the cash drawer without a sale. 

1. Press [NO SALE] to open cash drawer 

Other Department 

This function provides a way to sell to a department for which no department 
key or button has been assigned. 

1. Enter price and press [OTHER DEPT] 

2. Select the appropriate department from the list provided 

Other Functions 

This function offers a way to access Safe Drop, Safe Loan, Clock In/Out, Pay In, 
Pay Out, View Pending Transactions (Recall), View Previous Transactions (Ticket 
Reprint) and Safe Drop Correction through a single key or button. 

1. Press [OTHER FUNCTIONS] 

2. Select the appropriate function from the list provided 
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Price Check 

This function allows the clerk to check the price of an item without ringing it 
into a transaction. 

1. Press [PRICE CHECK] and enter or scan item to display item price 

2. Press [Y] if customer wants to add the item to the transaction or [N] if 
customer declines adding to transaction.  All restrictions still apply (ID 
Check, Blue Laws, etc) 

Price Check Enhancement 

In the enhanced item price check feature for the Topaz terminal, the existing 
ticket preview window is modified to add the price check item and also show 
any discounts and or taxes that would be applied if the item were to be added 
to the ticket.  The cashier is prompted to either add the previewed item to the 
ticket or cancel to remove the item from the ticket. 

1. Press [PRICE CHECK] and enter or scan item 

2. From the multiple-choice window, click the item or item modifier to be 
entered in the ticket preview window 

3. Press [Confirm Add] if customer wants to add the item to the 
transaction or [Cancel] if customer declines adding to transaction. All 
restrictions still apply (ID Check, Blue Laws, etc) 

Preview Reprint  

1. Press [Reprint] or [Ticket Print] 

2. Touch to select row or Key entry# and Press [ENTER]  

3. Preview the selected transaction prior to print. 

4. Press [ENTER] or [Reprint] to print receipt 

Preview Fuel Reprint 

1. Press [Pump#] [Reprint] 

2. Touch to select row or Key entry# and Press [ENTER] 

3. Press [ENTER] or [Reprint] to print receipt 
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Repeat Last Item 

This function adds another item to the transaction identical to the previous one. 
 It may be a PLU sale, menu item or department sale but does not apply to Fuel.  

1. Press [REPEAT LAST ITEM] to duplicate most recent line item in the 
transaction 

2. Continue adding items to transaction or enter MOP(s) to complete 
transaction 

Split Tender 

1. Press [TOTAL]. 

2. Enter MOPs in this order:  

1. Special discount: Press the MOP key or use [OTHER MOP]. 

2. Food stamps: Key the dollar amount then press the MOP key or 
[OTHER MOP]. 

3. Cash, check, coupons, or lotto: Key the dollar amount then press the 
MOP key or [OTHER MOP]. 

4. Credit, debit, or prepaid cards: Press the MOP key or [OTHER 
MOP]. 

3. Repeat step 2 until the transaction completes. 

If a customer pays for a transaction with more than one MOP, usually with 
food stamps or coupons, key the dollar amount of each method of payment 
except the last one. Each MOP entered deducts the amount from the total 
and displays the amount still due. 

The MOPs used, and the amounts entered print on the receipt. 

The following procedures apply: 

 Cash, checks, coupons, and lotto: Can be accepted between 
food stamps and network MOPs. Network MOPs include cards such 
as credit and debit. 

 Credit: Must be the last MOP entered because it takes the balance 
of the transaction. 
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 Debit: Must be the last MOP entered because it takes the balance 
of the transaction. 

 Drive Off: If a customer pays for part of the dispensed fuel, use 
drive off for the unpaid balance. 

 Food Stamps: Must be entered as the first MOP unless the item 
and customer qualify for a special discount. Enter paper food 
stamps in whole dollar amounts. Enter electronic food stamps in 
dollars and cents. If a balance remains, other MOPs can be 
entered. 

 POP Discount: For a customer to be awarded a POP discount 
when paying with multiple MOPs, the POP Discount File must be 
configured to handle the two MOPs being used in the transaction. 
Check site policy for information on handling POP discounts and 
multiple MOPs. 

 Prepaid Card: In some cases, more than one prepaid card can be 
used in a single transaction. If the balance is insufficient, another 
MOP can be used. 

 Special Discount: If a customer and an item qualify for a special 
discount, credit the customer with the special discount before 
entering other MOPs. 

Other MOPs 

1. Press [TOTAL]. 

2. Do one of the following:  

 Non-network MOPs: Key the dollar amount offered. 

 Network MOPs (credit, debit, etc.): Go to the next step. 

3. Press [OTHER MOP]. 

4. Choose the MOP by one of the following methods:  

 Key the MOP number then press [ENTER]. 

 Press [OTHER MOP] repeatedly until the MOP appears. Press 
[ENTER]. 
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Note: The [OTHER MOP] key accesses only MOPs that are not assigned to 
soft keys. 

Ticket Print 

Shows the last 500 indoor sales receipts or the last card reader receipt. 

1. Press [Ticket Print] 
2. In the overlay, select [Advanced Options]  
3. In the multi-select advanced options menu, select filter options like 

date, register, fuel etc to filter the receipts based on these options. 
4. From the filtered options, select the receipt to print.     

Total 

This function provides a subtotal for the current transaction and includes a 
subtotal on the resulting printed receipt. Depending on configuration settings, it 
may or may not be required.  It may be required in each transaction.  However, 
it may be used to trigger additional processing (such as sending transaction data 
off to a loyalty host). 

1. Press [TOTAL] 

2. Continue adding items to transaction or enter MOP(s) to complete 
transaction 
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Partner Interfaces 
Overview 

This topic summarizes the various partner interfaces available through the Verifone 
Point of Sale (POS) system. The implementation details for each of the interfaces is 
available through the individual partner programs. The purpose of this section is to 
give a brief overview of the available interfaces. 

Note: All the partner interfaces are configured through managed modules in 
Configuration Client, which is the configuration tool of the Commander Site 
Controller. Refer to the Managed Modules section in this document for more 
details. Most of these partner interfaces have feature references. Refer to the 
feature reference documents for more information. The Feature Reference 
documents are available on Premier Portal. 

Tank Level Sensors (TLS) 

The TLS is used for communicating with devices used to monitor the level of fuel in 
the tank. The sensor also sends alarms that are displayed on the POS. 

Reset Tank Alarm 

External input alarms of the TLS can be cleared from the POS by going to Fuel 
Manager Menu > Reset Tank Alarm.  

Tank Level Sensor (TLS): Tank Monitor Report 

The Tank Monitor Flash report lists information gathered from a tank level sensor. 
This report is available only if a tank level sensor is installed in the tanks and if the 
site uses the optional software. 

             TANK MONITOR REPORT 
INVENTORY 

Veeder-Root TLS 

TANK# 1 

DATE: 07/31  08:10 

TANK NAME:  tank01 

  

  

  

Sample TANK 
MONITOR REPORT 
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LEVEL:       39.20 INCHES 

VOLUME:      7123 GALLONS 

TEMP:        72.5 DEG F 

ULLAGE:      1377 GALLONS 

WATER:        0.8 INCHES 

TANK# 1 End report. 

TANK# 2 

DATE: 07/31  08:10 

TANK NAME:  tank02 

LEVEL:      37.95 INCHES 

VOLUME:      5914 GALLONS 

TEMP:        72.6 DEG F 

ULLAGE:      2586 GALLONS 

WATER:        0.8 INCHES 

TANK# 2 End report. 

----------      INVENTORY     ---------- 

LEAK 

Veeder-Root TLS 

TANK# 1 

Leak Test Started: 06/08  14:34 

Temp Change: -2.0        Start Vol: 5710 

 Hr1  Hr2  Hr3  Hr4  Hr5  Hr6  Hr7  Hr8 

  -5   -2   -1 
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TANK# 2 

Leak Test Started: 06/08  14:34 

Temp Change: -2.0        Start Vol: 4908 

 Hr1  Hr2  Hr3  Hr4  Hr5  Hr6  Hr7  Hr8 

  -6   -5   -5 

----------        LEAK        ---------- 

ALARM HISTORY 

Veeder-Root TLS 

HIGH WATER: 07/21  06:42 

HIGH WATER: 07/16  09:12 

LOW LIMIT:  07/24  08:08 

LOW LIMIT:  07/16  07:25 

TANK# 1 End report. 

HIGH WATER: 07/24  08:07 

HIGH WATER: 07/16  09:12 

HIGH WATER: 07/16  09:11 

LOW LIMIT:  07/29  14:34 

LOW LIMIT:  07/24  08:08 

TANK# 2 End report. 

----------    ALARM HISTORY   ---------- 

DELIVERY 

Veeder-Root TLS 

            -- Begin ---   --- End ---- 
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Tank Del   Volume  Temp   Volume  Temp 

           07/29  14:35   07/29  14:37 

   1   1     5945  73.1     7224  73.4 

           07/29  14:30   07/29  14:32 

   1   2     2957  72.9     5983  73.0 

           07/24  09:32   07/24  09:34 

   1   3     5917  73.2     5988  73.3 

TANK#1 End report. 

           07/29  14:34   07/29  14:37 

   2   1     1730  73.3     6173  73.6 

           07/29  14:30   07/29  14:32 

   2   2     1493  73.1     4920  73.2 

           07/29  11:26   07/29  11:29 

   2   3     5075  73.3     5140  73.1 

           07/29  08:17   07/29  8:19 

      TANK#2 End report. 

----------     DELIVERY       ---------- 

ALARM STATUS 

Veeder-Root TLS 

EXTERNAL INPUT STATUS: OFF 

               HIGH  OVER  LOW 

         LEAK WATER  FILL LIMIT THEFT 

TANK# 1   OFF   OFF   OFF   OFF   OFF 
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TANK# 2   OFF   OFF   OFF   OFF   OFF 

----------     ALARM STATUS   ---------- 

AUTO-TRANS FLAG 

Veeder-Root TLS 

EXTERNAL INPUT FLAGS 

         CLOSED: OFF OPEN: OFF 

               HIGH  OVER  LOW 

         LEAK WATER  FILL LIMIT THEFT 

TANK# 1   OFF   OFF   OFF   OFF   OFF 

         DELIV START: OFF  END: OFF 

TANK# 2   OFF   OFF   OFF   OFF   OFF 

         DELIV START: OFF  END: OFF 

----------   AUTO-TRANS FLAG  ---------- 

Report Details 

INVENTORY 

• TANK#: Tank number. Tank reports print in tank number order. 

• DATE: Date and time the report runs. 

• TANK NAME: Name of tank as assigned in the Tank Names function in Fuel 
Manager mode. 

• LEVEL: Fuel level in inches. 

• VOLUME: Fuel volume in gallons. 

• TEMP: Temperature in degrees Fahrenheit. 

• ULLAGE: Unused tank capacity in gallons. 
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• WATER: Water level. 

LEAK 

• TANK#: Tank number on which the test is run. 

• Started: Date and time the test is run. 

• Hr1 - Hr8: Number of hours of leak data. 

• “Leak Test is OFF/No leak data to report.”: This phrase appears instead of 
the data if the leak test is not running. 

• “Leak Test is ON/No leak data to report.”: This phrase appears instead of the 
data if the leak test has not been running for the minimum time set for 
collecting data. 

ALARM HISTORY 

Prints in tank number order. 

• HIGH WATER: Date and time of the last three high water alarms. 

• LOW LIMIT: Date and time of the last three low limit alarms. 

DELIVERY 

• Tank: Prints in tank number order. 

• Del: Delivery report number. The report can contain 0 - 10 deliveries. 

• Begin: Volume in gallons and temperature in degrees Fahrenheit at the 
beginning of delivery. 

• End: Volume in gallons and temperature in degrees Fahrenheit at the end of 
delivery. 

ALARM STATUS 

• TANK#: Printed in tank number order. 

• Alarm Status: The status (“OFF” or “ON”) of the following alarms: 

 Leak 

 High Water 
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 Overfill 

 Low Limit 

 Theft 

AUTO-TRANS FLAG 

• TANK#: Printed in tank number order. 

• Auto-transmit Flag Status: The status (“OFF’ or “ON”) of the following flags: 

 Leak Alarm 

 High Water Alarm 

 Overfill Alarm 

 Low Limit Alarm 

 Theft Alarm 

 Delivery Start 

 Delivery End 

Tank Level Sensor (TLS): Tank Reconciliation Report 

The Tank Reconciliation Report displays the inventory in gallons of fuel in each tank 
and compares the beginning inventory to the ending inventory. Reconcile the 
inventory at the end of each day to aid in tracking starting inventory from the 
previous day, deliveries, and dispensed fuel.  

        TANK RECONCILIATION  
       Tank              Date   Time  Volume  Total 

Inventory 1           06/11  12:24    5693 

Inventory 2           06/11  12:24    4606 

                  Starting Inventory     10299 

Del #           1 2  06/11  03:15    1000 

  

  

  

  

  

  

Sample TANK RECONCILIATION 
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Del #           1 3  06/11  03:22    1000 

                                          + Deliveries 
     2000 

Tank 1               Fuel Dispensed                 10 

Tank 1               Fuel Due                               5 

Tank 2               Fuel Dispensed                 20 

                                          - Dispensed        35 

Inventory 1       06/11  12:28    6683 

Inventory 2       06/11  12:28    5583 

                               - Ending Inventory     12266 

                                                              --------
- 

                                         Discrepancy         3 

REPORT 

 

Report Details 

• Tank: All tanks list in tank number order. 

• Date: Date the inventory is taken, beginning and ending. 

• Time: Time the inventory is taken, beginning and ending. 

• Volume: Volume of fuel: 

 Measured in each tank when the inventory is taken. 

 Delivered to each tank. 

 Dispensed from each tank. 
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• Total: 

 Starting Inventory: The total amount of fuel contained in the tanks 
when the beginning inventory is taken. 

 Deliveries: The total amount of fuel delivered and placed in the tanks is 
added to the inventory. 

 Fuel Dispensed: The total amount of dispensed fuel is subtracted from 
the inventory. 

 Fuel Due: The total amount of fuel dispensed without payment. 

 Ending Inventory: The total amount of fuel contained in the tanks when 
the ending inventory is taken. 

 Discrepancy: The amount of fuel unaccounted for by the inventory. 
(Discrepancy = Starting Inventory + Deliveries - Dispensed - Ending 
Inventory) 

Tank Module 

The Tank Model specifies add-on modules such as EDIM which are used for Business 
Inventory Reconciliation. 

Electronic Price Sign 

Electronic Price Sign interface is used for communicating with electronic price sign 
devices used at the site to display the fuel prices for each grade. 

Carwash 

Carwash interface is used for communicating with carwash controllers which generate 
codes for redeeming carwash purchases. 

Note: Refer to the Car topic in the document for more information. 

Carwash Paypoint 

The carwash paypoint accepts payment for carwash purchases. This interface handles 
forwarding of the credit card information to the payment network. 

Note: Refer to the Car Wash Pay Point feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 
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Money Order 

Money Order interface is used to communicate with money order devices. 

Digital Video Recorder (DVR) 

This interface is used to communicate transaction information with Digital Video 
Recorder systems so that video can be matched with transaction data. 

Proprietary Card 

Proprietary Card interface is used to communicate with proprietary card hosts. 

EPS Loyalty 

EPS loyalty sales allow the processing and redemption of loyalty transactions, both 
inside at the POS and outside at the dispenser card readers (DCR). These loyalty 
transactions are processed through the electronic payment system (EPS). 

Scanner 

There are two types of scanners supported: Ruby Ready Scanner (1D barcodes) and 2D 
Scanner (2D barcodes).  

The appropriate scanner type must be configured on the POS using CSR Functions > 
Maintenance > Device Configuration > Scanner Config, as the communication baud 
rate settings depends on this configuration. 

Note: Distributors need to preconfigure the scanner device to work with 
Verifone POS systems. 

Random Weight barcode support 

Random weight products are typically perishable items (e.g., meat, bakery, cheese, 
fish and poultry) that are sold on a price per pound basis. Most random weight 
products are packaged and price-marked in the store. However, some may be 
packaged, and price marked by a manufacturer before they are delivered to the 
store. 

Items are weighed, and the scale produces the barcode. Scale is configured with 
PLUs, item names and prices for 1 unit (pound) of the product. The scale weighs the 
items, calculates the price and creates the barcode.  
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Configure the POS with the same PLUs, same descriptions and prices. The parameter 
Fractional Quantity should be selected in the PLU form to sell the PLUs in fractional 
quantities.  

The barcode is scanned, POS calculates quantity based on price (in barcode) and price 
(in PLU file) to collect money from customer. The quantity gets printed on receipt 
and in reports. 

Using Scanners 

Scanners can be used at any point during the transaction to scan items prior to 
tendering the sale.  Coupons can also be scanned with scanners during the 
transaction. Scanners can also be used for entering drivers licenses with 2D 
barcodes. 

Note: See the Easy ID Feature Reference document for further information 
on scanning driver license barcodes and the Coupon Scanning Feature 
Reference document for further information on scanning coupons. The 
Feature Reference documents are available on Support.Verifone.com > 
Petro & Convenience > General Info – Feature Reference. 

Configuring Scanners 

The appropriate scanner type must be configured on the POS using CSR Functions > 
Maintenance > Device Configuration > Scanner Config, as the communication baud 
rate settings depends on this configuration. 

The POS system can be configured for only one type of scanner.  

  



450 

Pay In / Pay Out 
Overview 

The system uses sales, refund, safe drop, and safe loan information to keep track of 
how much cash should be in the cash drawer. The Pay In and Pay Out functions are 
used to log changes to the drawer not associated with these functions. 

The Pay In function logs cash added to your drawer that is not associated with either 
sales or the "Safe Loan” function. 

The Pay Out function logs cash taken from the drawer that is not associated with 
sales, refunds, or "Safe Drop" functions. 

Some sites support the use of the Pay Out function to pay vendors using an integrated 
Money Order device. 

Note: Pay Ins / Pay Outs log on the receipt printer and Summary Report. 

Note: Pay In is also used to settle IN-HOUSE MOP charges. 

Using Pay In / Pay Out 

Pay In 

1. Do one of the following: 

 Press [Pay In] 

 Press [OTHER FUNC] and touch [Pay In] or key <entry number> 
for Pay In and press [ENTER] 

2. Touch [No] to "In-House Account? [Y/N]" 

3. Touch the amount you are adding to the drawer and press [ENTER] 

4. Key <reference number> (1 - 6 digits) as defined by your store procedures 
and press [ENTER] 
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    WELCOME TO XXX STORE  

       P A Y    I N  

 CASH       158       150.00 

 ST# xx123 TILL XXX  DR# 1  TRAN# 101010  
 CSH:1                 10/04/12 22:34:47  
  

Sample Pay In 
Receipt 

Pay Out 

1. Do one of the following: 

 Press [Pay Out] 

 Press [OTHER FUNC] and touch [Pay Out] or key <entry 
number> for Pay Out and press [ENTER] 

2. Key <amount> you are removing from the drawer and press [ENTER] 

3. Key <reference number> (1-6 digits)  as defined by your store 
procedures and press [ENTER] 

    WELCOME TO XXX STORE 

        P A Y  O U T  

 CASH       258     150.00 

    
 ST# xx123 TILL XXX   DR# 1  TRAN# 101010  
 CSH: 1                 10/04/12 22:34:47  
  

Sample Pay Out 
Receipt 

Configuring Pay In / Pay Out 

Pay In / Pay Out cannot be configured manually. 

Reporting 

The Pay In / Pay Out Report reflects cash added or cash removed from drawer from 
non-sales and non-safe loan functions. 
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Pay In Report 

      PAYMENT IN 

 PAY IN      4        550.00 

 SAFE LOAN   4        329.00 

------------------------------ 

 TOTAL PAYMENT IN     879.00  

Sample Pay In Details in 
Cashier Report 

Reports Details 

 PAYMENT IN: Summary of non-sales transactions in which payment was added 
to the drawer. 

 PAY IN: Cash added to the drawer from non-sales, non-safe loan functions. 

 SAFE LOAN: Cash added to the drawer from the site safe. This usually occurs 
when more change is needed. 

Pay Out Report 

        PAYMENT OUT 

 PAY OUT        2      275.00 

 SAFE DROP 
  CASH         1       25.00 

                      ------- 

 TOTAL SAFE DROP        25.00 

 --------------------------------- 

 TOTAL PAYMENT OUT   (300.00)  

Sample Pay Out 
Details in 
Cashier Report 

Report Details 

 PAYMENT OUT: Cash removed from drawer that is not associated with sales, 
refunds, change on check (where face value of check exceeds transaction 
amount), or safe drop activities. 
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 CHANGE/CHECK: Transactions in which cash is returned to the customer 
because the check was tendered for more than the transaction amount. 

 SAFE DROP: Money removed from the drawer and placed in a safe at the site. 
This usually happens when the amount of a method of payment in the drawer is 
more than the amount allowed in the drawer at one time. Safe drops are 
grouped by method of payment. The total of all safe drops prints. 
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PLU Promotions 
Overview 

This is a simple-automated discount that sets a temporary price reduction (discount) 
for a PLU/modifier item any time that is sold between the configured start date/time 
and end date/time. Once the end date/time is reached, the item is again sold at its 
normal price. 

This feature is also used for Car Wash Promotions at the POS (point-of-sale) and at the 
pump. For example, two dollars off a Gold Wash with the purchase of ten gallons of 
fuel. 

Using PLU Promotions 

Automated discounts require no special handling by the cashier. Cashier sells 
items like any other PLU item (scanning, Soft Key, Menu item, or entering the 
PLU number), and then press [ENTER] to apply the discounts appropriately. 

Configuring PLU Promotions 

To Add, Delete, or Restore PLU Promotions, click on Store Operations > Restrictions 
> PLU Promotions. 

PLU Promotions 
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Field/Button Allowable Value/Function 

Add Click to add a new PLU Promotion. 

Delete Click to delete the selected Promotion. 

PLU Enter the PLU number to which the promotion 
applies. Do not enter leading zeros (0). 

Modifier Enter the modifier for the PLU. 

 

If the PLU is valid, a small yellow index card appears. 
If the PLU cannot be validated, a black ‘X’ appears. 

Start Date Enter the date the promotion starts. 

Start Time Enter the time the promotion starts. 

End Date Enter the date the promotion ends. 

End Time Enter the time the promotion ends. 

Discount - Percent 

  

Amount 

  

Amount 

Click to calculate the discount value of the promotion 
as a percent of the item’s price. 

Click to calculate the discount value of the promotion 
as a dollar amount. 

Enter the amount of the discount for the promotion. 

Car Wash Discount - 
 Minimum Ticket 
Purchase Amount 

  

  

Minimum Fuel Product 
Amount 

Click if the customer is required to purchase a car 
wash for a minimum amount to qualify for the 
promotion discount. Enter the minimum dollar 
amount in the Purchase text box.  

Click if the customer is required to purchase a 
minimum dollar amount of a specific fuel product to 
qualify for the promotion discount. 

Enter the minimum dollar amount in the Purchase 
text box and the fuel product ID in the Fuel Product 
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Field/Button Allowable Value/Function 

  

  

Minimum Fuel Volume 

ID text box. 

Click if the customer is required to purchase a 
minimum quantity of fuel to qualify for the 
promotion discount. 
Enter the minimum quantity in the Purchase text box. 

Amount  

   

   

   

   

  

Enter the purchase amount as follows: 

• Minimum Ticket Purchase Amount (dollar) - 
(0.01 - 99.99) 

• Minimum Fuel Product Amount (dollar) - (0.01 - 
99.99) 

• Minimum Fuel Volume (gallons) - (0.01 - 99.99) 

Fuel Product   If Minimum Fuel Product Amount is selected, enter 
the fuel product ID (numeric, 1 - 9). 

Reporting 

The following report focuses on all discounts against PLUs whether applied manually 
or automatically.  

  

       PLU PROMO REPORT 

 PLU NUMBER  DESCRIPTION 

 CUST       ITEMS PRICE TOT-SALES 
                       %SALES 
----------------------------------
-- 

 000000000050/000  DELUXE 

Sample PLU Promo 
Report 
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       2     2.00    2.74  5.48  P 

  

 TOTAL ITEMS SOLD:       2.00 

 TOTAL SALES:            5.48 

 % OF TOTAL SALES:       2.85% 

  

Report Details: 

• PLU NUMBER: Identification of the product as it appears in the PLU File or as it 
was entered if it is not found. 

• DESCRIPTION: Description of the product as it appears in the PLU File. Items 
without descriptions either do not have descriptions assigned in the PLU File, 
or the item does not exist in the PLU File and was sold with a cashier-assigned 
price. 

• CUST: Number of customers (separate completed transactions) who bought the 
item. If the item is sold at more than one price, the number of customers who 
purchased the item at a specific price is listed. 

• ITEMS: Quantity of the item sold. If the item is sold at more than one price, 
the quantity of the item sold at a specific price is listed. 

• PRICE: Price of the item. If the item is sold at more than one price, each price 
is indicated on a separate line. 

• TOT-SALES: Total amount collected for sales of this item. If the item is sold at 
more than one price, the total amount collected at each specific price is listed. 

• RC: Reason code identifies the method that is used to change the price of an 
item. 
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PLU Promo Report Reason Codes 

Code                   Description 

C The item was sold as a part of a combo. 

D A discount (percent or dollar as set up in Sales Configuration and Soft Key File 
under Manager) was applied to the item. 

M The item was sold as part of a match. 

O The item was sold at the dispenser card reader. 

P The item was sold with a promotion set up in the PLU Promotion File in 
Manager. 

• %SALES: Percent of total sales that this item represents. To find this number, 
use one of the following formulas. 

If you use departments: 

Net Department Sales ÷ Total sales of this item 

If you only use PLUs: 

Total PLU Sales ÷ Total sales of this item 

Troubleshooting 

# Messages Description / Action 

E3033 ERROR IN CARWASH 
SETUP 

The car wash parameters have not been set 
up correctly and the Discount Type prompt 
displays in the PLU Promotion File function. 
Check the car wash parameters. 

  



459 

PLU Sales 
Overview 

PLU means “Price Look Up” and a PLU sale is one whose price is defined and can be 
“looked up” on the system’s price book using a numeric identifier.  There are a 
number of ways to enter a PLU number (scanner, menu or button assignment or 
manually keyed). 

When this number (which may also be a barcode) is provided to the system, the 
system can locate the item’s price, taxability, reporting department and other details 
associated with that number.  So, all that is required to sell a PLU item is to provide 
the identifying number along with the quantity of the item being sold. 

Our system supports the concept of “modifiers” to provide a mechanism to more 
specifically define the product when the same barcode is used to indicate different 
packaging of the same product. This is seen most often on canned soda (singles, 6-
packs, etc). The combination of the PLU# and modifier uniquely identifies a product 
along with its price, taxability and other information.  For most PLUs, this modifier 
value is zero. 

Modifiers 

A PLU is made up of a PLU number and a modifier number. A single PLU can have up 
to 255 modified versions. Modifiers let you group similar items into the same PLU 
number. 

For example, you might want to group all Coke products: 

Product                                                                        PLU Modifier 

Coke - six-pack cans 100 0 

Coke - two-liter plastic 100 1 

Coke - single can 100 2 

Coke - 16-oz. bottle 100 3 

 

The first PLU/modifier combination created must use modifier 0. All other modifiers 
of the PLU can be any number between 1 and 255. If no modifier is entered during a 
selection, the modifier is assumed to be 0. 
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Using PLU Sales 

The PLU sales functions are: 

• Basic PLU Sale 

• PLU Sale with Modifier 

• PLU Sale with Quantity 

• Open PLU 

• PLU Not Found 

• Manual PLU 

• Managed PLUs 

Basic PLU Sale 

All PLU sales are a variation of one of these basic methods.  

Enter the PLU item using one of the following methods: 

 Touch the PLU soft key or scan the barcode 

 Select the appropriate key or button assigned to that item 

 Select the appropriate menu, then select the item from that 
menu 

 Manually enter the PLU# or barcode and press [ENTER]. Do not 
enter the first or last number; only the numbers in between. In 
the example below, the correct entry would be 2193511112 
[ENTER]. Item is added to the transaction.  
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PLU Sale with Modifier 

Key, Button, Menu or Manual Entry with Modifier  

a. Enter the PLU item 

b. The system displays a modifier menu listing the items 

c. Touch the entry for appropriate sized item or key the entry 
number and press [ENTER]. The selected item is added to the 
transaction. 

d. To edit an entry, touch or press [MODIFY] until the appropriate 
sized item is displayed in the ticket window 

e. Continue the transaction 

Scanned PLU Sale with Modifier  

 Scan the PLU item 

 When item has multiple entries (multiple modifiers), the system 
may display a menu listing them 

 Touch the entry for appropriate sized item or key the entry 
number and press [ENTER]. The selected item is added to the 
transaction. 

 Continue the transaction 

Note: When a scanned item has multiple modifiers, the system may be 
configured to display a menu that lists all modifier items associated with that 
barcode.  No additional items may be scanned until an entry is selected from 
the menu. 

PLU Sale with Quantity 

Method 1 

1. Use the numeric keypad to enter quantity, 

2. Press [QTY] 

3. Enter the PLU item 
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Method 2 

1. Enter the PLU item 

2. Touch the line item in the receipt window, 

3. Select [QTY] from the menu, 

4. Key quantity and press [ENTER] 

Item displays in ticket with appropriate quantity and extended price 

Open PLU 

An open PLU is tracked and reported at the item level but requires the price to 
be entered each time it is sold. 

Note: Refer to the Open PLU feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

1. Enter PLU item 

2. Key the item price and press [ENTER]. Item is added to the transaction 

3. On transaction completion, an additional ticket prints on which the clerk 
should write the description and size of the product and add to 
paperwork to be submitted according to store policies and procedures 

PLU Not Found 

1. Enter PLU item and PLU is not found in price book 

2. System prompts for item price 

3. Key the item price and press [ENTER] 

4. Item is added to the transaction using its identifying number as the 
description 

5. On transaction completion, an additional ticket prints on which the clerk 
should write the description and size of the product and add to 
paperwork to be submitted according to store policies and procedures 
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Manual PLU 

This function allows screen entry of items using the <PLU number> [ENTER] key 
sequence.  

1. Touch or press [MANUAL PLU] 

2. Touch <PLU number> and [OK] 

3. If PLU number is not found, processing follows the “PLU Not Found” 
sequence 

Configuring PLU Sales 

Price Look Up Manager 

Use Store Operations > PLUs to configure PLUs.  

PLU sales primarily deal with the PLU file; also known as the pricebook.  PLUs may be 
scannable (represented by a barcode) or may be assigned to keys, buttons or menus. 
 The focus of this section is the maintenance of the PLU file itself.  

The Price Look Up Manager form is used for editing, adding, and deleting PLUs. The 
current PLUs are listed on the left side of the form. 
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Field/Button Allowable Value/Function 

Retrieve PLUs 
Click to display the Retrieve PLUs criteria entry form on 
the right of the Price Look Up Manager. See Retrieve 
PLUs. 

PLU Enter the PLU number (up to 14 digits). 

Add  Click to create a new PLU record. 
Modifier Enter the modifier (up to three digits). 
Delete Click to delete the selected PLU. 

Description  

Enter a description of the PLU item (alphanumeric, 1 - 
16 characters). The description appears on receipts and 
reports. 

Price Enter the price of the PLU. 

Sell Unit 
Enter the number of items represented in packaging of 
the item. 

Department Select the department to which this PLU is assigned. 

Product Code  

Select the name assigned to the product code (set by 
the network) that categorizes the products sold. 

Note: Although product code can be assigned at PLU 
level, if left at 0, system retrieves product code from 
Department to which item is assigned.   

Fee Select the fees. 

ID Check 

If the PLU requires an ID check for purchase, click the 
Edit button. 

In the ID Check form, select the appropriate ID Check. 
Click Done. 

Note: ID Checks are set up in Store Operations > 
Restrictions > ID Check. 
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Field/Button Allowable Value/Function 

Taxes  

If a tax is added when items in the department are 
sold, click the Edit button. 

In the Tax form, select the appropriate tax(es). Click 
Done. 

Blue Laws  

If the sale of an item in the department is restricted on 
a designated day(s), select the appropriate Blue Law. 
Click the Edit button. 

In the Blue Laws form, select the appropriate Blue 
Laws. Click Done. 

Group ID 

The group ID to which this PLU belongs. When one of 
the items in the group is scanned, the system will allow 
the cashier to select from a menu of the grouped items. 
The selected item is added to the ticket, which may not 
be the original item scanned. 

For this feature to work, 
“topaz.sales.showGroupedItems” and 
“topaz.sales.allowDismissalOfGroupedItemMenu” 
should be enabled in System Properties. 

Sequence # The sequence number of this PLU item in the group. 

Transaction Quantity 
Limit 

Determines the quantity of the PLU that can be 
purchased per transaction. 

This parameter is used to restrict bulk quantity 
purchase of certain items. This field accepts non-
negative decimal number to allow for fractional 
quantity. Default value is 0.00 and means that there is 
no restrictions on the total purchase quantity in a 
transaction. 

Properties 

Open 
Select to make the PLU an Open PLU. When an Open 
PLU is used during a sale, the system prompts for a 
price for the PLU item. 
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Field/Button Allowable Value/Function 

Not Sold Select to prevent the PLU item from being sold. 

Refundable Select to allow the PLU item to be returned for a 
refund. 

Food Stamp Select if food stamps may be used to purchase the PLU 
item. 

Special Discount 

Select if the PLU item is eligible for special discount. 
When this parameter is selected, the Special Discount 
MOP must be set up on Payment > MOP. 

 

Promo 
Select to allow the PLU item to be on promotion. When 
this parameter is selected, it must be defined at 
Restrictions > PLU Promotions. 

Fractional Quantity 

Select if the PLU item may be sold in fractional 
quantities (for example, sold by weight).  

Note: If this parameter is selected, all quantities 
entered in Sales mode for this PLU are read as 
decimals. For example, if the quantity is 1¾ lbs of 
turkey, key [1][7][5]. If this parameter is not selected, 
all quantities entered are read as whole numbers. 

Prompt Serial Number 

Some items that Convenience Stores sell need to have 
their serial number printed on the receipt.  When such 
an item is scanned/entered, the POS needs to prompt 
the cashier to enter the product’s serial number. 
Enable to prompt for serial number to be printed on the 
receipt. Cashier can either enter the serial number or 
bypass the prompt to complete the transaction.  Serial 
number can be entered via screen keys, hard keys, or 
scanned via scanner. 

Prohibit Manual 
Discount 

Select to prohibit discounts configured to be applied by 
pressing the discount key. Prohibit Discount does not 
affect PLU Promo, NAXML Promo (Combo/MixMatch), or 
Loyalty line item discounts. 
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Field/Button Allowable Value/Function 

Taxable Rebate 
The rebate amount and the taxes applied to the rebate 
amount. 

Retrieve PLUs 

Use the Retrieve PLUs button on Price Look Up Manager to change the form to allow 
retrieval of all PLUs or specific PLUs based on entered criteria. 

 

Field/Button Allowable Value/Function 

Retrieve Page Click to retrieve PLUs that match the criteria entered. 

Done Click to close the Retrieve PLUs form and display the PLU 
entry form. 

Reset Click to delete the entries on the Retrieve PLU page. 

Where 

Enter the PLU return conditions.  

Note: Leaving any of the “Where” conditions blank will return 
all PLUs. For example, entering ‘Milk’ in this field will return 
all PLUs that have the word Milk in their description. 
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Field/Button Allowable Value/Function 

PLU Number Enter the PLU number to retrieve one specific PLU. 

Department Select the department to retrieve all of the items assigned to 
a specific department. 

Product Code Select the product code description to retrieve all of the items 
assigned to a specific product code. 

Order By Select the PLU retrieval order. Click + to retrieve by UPC 
(PLU), Description, Department, Product Code, Price. 

Managed Updates 

The Managed Updates feature provides an interim approval step during the PLU file 
update process and allows updates to take effect within the POS system immediately 
after approval. The business purpose behind the approval step is to allow store 
management to use a 3rd party system (SAP Retail Store) to identify, print and update 
shelf labels as needed for price changes prior to those changes being reflected within 
the POS system. 

Enable Managed PLU Update 

From Store Operations > Sales > Sales Configuration, enable “Enable Managed 
Updates”. 
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Managed Update Security Level 

In Store Operations > Sales > Sales Configuration > Managed Update Security Level, 
enter the security level of the manager who can apply the update. 

 

"Apply Updates" Touchscreen Button 

In Store Operations > Touch Screen > Panel Configuration, select “Add Item” and 
Type as “Function”. Select “Apply Updates” to assign this function to a touch screen 
key or POS key for easy access to the function. 

 

Note: Refer to the Base 53 and Higher feature reference documentation for 
information on configuring the touch screen. The Feature Reference is available 
on The Feature Reference is available on Premier Portal. 
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“PLU File Update Pending” Alarm 

This alarm is posted on the POS in the “Alarm” section of the display.  

After the “PLU File Update Pending” alarm appears on the display, press the Apply 
Updates soft key (configured above) to apply the price updates to the PLU items in 
the system.  

If Managed PLU Updates is disabled, “Feature Not Enabled” is displayed.  

If Managed PLU Update is enabled, Managed PLUs screen with updates or none is 
displayed. 

Pending Updates 

View Pending Managed Updates from Store Operations > Managed Updates. 

 

Reporting 

The PLU Report reflects all PLU sales for a given reporting period.  It provides an 
entry for every price at which a PLU was sold along with a “reason Code” when it is 
sold at a price different than the one stored in the price book. 

                  PLU REPORT 

PLU NUMBER             DESCRIPTION 

 CUST    ITEMS  PRICE    TOT-SALES    RC 

                                        %SALES 

---------------------------------------------- 

    

Sample PLU 
Report for 
All PLUs 
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000000000031/000     MILK 

 2       2.00    2.54     5.08        P 

                                         1.31% 

000000000080/000      2L. SODA 

 3       4.00    1.19      4.76 

                                         1.23% 

000000000135/003     COFFEE CLUB 

 1       1.00    12.00    12.00       G 

                                         3.09% 

000000000141/000    SM FOUNT DR 

         2.00     0.69      1.38 

         5.00     0.55      2.75      D 

 -------- -------- --------------------------- 

 4       7.00               4.13 

                                         1.06% 

000000000141/001     MED FOUNT DR 

 3       4.00     0.89      3.56 

 1       1.00     0.50      0.50      V 

----------- ---------------------------------- 

 4        5.00              4.06 

                                         1.00% 

00000000999/000      ITEM F 

 1        6.00      1.19     7.14     D 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Generic 
Loyalty 
discounted 
price 
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                                         1.84% 

000000000999/000 

 1        1.00      1.25     1.25 

                                         0.32% 

TOTAL ITEMS SOLD:      27.00 

TOTAL SALES:           19.28 

% OF TOTAL SALES:       4.97% 

---------------------------------------------- 

 

Report Details 

 PLU NUMBER: Identification of the product as it appears in the PLU File. This 
includes the PLU number followed by the three-digit modifier. There is a 
separate entry for each PLU/modifier combination. 

 DESCRIPTION: Description of the product as it appears in the PLU File. Items 
without descriptions either do not have descriptions assigned in the PLU File, 
or the item does not exist in the PLU File and was sold with a cashier-assigned 
price. If the PLU does not exist, it is listed separately in the PLU Exception 
Report. Items with the description of “OPEN PLU” have no defined price and 
require the cashier to key a price. 

 CUST: Number of customers (separate completed transactions) who bought the 
item. If the item is sold at more than one price, the number of customers who 
purchased the item at a specific price is listed. 

 ITEMS: Quantity of the item sold. If the item is sold at more than one price, 
the quantity of the item sold at a specific price is listed. 

 PRICE: Price of the item. If the item is sold at more than one price, each price 
is indicated on a separate line. 

 TOT-SALES: Total amount collected for sales of the item. If the item is sold at 
more than one price, the total amount collected at each specific price is 
listed. 
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 RC: Reason code identifies the method used to change the price of an item. 
Line item discounts apply only to non-fuel sales. When Generic Loyalty is in 
effect, the loyalty host does not return fuel line items in the discount detail 
data. 

Reason 
Code 

Description 

  

C The items sold as a part of a combo. 

D 
A discount is applied to the item. The setting of the “Discount (P, A)” 
parameter determines whether the discount is a percentage or amount 
discount. 

M The item sold as part of a match. 

O The item sold at the dispenser card reader. 

P The item sold with a promotion set up in the PLU Promotion File in 
Manager mode. 

PD A promotion applied to an already discounted item. 

PO The item sold from a dispenser card reader with a promotion. 

PV A price override applied to an item already set up as a promotion. See 
“PLU Exception Report.” 

V A price override applied to the item. 

VD A price override applied to an already discounted item. 

 % SALES: Percent of total sales that the item represents. To find this number, 
use one of the following formulas. 

– If departments are used, get the “Total Sales” figure from the Department 
Report: 

Net Department Sales ÷ Total sales of this item 

– If PLUs: are used 

Total PLU Sales ÷ Total sales of this item 
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 TOTAL ITEMS SOLD: Total number of items sold as PLUs. 

 TOTAL SALES: Total amount of PLU sales. 

 % OF TOTAL SALES: Percent of total sales made as PLUs. To find this number, 
add all the %Sales entries in this report. 

Other PLU Related Reports 

 PLU section of the Cashier Tracking Report offers similar totals, but all sales 
for a PLU are represented as a single line entry regardless of the price at which 
it was sold. 

 PLU Exception Report focuses entirely on Price Override and PLU NOT FOUND 
condition sales.  It shows the PLU#, type of exception, original price, sale price 
and cashier ID. 

 PLU Promo Report offers sales of PLUs in promotion only 

Troubleshooting 

      #  Message  Description/Action 

E1109 PRESET NOT USED The soft key has not been defined or the PLU no 
longer exists. 

E1110 PLU TOO LONG PLU entered has too many digits. Key the correct 
PLU. 

E1111 INVALID PLU PLU entered does not exist. Key the correct PLU. 

E1113 NO REFUND 
ALLOWED 

No refund is allowed on this PLU or in this 
department. 

E1197 INVALID PRICE This item does not have a unit price assigned to it 
in the PLU File function in Manager mode. 

E7050 PLU NOT FOUND User attempted to configure a PLU that does not 
exist for one of the CRM programs. 

E7053 PLU CANNOT ALSO 
BE IN A MIX 

CRM programs do not operate with PLU items also 
configured for Mix ‘n Match. 
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      #  Message  Description/Action 

E7054 PLU CANNOT ALSO 
BE IN A COMBO 

CRM programs do not operate with PLU items also 
configured for combo. 

E7055 PLU ALREADY A PART 
OF EPC 

User has to enter a single PLU number more than 
once in the EPC configuration file. 
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POP Discount 
Overview 

The Point of Purchase (POP) Discount feature is a type of automated discount that 
offers fuel at a discounted price based on certain qualifying characteristics in the 
transaction. 

Those characteristics can be the purchase of a specific PLU (perhaps, Car Wash), 
payment with a specific MOP (perhaps, Cash), payment with a specific card type (the 
site’s own payment card type), purchase of a minimum amount from a department 
(perhaps, Premium Fuel) or membership in the site’s loyalty program. 

This broad variety of options is provided to offer flexibility.  Running more than two 
types of POP promotions at the same time can be confusing for the clerks and for the 
customers and is not recommended. 

Note: Fuel Discounts cannot be more than $ 0.99. 

Multiple POP PPG Discounts are allowed in a single transaction. The POS stacks a 
maximum of three POP categories, one from each category: 

• Merchandise Based: PLUs (#), Minimum purchase amount ($), or Min Dept 
 Amount ($ or #) 

• Payment Based: MOP or Card Type 

• Membership/Code Based  

Note: Refer to the POP Discount feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 
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Refunds 
Overview 

Refunds and Sales are separate transaction types and cannot be combined. Refunds 
are subject to additional rules and restrictions; some that can be configured, some 
that are determined by the card processing network and some that are determined by 
your company’s policies and procedures. 

Using Refunds 

Sales and Refunds are separate transaction types and cannot be combined. Any 
Refund must start by selecting REFUND. 

1. Press [REFUND] to indicate that this is a REFUND transaction 

2. If prompted, key the User ID and password 

3. Enter items to be refunded as appropriate 

4. Press [TOTAL] if required 

5. Touch or press the method of payment (MOP) 

The system does not consider the following scenarios as Refunds: 

• Funds returned to customer from Prepay Underrun. 

• Funds returned to customer from a sales transaction with negative line 
items that force the transaction total too be negative. 

Configuring Refunds 

Parameter Path Value Description 

Allow Refund Store Operations > 
PLUs > Properties Yes, No 

Select to allow this MOP to be 
given to a customer when an 
item is refunded. 

Refundable 
Store Operations > 
Payment > MOP Yes, No Select to allow the PLU item 

to be returned for a refund. 
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Parameter Path Value Description 

Refund 
Security 

Store Operations > 
Sales > Sales 
Configuration 

Yes, No 

Enter the security level an 
employee must have to 

perform a refund transaction. 

Entering 1 - 9 indicates 

that an employee with a 
security level of at least that 

number must approve refunds 
(0 - 9). 

0 — Refunds do not require a 
security check. 

Reporting 

                       MOP SALES     
CARD BASED 

     CREDIT     2           50.76 

CASH 

   DOLLAR      18          165.90 

   ARGENTINA    1            7.87 

DRIVE OFF       1           50.00 

INHOUSE         1           10.00 

PUMP TEST       1            1.00 

                ------------------- 

TOTAL MOP SALES             275.53 

                        MOP CANCEL/REFUNDS 

    

  

Sample MOP SALES 
and  MOP 
CANCEL/REFUNDS 
in Cashier 
Report. 

  

MOP totals are 
represented in 
Summary and 
Cashier Reports. 
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CASH            2            2.74 

                                                                 -------------------- 

TOTAL MOP CANCEL/REFUNDS   ( 2.74)    

Report Details 

• MOP SALES: Summary of sales by method of payment (MOP). 

Note: If a foreign currency has been set up in the Currency File that 
currency appears in the CASH section. 

• MOP CANCEL/REFUNDS: Summary of cancelled or refunded transactions. The 
total is displayed in parentheses because the number is negative. 

Troubleshooting 

      #  Message  Description/Action 

E1257 MUST PRESS 
CREDIT 

Part of the Auto-Refund feature. A credit card 
was used to pay for the initial prepay transaction 
and cashier tries to refund the underrun amount 
to any MOP other than credit. 

E1113 NO REFUND 
ALLOWED 

No refund is allowed on this PLU or in this 
department. 

E1150 
REFUND NOT 
ALLOWED ON 
CREDIT SALE 

A credit card purchase cannot be refunded in 
cash. 

E1164 REFUND NOT 
ALLOWED “Refund Allowed” is set to ‘No’. 

E1257 MUST PRESS 
CREDIT 

Part of the Auto-Refund feature. A credit card 
was used to pay for the initial prepay transaction 
and cashier tries to refund the underrun amount 
to any MOP other than credit. 
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Reports Manager 
Overview 

Reports are based on a period such as a shift, a day, a month, or a year in which sales 
are made. These reports show sales on a system-wide basis while Cashier reports 
apply only to a single cashier on a single register. 

Using Reports Menu 

Navigate to CSR Func > Reporting Menu from the POS (While in Sales, CSR Func 
can be located on the right-hand side bottom corner of the screen on Topaz and 
bottom of the screen on Ruby2) to access the following Reporting functions: 

• Cashier Worksheet 

• Close Cashier Report 

• Print Cashier Report 

• Payroll Reports 

• Other Reports 

Key points to remember: 

• Closing a report does not automatically print the report. The Print 
Report functions print the reports. 

• Cashier Close affects only that register 

• A Period Close, closes all registers for inside and outside sales 

• Closing a period closes that period as well as any lower level periods. For 
e.g. “Close Day” function automatically runs a “Close Shift” 

• Flash Reports provide current information for Period 1 (Shift) without 
closing 

Cashier Worksheet 

MOPs printed on the cashier worksheet are based on flags in MOP file. 

1. Touch [Cashier Worksheet] 



Commander Site Controller User Reference 

481 

2. Prints a form to enter the counted amount of each method of payment 
(MOP) during Print Cashier Report function 

Close Cashier Report 

This function calculates sales totals for the cashier; then closes and resets 
drawer totals for the cashier on the terminal where the cashier performed the 
sales. The other registers in the system remain unaffected. 

1. Touch [Close Cashier Report] 

2. Key the cashier number 

3. Touch [OK] or press [ENTER] 

4. Touch [OK] to confirm the sequence 

Print Cashier Report 

Only an employee with the required security level, can print the report. 

For the first time only the systems prompts the cashier to enter the ending 
drawer amounts.  After that, it is simply a reprint using the same amounts. Most 
recently closed report will always be displayed at the top of the list. 

1. Touch [Print Cashier Report] 

2. Key the cashier number 

3. Touch [OK] 

4. In the Cashier Period list, touch the report to print 

5. In the Print Cashier Report overlay, key the amounts of each method of 
payment (MOP) counted in a cashier drawer 

Payroll Reports 

1. Touch [Payroll Reports] 

2. In the Select Payroll Function list, touch [CLOSE] or press [ENTER] 

3. Key <the employee ID> and touch [OK] or press [ENTER] to close all 
employees 
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4. Touch [OK] or press [ENTER] to acknowledge 

Other Reports  

Close Period Reports: 

Touch the reports function or key <entry#> and press [ENTER] 

Print Period Reports: 

1. Touch the reports function or key <entry#> and press [ENTER] 

2. Select the report to be printed 

The available other reports are: 

 Close Shift Report 

 Print Shift Report 

 Close Daily Report 

 Print Daily Report 

 Close Monthly Report 

 Print Monthly Report 

 Close Yearly Report 

 Print Yearly Report 

 Close Carwash Pay Point Period 

 Print Carwash Pay Point Period 

 Funds Audit Report 

 Flash Reports 
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Configuring Reports 

Period Reports are made up of a number of smaller reports. Use Configure Group List 
in Report Configuration form to turn off printing of those reports that should not be 
printed. 

Note: Even if a report is turned off for printing, it will still be generated and so, 
could be printed at a later time. 

Use Reporting to configure reports. 

Report Configuration 

Report Configuration 

Use to configure reports for the selected period. 

 

Field/Button Allowable Value/Function 

Period 
Configuration 

Select the period to be configured. 

Note: This period selection does not apply to the Configure 
Group List. Make sure that the appropriate period is selected 
under the Configure Group List section.  
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Field/Button Allowable Value/Function 

Description The name of the period selected in Period Configuration. 

Delay Between 
Close 

Enter the minimum time that must lapse between period closes 
(0 - 366). 

Unit of Measure Select to define the unit of time between period closes (Hours 
or Days). 

Roll Up DB Reports Allows rolling up of database totals into the next period. (Shift 
always rolls up into Day so selection is not available for Shift.) 
Select ‘Yes’ for other periods to roll data into the next period. 

Store T Log Data Select ‘Yes’ to store transaction log data for periods 1 and/or 2. 

Report Parameters 
-Reclose Security 

Select the security level required to close a period without 
waiting the preset time since the previous period close (1 - 9). 

Force Close 
Pending Security 

Select the security level required to force close a pending 
period (1 - 9). 

Force Cashier 
Closed 

(Applies only if Shift is selected in Period Configuration.) Select 
to automatically close all open cashiers when a Close Shift 
Report is run. 

(If not selected, cashier totals must be closed manually.)  

Note: If “Force Cashier Closed” is selected, do not select 
“Cashier Spans Shifts” or “Force Cashier to Print.” 

Cashier Span Shifts Select if open cashiers are not required to close cashier totals 
when a Close Shift Report is run. If not selected, open cashiers 
must manually close cashier totals when a Close Shift is run. 

Force Cashier to 
Print 

Select to require the cashier to print a cashier report in addition 
to closing. 

Allow Close with No 
Activity 

Select to allow a period close with no transactions. 
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Field/Button Allowable Value/Function 

Allow Suspended 
Sales 

Select to allow a period close when suspended sales are present. 

Configure Group 
List 

Make sure that the appropriate period is selected for configuring 
the group list. Click Edit to add reports to be printed by POS for 
that period. 

Delete 
To prevent a report from printing, select the report in the 
Configure Group List and select Delete. 

Auto End of Day (AEOD) 

Automatic End of Day (AEOD) function performs an automatic close daily at a 
specified time of day even if the POS is not attended by a cashier.  

Note: As part of the AEOD period close, the logged in cashier is logged out of 
the register.  

For a manual period close, on the initiated register cashier will be allowed to 
continue with CSR functions (non-sales activities) as they may need to print 
reports.  Cashier will be logged out of register when trying to return to sales 
function. 

 

Field/Button Allowable Value/Function 

AEOD Enabled Select to automatically perform a close daily. 

Disable Fuel Select to disable fueling during AEOD. 
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Field/Button Allowable Value/Function 

Note: Disable fuel will perform a “Fuel Site Pause” 
function. When Disable fuel is enabled it will prevent 
both new DCR and prepay fuel transactions from 
starting.  Although new fuel sales cannot be approved 
while the pumps are paused, pumps currently 
dispensing fuel are not interrupted. The functionality 
does NOT wait until all fuel positions are idle before 
the Close Day can begin. 

AEOD Time (HH:MM) The time the Close Daily starts. 

Ignore Network Error Select to ignore network error messages during AEOD.  

Forced AEOD 

Note: This feature is only enabled on Buypass Distribution for ExxonMobil brand. If 
other brands want to enable this feature, get in touch with Verifone. For ExxonMobil 
sites running Commander Buypass 3.12.27 (Base 53.24) and higher versions, Automatic 
End of Day (AEOD) feature is now forced. Sites should no longer perform a manual End 
of Day (EOD) Close except when upgrading the software.  

 With this feature, the system will automatically set “AEOD Enabled” field to checked 
and the field is non-editable, and the AEOD time field is also non-editable.  

The AEOD time is set at the site from the EPS during the PDL download. 

 

Override AEOD Security 

When AEOD is forced at the site, only authorized users can perform a manual period 
close.   
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The "Override AEOD Security" field in Configuration Client > Reporting > Report 
Configuration > Report Parameters determines the security level of the person who 
can perform a period close.   

 

When AEOD is not forced at the site, the "Override AEOD Security" field is non-
editable.  

 

When AEOD is forced at a site and if a manual period close is attempted, the 
following warning message is shown.  
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Note: The following prompts depends on the batch close period type set in POS 
configuration. 

 

Clicking YES on the warning message brings the employee login screen to 
check if the user is authorized to do a manual period close.  

 

If the user is not authorized to do a manual period close, a message is 
shown indicating Invalid User and the Period Close is aborted. 

Clicking NO on the warning messages brings up the following message. 
Click OK to continue.   
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Manager Workstation 

Manager Workstation (MWS) allows entries to be adjusted after a period close at the 
POS. Drawer counts and the adjusting entries to the Day Close can be entered at a PC 
located in another area away from the counter.  

Note: Refer to the Manager Workstation Feature Reference for more information 
on the feature. The Feature Reference is available on Premier Portal. 

 

Field/Button Allowable Value/Function 

Manager Workstation 
Enabled Select to enable Manager Workstation. 
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Field/Button Allowable Value/Function 

Max Unaccepted Period 
Reports 

Enter the maximum number of open Days that can be 
allowed. This parameter determines how many 
unaccepted reports can be kept in queue for the 
manager to correct and close. When the reports in 
queue cross this number, the earliest one is auto-
closed. 

Verifone recommends max value as 3 if the close 
period type is Day and max value as 9 if close period 
type is Shift. 

 
Note: Manager Workstation is enabled by default. When this feature is enabled, the 
cashier is prompted to open the connected drawers on day close. To stop this 
prompt, Manager Workstation Enabled box should be unchecked if the site doesn’t 
support this feature.  

Cashier Tracking 

Use to track selected PLUs (up to 50), departments (up to 30) or categories (up to 10) 
by cashier. 

Note: Cashier Tracking reports are printed only as part of a Cashier Report. 
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Field/Button Allowable Value/Function 

PLU Tracking 1. Click Edit. 

2. In the Retrieve PLUs form, enter the conditions and click 
Done or Retrieve Page. 

3. Select PLUs and click Done. 

Department 
Tracking 

1. Click Edit. 

2. In the Added Departments form, select the departments 
and click Done. 

Category Tracking 1. Click Edit. 

2. In the Added Categories form, select the categories and 
click Done. 

Close Car Wash Pay Point Period 

Click Reporting >Close Car Wash Pay Point Period to close car wash pay point 
period. 

Site Asset Data 

This screen contains tabs that has information about site details, POS Terminals, 
Dispenser Data, and Stand-Alone Devices. 

Close Day NOW 

The Close Day NOW function performs a day close.  

Mobile Food Order Report 

Note: Refer to the Mobile Food Order Feature Reference for more information on 
the feature. The Feature Reference is available on Premier Portal. 

Reporting 

See Reports topic for examples of all reports and the report details. 

Troubleshooting 
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  #  Message  Description/Action 

E1206 PAYROLL RECORD 
FULL 

The POS stored as many clock in/outs as it can hold. Run 
the Payroll Report function. 

E2001 ABORT PRINTING NOT 

ALLOWED 

Attempted to stop printing the Close Yearly report. 
Printing this report cannot be aborted. 

E2002 NO CASHIER REPORT 

AVAILABLE 

The Print Cashier Report function has been selected and 
there is no data to print. Choose another report or 
function. 

E2004 INVALID INPUT  An invalid cashier number was entered or an 
invalid key was pressed when trying to close a 
cashier. 

 An invalid number was entered to list the PLU or 
department data. 

 An invalid choice was entered when prompted to 
print a current or close a Payroll Report. 

 An invalid cashier number was input for the 
Payroll Report. 

Enter the correct information. 

E2005 CASHIER NOT OPEN Attempted to run the Close Cashier function in Reports 
mode and the specified cashier has not logged in. 

E2006 INVALID EMPLOYEE 

NUMBER 

Logged in with an invalid ID. Re-enter the correct 
number. 

E2007 INVALID CASHIER 
REPORT AMOUNT 

Entered 0.00 for an MOP amount when printing a Cashier 
Report and the “Allow $0.00 Entry” parameter is set to 
‘N’ in the MOP File. Re-enter the information. 

E2008 NO REPORTS 
AVAILABLE 

The selected period report has not been closed yet. Run 
the close period report first. This occurs in the Print 
Shift, Daily, and Monthly report functions in Reports 
mode. 
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  #  Message  Description/Action 

E2009 ACCESS DENIED Attempted to print a report or close a period with a 
security level lower than that set in Manager > Security 
Control > Report Functions. Check with your manager to 
get access to this function. 

E2010 UNABLE TO OPEN 
TANK MONITOR PORT 

Selected the Tank Monitor Report for printing but the 
appropriate COM port could not be opened. Check for 
loose connections in the back of the POS. 

E2011 NO RESPONSE FROM 
TANK MONITOR 

Selected Tank Monitor Report for printing but the POS 
did not receive a response from the TLS. A servicer 
should check the communications between the TLS and 
the POS. 

E2012 ERR CLSING MO PRD The period could not be closed on the money order 
device. 

See the money order terminal documentation for 
instructions. 

E2014 DUE SALES PENDING An Automatic End of Day (AEOD) has started while there 
are due sales on the register or when sales are in 
progress. If AEOD is configured with "Wait for no due 
sales", then after the due sales are completed and the 
registers are idle, the AEOD will start.  

E2015 FUEL PUMPS NOT IDLE An Automatic End of Day (AEOD) has started while fuel 
pumps in use. If AEOD configured with  "Fuel idle wait 
time (minutes)” not equal to zero, then after the fuel 
pumps idle for the time period mentioned, the AEOD will 
start.  
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Reports 
Overview 

This topic contains instructions for the following report functions: 

• Cashier Reports 

• Close Cashier Report 

• Print Cashier Report 

• Cashier Worksheet 

• Period Reports 

• Shift Reports 

• Close Shift Report 

• Daily Reports 

• Close Daily Report 

• Monthly Reports 

• Close Monthly Report 

• Yearly Reports 

• Close Yearly Report 

• Payroll Reports 

• Flash Reports 

• Print Current Cashier Report 

Report Configurations 

All possible report functions are described in this topic. See the following table for 
the functions that appear in the system. 
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  POS Reporting Menu Functions 

1 Close Cashier Totals 

2 Print Cashier Report 

3 Cashier Worksheet 

4 Print Current Cashier Report 

5 View Amber 

6 Close Shift Report 

7 Close Daily Report 

8 Close Monthly Report 

9 Close Yearly Report 

10 Close Carwash Pay Point Period 

11 Print Shift Report 

12 Print Daily report 

13 Print Monthly Report 

14 Print Yearly Report 

15 Print Carwash Pay Point Period 

16 Payroll Reports 

19 Funds Audit Report 

20 Flash Reports 

Report Periods 

A system can have reports for up to 60 cashiers and for up to four periods. 
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• The Cashier Report calculates totals for a single cashier on a single register. 

• Shift is the smallest amount of time that contains report totals for all registers 
and cashiers. 

• Yearly is the largest amount of time that contains report totals for all registers 
and cashiers. 

• The Current Cashier Report prints the current totals for cashiers without having 
to close the shift. 

Note: Closing a period will close all smaller periods.  For example, if a Close Daily is 
performed, it will also close any open cashiers, then it will close any open shifts, and 
then it will close the open day.  

See the example below: 

 

The example displays a two-period system. The following period closings were done: 

• Close Shift 1  

• Cashiers 1 and 2 close. The cashier totals reset to 0. 
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• The shift closes for the 12 A.M. to 8 A.M. period. The shift totals reset to 
0. 

• Close Shift 2  

• Cashiers 3 and 4 close. The cashier totals reset to 0. 

• The shift closes for the 8 A.M. to 4 P.M. period. The shift totals reset to 
0. 

• Close Daily (includes Close Shift 3 )  

• Cashiers 5 and 6 close. The cashier totals reset to 0. 

• The shift closes for the 4 P.M. to 12 A.M. period. The shift totals reset to 
0. 

• The day closes the three shifts (12 A.M. to 12 A.M.). The daily totals 
reset to 0. 

Cashier Reports 

Close Cashier Totals 

The Close Cashier Totals function closes and resets drawer totals. A cashier’s totals 
can be closed by the cashier who entered Sales mode and used the drawer, or another 
employee, such as a manager, who has a higher security level than the cashier. In a 
multiterminal system, the totals are closed for the cashier on the terminal where the 
close is done. If a cashier has sales on more than one terminal, the cashier totals must 
be closed on each terminal separately. 

In Configuration Client, If the “Force Cashier Closed” setting in Report Configuration 
is selected, then each open cashier is closed automatically when a Close Shift 
function is run. 

Note: The Cashier Report is not printed when performing the Close Cashier Totals 
function.  This allows the cashier whose shift is over to take the closed drawer to 
another location and count it while a new cashier starts working on a new drawer. 
 When the cashier finishes counting their drawer, they can then use the Print Cashier 
Report function and enter the totals from their Cashier Worksheet. 

Print Cashier Report 

The Print Cashier Report function prints any one of the last three cashier closes for a 
specific cashier. A Cashier Report can be printed by the cashier who entered Sales 
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mode and ran transactions or another employee, such as a manager, who has a higher 
security level than that cashier. The first time a Cashier Report prints, the POS 
prompts for the amount of each method of payment. The amounts the cashier enters 
are compared to the totals the terminal has calculated. If a Cashier Report prints 
more than once, then the POS does not prompt for MOP amounts. 

If the Cashier Report prints again after the totals have been entered, the report prints 
with no questions. 

Cashier Changes 

The Cashier Report is not printed when the report is closed. This allows the cashier 
who is leaving to close totals, remove the drawer, and go into another room to count 
the drawer. The new cashier can put another drawer in and start work right away. 

The cashier who is counting the closed drawer can enter the amount of each method 
of payment on the Cashier Worksheet. Then, when there is a break in customer 
activity, the cashier can run the Print Cashier Report function, enter the totals from 
the worksheet, and print the report. 

MOP File 

The Method of Payment types that are prompted for when performing the Print 
Cashier Report function are configured on Configuration Client > Store Operations > 
Payment > MOP tab.  On each MOP, selecting the “Cashier Report Prompt” setting 
determines if that MOP type will prompt. 

Sample Cashier Worksheet 

The Print Worksheet function prints a form to record the amounts of each method of 
payment when counting a closed drawer.  The totals on this worksheet are then used 
when performing the Print Cashier Report function. 

CASHIER WORKSHEET 

  CASHIER #001 CORPORATE 

AMOUNTS AT CLOSE 

  DOLLAR            ___________________   

  CHECK              ___________________   
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  CREDIT             ___________________   

  DEBIT                ___________________   

  MAN CRED         ___________________   

  IN-HOUSE           ___________________   

  ELECTR FS          ___________________   

  LOTTO               ___________________   

  DRIVE OFF          ___________________   

  COUPON            ___________________ 

Sample Cashier Report 

03/25/02 15:02 

CASHIER REPORT #001 

REG# 01 CASHIER #01 JO MARCH 

RCPTS: 056-084 TOT=030 ACT=030 

OPEN CASHIER 03/25/02 10:43 

CLOSE CASHIER 03/25/02 11:45 

CASHIER REPORT #002 

REG #101 CASHIER #01 CORPORATE 

RCPTS: 1010003-1010122 TOT=120 ACT=120 

OPEN CASHIER 10/15/14 12:35 

CLOSE CASHIER 10/16/14 19:04 

--------------- SUMMARY ---------------- 
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BEGINNING CASH                                    1000.00  

MOP SALES                                              1128.93  

MOP CANCEL/REFUNDS                            (  16.49) 

                                                           ------------ 

NET SALES TOTAL                                  2112.44  

PAYMENT OUT                                     (  109.00) 

PAYMENT IN                                              21.00  

                                                           -------------- 

TOTAL TO ACCOUNT FOR                        2024.44  

----------- CASHIER DETAILS ------------ 

               MOP SALES 

CARD BASED 

  CREDIT                                    28    244.06           

CASH 

  DOLLAR                                    37    842.91           

MAN CRED                                    3     25.00           

Special Discount                           1      0.05           

Pump Test                                    1     16.91           

                                       -------------------------------------- 

TOTAL MOP SALES                             1128.93 

           MOP CANCEL/REFUNDS 

CASH                                              1     15.00           
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CREDIT                                           1       1.49           

                                        --------------------------------------- 

TOTAL MOP CANCEL/REFUNDS                 16.49  

              PAYMENT OUT                

PAY OUT                                            1      10.00 

SAFE DROP 

  CASH                                               1      99.00            

                                                         ------------------------- 

  TOTAL SAFE DROP                                    99.00 

                                                            ------------------------ 

TOTAL PAYMENT OUT                               (109.00) 

               PAYMENT IN                

SAFE LOAN                                        1       10.00 

IN HOUSE                                          2       11.00 

                                                          ---------------------- 

TOTAL PAYMENT IN                                     21.00 

----------------------MEMO ITEMS -------------------------------- 

#ITEMS                            274                

#CUSTOMERS                     76                

DISCOUNTS                         9                        28.56 

ERR/CORRECTS                   3                        21.58 

VOID LINES                         1                          1.49 
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VOID TICKETS                    29                      348.97 

SUSPEND/SETTLE                1                        35.00 

PAY OUT 

          ---------------------- TOTALS ------------------------------ 

TOTAL FUEL SALES                              181.05 

TOTAL MERCH SALES                           905.51 

TOTAL TAXES                                        26.18 

------------------------ TRANSACTION TIMINGS -   (in seconds) 

                                                 MAX              AVG 

TOTAL                                        759             18.00       

NETWORK                                  195               9.00       

NETWORK SUSPENDED                   0               0.00       

END OF TICKET                          293               0.00       

-------------------------- AMOUNTS AT CLOSE --------------------------- 

                              ECR              ACTUAL          OVER(SHORT) 

                       -----------------------------------------------------------------
- 

CASH                   1739.91         100.00               (  1639.91) 

CHECK                       0.00           10.00                      10.00  

CREDIT                   242.57           20.00               (   222.57) 

DEBIT                         0.00          30.00                     30.00  

MAN CRED               25.00          40.00                      15.00  

IN-HOUSE                    0.00         50.00                     50.00  
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ELECTR F                    0.00       600.00                   600.00  

FOODSTAM                 0.00         70.00                     70.00  

LOTTO                        0.00         80.00                    80.00  

DRIVE OF                     0.00         90.00                      90.00  

Special                        0.05                       

Pump Test                  16.91                       

EBT                              0.00           5.00                       5.00  

                          -------------------------------------------------------------- 

TOTAL                      2007.48       1095.00             (   912.48) 

MISC MOP                   16.96                       

                      ------------------------------------------------------------------ 

GROSS                      2024.44                       

CASH PASSED:  $__________________ 

TO: X___________________________________ 

CASHIER SIGNATURE: 

X_______________________________________  

Report Details 

Report Header 

These items define the period’s beginning and end, and the cashier for whom the 
report was run. 

• REG#: Register for which the Cashier Report was run. 

• CASHIER#: ID and name of the employee who used the register. 

• RCPTS: Beginning and ending receipt numbers issued during the cashier period. 
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• TOT: Total number of receipts printed on this terminal. 

• ACT: Total number of receipts used by this cashier. The number is different 
from the number of receipts (TOT) if more than one cashier entered Sales 
mode on the same terminal during the report period. 

• OPEN CASHIER: Date and time this cashier started using the register. 

• CLOSE CASHIER: Date and time this register was closed. 

SUMMARY 

This section summarizes the main totals calculated in other parts of the report and 
provides the total amount that should be in the closed drawer. 

• BEGINNING CASH: Amount with which cashier started the drawer. 

• MOP SALES: Total amount from the MOP SALES section. 

• MOP CANCEL/REFUNDS: Total amount from the MOP CANCEL/REFUNDS 
section. 

• NET SALES TOTAL: Total amount in sales transacted for the drawer. 

• PAYMENT OUT: Total amount from the PAYMENT OUT section. 

• PAYMENT IN: Total amount from the PAYMENT IN section. 

• TOTAL TO ACCOUNT FOR: Total amount that should be in the closed drawer. 

CASHIER DETAILS 

• MOP SALES: Summary of sales by method of payment (MOP). 

Note: If a foreign currency has been set up on the Configuration Client > Store 
Operations > Payment > Currencies tab, the foreign currency appears in the 
CASH section. 

• MOP CANCEL/REFUNDS: Summary of cancelled or refunded transactions. The 
total is displayed in parentheses because the number is negative. 

• PAYMENT OUT: Summary of transactions in which money was removed from 
the drawer. The total is displayed in parentheses because the number is 
negative. 
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• PAY OUT: Money removed from the drawer to purchase an item for the 
store or to pay a bill. This item includes payments to vendors made with 
money orders as the MOP. This total represents the total of all pay outs. 
Pay outs appear separately in the Memo Items section. 

• CHANGE/CHECK: Transactions in which cash is returned to the customer 
because the check was tendered for more than the transaction amount. 

• SAFE DROP: Money removed from the drawer and placed in a safe at the 
site. This usually happens when the amount of a method of payment in 
the drawer is more than the amount allowed in the drawer at one time. 
Safe drops are grouped by method of payment. The total of all safe 
drops prints. 

• PAYMENT IN: Summary of non-sales transactions in which payment was added 
to the drawer. 

• PAY IN: Cash added to the drawer from a non-sales payment. This 
represents the total of all pay ins. Pay ins appear separately in the 
Memo Items section. 

• SAFE LOAN: Cash added to the drawer from the site safe. This usually 
occurs when more change is needed. 

MEMO ITEMS 

Various transaction-related items have happened but they either do not affect totals 
or have already been counted in totals. 

• #ITEMS: Quantity of items sold. Each of the following counts as one item: 

 Fuel sale 

 Fee/charge, separate items for each type 

 Negative fees such as bottle returns. These count as refunded 
items. 

 Cashback 

 Cashback fee, separate from the cashback itself 

• #CUSTOMERS: Number of customers (individual transactions). 

 If a prepay fuel sale has an underrun or is refunded due to a 
reserve stop, the resulting refund is counted as the same 
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customer as the original fuel sale. In other words, this does not 
increase the number of customers. 

 A void ticket does not increase the number of customers. 

• #NO-SALES: Number of times the [NO SALE] key has been pressed. 

• #LOGIN OVERRIDES: Number of times a login override was allowed. 

• DISCOUNTS: Number of times and total amount of discounts. This includes 
discounts from: 

 Use of the [DISC] , [DISC%] , and [DISC AMT] keys 

 Combo, mix ’n match, fuel, and promotional discounts 

• ERR/CORRECTS: Number of times and total amount caused by using the 
[ERROR CORR] key. 

• VOID LINES: Number of times and total amount caused by using the [VOID 
LINE] key. This does not include lines voided as part of a void ticket. 

• VOID TICKETS: Number of times and total amount caused by using the [VOID 
TICKET] key. This includes a line for positive amounts and a line for negative 
amounts. 

• SUSPENDED: Number of times and total amount of suspended transactions. This 
happens when the [SUSPEND] key is used to suspend and then recall a 
transaction. If a single transaction is suspended more than once, each time the 
transaction is suspended adds to the total number and amount of suspends. 

• SUSPEND/VOID: Number of times and total amount of suspended transactions 
that were voided rather than settled. 

• UNSETTLED SUSPENDS: The number and amount of transactions suspended at 
the time a period is closed. 

• #SAFE DROP CANCELS: Number of times a Safe Drop operation is cancelled. 

Note: After an MOP is entered for the Safe Drop, [EXIT] does not 
produce a Safe Drop Cancel. Instead a Safe Drop with a reference number 
of zero occurs. If a number is entered but [EXIT] is pressed instead of an 
MOP, the Safe Drop is cancelled. 

• UNSOLD PRICE CHECKS: The number and amount of items that were price 
checked, but were not sold. 



Commander Site Controller User Reference 

507 

• PAY IN: Each pay in made, its reference number, and the amount paid in. The 
first 25 pay ins appear. 

• PAY OUT: Each pay out made, its reference number, and the amount paid out. 
The first 25 pay outs appear. 

• VENDOR PAYMENTS: Number and total amount of payments made to vendors 
by money order. 

POP DISCOUNT TOTALS 

This section displays POP discounts applied as pre-dispensed or post-dispensed 
discounts. It also summarizes total discounts earned and redeemed. 

TOTALS 

Summary of totals by fuel, fuel discount, merchandise, and taxes in sales; beginning 
and ending overall and sales totals. 

• TOTAL FUEL SALES: Total amount of fuel sold. 

Note: The totals do not include dispenser card reader sales. 

• TOTAL FUEL DISCOUNT: Total amount discounted on fuel sales. 

• TOTAL MERCH SALES: Total amount of merchandise sales. 

• TOTAL TAXES: Total amount of taxes collected. 

TRANSACTION TIMINGS 

The length of time, in seconds, it took to complete various transactions. Timings are 
displayed as the longest time it took to complete any one transaction and the average 
time it took to complete a transaction. 

• TOTAL: The total time a transaction takes from the first item that is 
entered to the end when the ticket is finished. The ticket is finished in 
one of two ways: 

 The drawer is closed. 
 The “Ready for sale” prompt returns to the Operator Display if 

the drawer is not opened for the MOP. 
• NETWORK: The total time from the moment a card is swiped (or 

manually entered) to the time a response is received from the host. 

• NETWORK SUSPENDED: The total time from the moment a card is 
swiped (or manually entered) to the time the transaction is returned 
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from being suspended. This occurs when a cashier suspends a transaction 
that is waiting for a network response to wait on the next customer. 

• END OF TICKET: The total time from the moment the last MOP was 
entered until the ticket is finished. The ticket can be finished in one of 
two ways: 

 The drawer is closed. 
 The “Ready for sale” or “NO DUE SALES” prompt returns to the 

Operator Display if the drawer is not opened for the MOP. 

AMOUNTS AT CLOSE 

The totals by method of payment calculated by the terminal and by the cashier. 

• All Currency at Close 

 ECR: Total for each method of payment as calculated by the 
terminal (electronic cash register). 

 ACTUAL: Total for each method of payment as calculated by the 
cashier. 

 OVER (SHORT): Amount of difference between the ECR and 
ACTUAL entries. If the cashier counted more than the terminal 
did, the number is positive. If the cashier counted less than the 
terminal did, the number is negative, which is displayed by 
parentheses around the number. 

• FOREIGN CURRENCY AT CLOSE: The totals by method of payment 
calculated by the terminal and the cashier.  This section appears if an 
alternate (foreign) currency is defined on the Configuration Client > 
Store Operations > Payment > Currencies tab. 

 ECR: Total for the foreign method of payment as calculated by 
the terminal (electronic cash register). 

 ACTUAL: Total for the foreign method of payment as calculated 
by the cashier. 

 OVER (SHORT): Amount of difference between the ECR and 
ACTUAL entries. If the cashier counted more than the terminal 
did, the number is positive. If the cashier counted less than the 
terminal did, the number is negative, which is displayed by 
parentheses around the number. 

• CURRENCY CONVERSION: The total tendered amount in other currency, 
the exchange rate, and the value of the total other currency amount. 
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• CASH PASSED: Amount of money passed from the closing cashier to the 
opening (next) cashier, if any. 

• TO: Signature of the opening cashier. The opening cashier should count 
the money passed with the drawer from the closing cashier and sign at 
this place to display that the amount of money listed is there. 

• CASHIER SIGNATURE: Closing cashier’s signature. The closing cashier 
should sign on the line to show agreement with the information in the 
report. 

TRACKING REPORT 

This section summarizes PLUs, departments, categories, and tax exemptions that are 
configured to be tracked.  Tracked PLUs, departments, and categories are set up in 
Configuration Client > Reporting > Cashier Tracking.  Fuel tax exemptions are set up 
in Configuration Client > Forecourt > Fuel Tax Exempt. 

Note: Tracked PLUs and departments sold as part of a combo or mix and match 
are not reported separately. 

PLU Section 

• NR.: The PLU tracking number. 

• PLU NUMBER: PLU number set in Configuration Client > Merchandise 
Sales > PLUs. 

Note: A PLU labeled as “OTHER” in this report includes all PLUs that are 
not set up for tracking in Configuration Client > Reporting > Cashier 
Tracking. 

• CUST: Number of customers (separate, completed transactions) who 
bought this item. 

• QTY: Quantity of the item sold. 

• AMOUNT: Total amount of the items sold.  This column includes discount 
prices for PLUs sold in combos, mix & matches, and PLUs sold for $0.00. 

Department Section 

• NR: The department tracking number. 

• DEPT#: Four-digit number for the department set on the Configuration 
Client > Merchandise Sales > Merchandise > Departments tab.  

Note: A department labeled as “OTHER” in this report includes all 
departments that are not set up for tracking in Configuration Client > 
Reporting > Cashier Tracking. 
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• DESCRIPTION: Description of the department as it appears on the 
Configuration Client > Merchandise Sales > Merchandise > Departments 
tab. 

• CUST: Number of customers (separate, completed transactions) who 
bought items in this department. 

• ITEMS: Quantity of items sold in this department. 

• GROSS: The total sale amount for this department. 

• REFUNDS: The total refund amount for this department. 

• DISCOUNTS: The total discount amount for this department.  This 
column includes discounts from the use of the [DISC] key, [DISC%] key, 
[DISC AMT] key, combo and match sales, fuel discounts and promotional 
discounts. 

• NET SALES: The total amount of items sold in this department. 

• TOTAL: The total amount for gross sales, refunds, discounts, and net 
sales. 

Category Section 

• NR: The category tracking number. 

• CAT#: Three-digit number for the category set on the Configuration 
Client > Merchandise Sales > Merchandise > Categories tab. 

Note: A category labeled as “OTHER” includes all categories that are not 
set up for tracking in Configuration Client > Reporting > Cashier 
Tracking. 

• DESCRIPTION: Description of the category as it appears on the 
Configuration Client > Merchandise Sales > Merchandise > Categories tab. 

• CUST: Number of customers (separate, completed transactions) who 
bought items in this category. 

• QTY: Quantity of items sold in this category. 

• NET SALES: The total amount of items sold in this category. 

FUEL TAX EXEMPTION REPORT 

• DESCRIPTION: Description of the tax as it appears in Configuration Client 
> Forecourt > Fuel Tax Exempt. 

• CUST: Number of customers who completed sales qualifying for a tax 
exemption or addition. 

• VOLUME: Amount of fuel dispensed for each exempted or added tax. 

• EXEMPT AMT: The total amount exempted or added for each completed 
fuel sale. 
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Shift Reports 

The Close Shift function closes all totals for the Shift. The totals reset to zero. 

Close Shift 

Force Cashier Closed 

If cashier closes are forced before a shift is closed, then all cashiers must exit Sales 
mode before the Close Shift report can be processed. 

Period Close Restriction 

Period Restrictions can be set up in Configuration Client > Reporting > Report 
Configuration.  Restrictions that can be changed are: 

• The minimum amount of time required between period closes 

• The minimum-security level required to perform a period close 

When no time period is defined, the POS reverts to default settings. 

Daily Reports 

The Close Daily Report function closes all totals for the first (Shift) and second periods 
(Daily). The totals are reset to zero. 

The Print Daily Report function provides a list of the last two daily closes to choose 
from for reprinting. 

Close Daily 

Force Close Cashier 

If cashier closes are forced before a day is closed, then all cashiers must exit Sales 
mode before the Close Daily report can be processed. 

Period Close Restriction 

Period Restrictions can be set up in Configuration Client > Reporting > Report 
Configuration.  Restrictions that can be changed are: 

• The minimum amount of time required between period closes 

• The minimum-security level required to perform a period close 

When no time period is defined, the POS reverts to default settings. 
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Monthly Reports 

The Close Monthly Report function closes all totals for the first (Shift), second (Daily) 
and third (Monthly) periods. The totals are reset to zero. 

The Print Monthly Report function displays the last monthly close for reprinting. 

Close Monthly 

Force Close Cashier 

If cashier closes are forced before a shift is closed, then all cashiers must exit Sales 
mode before the Close Monthly report can be processed because the Close Monthly 
function also closes the shift and day. 

Period Close Restriction 

Period Restrictions can be set up in Configuration Client > Reporting > Report 
Configuration.  Restrictions that can be changed are: 

• The minimum amount of time required between period closes 
• The minimum-security level required to perform a period close 

When no time period is defined, the POS reverts to default settings. 

Yearly Reports 

The Close Yearly function closes all totals for first (Shift), second (Daily), third 
(Monthly), and fourth (Yearly) report periods. The totals are reset to zero. 

Note: Totals from the Close Yearly are not saved. 

Close Yearly 

Force Close Cashier 

If cashier closes are forced before a shift is closed, then all cashiers must exit Sales 
mode before the Close Yearly report can be processed. This is because the Close 
Yearly function also closes Shift, Daily, and Monthly. 

Period Close Restriction 

Period Restrictions can be set up in Configuration Client > Reporting > Report 
Configuration.  Restrictions that can be changed are: 
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• The minimum time during which additional period closes are restricted 

• The minimum security level required to override the restriction 

When no time period is defined, the POS reverts to default settings. 

Payroll Report 

The Payroll Reports function closes payroll for employees who clocked in and clocked 
out since the last Payroll Report close was processed and resets total hours to zero. 

1. Touch [Payroll Reports] 

2. In the Select Payroll Function list, touch [CLOSE] or press [ENTER] 

3. Key <the employee ID> and touch [OK] or press [ENTER] to close all 
employees 

4. Touch [OK] or press [ENTER] to acknowledge 

If no employees have clocked in or out during the payroll period chosen, “*** No 
Records Found ***” prints on the report. 

Flash Reports 

The Flash Reports function prints specific parts of a Current Shift report. The section 
printed contains the data collected from the beginning of the shift (period 1) up to 
the point that the Flash Report is run. Flash Reports do not reset totals. 

Samples and details of the following Flash Reports are included in this section: 

• Print Summary Report 

• Print Category Report 

• Print Deal Report 

• Print Department Report 

• Print Hourly Report 

• Print Loyalty Report 

• Print PLU Report 

• Print PLU Promotion Report 

• Print Tax Report 

• Print Fuel Autocollect Report 

• Print Fuel Blend Product Report 

• Print Fuel Dispenser Report 



Reports 

514 

• Print Fuel FP/Hose Report 

• Print Fuel FP/Hose Running Report 

• Print Fuel FP/Hose Test Report 

• Print Fuel PR/Price Level Report 

• Print Fuel Price Change Report 

• Print Fuel SL/Price Level Report 

• Print Fuel Tank Report 

• Print Fuel Tier Product Report 

• Print DCR Statistical Report 

• Print POP Discount Report 

• Print POP Discount Definition Report 

• Print POP Discount Program Report 

• Print Network Card Report 

• Print Network Product Report 

• Print Carwash Pay Point Report 

• Print E-Safe Content Report 

• Print E-Safe End of Day Report 

• Print Tank Reconciliation Report 

• Print Proprietary N/W Card Report 

• Print Proprietary N/W Product Report 

• Print Cash Acceptor Report 

Sample Flash Report Header 

This section prints at the top of every Flash Report. 

FLASH SHIFT REPORT 

09/15/14                       1:57 

STORE#  AB123 REGISTER# 01 SHIFT# 015 

CASHIER  #001 JO MARSH 

REGISTER # 1  Receipt #092 to #199 
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OPEN SHIFT  09/15/14 12:03 

CLOSE SHIFT PENDING 

Report Details 

• Date/Time: Date and time the Flash Report was run. 

• STORE#: Store number as defined in Configuration Client > Store 
Operations > Sales > Store Number. 

• REGISTER#: Number of the register where the Flash Report is run. 

• SHIFT#: Shift (period 1) during which the Flash Report is run.  

• CASHIER #: Number (employee ID) and name of the employee who ran 
the Flash Report. 

• Receipt: Numbers of the receipts included in this report. 

• OPEN SHIFT: Time the shift started. 

• CLOSE SHIFT: Always displays “PENDING” because a Flash Report reports 
on an open period. 
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Summary Report 
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The Summary Flash Report provides an overview of all sales from the beginning of the 
current period up to the time the Flash report is printed. 

In a multi-terminal system, the report includes all registers together.  

If the necessary parameters are set, the site may have Autocollect Inside. 
Autocollect transactions that are recalled inside on a POS do not appear in the 
Autocollect Report. They appear in the fuel totals and in the credit and cash 
section of that register’s Summary Report. 

Note: In general, Summary Report items that have a $0.00 balance at the time 
the report prints or closes, are not included in the report.  
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Report Details 

SUMMARY 

• MOP SALES: The total sales amount by method of payment. 

• MOP CANCEL/REFUNDS: The total amount of cancelled or refunded 
transactions. The total is in parentheses because the number is negative. 

• NET SALES TOTAL: The total amount tendered after cancellations and 
refunds are deducted. 

• PAYMENT IN: The total amount of non-sales transactions that added 
payment to the drawer. 

• PAYMENT OUT: The total amount of non-sales transactions that removed 
money from the drawer. The total is in parentheses because the number 
is negative. 

• TOTAL TO ACCOUNT FOR: Calculated using the following: 
+ Net sales total 

- Payment out 

+ Payment in 

CASHIER DETAILS 

• MOP SALES: Summary of sales by method of payment. 

 CASH: If a foreign currency is set up in the Configuration Client > 
Store Operations > Payment > Currencies tab, that currency is 
displayed in the CASH section. If more than one foreign currency 
is used during the period, only the last currency used is displayed 
on the report. However, the total includes all currencies entered. 

 MOP CANCEL/REFUNDS: The total amount of canceled or refunded 
transactions. The total is in parentheses because the number is negative. 

 PAYMENT OUT: Summary of transactions in which money is removed 
from the drawer. The total is in parentheses because the number is 
negative. If a customer requests cashback on a debit sale, that amount 
appears here. 

 PAY OUT: Money removed from the drawer to purchase an item 
for the store or to pay a bill. This represents the total of all pay 
outs. Pay outs are listed separately in the Memo Items section. 

 CHANGE/CHECK: The total of cash returned to customers who 
write a check for more than the amount of the transaction. 

 SAFE DROP: Money removed from the drawer and placed in a safe 
at the site. This usually happens when the amount of a method of 



Reports 

520 

payment in the drawer is more than the amount allowed in the 
drawer at one time. Safe drops are listed only if at least one safe 
drop is done. Safe drops are grouped by method of payment. The 
total of all safe drops prints. 

 PAYMENT IN: Summary of non-sales transactions in which payment is 
added to the drawer. When a customer returns a cashback amount on a 
debit refund, that amount appears here. 

 PAY IN: Cash added to the drawer from a non-sales payment. This 
represents the total of all pay ins. Pay ins list separately in the 
Memo Items section. 

 SAFE LOAN: Cash added to the drawer from the site safe. This 
usually occurs when more change is needed. 

MEMO ITEMS 

Various transaction-related items that either do not affect totals or have already been 
counted in totals. 

• #ITEMS: Quantity of items sold. 

• This number has two decimal places to include items sold by 
weight. 

• A fuel sale is counted as one item. 

• If a prepay fuel sale has an underrun or is refunded due to a 
reserve stop, the resulting refund is counted as the same item as 
the original fuel sale. In other words, this does not increase the 
number of items. 

• Bottle deposits count as items. 

• Bottle returns are treated as refunded items. 

• #CUSTOMERS: Number of customers (individual transactions). 

• If a prepay fuel sale has an underrun or is refunded due to a 
reserve stop, the resulting refund is counted as the same 
customer and does not increase the total number of customers. 

• A void ticket does not increase the number of customers. 

• #NO-SALES: Number of times the [NO SALE] key has been pressed. 

• #LOGIN OVERRIDES: The number of times login overrides were allowed. 

• DISCOUNTS: Number of times and total amount of discounts. This 
includes discounts from: 

• Use of the [DISC] , [DISC%] , and [DISC AMT]keys 

• Combo, mix ’n match, fuel, and promotional discounts 
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• ERR/CORRECTS: Number of times and total amount caused by using the 
[ERROR CORR] key. 

• VOID LINES: Number of times and total amount caused by using the 
[VOID LINE] key. This does not include lines that were voided as part of a 
void ticket. 

• VOID TICKETS: Number of times and total amount caused by using the 
[VOID TICKET] key. This includes a line for positive amounts and a line 
for negative amounts. 

• SUSPENDED: Number of times and total amount of suspended 
transactions. This happens when the [SUSPEND] key is used to suspend 
and then recall a transaction. If a transaction is suspended more than 
once, each time the transaction is suspended adds to the total number 
and amount of suspends. 

• SUSPEND/VOID: Number of times and total amount of suspended 
transactions that are voided rather than settled. 

• UNSETTLED SUSPENDS: The number and amount of transactions that are 
suspended at the time a period is closed. 

• #SAFE DROP CANCELS: Number of times a Safe Drop operation is 
cancelled. 

Note: After an MOP is entered for the Safe Drop, [EXIT] does not 
produce a Safe Drop Cancel. Instead a Safe Drop with a reference 
number of zero occurs. If a number is entered but [EXIT] is pressed 
instead of an MOP, the Safe Drop is cancelled. 

• UNSOLD PRICE CHECKS: The number and amount of items that are price 
checked, but not sold. 

• COIN DISPENSER: Number of times and total amount dispensed. 

• RESERVE/STOP: Number of times and total amount caused when a 
reserve stop function is performed. 

• RESERVE/APPROVE: Number of times and total amount caused when a 
reserve approve function is performed. 

• PAY IN: Each pay in made, its reference number, and the amount paid 
in. The first 25 pay ins are listed. 

• PAY OUT: Each pay out made, its reference number, and the amount 
paid out. The first 25 payouts are listed. 

• VENDOR PAYMENTS: Number and total amount of payments made to 
vendors by money order. 
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Print POP DISCOUNT TOTALS 

This section displays POP discounts applied as pre-dispensed or post-dispensed 
discounts. It also summarizes total discounts earned and redeemed. 

FUEL TAX EXEMPTION 

Totals of fuel taxes that are exempt or added to postpay fuel sales. 

• DESCRIPTION: Description of the tax as it appears in Configuration Client 
> Forecourt > Fuel Tax Exempt. 

• CUST: Number of customers who completed sales qualifying for a tax 
exemption or addition. 

• VOLUME: Amount of fuel dispensed for each exempted or added tax. 

• EXMPT AMT: The total amount exempted or added for each completed 
fuel sale. 

TRANSACTION TIMINGS 

The length of time, in seconds, it took to complete various transactions. Timings are 
displayed as the longest time it took to complete any one transaction and the average 
time it took to complete a transaction. 

• TOTAL: The total time a transaction takes starting from the first item 
that is entered and ending when the ticket is finished. The ticket can be 
finished in one of two ways: 

• The drawer is closed. 

• The “Ready for sale” or “NO DUE SALES” prompt returns to the 
Operator Display if the drawer is not opened for the MOP. 

• NETWORK: The total time from the moment a card is swiped (or 
manually entered) to the time a response is received from the host. 

• NETWORK SUSPENDED: The total time from the moment a card is swiped 
(or manually entered) to the time the transaction is returned from being 
suspended. This occurs when a cashier suspends a transaction that is 
waiting for a network response so that the next customer can be waited 
on. 

• END OF TICKET: The total time from the moment the last MOP was 
entered until the ticket is finished. The ticket can be finished in one of 
two ways: 

• The drawer is closed. 

• The “Ready for sale” or “NO DUE SALES” prompt returns to the 
Operator Display if the drawer is not opened for the MOP. 
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TOTALS 

Summary of totals by fuel, fuel discount, merchandise, and taxes in sales; beginning 
and ending overall and sales totals. 

• TOTAL FUEL SALES: Total amount of fuel sold. This amount is the net 
fuel sales after discounts. 

• TOTAL FUEL DISCOUNT: Total amount discounted on fuel sales. This item 
prints only if fuel discounts are used. 

• TOTAL MERCH SALES: Net amount of merchandise sales. 

• REFUND TAXES: The total amount of taxes deducted due to refunds. 

• SALES TAXES: The total amount of taxes for all sales. 

• TOTAL TAXES: Net amount of taxes collected. This number is the total 
sales tax amount minus the total refunds tax amount. 

• Sales Totalizer Beginning: Sales totalizer calculated at the last period 
close. 

• Sales Totalizer Ending: Calculated using the following: 

+ Total Net Department Sales (Department Report) 

+ Total Sales Tax (Tax Report) 

+ Sales Totalizer Beginning (Memo Items) 

• Sales Totalizer Difference: Calculated using the following: 

+ Sales Totalizer Ending (Totalizers) 

- Sales Totalizer Beginning (Totalizers) 

• Grand Totalizer Beginning: Grand totalizer calculated from the last 
period close. 

• Grand Totalizer Ending: Use the following method to calculate the figure 
that appears on the report. First, look at the Department Report. 

 Highlight all negative departments (departments that have the 
“Dept Type #” parameter set to ‘1’) such as bottle returns. These 
are negative numbers. 

 Add all the numbers up. 

 If the sum is negative, take away the negative (minus) sign. 

 This is the Total Negative Sales. 
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Then, perform the following calculation (all figures come from the 
Summary Report except for the Total Negative Department Sales, which 
is calculated above): 

+ 2 X Total Negative Sales (Calculated) 

+ Total MOP Sales (MOP Sales) 

- Change/Check (Payment Out) 

+ Total MOP Cancel/Refunds (MOP Cancel/Refunds) 

+ 2 X Void Lines (Memo Items) 

+ Void Transactions (Memo Items) 

+ Suspended (Memo Items) 

+ Suspend/Voids (Memo Items) 

+ Discounts (Memo Items) 

+ Grand Totalizer Beginning (Totalizers) 

• Grand Totalizer Difference: Calculated using the following: 

+ Grand Totalizer Ending (Totalizers) 

- Grand Totalizer Beginning (Totalizers) 

Totalizer Handling 
There are two main differences between the SALES TOTALIZER and the GRAND 
TOTALIZER.  The first difference involves how each is affected by different types of 
transactions and item sales. The second difference is whether an amount is 
subtracted from it. 

The SALES TOTALIZER difference (ENDING SALES TOTALIZER minus BEGINNING SALES 
TOTALIZER) reflects NET SALES plus NET TAX.  Refunds, discounts and negative sales 
are subtracted from it along with any applicable taxes.  As a result, the Sales 
Totalizer tracks more closely to actual NET SALES than does the Grand Totalizer. 

The GRAND TOTALIZER difference (ENDING GRAND TOTALIZER minus BEGINNING 
GRAND TOTALIZER) reflects a more complex formula and numbers are never 
subtracted from it.  Because of this one rule, when reconciling the GRAND TOTALIZER 
to the SALES TOTALIZER (or to other NET SALES-based totals), any amount which 
would have normally subtracted from the SALES TOTALIZER (refunds, discounts, 
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negative sales, etc) will vary by twice its amount when compared to the GRAND 
TOTALIZER. 

 Sales Totalizer Grand Totalizer* 

Std Item Sale + + 

Std Item Tax + + 

Std Item Refund - +   | amount | 

Std Item Refund Tax - +   | amount | 

Neg Item Sale - +   | amount | 

Neg Item Tax - +   | amount | 

Neg Item Refund + +   | amount | 

Neg Item Refund Tax + +   | amount | 

Discount Std Item - +   | amount | 

Discount Neg Item + +   | amount | 

Void Line Not applicable +   | amount | 

Void Ticket Not applicable +   | amount | 

Suspend Void Not applicable +   | amount | 

 
* +  | amount |  indicates that the “absolute value” is added to the GRAND TOTALIZER.  For 
example, if an item is refunded in the amount of $1.50, the amount added to the GT is 
$1.50.  Also, if a negative item sale occurs in the amount of $1.00, then the amount of $1.00 
is added to the GT. 

ALL DCRs 

If outside DCRs are enabled, the ALL DCRs section includes information about DCR and 
cash acceptor sales. This section includes the SUMMARY, CASHIER DETAILS, MEMO 
ITEMS, and TOTALS sections. 
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ALL REGISTERS 

If a multi-terminal set up is used, the ALL REGISTERS section includes information 
about all the terminals, DCRs, and cash acceptors. This section includes the CASHIER 
DETAILS, MEMO ITEMS, and TOTALS sections. 

PLU Report 

The PLU Flash Report calculates all PLU sales that occur from the beginning of the 
current period up to the time the flash report is printed. If there are PLU exceptions, this 
report is followed by a PLU Exception Report.  

 

Report Details 

• PLU NUMBER: Identification of the product as it appears in Configuration 
Client > Store Operations > PLUs. This includes the twelve-digit PLU 
number followed by the three-digit modifier. There is a separate entry 
for each PLU/modifier combination. 
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• DESCRIPTION: Description of the product as it appears in the PLU File. 
Items without descriptions either do not have descriptions assigned in 
the PLU File, or the item does not exist in the PLU File and was sold with 
a cashier-assigned price. If the PLU does not exist, it is listed separately 
in the PLU Exception Report. Items with the description of “OPEN PLU” 
have no defined price and require the cashier to key a price. 

• CUST: Number of customers (separate completed transactions) who 
bought the item. If the item is sold at more than one price, the number 
of customers who purchased the item at a specific price is listed. 

• ITEMS: Quantity of the item sold. If the item is sold at more than one 
price, the quantity of the item sold at a specific price is listed. 

• PRICE: Price of the item. If the item is sold at more than one price, each 
price is indicated on a separate line. 

• TOT-SALES: Total amount collected for sales of the item. If the item is 
sold at more than one price, the total amount collected at each specific 
price is listed. 

•  RC: Reason code identifies the method used to change the price of an 
item. Line item discounts apply only to non-fuel sales. When Generic 
Loyalty is in effect, the loyalty host does not return fuel line items in 
the discount detail data. 

PLU Report Reason Codes 

Code         Description 

C The items sold as a part of a combo. 

D 
A discount is applied to the item. Whether the discount type is set to Percent or 
Amount on the Configuration Client > Store Operations > Sales Configuration tab 
determines if the discount is a percentage or amount discount. 

M The item sold as part of a match. 

O The item sold at the dispenser card reader. 

P The item sold with a promotion set up on the Configuration Client > Store 
Operations > Restrictions > PLU Promotions tab. 

PD A promotion applied to an already discounted item. 

PO The item sold from a dispenser card reader with a promotion. 
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PV A price override applied to an item already set up as a promotion. See “PLU 
Exception Report.” 

V A price override applied to the item. 

VD A price override applied to an already discounted item. 

• % SALES: Percent of total sales that the item represents. To find this 
number, use one of the following formulas. 

• If departments are used, get the “Total Sales” figure from the 
Department Report: 
Net Department Sales ÷ Total sales of this item 

• If PLUs: are used 
Total PLU Sales ÷ Total sales of this item 

• TOTAL ITEMS SOLD: Total number of items sold as PLUs. 

• TOTAL SALES: Total amount of PLU sales. 

• % OF TOTAL SALES: Percent of total sales made as PLUs. To find this 
number, add all the %Sales entries in this report. 

PLU Exception Report 

The information contained in this report is intended to be used with the PLU Flash 
Report that prints just before it. This report lists all PLU sales for which standard 
pricing was not used. Sales print in the order they occur. If there are no exceptions, 
then “NO PLU EXCEPTIONS” prints. 

 

Report Details 

  PLU NUMBER: Identification of the product as it appears in Configuration Client 
> Store Operations > PLUs or as it was entered if it was not found. This includes 
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the twelve-digit PLU number followed by the three-digit modifier. There is a 
separate entry for each exception. 

  EXCEPTION: Description of how the price was entered. 

• PLU NOT FOUND: The item does not exist in Configuration Client > 
Store Operations > PLUs. The cashier entered a price for the item. 

• PRICE OVER: The item has a price set in Configuration Client > 
Store Operations > PLUs. The cashier used the [PRICE OVER] key 
to force the sale of the item at another price. 

  STATE: Type of transaction in which the exception occurred. 

• REFUND 

• SALE 

• VOID 

  CSH#: Number of the cashier who entered the exception. 

  QTY: Quantity of the item excepted. 

  ORG PRICE: Original price of the item if it exists in Configuration Client > Store 
Operations > PLUs. 

  OVER PRICE: New price of the item as entered by the cashier for a price 
override. 

PLU Promotion Report 

 The PLU Promotion Report lists all PLU sales for items that were discounted through a 
promotion. 

 

Report Details 

  PLU NUMBER: Identification of the product as it appears in Configuration Client 
> Store Operations > PLUs or as it was entered if it was not found. 

  DESCRIPTION: Description of the product as it appears in Configuration Client > 
Store Operations > PLUs. Items without descriptions either do not have 
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descriptions assigned, or the item does not exist in the Configuration Client > 
Store Operations > PLUs and was sold with a cashier-assigned price. 

  CUST: Number of customers (separate completed transactions) who bought the 
item. If the item is sold at more than one price, the number of customers who 
purchased the item at a specific price is listed. 

  ITEMS: Quantity of the item sold. If the item is sold at more than one price, the 
quantity of the item sold at a specific price is listed. 

  PRICE: Price of the item. If the item is sold at more than one price, each price is 
indicated on a separate line. 

  TOT-SALES: Total amount collected for sales of this item. If the item is sold at 
more than one price, the total amount collected at each specific price is listed. 

  RC: Reason code identifies the method that is used to change the price of an 
item. 

PLU Promo Report Reason Codes 

Code Description 

C The item was sold as a part of a combo. 

D A discount (percent or dollar as set up on the Configuration Client > 
Store Operations > Sales Configuration tab) was applied to the item. 

M The item was sold as part of a match. 

O The item was sold at the dispenser card reader. 

P The item sold with a promotion set up on the Configuration Client > 
Store Operations > Restrictions > PLU Promotions tab. 

  %SALES: Percent of total sales that this item represents. To find this number, 
use one of the following formulas. 

If you use departments: 

Net Department Sales ÷ Total sales of this item 

If you only use PLUs: 

Total PLU Sales ÷ Total sales of this item 
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Department Report 

 The Department Flash Report calculates all department sales that occur from the 
beginning of the current period up to the time the flash report is printed. In a multi-
terminal system, totals for all registers print together. 

 

Report Details 

  DEPT#: Four-digit identification of the product as it appears on the 
Configuration Client > Merchandise Sales > Merchandise > Departments tab. 

  DESCRIPTION: Description of the product as it appears on the Configuration 
Client > Merchandise Sales > Merchandise > Departments tab. 

  CUST: Number of customers (separate completed transactions) who bought the 
item. 

  ITEMS: Quantity sold of this item. 

  %OF SALES: Percent of total sales this department represents. To find this 
number, use the following formula. 

Total Department Sales ÷ Total sales of this item 

  GROSS: Total amount collected for sales of a department. 

  REFUNDS: Total amount refunded for items returned in a department. 
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  DISCOUNTS: Total amount discounted for items sold in a department. These 
include discounts from: 

o    Use of the [DISC] , [DISC%] , and [DISC AMT]keys 

o    Combo, mix ’n match, fuel, and promotional discounts 

o    POP discounts 

Note: “Price Overrides” appear in the PLU Exceptions Report. 
  NET SALES: Total amount of items sold in a department. 

  NEG DEPTS: The totals for negative department sales. 

  OTHER DEPTS: The totals for other department sales. 

  TOTAL: The totals for each category in the report except number of customers. 

Deal Report 

 The Deal Flash Report calculates all combo and mix ’n match sales that occur from 
the beginning of the current period up to the time the flash report prints. 

 

Report Details 

Combo Deals 

  C#: Combo number as it appears on the Configuration Client > Promos and 
Discounts > Combo Maintenance tab. 

  DESCRIPTION: Name of the combo as it appears on the Configuration Client > 
Promos and Discounts > Combo Maintenance tab. 

  #CUST: Number of customers (separate completed transactions) who bought 
combos. 

  #COMBOS: The number of combos sold. 
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  TOTAL SALES: The total sales in dollars of combo deals. 

Mix-N-Match Deals 

  M#: Match number as it appears on the Configuration Client > Promos and 
Discounts > Mix & Match Maintenance tab. 

  DESCRIPTION: Name of the Match as it appears on the Configuration Client > 
Promos and Discounts > Mix & Match Maintenance tab. 

  #CUST: Number of customers (separate completed transactions) who bought 
matches. 

  #MATCH: The number of matches sold. 

  TOTAL SALES: The total sales in dollars of mix-n-match deals. 

Totals for all Deals 

  #CUST: Number of customers (separate completed transactions) who bought 
combos and matches. 

  #COMBO / #MATCH: The total number of combos and matches sold. 

  TOTAL SALES: The total sales in dollars of combo and mix-n-match deals. 

Category Report 

 The Category Flash Report calculates all category sales that occur from the beginning 
of the current period up to the time the flash report prints. 

 

Report Details 

  CAT#: Four-digit identification of the product as it appears in the Category File. 

  DESCRIPTION: Description of the product as it appears in the Category File. 

  CUST: Number of customers (separate completed transactions) who bought 
items in this category. 
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  ITEMS: Quantity of this category sold. 

  NET SALES: Total amount of items sold in this category. This amount is the total 
minus any discounts. 

  %OF SALES: Percent of total sales the category represents. To find this number, 
use the following formula. 
Total Dept. Net Sales ÷ Total sales of this category 

  TOTAL: The total of each category in the report except number of customers. 

Tax Report 

 The Tax Flash Report calculates the taxes on sales that occur from the beginning of 
the current period up to the time the flash report prints. 

 

Report Details 

  NAME: Name of the tax as assigned on the Configuration Client > Store 
Operations > Payment > Tax Rates tab. Each of the following report items 
repeat for each tax defined. 

  TAX-RATE: Value entered in the ‘Rate’ parameter on the Configuration Client > 
Store Operations > Payment > Tax Rates tab. 
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  ACT-RATE: Actual tax rate percentage collected against the total taxable sales 
for this tax name. The following equation is used to calculate the actual rate: 
Actual Rate = (Taxes ÷ Taxable Sales) × 100 

  TAXABLE-SALES: Sum of all item prices that were taxed by this tax name. 

  TAXES: Sum of all taxes collected for this tax name. 

  NON-TAX SALES: Sum of all item prices not taxed by this tax name. 

  REFUND TAXES: The total amount of taxes deducted due to refunds. 

  SALES TAXES: The total amount of taxes for all sales. 

  TOTAL SALES TAX: Net amount of taxes collected. This number is the total sales 
tax amount minus the total refunded tax amount. 

N/W Product Report 

 The Network Product Report summarizes fuel products paid for with credit, debit, 
and stored value cards. 

 

Report Details 

  PRODUCT: Fuel product number as it is set up on the Configuration Client > 
Forecourt > Fuel Configuration > Fuel Products tab. 

  DESC: The name of the fuel product. This name is set up on the Configuration 
Client > Forecourt > Fuel Configuration > Fuel Products tab. 

  QTY: The amount of fuel dispensed. 

  CNT: The number of credit fuel sales for each fuel product. 

  TOTAL$: The total amount sold for all credit fuel sales. 
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E-Safe Day Report 

The E-Safe Day Report summarizes the E-Safe Drop and E-Safe Loan data reported 
from the E-Safe and the POS. It also reports the differences in both the reports. 

 

E-Safe Content Report 

E-Safe Content Report prints current contents of the E-Safe as reported by the safe. 
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Network Card Report 

The Network Flash Report lists the network transactions by batch, terminal, and card 
type and summarizes all totals. 

Report Details 

  TOTALS SUMMARY: A summary of the number and amount of each type of credit 
or debit transaction and the total net amount of credit and debit sales. 

  TYPE: The type of network transaction performed. 

  COUNT: The number of transactions for each type of network sales type. 

  AMOUNT: The total amount of network sales transactions. 

  TOTALS BY BATCH: Summary of network transactions in each batch by terminal 
and card type. 

Proprietary Network Reports 

Note: This report can also be used with the full-serve attendant tracking option. 

The Proprietary Network Flash Reports summarize sales and refunds made on 
proprietary cards and include sales organized by product code. 

 

Report Details 

  NAME: Name of the proprietary card used. 

  CNT: The total number of sales and refunds for each proprietary card type. 

  SALES: The total sale amount for each proprietary card type. 

  REFUNDS: The total refund amount for each proprietary card type. 
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  PROD DESC: The product code of the item sold. 

  VOLUME CNT: The total number of times each product code type is used. 

  SALES: The total sale amount for each product code type. 

Fuel SL/Price Level Report 

 The SL/Price Level Flash Report lists gross fuel sales by service level (SL) and price 
level that occur from the beginning of the current period up to the time the flash 
report is printed. 

Service levels are defined on the Configuration Client > Forecourt > Fuel 
Configuration > Fuel Service Levels tab. The gross volume and amount for each 
service level used during the period is calculated as a subtotal. 

 

Report Details 

  VOLUME: Volume of fuel pumped at the service level and price level. Repeats 
for each SL/price level combination. 

  AMOUNT: Amount of fuel pumped at the service level and price level. Repeats 
for each SL/price level combination. 

  TOTAL: Total volume and amount of fuel sold during the period. 

Fuel PR/Price Level Report 

 The PR/Price Level Flash Report lists gross fuel sales by fuel product (PR) and price 
level that occur from the beginning of the current period up to the time the flash 
report is printed. 

Fuel products are defined on the Configuration Client > Forecourt > Fuel 
Configuration > Fuel Products tab. Only the products actually sold print. The gross 
volume and amount for each product sold during the period is calculated as a 
subtotal. 



Reports 

540 

 

Report Details 

  VOLUME: Volume of fuel product pumped and the price level at which it was 
sold. Repeats for each PR/price level combination. 

  AMOUNT: Amount of fuel pumped at the product and price level. Repeats for 
each PR/price level combination. 

  TOTAL: Total volume and amount of fuel sold during the period. 

Fuel Tier/PR Report 

 The Tier/PR Flash Report lists gross fuel sales by price tier and fuel product (PR) that 
occur from the beginning of the current period up to the time the flash report prints. 

 

Report Details 

  TIER#: Price tier (1 or 2) at which fuel is sold. Price tiers are set in 
Configuration Client > Forecourt > Fuel Prices. The gross volume and amount 
for each price tier sold during the period calculates as a subtotal. Only the 
tiers actually used print. 

  Product: Fuel product sold at the price level. Fuel products are defined on the 
Configuration Client > Forecourt > Fuel Configuration > Fuel Products tab. 
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  VOLUME: Volume of fuel pumped for the price tier and product combination. 

  AMOUNT: Amount of fuel pumped for the price tier and product combination. 

  TOTAL: Total volume and amount of fuel sold during the period. 

Fuel Tank Report 

 The Tank Flash Report lists all fuel sales by fuel tank that occur from the beginning 
of the current period up to the time the flash report prints. 

 

Report Details 

  Tank Name: Each tank that sold fuel lists. 

  VOLUME: Volume of fuel pumped from the tank. 

  AMOUNT: Amount of fuel pumped from the tank. 

Note: Blending Sites: When some of the contents of a tank is used in a blended 
product, the price of the blended product is used to calculate the amount for 
the tank volume used in the blended product. 

  TOTAL: Total volume and amount of fuel sold during the period. 
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Fuel Autocollect Report 

The Fuel Autocollect Flash Report lists gross fuel sales by method of payment that 
were made, but not paid into the register. Fuel sites that have an employee outside 
to collect sales directly from the customer at the pump use this method. 

If ‘Autocollect Inside’ is selected in Configuration Client > Forecourt > Fuel Config > 
Site Parameters, autocollect transactions that are recalled inside on a POS do not 
display on the Autocollect Report; they appear in the fuel totals and in the credit and 
cash section. 

To log autocollects, the ‘Auto Collect’ parameter on the Configuration Client > 
Forecourt > Fuel Config > Fueling Positions tab must be set to ALL or CASH for each 
pump at which payment is directly received. 

 

Report Details 

  Method of Payment: Gross volume and amount for each method of payment 
autocollected. 

  VOLUME: Gross volume dispensed and autocollected for each method of 
payment. 

  AMOUNT: Gross amount collected for each method of payment. 

  TOTAL: Total gross volume and amount of fuel sold through autocollect 
methods. 

Fuel FP/Hose Report 

 The FP/Hose Flash Report lists gross fuel sales by fueling point (FP) that occur from 
the beginning of the current period up to the time the flash report prints. 
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Report Details 

  FUELING POINT #: Gross fuel and amount dispensed by each product at the 
fueling point used. A subtotal of the sum of all products sold from the fueling 
point is calculated for each fueling point number. 

  VOLUME: Gross volume dispensed for each product at the fueling point. 

  AMOUNT: Gross amount collected for each product at the fueling point. 

  TOTAL: Gross volume and amount of fuel sold. 

  PRODUCT TOTALS: Gross fuel and amount dispensed by each product. The total 
gross volume and amount is calculated. 

Fuel FP/Hose Running Report 

 The FP/Hose Running Flash Report lists gross fuel sales by fueling point (FP) that 
occur from the time the fueling point is started (reset to zero) up to the time the 
flash report prints. 
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Report Details 

  FUELING POINT #: Gross fuel and amount dispensed by each product at the 
fueling point used. A subtotal of the sum of all products sold from the fueling 
point is calculated for each fueling point number. 

  VOLUME: Gross volume dispensed for each product at the fueling point. 

  AMOUNT: Gross amount collected for each product at the fueling point. 

  PRODUCT TOTALS: Total gross fuel and amount dispensed by each product. The 
total gross volume and amount is calculated. 

Fuel Dispenser Report 

 The Dispenser Flash Report lists fuel sales by fueling point (FP) that occur from the 
time the dispenser is started (reset to zero) up to the time the flash report prints. 
This information is received directly from the totals kept by the dispenser. 
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Report Details 

  FUELING POINT #: Total fuel and amount dispensed by each product at the 
fueling point used. A subtotal of the sum of all products sold from the fueling 
point is calculated for each fueling point number. 

  VOLUME: Total volume dispensed for each product at the fueling point. 

  AMOUNT: Total amount collected for each product at the fueling point. 

  PRODUCT TOTALS: Total volume and amount dispensed of each fuel product for 
all fueling points. 

Fuel Blend Product Report 

 The Blend Product Flash Report lists blended fuel sales that occur from the time the 
dispenser or dispenser controller started to the time the flash report is run. The 
report divides the fuel sales into sales of pure fuel products and sales of blended 
products. 

The information is received directly from the dispenser. Totals are reset only if the 
dispenser or dispenser controller is reset. 

No information prints if blended fuel is not used. Blended fuel is defined on the 
Configuration Client > Forecourt > Fuel Config > Fuel Products tab. 

 

Report Details 

PURE PRODUCT 

This section of the report lists the blended products as they are defined on the 
Configuration Client > Forecourt > Fuel Config > Fuel Products tab. 

  FUELING POINT #: Product, total volume for the product, and subtotal for all 
products of the fueling point, repeated for each fueling point fuel is sold and 
for all fueling points together. 

  PROD: Each pure product used to create a blended product. 

  VOLUME: Volume of the pure product dispensed from the fueling point. 
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  TOTAL: Subtotal for the total pure product dispensed for each fueling point and 
total of all pure product sales. 

BLEND PRODUCT 

This section of the report lists the blended products as they are defined in the 
Product Configuration function in Fuel Manager mode. 

  PROD: Blended product created by blending two pure products. 

  PROD1: The tank name of the first pure product used to make the blended 
product. 

  %PROD1: The percent of the first pure product (PROD1) used to make the 
blended product. 

  PROD2: The tank name of the second pure product used to make the blended 
product. 

  %PROD2: The percent of the second pure product (PROD2) used to make the 
blended product. 

Fuel Tank Report 

The Fuel Tank report lists information gathered from a tank level sensor. This report is 
available only if a tank level sensor is installed in the tanks. 
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Report Details 

INVENTORY 

  TANK#: Tank number. Tank reports print in tank number order. 

  DATE: Date and time the report runs. 

  TANK NAME: Name of tank as assigned in the Tank Names function in Fuel 
Manager mode. 

  LEVEL: Fuel level in inches. 

  VOLUME: Fuel volume in gallons. 

  TEMP: Temperature in degrees Fahrenheit. 

  ULLAGE: Unused tank capacity in gallons. 

  WATER: Water level. 

LEAK 

  TANK#: Tank number on which the test is run. 

  Started: Date and time the test is run. 

  Hr1 - Hr8: Number of hours of leak data. 

  “Leak Test is OFF/No leak data to report.”: This phrase appears instead of the 
data if the leak test is not running. 

  “Leak Test is ON/No leak data to report.”: This phrase appears instead of the 
data if the leak test has not been running for the minimum time set for 
collecting data. 

ALARM HISTORY 

  Prints in tank number order. 

  HIGH WATER: Date and time of the last three high water alarms. 

  LOW LIMIT: Date and time of the last three low limit alarms. 

DELIVERY 

  Tank: Prints in tank number order. 

  Del: Delivery report number. The report can contain 0 - 10 deliveries. 

  Begin: Volume in gallons and temperature in degrees Fahrenheit at the 
beginning of delivery. 

  End: Volume in gallons and temperature in degrees Fahrenheit at the end of 
delivery. 
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ALARM STATUS 

  TANK#: Printed in tank number order. 

  Alarm Status: The status (“OFF” or “ON”) of the following alarms: 

o    Leak 
o    High Water 
o    Overfill 
o    Low Limit 
o    Theft 

AUTO-TRANS FLAG 

  TANK#: Printed in tank number order. 

  Auto-transmit Flag Status: The status (“OFF’ or “ON”) of the following flags: 

o    Leak Alarm 
o    High Water Alarm 
o    Overfill Alarm 
o    Low Limit Alarm 
o    Theft Alarm 
o    Delivery Start 
o    Delivery End 

Print Tank Reconciliation Report 

 The Tank Reconciliation Report displays the inventory in gallons of fuel in each tank 
and compares the beginning inventory to the ending inventory. Reconcile the 
inventory at the end of each day to aid in tracking starting inventory from the 
previous day, deliveries, and dispensed fuel. 
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Report Details 

  Tank: All tanks list in tank number order. 

  Date: Date the inventory is taken, beginning and ending. 

  Time: Time the inventory is taken, beginning and ending. 

  Volume: Volume of fuel: 

o    Measured in each tank when the inventory is taken. 
o    Delivered to each tank. 
o    Dispensed from each tank. 

  Total: 

o    Starting Inventory: The total amount of fuel contained in the tanks 
when the beginning inventory is taken. 

o    Deliveries: The total amount of fuel delivered and placed in the tanks 
is added to the inventory. 

o    Fuel Dispensed: The total amount of dispensed fuel is subtracted from 
the inventory. 

o    Fuel Due: The total amount of fuel dispensed without payment. 
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o    Ending Inventory: The total amount of fuel contained in the tanks 
when the ending inventory is taken. 

o    Discrepancy: The amount of fuel unaccounted for by the inventory. 
(Discrepancy = Starting Inventory + Deliveries - Dispensed - Ending 
Inventory) 

Print Carwash Pay Point Report 

The Car Wash Report summarizes car wash sale activity and totals. 

Report Details 

  COIN: The total amount collected at the coin box outside the car wash. 

  TOKEN: The total dollar value of tokens collected at the coin box outside the 
car wash. 

  WASHES USED: The total amount of car washes. 

DCR Statistical Report 

 The DCR Statistical Report prints a summary of fuel sales at the dispenser card 
readers (DCRs). The report summarizes fuel sales minus cancelled transactions and 
under-dispensed sales for each DCR configured and totals all DCR fuel sale activity. 

 

Report Details 

  #CUST: The number of customers at a DCR. 

  VOLUME: The amount of fuel dispensed at a DCR. 

  AMOUNT: The sale amount of fuel dispensed at a DCR. 

  %FP: The total percent of DCR activity at a specific fueling point. 

  %DCR: The percent of all dispenser card reader sales dispensed at a specific 
DCR. 

  %FUEL: The percent of all fuel sales dispensed at a specific DCR. 
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Cash Acceptor Report 

 The Cash Acceptor Report prints a summary of sales at the cash acceptors. The 
report summarizes the sales for each cash acceptor configured and totals all cash 
acceptor sales activity. 

 

Report Details 

  CASH ACCEPTOR: The number of the cash acceptor. 

  #CUST: The number of customers at a cash acceptor. 

  DOLLARS ACCEPTED: The total amount of money accepted. 

  DOLLARS SOLD: The total value of sales. 

  BILL COUNT: The number of bills accepted. An asterisks symbol (*) in the Bill 
Count column indicates the cash acceptor was opened since the last Close 
Daily. 

Fuel FP/Hose Test Report 

 The FP/Hose Test Flash Report lists simulated fuel sales by fueling point (FP) that 
occur from the time the fueling point is started (reset to zero) up to the time the 
flash report prints. 
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Report Details 

  FUELING POINT #: Gross count, volume, and amount dispensed by each product 
at the fueling point used. A subtotal of the sum of all products sold from the 
fueling point is calculated for each fueling point number. 

  COUNT: The number of tests for each product at the fueling point. 

  VOLUME: Gross volume dispensed for each product at the fueling point. 

  AMOUNT: Gross amount collected for each product at the fueling point. 

  PRODUCT TOTALS: Total gross count, volume, and amount dispensed by each 
product. The total gross count, volume, and amount is calculated. 

Fuel Price Change Report 

 Fuel price change report is an optional report for daily/shift reports. This report 
prints the fuel price change information for the current shift. 
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Fuel Street Price Change Report 

This report includes the street fuel price changes done via fuel price change 
initialization or fuel initialization from POS or SMS/Config Client. This report includes: 

  Date and Time of price change 

  Cashier who performed the price change 

  Old price and new price 

  Price Per Gallon, Gallons Sold, Total Amount since last price change within 
the period. 

 

Print POP Discount Report 

The POP Discount Report displays discounts applied by fuel grade. Within each grade, 
the report is further broken out according to how the discount is applied, either as a 
pre-dispensed discount or a post-dispensed discount. 

When fuel is dispensed at the discounted rate, the amount of the discount is not 
included in the sales information. Therefore, it is calculated based on the amount of 
the discount and the volume dispensed. This discount amount is not reported as a 
discount to that department, nor is it reflected in either the Discount or Fuel Discount 
memo item totals. Fuel discounts are only reflected in the POP Discount Report as a 
pre-dispensed (“PRE-DISP”) discount. 
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When fuel is dispensed at the street price and discounted at the register, the discount 
amount is part of the sales transaction and is reported as a discount to that fuel 
department. The discount amount is also included in the memo item entry for 
“Discounts” but is not included in Fuel Discount memo item totals. This discount 
amount is reflected in the POP Discount Report as a Post-dispensed (“POST-DISP”) 
discount. 

Note: Totals are not reported by POP Discount Level, POP Definition, or POP 
Discount Configuration. 

 

Report Details 

  PROD : The fuel grade. 

  DISC TYPE: Indicates the discounts applied on pre-dispensed fuel and post-
dispensed fuel. 

  VOLUME : Volume of fuel pumped from the tank. 

  DISC AMT : Amount discounted on the volume dispensed. 

Print POP Discount Definition Report 

The POP Discount Definition Report saves the discounted portion of the fuel sales 
where POP is applied. The report prints both pre-dispensed and post-dispensed 
transactions. 

 Note: Totals are not reported by POP Discount Level, POP Definition, or POP 
Discount Configuration. 
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Report Details 

  PROD : The fuel grade. 

 DISC Definition: POP Discount Definition ID. 

  VOLUME : Volume of fuel pumped from the tank. 

  DISC AMT : Amount discounted on the volume dispensed. 

Print POP Discount Program Report 

The POP Discount Definition report only presents data by fuel grade within a reporting 
period. A POP Discount Program report displays discounts by program within reporting 
period.  The report includes the same data as the Pop discount definition report 
except it prints as well as sort by the POP program id. 
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Report Details 

  PROD : The fuel grade. 

 POP DISCOUNT DEFINITION: POP Discount Definition ID. 

 FUEL DISCOUNT DEFINITION: FUEL Discount Definition ID. 

  VOLUME : Volume of fuel pumped from the tank. 

 DISC AMT : Amount discounted on the volume dispensed. 

Loyalty Report 

 The Loyalty Flash Report is available only when loyalty is enabled. 
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Report Details 

  TOTAL CUSTOMERS: The total number of customers at the site during the 
period. 

  TOTAL LOYALTY CUSTOMERS: The number of customers using the loyalty 
program during the period. 

 SALES (Before Ticket Disc): The amount of sales for the site during the period, 
before subtracting any ticket level discounts. 

 TOTAL PPG DISCOUNT: The amount of loyalty discounts given for price-per-
gallon fuel sales. 

  TOTAL TICKET DISC: The amount of loyalty ticket discounts for all items. 

  TOTAL LOYALTY DISC: The amount of all loyalty discounts (PPG and ticket 
discounts). 

  %LOYALTY CUSTOMERS: The number of loyalty customers as a percentage of the 
total number of customers. 

  %SALES ON LOYALTY: The loyalty sales dollars as a percentage of the total sales 
dollars for the site. 

  %SALES W/OUT LOYALTY: The percentage of total sales dollars not using loyalty. 

  LOYALTY TRANS. INSIDE/OUTSIDE: Breakdown of inside and outside sales by: 

o    Total # Customers: The total number of inside/outside loyalty 
customers. 

o    Sales (After All Disc): The amount of sales after all loyalty discounts 
are subtracted. 

o    Total PPG Discounts: The amount of PPG loyalty discounts 
inside/outside. 

o    Total Ticket Disc: The amount of loyalty ticket discounts for all items 
inside/outside. 

o    Total Discounts: The amount of all loyalty discounts (PPG and ticket 
discounts) inside/outside. 

Current Cashier Report 

The Current Cashier Report function prints the cashier report without having to close 
the cashier’s shift. The report is identical to the Print Cashier Report function except 
for the heading and the omission of the cashier close time stamp. 

Note: In general, Current Cashier Report items that have a $0.00 balance at 
the time the report prints or closes are not included in the report. 
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Age Verification Report 

The Age Verification Report shows not only the cashier's transaction information but 
the calculated age and birth date for age verification to purchase age restricted items 
(e.g. alcohol, cigarettes etc). 

Age Verification Report 

Store Number: AB123 

 

Period Information  

Open 
Period  2018-08-21 15:27  

Close 
Period  2018-08-23 15:33  

 

ID Verified  

Register ID 101  

 

Date/Time Transaction ID Cashier ID Entry 
Method 

Min 
Age Birth Date Age  

2018-08-21 
16:14:41 1010003 1 Manual 32 122568 49  

2018-08-21 
16:20:51 1010004 1 Manual 32 082186 49  

2018-08-21 
16:21:19 1010007 1 Manual 32 082186 49  

2018-08-21 
16:26:28 1010008 2 Manual 32 122568 49  

2018-08-22 
12:45:47 1010009 1 Manual 32 122569 48  

2018-08-23 
15:18:07 1010011 1 Manual 32 121219 98  
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Register ID 102  

 

Date/Time Transaction ID Cashier ID Entry 
Method 

Min 
Age Birth Date Age  

2018-08-21 
16:08:30 1020003 2 Manual 32 082186 49  

  

 

ID Verified Summary  

 

Cashier Name Cashier ID Scanned Swiped Manual Entry Skipped  
CORPORATE 1 0 0 5 0  

STORE MANAGER 2 0 0 2 0  
 

Report Details 

 Date/Time:  Date and Time of each transaction. 
 Transaction ID:  The ID or identifier of the transaction on the system.  
 Cashier ID:  The ID of the cashier who performed the transaction. 
 Entry Method:  The Entry Method (SKIPPED, SCANNED, SWIPED, MANUAL 

ENTRY). 
 Min Age: The minimum age allowed to purchase the item. 
 Birth Date:  The birth date of the customer or default birth date based 

on current date if ID Check is skipped. 
 Age:  The calculated age based on the birth date of the customer or 

default age based on current date. 
 Cashier Name: Name of the Cashier who performed the transactions. 
 Cashier ID:  ID of the Cashier who performed the transactions. 
 Scanned:  Total count of drivers’ licenses scanned. 
 Swiped:  Total count of drivers’ licenses swiped. 
 Manual Entry:  Total count of all manual entries. 
 Default Button:  Total count of ID Check SKIPPED. 

To view the Date of Birth (DOB) on the sales journal, the “Print DOB on Journal” must 
be enabled from Store Operations > Sales > Sales Configuration. 
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To enable the cashier skipping the entry of the DOB, the flag for “Force DOB on ID 
Check” must be unchecked on the Sales Configuration menu from Config Client. 
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Close Reports and Balancing 

Balancing Your Cash Drawer 

To determine how much money should be in the drawer, enter the figures from the 
“ALL REGISTERS” section of the close period report for each of the following items: 

+ BEGINNING CASH IN DRAWER                                            ____________________ 
  
+ TOTAL MOP SALES                                                            ____________________ 
    
- TOTAL MOP CANCEL/REFUNDS                                          ____________________ 
  
- CASHBACK                                                                      ____________________ 
  
- TOTAL PAYMENT OUT (do not subtract SAFE DROP)          ____________________ 
  
+ TOTAL PAYMENT IN                                                         _____________________ 
  
- CREDIT                                                                           _____________________ 
  
- DEBIT                                                                             ______________________ 
  
- PREPAID                                                                         ______________________ 
  
                                           Total in Drawer               _________________ 

Calculating Total Sales 

To calculate total sales for the period, enter the figures from the “ALL REGISTERS” 
section of the close report for each of the following items: 

+ TOTAL MOP SALES                                                            ______________ 
  
- TOTAL MOP CANCEL/REFUNDS                                        ______________ 
  
- CHANGE/CHECK                                                                  ______________ 
  
- CASHBACK (do not subtract PAY OUT or SAFE DROP)      ______________ 
  
                                             Total Sales                     _____________ 

   

  



563 

Restrictions 
Overview 

In a transaction, restrictions prevent sales of specific items during specific periods of 
time and restricts sale of some products by age. 

In a transaction, following types of restrictions can be used:  

 Blue Law - Set up any local government time periods that restrict sales on 
certain items during defined periods of time. 

 Customer ID Check - Sale of some products is restricted by age. 

Using Restrictions 

Customer ID Check 

Note: Refer to the Age Restrictions feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 

Configuring Restrictions 

Blue Laws 

Use Store Operations > Restrictions > Blue Laws form to set up, delete, or edit Blue 
Laws. 

For the Blue Laws to take affect for departments and PLUs, Blue Laws must be 
selected for the specific department or PLU. 
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Field/Button Allowable Value/Function 

Clear Click to delete the selected Blue Law information. 

Select To Duplicate 
Check the "Select To Duplicate" check box for the 
row to be duplicated. Click the Duplicate button for 
each row that should contain the same data. 

Enabled Select to activate a Blue Law for each day (Blue Laws 
may be set up ahead of time and activated later). 

Start 1 

Enter the start time (using the 24-hour clock) for the 
first Blue Law on a specific day (00:00 – 23:59). Press 
the Tab key on the keyboard. 

Note: The start time cannot be the same as the end 
time. 

End 1 

Enter the end time (using the 24-hour clock) for the 
first Blue Law on a specific day (00:00 – 23:59.) Press 
the Tab key on the keyboard. 

Note: To set the end time to midnight, enter the end 
time as 23:59. 

Start 2 
If the Blue Law is in effect again on the same day, 
enter the second start time (00:00 – 23:59). Press the 
Tab key on the keyboard. 

End 2 
If the Blue Law is in effect again on the same day, 
enter the second end time (00:00 – 23:59). Press the 
Tab key on the keyboard. 

Customer ID Check 

Use Store Operations > Restrictions > ID Checks to set up, delete, or edit Customer 
ID Checks. 

Note: Refer to the Age Restrictions feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 
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Reporting 

Blue Law Report 

  03/25/13                          10:07 

 Store# 1 Register ID#1 

 BLUE LAW FILE 

 # DAY    REST  PERIOD 1     PERIOD 2 

 ---------------------------------------- 

 1 SUNDAY    N   1000 - 2200  0000 - 0000 

 1 MONDAY    N   1000 - 2200  0000 - 0000 

 1 TUESDAY   N   0000 - 0000  0000 - 0000 

 1 WEDNESDAY N   0000 - 0000  0000 - 0000 

 1 THURSDAY  N   0000 - 0000  0000 - 0000 

 1 FRIDAY    N   0000 - 0000  0000 - 0000 

 1 SATURDAY  N   0000 - 0000  0000 - 0000 

 2 SUNDAY    N   0000 - 0000  0000 - 0000 

 2 MONDAY    N   0000 - 0000  0000 - 0000 

 2 TUESDAY   N   0000 - 0000  0000 - 0000 

 2 WEDNESDAY N   0000 - 0000  0000 - 0000 

 2 THURSDAY  N   0000 - 0000  0000 - 0000 

 2 FRIDAY    N   0000 - 0000  0000 - 0000 

 2 SATURDAY  N   0000 - 0000  0000 - 0000  

Sample Blue Law 
Setup Listing 



Restrictions 

566 

Troubleshooting 

 #  Message  Description/Action 

E1141 PURCH. NOT ALLOWED 

The customer cannot purchase this item 
because either (1) the date of birth entered 
for the ID check does not meet the age 
requirements or (2) a Blue Law restriction 
has been set up for this item or department 
at this time on this day. 

E1196 BLUE LAW RESTRICTION 
A Blue Law restriction is set up for this item 
or department, preventing its sale during a 
certain time of the day. 

E1216 LICENSE TRACK 2 EMPTY 

The driver's license reader failed to read the 
magnetic stripe information. Run the ID 
check again or enter the information 
manually. 

E1219 LICENSE EXPIRATION 
DATE ERROR 

The driver’s license just swiped/scanned has 
expiration date information errors. Run the 
ID check again or enter the information 
manually. 

E1220 LICENSE BIRTH DATE 
INVALID 

The driver’s license just swiped/scanned has 
invalid birth date information. Run the ID 
check again or enter the information 
manually. 

E1263 ITEM REJECT - 
BIRTHDATE ENTRY REQ'D 

Attempted to continue the transaction 
without responding to the ID check prompt 
with a valid DOB entry. 
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Safe Drop / Safe Loan 
Overview 

The Safe Drop function is designed to track the amount and method of payment 
(MOP) that the cashier removes from the cash drawer and puts in the store safe. The 
journal records the date, time, and cashier number when the cashier accesses the 
Safe Drop function. 

The Safe Loan function logs transfers of cash from the safe to your drawer. 

Using Safe Drop / Safe Loan 

• Safe Drop 

• Safe Drop Correction 

• Safe Loan 

Safe Drop 

Note: After the safe drop is pressed, even if by mistake, the user is committed to 
complete a safe drop. 

1. Do one of the following:  

• Press [SAFE DROP] 

• Press [OTHER FUNC], press an arrow key until the Safe Drop function 
appears and press [ENTER] 

2. Key the amount dropped:  

• For checks, choose the check MOP and enter the amount of each check 
separately 

• For all other MOPs, key the dollar amount and MOP that is dropped 

3. Key a one- to six-character reference number as defined by the store’s 
procedures 

4. Press [ENTER] 
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5. Press [EXIT] if you used the [OTHER FUNC] key in step 1 or if MOP type is 
[CHECK] 

There are two messages related to Safe Drop that may be displayed on the POS: 

• DROP (MOP) – Cash drawer contains more than the configured limit for 
the MOP noted.  Continue entering sales, but drop the specified MOP at 
the first opportunity. 

• DROP (MOP) FIRST – Cash drawer contains more than the configured 
limit for the MOP noted.  Sales using that MOP will not be permitted 
until a Safe Drop is performed and the calculated amount in the cash 
drawer of that payment type is less than the configured limit. 

If more than one method of payment exceeds its configured limit, the message 
for each will be displayed on a rotating basis.  

            WELCOME TO XXX STORE              

                            SAFE DROP                   

    CASH          Ref#158             150.00 

     ST# xx123  TILL XXX    DR# 1    TRAN# 101010 

 CSH:1                      10/04/12 22:34:47 

    

Sample Safe Drop 
Receipt 

Safe Drop Correction 

If a cashier enters an incorrect amount, it can be corrected using this function. 
 To correct the amount entered for a previous Safe Drop, do the following: 

1. Press [OTHER FUNC] then press an arrow key until the Safe Drop Correction 
function appears 

2. Press [ENTER] 

3. Enter cashier number and password 

4. Enter the original ticket number and press [ENTER] 

5. Enter the correct safe drop amount and press [ENTER] 

6. Press [EXIT] 
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Safe Loan 

1. Press [OTHER FUNC] then press an arrow key until the Safe Loan function 
appears and press [ENTER] 

2. Key the dollar amount you are adding to the drawer and press [ENTER] 

3. Press [EXIT]. 

Safe loans log on the receipt printer and Summary Report. 

                WELCOME TO XXX STORE 

                     SAFE LOAN    
 CASH          158         150.00 

   ST# xx123 TILL XXX  DR# 1     TRAN# 101010 

 CSH: 1                   10/04/12 22:34:47 

    

Sample Safe Loan 
Receipt 

Configuring Safe Drop / Safe Loan  

Parameter Path Value Description 

Limit Store Operations > 
Payment > MOP 

0.00 – 
9999.99 

Enter the amount of the MOP 
that alerts the cashier to 
make a safe drop when 
amount in drawer reaches this 
limit. 

 0.00 - The MOP does not 
require a safe drop. 

 Note: The setting for “Force 
Safe Drop” determines if a 
safe drop must be performed. 

Force Safe 
Drop 

Store Operations > 
Payment > MOP Yes, No 

Display a safe drop message if 
the MANAGER > Payment > 
MOP > Limit value is not 0.00. 

A safe drop must occur before 
additional sales transactions 
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Parameter Path Value Description 

can be performed using this 
MOP. 

Allow Safe 
Drop 

Store Operations > 
Payment > MOP Yes, No Allow a safe drop for the MOP 

Check Drawer 
Amount on 
Safe Drop 

Store Operations > 
Sales > Sales 
Configuration 

Yes, No 

Compare the amount of the 
MOP entered to the calculated 
amount currently in the 
drawer. 

Safe Drop 
Correction 
Security 

Store Operations > 
Sales > Sales 
Configuration 

0 - 9 

Enter the security level an 
employee must have in order 
to perform a safe drop 
correction. Entering 1 - 9 
indicates that an employee 
with a security level of at 
least this number must 
perform the safe drop 
correction. 

0 - Safe drop corrections do 
not require a security check. 

Reporting 

The Safe Drop Flash Report prints after each period report and lists safe drops that 
occur from the time the period started up to the time the flash report prints. The 
information is given two ways: 

 In the order the safe drops occur 

 In order by method of payment 

If the period report prints at any time other than when the period is closed, the Safe 
Drop flash report states “No Totals Available.” If no safe drops have been made, “NO 
SAFE DROPS” prints. 

Safe Drop and Safe Loan aggregate totals (count and amount by MOP) are included in 
the Pay In / Pay Out sections of the Cashier and Summary Reports. Safe Drop Detail is 
provided in the Safe Drop Detail Report. 
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    SAFE DROP DETAIL 
DATE TIME REF# C# R# AMOUNT   MOP 

----------------------------------- 

05/1810:17 000126 1 1 100.00 CREDIT 

05/1810:35 000127 1 1 100.00 CASH 

05/1811:49 000128 1 1  50.00 CASH 

05/1811:57 000000 1 1   0.00 CASH 

----------------------------------- 

MOP          NO.      AMOUNT 

CASH         2         150.00 

CREDIT       1         100.00 

----------------------------------- 

TOTAL        3         250.00 

----------------------------------- 

#SAFE DROP CANCELS       1 

  

  

  

Safe Drops in Order 

  

  

  

  

Safe Drops by MOP 

  

  

  

  

Number of Safe Drop 
Cancels 

Safe Drops in Order 

This section of the report lists all safe drops in the order they are done: 

 DATE: Date the safe drop is made. 

 TIME: Time the safe drop is made. 

 REF#: Reference number assigned to the safe drop by the cashier, if any. A 
reference number of “000000” denotes a zero safe drop. 

 C#: Number of the cashier who makes the safe drop. 

 R#: Number of the register the safe drop is made. 
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 AMOUNT: Amount of the safe drop. 

 MOP: Method of payment dropped. 

Safe Drops by MOP 

This section of the report lists all safe drops by the method of payment dropped. They 
are listed in the order that the methods of payment are defined in the MOP File. 

 MOP: Method of payment dropped. Only the methods of payment actually 
dropped are listed. 

 NO.: Number of drops for each method of payment. 

 AMOUNT: Total amount dropped for each method of payment. 

 TOTAL: Total number of safe drops and total amount dropped. 

 #SAFE DROP CANCELS: Number of times a Safe Drop operation has been 
cancelled. 

Note: After an MOP is entered for the Safe Drop, [EXIT] does not produce a Safe 
Drop Cancel. Instead a Safe Drop with a reference number of zero occurs. If a number 
is entered but [EXIT] is pressed instead of an MOP, the Safe Drop is cancelled. 

                 PAYMENT    I N    
     PAY IN     4          550.00 

 SAFE LOAN  4          329.00 

----------------------------- 

TOTAL PAYMENT IN       879.00   

 

These aggregate totals 
(as shown) are reported 
in the Summary and 
Cashier Reports. 

Report Details 

 PAYMENT IN: Summary of non-sales transactions in which payment was added 
to the drawer. 

 PAY IN: Cash added to the drawer from a non-sales payment. This represents 
the total of all pay ins. Pay ins appear separately in the Memo Items section. 

 SAFE LOAN: Cash added to the drawer from the site safe. This usually occurs 
when more change is needed. 



Commander Site Controller User Reference 

573 

               PAYMENT    OUT     
  PAYOUT     2     275.00 

 SAFE DROP 

    CASH     1      25.00 

            ------------------- 

TOTAL SAFE DROP     25.00 

TOTAL PAYMENT OUT (300.00)         

    

These aggregate totals 
(as shown) are 
reported in the 
Summary and Cashier 
Reports. 

Report Details 

 PAYMENT OUT: Summary of transactions in which money was removed from 
the drawer. The total is displayed in parentheses because the number is 
negative. 

 PAY OUT: Money removed from the drawer to purchase an item for the store or 
to pay a bill. This item includes payments to vendors made with money orders 
as the MOP. This total represents the total of all pay outs. Pay outs appear 
separately in the Memo Items section. 

 CHANGE/CHECK: Transactions in which cash is returned to the customer 
because the check was tendered for more than the transaction amount. 

 SAFE DROP: Money removed from the drawer and placed in a safe at the site. 
This usually happens when the amount of a method of payment in the drawer is 
more than the amount allowed in the drawer at one time. Safe drops are 
grouped by method of payment. The total of all safe drops prints. 
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Troubleshooting 

      #  Message  Description/Action 

  DROP (method of 
payment) 

The cash drawer contains more than the 
maximum allowed for the method of payment 
indicated.  

Make a large enough safe drop to reduce the 
amount in the drawer to below the maximum 
allowed. 

E1135 DROP MONEY FIRST  
  

The amount of money in the drawer exceeds the 
limit set in the MOP File function. Perform a Safe 
Drop. 

E1181 SAFE DROP NOT 
ALLOWED FOR MOP The MOP used disables Safe Drop in the MOP File. 

E1194 NOT ENOUGH 
MONEY IN DRAWER 

The POS does not have sufficient funds in the 
cash drawer for the MOP entered for a safe drop 
amount. 

E1195 NOT ALLOWED FOR 
AMT 0.00 

$0.00 is not allowed for a safe drop amount. 
Specify an amount more than $0.00. 

E1294 
NO MOP 
CONFIGURED FOR 
SAFE DROP 

Attempted to perform safe drop using [OTHER 
MOP] key, but there are no MOPs configured to 
allow safe drop. 

E1298 
INVALID SAFE 
DROP TICKET 
NUMBER 

Entered an invalid number when prompted for the 
original safe drop ticket number. 

E1300 
SAFE DROP 
ALREADY 
CORRECTED 

Attempted a safe drop correction on a safe drop 
that has already been corrected. Only one 
correction is allowed. 
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Soft Key 
Overview 

Certain keys on the keyboard and buttons on the screen can be configured for fuel 
control, item sales, department sales, menus, payment or some other function like 
safe drop. 

Using Soft Key 

Buttons on the Screen will be automatically labeled and as part of your training, you 
will learn how to use them. 

Keys on the keyboard need to be manually labeled so, if you notice that the label on a 
key does not match what it actually does, report it to your store manager so that the 
appropriate action can be taken. 

While in the Soft Key File, press [List] to print the current list of soft keys in key 
number order. 

                 WELCOME TO XXX STORE                

                           SOFT KEY FILE 

   KEY    TYPE       NUMBER     DESCRIPTION 

-------------------------------------------- 

01   Approve 

02   Prepay 

03   View 

04   Fuel Sale 

05   Preset 

06   Void Line 

07   Ticket Print 

    

  

  

  

Sample Soft Key 
File 
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08   No Sale 

09   Discount 

10   Price Override 

11   Void Ticket 

12   Network Functions 

13   MOP                     009 LOTTERY 

14   Other MOP 

15   PLU               000000000006/000 SODA 

16   PLU               000000000019/001 BREAD 

17   Menu      08  BOT SODA                      

18   Combo     02  SAND SPEC             

 Store#       AB123               Register ID#  1 

CSH: 1            10/04/12        22:34:47  

Configuring Soft Key 

Soft Keys 

Use Store Operations > Register > Soft Key to configure soft keys.  
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Field/Button Allowable Value/Function 

Register Select the register. 

SoftKeys Click the soft key on the screen keyboard to change the key 
feature assignment. 

Soft Key Assignment 

Soft key assignments can be changed by directly accessing the menu list. Be sure that 
the soft key to be changed is selected. 

• Combo File: Combo files must be defined before they can be assigned a soft 
key. When you have more combos to assign than soft keys available, set up a 
soft key for [OTHER COMBO]. The repeated keying of the [OTHER COMBO] 
soft key cycles through each Combo defined in the Combo File that is not 
assigned to a soft key. 

• Department File: A department must already be set up in the Department File 
before it can be assigned to a soft key. When you have more departments to 
assign than soft keys available, set up a soft key for [OTHER DEPT]. The 
repeated keying of the [OTHER DEPT] soft key cycles through each 
Department defined in the Department File that is not assigned to a soft key. 

• Fuel Functions: If you have more fuel functions to assign than soft keys 
available, instead of assigning the following functions to separate keys, assign 
[OTHER FUEL] to a key. 

 These functions appear in a menu format when the cashier keys [OTHER 
FUEL]. 

• Convert Price Level 

• Free POP Award 

• Fuel Discount 

• Fuel Tax Addition 

• Fuel Tax Exemption 

• Move Fuel Point (Prepay Move) 

• Preset Fuel 
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• Site Pause 

• MOP File: A method of payment must already be set up in the MOP File before 
it can be assigned to a soft key. When you have more MOPs to assign than soft 
keys available, set up an [OTHER MOP] soft key. 

• PLU File: A PLU/modifier combination must be set up in the PLU File before it 
can be assigned to a soft key. 

• Sales Management Functions: If you have more sales management functions to 
assign than soft keys available, set up an [OTHER FUNC] soft key. These 
functions appear in a menu format when the cashier keys the [OTHER FUNC]. 

o Clock In/Out 

o Pay In 

o Pay Out 

o Print Previous Transaction 

o Safe Drop 

o Safe Loan 

o View Pending Transactions 

Function 
Name Description 

Allow Food 
Stamps for 
Item 

This function processes an item not configured as food stamp 
eligible as though it is eligible for payment with food stamps.   

AutoGen POP 
Code 

Select to auto generate POP Code.  

Note: Refer to the POP Discount feature reference 
documentation for information on this feature. The 
Feature Reference is available on Premier Portal. 

Amount 
Discount Used to give an amount discount on the last entered sale item. 

Approve Fuel Approves all or a specific pump for fuel dispensing. 
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Function 
Name Description 

Apply Updates Use to apply PLU price update.   

Choose Pinpad 

Select to choose the secondary PIN pad.  

Note: Refer to the P400 Implementation Guide for more 
information on this feature. The Feature Reference is available 
on Premier Portal. 

Clock In/Out Employees can Clock In/Out using this key. 

Comm Fleet 
Prepay 

Use to trigger a commercial fleet prepay transaction. 

Note: Refer to the Fleet Cards feature reference documentation 
for information on this feature. The Feature Reference is 
available on Premier Portal. 

Convert Fuel 
MOP 

Changes fuel pricing systems (usually between cash and credit) 
when different fuel prices are charged based on the method of 
payment. 

Discount Discounts the last entered sales item as an amount or percent 
depending on the Sales Configuration setup. 

Department Assigns a department to a soft key.  

Edit Food 
Order Edits a food order.  

Electronic Void 

Use to void a commercial fleet transaction. When someone 
accidentally fuels one or more grade/s in a multi-grade fuel 
transaction instead of the owner of the preauth card, the cashier 
will refund the entire transaction using electronic void to the card 
that was used during pre-auth. To perform an electronic void 
transaction, both the customers should be with the cashier. The 
cashier initiates a manual fuel department sale to the respective 
people who pumped the fuel. 

Note: Refer to the Fleet Cards feature reference documentation 
for information on this feature. The Feature Reference is 
available on Premier Portal. 
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Function 
Name Description 

Exception 
Ticket Print Prints Exception Ticket. 

Fill Up Fills up the tank. 

Food Stamp Allows the item that is entered to be purchased with food stamps. 

FREE POP 
AWARD 

Allows the cashier the discretion to issue a free POP code or coupon 
to a customer (e.g., when a customer returns after being 
incorrectly charged for an item on a previous visit). 

Fuel Discount Discounts a specified quantity of fuel. 

Fuel Prepay Allows the customer to pay for a fuel sale before pumping. 

Fuel Preset Presets a pump for a specific amount or quantity. Payment may be 
made before or after dispensing. 

Fuel  Enters the most recent fuel sale for the specified pump into the 
current transaction. 

Fuel Tax 
Addition  Adds taxes to a tax-exempt fuel transaction. 

Fuel Tax 
Exemption  Adjusts fuel taxes to allow for tax exemptions. 

Fuel Ticket 
Print This function reprints postpay fuel transaction receipts. 

Fueling Point 
Move 

This function moves a preset or prepay fuel sale that has not been 
dispensed from the original pump number to a new pump number. 

Get Order 

After a customer arrives at the “Payment” window, the cashier 
retrieves the the customer’s order by invoking the “Get Order” 
function.  The “Get Order” function retrieves only those 
transactions suspended by the “Place Order” function. 

Gift Card 
Purchase Allows the purchase of a Gift Card. 
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Function 
Name Description 

Gift Card 
Activate Activates a Gift Card.  

Gift Card 
Recharge Allows the recharge of a Gift Card. 

Kiosk Order Allows to make a kiosk order. 

Manual POP 
Discount 

This is an option that can provide either a coupon or free POP code 
(with Basic + Code program type).  The cashier has the option of 
offering the award to customers at their discretion; perhaps to an 
especially loyal customer or to a customer who has experienced 
some perceived inconvenience. 

Menu Key Assigns a menu to the soft key. 

Manual PLU This function allows screen entry of items using the <PLU number> 
[ENTER] key sequence. 

MOP Assigns a Method of Payment to the soft key. 

Modify 

Modifies the current PLU sales entry so that the next modifier 
defined for the PLU, if any, displays. 

Note: Review the “Considerations” before moving this key. 

Next Dollar 
Amount 

 Use when customer presents the next dollar amount (for example, 
$17 for a sale totaling $16.54). 

Network 
Functions 

Contains a menu of functions that relate to your credit card 
network. 

No Sale Opens the cash drawer between sales transactions. 

Loyalty 
Balance 

Use to send the loyalty point balance inquiry to the loyalty host for 
a loyalty card. Scan the loyalty card barcode or manually enter the 
loyalty account number to perform the balance inquiry.  
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Function 
Name Description 

Loyalty Card Use to scan the loyalty card barcode or manually enter the loyalty 
account number during a sales transaction. 

Other Combo Allows entry of a combo number that is not already assigned to a 
specific soft key. 

Other Currency Changes the total amount due from the local currency to another 
currency. 

Other 
Department 

Allows entry of a department number for a sales item for all 
departments not already assigned to a specific soft key. 

Other Fuel 
Functions 

Contains a menu of the following functions: Move Fuel Point, 
Convert Price Level, Fuel Discount, Preset Fuel, Free POP Award, 
Fuel Tax Exemption, Site Pause. 

Other 
Functions 

Contains a menu of the following functions: Safe Drop, Safe Loan, 
Clock In/Out, Pay In, Pay Out. 

Other MOP Allows entry of a method of payment number that is not already 
assigned to a specific soft key. 

Pay In Logs that an amount has been added to the cash drawer without a 
sales transaction. This is also under [OTHER FUNC] key. 

Pay Out 

Logs that an amount has been removed from the cash drawer 
without a sales transaction. This is also under [OTHER FUNC] key. 

 Note: To make vendor payments by money order, use the Pay Out 
function under the [OTHER FUNC] key. 

Percent 
Discount Discounts the last entered sales item as a percent. 

Place Order 

Place Order function is like “Suspend” function.  However, “Food 
Service” identified transactions are precluded from being 
suspended by the “Suspend” function.  Place Order function allows 
a “Food Service” identified transaction to be suspended.  Along 
with “Place Order”, the current transaction items identified by the 
the “Food Service” rule set are sent to the iOrder system. 
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Function 
Name Description 

PLU Assigns a PLU to the soft key. 

Price Override Changes the defined price of a PLU item to the price you enter. 

POP Member 
Card ENTRY Allows entry or change of a POP membership card. 

Prepay Move This function moves a preset or prepay fuel sale that has not been 
dispensed from the original pump number to a new pump number. 

Price Check Checks the price of an item by scanning or manually entering its 
PLU after the price check key is pressed. 

Purge Kiosk 
Order Deletes a kiosk order. 

Quantity Indicates that two or more of an item (PLU or department) are 
entered. 

Refund Allows items from a previous sale to be returned. 

Reminder to 
use Imprinter 
[Y/N] 

Determines whether a message is displayed that reminds the 
cashier to use the imprinter after completing a transaction using 
the manual credit MOP. 

Rest In Gas Allows customers to use change from a cash merchandise sale to 
buy as much fuel as the change pays for. 

Recall Recalls suspended transactions.  

Repeat Last 
Item Repeats last item.  

Remove Kiosk 
Order Removes kiosk order.  

Safe Drop Logs that a specific amount of an MOP is removed from the drawer 
and placed in the safe. This is also under [OTHER FUNC]. 
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Function 
Name Description 

Safe Drop 
Correction 

If a cashier enters an incorrect amount, it can be corrected using 
this function.   

Safe Loan Logs that a specific amount of cash was removed from the safe and 
placed in the cash drawer. This is also under [OTHER FUNC]. 

Sales Flash 
Reports List of flash reports. 

Stop Fuel Stops all or a specific pump from dispensing. 

Suspend 
Transaction 

Suspends one transaction to allow other transactions to be 
processed. 

Tax Exempt Removes one or more taxes from the current item. 

Ticket Print Prints the last 500 indoor sales receipts or the last card reader 
receipt. 

Total Adds up the amount of the current transaction. 

View Fuel Sales Displays the status of a specific pump or all due sales. 

Void Line Removes the specified item from the current transaction. 

Void Ticket Deletes the entire current transaction and resets the terminal to 
start a new one. 

3rd Party 
Product Sells a third-party product.  
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Troubleshooting 

      #  Message  Description/Action 

E1104 MOP INVALID/NOT 
ALLOWED 

Used an MOP soft key that no longer exists. 
Choose another MOP. 

E1109 PRESET NOT USED The soft key has not been defined or the PLU no 
longer exists. 

E1167 SOFT KEY NOT 
DEFINED The soft key is not defined in the Soft Key File. 

E3030 SOFT KEY FILE 
RESET ERROR 

The Reset Soft Key File function was chosen and 
the soft key file could not be reset. Try the action 
again. If this continues to happen call the service 
center.  

E3050 NO MENUS HAVE 
BEEN DEFINED 

Attempted to set up a menu soft key but no 
menus are defined. Set up menus in the Menu 
File function. 
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Special Discount 
Overview 

Special discounts are discounts for specific situations or customers, such as students 
or seniors. These discounts differ from standard discounts, because the discount is 
subtracted from the subtotal. 

This feature applies a percentage discount to items flagged as eligible in the PLU or 
Department file. The clerk determines if the customer is eligible for the discount 
according to store policies and procedures, then applies it by selecting the [Special 
Discount] MOP as the first MOP in the transaction. 

As special discount eligible items are added to the transaction, the system keeps a 
subtotal and displays it to the left of the food stamp total in the MOP section of the 
ticket window with an indicator of “SD”. 

Note: Refer to the Special Discount feature reference documentation for 
information on this feature. The Feature Reference is available on Premier 
Portal. 
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Taxes 
Overview 

Taxes are determined by government entities based on the location of the retail site; 
each having their own unique requirements as to what it and is not taxable.  Because 
multiple governing entities may collect tax for a specific area, multiple taxes may 
apply specific items within a transaction. 

For each tax that applies to a given transaction the system keeps a separate subtotal 
of taxable sales and applies the tax at the transaction level. 

Using Taxes 

In the POS, taxes for a given department or PLU item are already configured and 
 normally require no special handling on the part of the cashier. The system may 
automatically treat certain taxed items as non-taxed items when items flagged 
as food-stamp eligible the configuration are purchased with food stamps. 

Tax Exemption 

There may be circumstances when items normally taxed in a transaction should 
be sold as tax exempt: sales to tax exempt organizations or purchase for resale. 
Each situation has its own requirements and cashiers should follow in-store 
policies and procedures before tax exempting any purchases. 

1. Touch the line item that is to be exempted from tax 

2. Touch Add Tax Exempt to exclude the line item when calculating 
taxability for this transaction 

Configuring Taxes 

Tax Rates 

Use Store Operations > Payment > Tax Rates to define up to eight tax rates. 
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Field/Button Allowable Value/Function 

Name Enter the name of the tax. This name appears in 
reports. 

Delete Click to delete the selected tax. 

Adjust Break Points  

Click to Adjust Break Points. See “Break Point 
Table.” Adjust Break Point appears only if “Use Break 
Point Table” is selected. 

Indicator 

From the drop-down menu, select the character that 
prints on receipts to indicate that this tax was 
applied. 

Tax Rate 
Enter the tax percentage for this tax if the Break 
Point Table is not being used. 

Percent Start 
Enter the minimum dollar amount that may be taxed 
(0.00 – 99999.99). 

Options  

Prices Include Tax 

 

Select if the price of an item already includes this 
tax. 
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Field/Button Allowable Value/Function 

Prompt for Exemption 

Select to make a prompt appear that requests cashier 
verification when the [TAX EXEMPT] key is pressed. 

(If not selected, the terminal automatically removes 
this tax when the cashier presses [TAX EXEMPT]) 

Use Canadian GST 

Canadian GST Settings 
Reg Number Options  

Fuel Includes Tax 

Select to use Canadian GST. 

Enter the registration number. 

Select to include tax for fuel. 

Use Break Point Table 
Select to use the Break Point Table and click Adjust 
Break Points. See “Break Point Table.” 

Break Point Table 

Use the Break Point Table form to define tax break points for sales amounts when a 
flat sales tax does not apply. The amount of tax charged depends on where in the 
table the taxable amount falls. 

Before setting up the Break Point Table in SMS, obtain the state, county, or local tax 
table for which you want to create a break point definition. By entering data from 
that table into a worksheet you can determine the following: 

• The starting point. 

• The tax break points and the repeating pattern. 

• The limit of the tax table, if there is one. 

In addition, you need to know the tax rate to apply to sales above the break point tax 
limit (if there is a limit). 

Example Worksheet 

Following is a worksheet used to determine the information above for our example 
Break Point Table. You can see that the pattern repeats every six increments. 

Number Start  End Difference Increment 
1 .11 .17   6 1 
2 .18 .34 16 1 



Taxes 

590 

Number Start  End Difference Increment 
3 .35 .50 15 1 
4 .51 .67 16 1 
5 .68 .84 16 1 
6 .85 1.10 25 1 
7 1.11 1.17   6 1 
8 1.18 1.34 16 1 
9 1.35 1.50 15 1 
10 1.51 1.67 16 1 
11 1.68 1.84 16 1 
12 1.85 2.10 25 1 

To define the Break Point Table: 

1. On the Tax Rates tab, select a Tax Rate Name and select Use Break Point 
Table. 

2. Click Adjust Break Points to open the Break Point Settings Table. 

 

3. In Min. Taxable Amount, enter the starting point that you previously 
determined. For this example, .11 is the starting point. 

4. In Repeat Start drop-down menu, select the desired repeat start point. 

5. In Repeat End drop-down menu, select the desired repeat end point. 
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6. In Options, check Table is for All Amounts if the break point table covers all 
sales amounts and taxes never revert to a flat tax and do not enter an amount 
in “Tax at Flat Rate above this Amount.” 

7. In Break Point Table ID, select and click the Break Point Table ID to enable to 
add a new or modify existing Diff and Tax Inc. 

8. In the Break Point box (lower right), enter the difference (Diff) between the 
start and end of break point #1 prices. For example, enter .06. The table 
automatically computes .17 as the end of the break point. 

9. In Tax Inc, enter the tax increment, such as .01 (The tax percentage usually 
increases by .01 cent per break point). 

10. Click Delete Break Point to delete the selected break point. 

11. Click Accept Changes to accept the changes made. 

12. Click Cancel Changes to cancel the changes made. 

13. Repeat steps 2 through 9 until you reach the point at which the pattern 
repeats, that is, the point where the difference and the increment begin again 
(See the Difference column in the “Example Worksheet.”) 

 

14. Click Save. 
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Reporting 

Tax Report 

  TAX REPORT 

  NAME    TAX-RATE           ACT-RATE 

          TAXABLE-SALES      TAXES 

          NON-TAX SALES 

 -------------------------------------- 

  STATE     7.000%           7.000% 

         47.90               3.35 

        357.51 

 -------------------------------------- 

  REFUND TAXES              -0.00 

  SALES TAXES                3.40 

 -------------------------------------- 

  TOTAL SALES TAX            3.35 

Sample Tax Flash 
Report 
 
 
 
 
 
All taxes sales 
during the current 
shift. 

Report Details 

• NAME: Name of the tax as assigned in the Tax Rate Form. Each of the following 
report items repeat for each tax defined in the Tax Rate Form. 

• TAX-RATE: Value entered in the ‘Percent’ parameter in the Tax Rate Form for 
the tax name. 

• ACT-RATE: Actual tax rate percentage collected against the total taxable sales 
for this tax name. The following equation is used to calculate the actual rate: 
Actual Rate = (Taxes ÷ Taxable Sales) x 100 

• TAXABLE-SALES: Sum of all item prices that were taxed by this tax name. 

• TAXES: Sum of all taxes collected for this tax name. 
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• NON-TAX SALES: Sum of all item prices not taxed by this tax name. 

• REFUND TAXES: The total amount of taxes deducted due to refunds. 

• SALES TAXES: The total amount of taxes for all sales. 

• TOTAL SALES TAX: Net amount of taxes collected. This number is the total 
sales tax amount minus the total refunded tax amount. 
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Taxable Rebates 
Overview 

Tax laws exist that require sales tax to be collected against the amount of the 
discount when said discount is the result of an agreement between the vendor and 
merchant that provides for the merchant to be reimbursed for all or part of the 
discounted amount.  Such a scenario is termed a “rebate”. 

With the “Taxable Rebate Feature”, a product can now be marketed to the consumer 
at the discounted price while collecting tax against the amount of the rebate.  The 
price book/PLU file reflects the discounted price, the amount of the rebate is stored 
separately and the system adds the amount of the rebate to the transaction’s taxable 
sales total for purposes of calculating tax.  Taxable rebates may be applied at the 
item level when a particular PLU is sold and/or at the promotional level when a 
particular NAXML promotion requirement is met. A single PLU may participate in 
multiple rebates in the same transaction regardless of whether rebates are item or 
promotion-based. 

Note:  In order to legally increase the tax basis of the transaction without 
increasing the before-tax subtotal, use of this feature may involve additional 
requirements such as on-site signage. Compliance with those additional 
requirements is the responsibility of the merchant and/or enterprise. 

Using Taxable Rebates 

The examples provided here assume the following tax definitions: 

         Tax Description    Indicator          Rate 

      State Tax          T             7% 

     County Tax        N             1% 

     City Tax          C             2% 

     Luxury Tax X             5% 

Taxable Rebate on Single Item 

Consumer purchases a single bag of Fritos XXL where a manufacturer rebate of  $ 0.15 
applies. 

  Tax Type              Purchases           Rebate          Taxable           Tax 
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  T(07.000%)              3.00                 0.15             3.15              0.22 

WELCOME TO OUR STORE 

 66666666666-666 

   Description             Qty    Amount 
   -------                 ---    ------ 
T  FRITOS XXL                1      3.00 
+T Tax on Rebate of $ 0.15 
                              ---------- 
                     Subtotal       3.00 
                          Tax       0.22 
         T O T A L               3 . 2 2 
                         CASH  $   10.00 
                       Change  $   -6.78 
Tax Type     Purchases   Rebate   Taxable   Tax 

T(07.000%)   3.00        0.15      3.15    0.22 

  

  

Sample Receipt 

Taxable Rebate on Multiple Quantity Item 

Consumer purchases 2 quantities of Fritos XXL where a manufacturer rebate of $ 0.15 
applies to each bag. 

   Tax Type      Purchases    Rebate     Taxable     Tax 

 T(07.000%)        6.00            0.30         6.30     0.44 
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        WELCOME TO OUR STORE 

              66666666666-666 

     Description             Qty    Amount 
   -------                 ---    ------ 
T  FRITOS XXL                2      6.00 
+T Tax on Rebate of $ 0.30 
                              ---------- 
                     Subtotal       6.00 
                          Tax       0.44 
          T O T A L               6 . 44 
                         CASH  $   10.00 
                       Change  $   -3.56 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)   6.00        0.30     6.30     0.44  

  

  

Sample Receipt 

Taxable Rebate on Item and Item in Combo 

Consumer purchases 2 bags of Fritos XXL plus an 18 PK of 24 oz Bud. 

This purchase qualifies as a promotion resulting in a final price of $1.50 for each of 
the bags of Fritos. 

Fritos XXL has an applied rebate of $ 0.15 per bag. 

A separate rebate applies to the promo itself where $ 0.75 cents of the discounted 
amount is a manufacturer rebate. 

Applicable rebates = 2 x 0.15 + 0.75 = 1.05 

   Tax Type      Purchases    Rebate        Taxable         Tax 

 T(07.000%)       18.99            1.05          20.04        1.40 
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WELCOME TO OUR STORE 

               66666666666-666 

    Description             Qty    Amount 
   -------                 ---    ------ 
T  FRITOS XXL                1      3.00 
        TGATE                      -1.50 
+T Tax on Rebate of $ 0.15 
T  FRITOS XXL                1      3.00 
        TGATE                      -1.50 
+T Tax on Rebate of $ 0.15 
4  BUD 18PK 24OZ             1     15.99 
CUSTOMER ID VERIFIED            
+T Tax on TGATE Rebate of $ 0.75 
                              ---------- 
                     Subtotal      18.99 
                          Tax       1.40 
         T O T A L             2 0 . 3 9    
                         CASH  $   25.00 
                       Change  $   -4.61 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)    18.99       1.05     20.04    1.40  

  

  

Sample Receipt 

Taxable Rebate on Multiple Combos  

Consumer purchases 4 quantities of Fritos XXL plus 2 quantities 18 PK of Bud. 

This purchase qualifies as 2 promotions resulting in a final price of $1.50 for each of 
the 4 bags of Fritos. 

Fritos XXL has an applied rebate of $ 0.15 per bag. 

A separate rebate applies to the promotions where $ 0.75 cents of the discounted 
amount is a manufacturer rebate.  Since this purchase has 2 of these combos, the 
amount of the rebate for the promos is $ 1.50 

Applicable rebates = 4 x 0.15 + 2 x 0.75 = 2.10 

  Tax Type         Purchases       Rebate        Taxable        Tax 

 T(07.000%)          37.98            2.10          40.08          2.80 
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       WELCOME TO OUR STORE  

 66666666666-666  

   Description             Qty    Amount 
   -------                 ---    ------ 
T  FRITOS XXL                1      3.00 
        TGATE PROMO                -1.50 
+T Tax on Rebate of $ 0.15 
T  FRITOS XXL                1      3.00 
        TGATE PROMO                -1.50 
+T Tax on Rebate of $ 0.15 
T  FRITOS XXL                1      3.00 
        TGATE PROMO                -1.50 
+T Tax on Rebate of $ 0.15 
T  FRITOS XXL                1      3.00 
        TGATE PROMO                -1.50 
+T Tax on Rebate of $ 0.15 
T  BUD 18PK 24OZ             1     15.99 
CUSTOMER ID VERIFIED  
T  BUD 18PK 24OZ             1     15.99 
+T Tax on TGATE Rebate of $ 1.50   
                              ---------- 
                     Subtotal      37.98 
                          Tax       2.80 
         T O T A L             4 0 . 7 8     
                         CASH  $   50.00 
                       Change  $   -9.22 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)   37.98      2.10      40.08    2.80 

  

  

Sample Receipt 

Taxable Rebate on Multiple MixMatch 

Consumer purchases 2 2L Pepsi products. 

When purchased as Pepsi 2fer, items are offered at promotional price of $1.59 and a 
taxable rebate of $ 0.20 applies to the promo. 

  Tax Type         Purchases       Rebate      Taxable      Tax 

T(07.000%)           3.18             0.20          3.13         0.24 
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       WELCOME TO OUR STORE 

              66666666666-666 

   Description             Qty    Amount 

   -------                 ---    ------ 
T  PEPSI 2L                  1      1.89 
        PEPSI 2fer                 -0.30 
T  MTN DEW 2L                1      1.89 
        PEPSI 2fer                 -0.30 
+T Tax on PEPSI Rebate of $ 0.20   
                              ---------- 
                     Subtotal       3.18 
                          Tax       0.24 
         T O T A L               3 . 4 2     
                         CASH  $    5.00 
                       Change  $   -1.58 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)    3.18       0.20      3.13     0.24 

  

  

Sample Receipt 

Taxable Rebate on Item, Combo and MixMatch 

Consumer purchases 2 2L Pepsi products (Pepsi 2Fer), 2 Fritos XXL (item eligible 
rebate) and 1 18 PK of 24 OZ Bud (combined with Fritos, eligible for TGate Promo 
Rebate). 

Item Rebates: Fritos 

Combo Rebate:  TGATE 

MixMtch Rebate: PEPSI 

  Tax Type       Purchases    Rebate         Taxable       Tax 

T(07.000%)       22.17            1.25           23.42        1.64 
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       WELCOME TO OUR STORE 

              66666666666-666 

   Description             Qty    Amount 
   -------                 ---    ------ 
T  PEPSI 2L                  1      1.89 
        PEPSI 2fer                 -0.30 
T  MTN DEW 2L                1      1.89 
        PEPSI 2fer                 -0.30 
T  FRITOS XXL                1      3.00 
        TGATE                      -1.50 
+T Tax on Rebate of $ 0.15 
T  FRITOS XXL                1      3.00 
        TGATE                      -1.50 
+T Tax on Rebate of $ 0.15 
4  BUD 18PK 24OZ             1     15.99 
CUSTOMER ID VERIFIED            
+T Tax on PEPSI Rebate of $ 0.20 
+T Tax on TGATE Rebate of $ 0.75 
                              ---------- 
                     Subtotal      22.17 
                          Tax       1.64 
         T O T A L             2 3 . 8 1     
                         CASH  $   30.00 
                       Change  $   -6.19 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)    22.17      1.25     23.42    1.64 

  

  

Sample Receipt 

Taxable Rebate on Multiple Taxes 

Consumer purchases a single JD Breakfast Sandwich which has a taxable rebate of $ 
0.15 

JD Breakfast Sandwich  is flagged with three separate taxes; two of which have 
rebates defined.  

 Tax Type     Purchases        Rebate       Taxable          Tax 

  T(07.000%)       1.79              0.20          1.99            0.14 

  N(01.000%)      1.79              0.00          1.79           0.02 

  C(02.000%)      1.79              0.20          1.99           0.04  
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       WELCOME TO OUR STORE 

             66666666666-666 

    Description             Qty    Amount 

   -------                 ---    ------ 
TNCJD BRKFST SAND            1      1.79 
+T Tax on Rebate of $ 0.20 
+C Tax on Rebate of $ 0.20 
                              ---------- 
                     Subtotal       1.79 
                          Tax       0.20 
         T O T A L               1 . 9 9 
                         CASH  $    2.00 
                       Change  $   -0.01 
Tax Type     Purchases   Rebate   Taxable   Tax 
T(07.000%)    1.79        0.20     1.99     0.14 
N(01.000%)    1.79        0.00     1.79     0.02  
C(02.000%)    1.79        0.20     1.99     0.04 
  

  

  

Sample Receipt 

Configuring Taxable Rebates 

Sales Configuration 

Use Store Operations > Sales > Sales Configuration to enable the taxable rebates 
feature. 
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Price Look Up Manager  

 

Combos (NAXML Promotions) 
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 Match (NAXML Promotions) 

 

Reporting 

Taxable Rebate Report 

For each tax against which taxable rebate is  applied, the taxable rebate report shows 
sales (taxed and tax exempt), rebate amount and a calculated total of the increased 
taxable sales. Totals are shown separately for item based rebates and promo based 
rebates. 
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Time Clock 
Overview 

Use any of the following Payroll Functions to clock in, clock out, or change job code 
to log time spent performing various tasks. Job code numbers are assigned according 
to company policy and procedures. 

Note: Time clock functions are separate from logging into or exiting from sales. 

Clock In / Out 

The "Clock In / Out" function clocks an employee in and out. The Clock In / Out adds 
and removes employees from the POS’ internal time clock, and this information is 
used to calculate the payroll. 

Notes:  

• Employees cannot clock in or out without having a name assigned in 
Employee File. 

• Clock Out function permitted only for employees who are clocked in and 
vice versa. 

Change Job Code 

Use "Change Job Code" function to change the job code. Job codes are used to log 
time spent performing particular job tasks. Also, the job code function logs when a 
new/different job task is begun. 

Using Time Clock 

 Clock In 

 Clock Out 

 Change Job Code 

Clock In 

Use Clock In function in any of the following ways:  

 A specific soft key: [CLOCK IN/OUT] 

 A function under the [OTHER FUNC] 
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From Sales Mode 

1. In Sales Mode, touch [CSR FUNC] 

2. On the left-hand top corner, touch [CLOCK IN/OUT] 

3. ln Payroll Functions > touch [CLOCK IN] 

4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER] 

6. Key the job code number and touch [OK] or press [ENTER]. 

A Clock In receipt prints 

From [OTHER FUNC] Key 

1. Press [OTHER FUNC] 

2. In Other Functions, touch [CLOCK IN/OUT] 

3. ln Payroll Functions, touch [CLOCK IN] 

4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER] 

6. Key the job code number and touch [OK] or press [ENTER], a Clock In 
receipt prints. 

 Clock In 

  Cashier# 1 at 08:01 

  STORE MANAGER 

    Job Code:  1 

  REG# 101 CSH#2   TRAN# 1010004 

  10/10/12 08:01   ST#  AB123 

Sample Clock In 
Receipt 
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Clock In displays just the time in Hours and Minutes you clocked in. 

Clock Out 

Use the Clock Out function in any of the following ways: 

• A specific soft key: [CLOCK IN/OUT] 

• A function under the [OTHER FUNC] 

From Sales Mode 

1. In Sales Mode, touch [CSR FUNC] 

2. On the left-hand top corner, touch [CLOCK IN/OUT] 

3. ln Payroll Functions, touch [CLOCK IN/OUT] 

4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER] 

6. Key the job code number and touch [OK] or press [ENTER] 

A Clock Out receipt prints 

From [OTHER FUNC] Key 

1. Press [OTHER FUNC] 

2. In Other Functions, touch [CLOCK IN/OUT] 

3. ln Payroll Functions, touch [CLOCK OUT] 

4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER], a Clock Out receipt 
prints. 
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   Clock Out 
 Cashier# 2 at 16:01 

 STORE MANAGER 

  JOB                           TOTAL 

 CODE  TIME IN      TIME OUT   HOURS 

 --------------------------------------------------- 

 1   10/10/12 08:00 10/10/12 16:00  08:00 

 123 10/10/12 08:01 10/10/12 16:00  08:00 

   ENDING 10/10/12 16:01    08:00  

   REG# 101 CSH#2           TRAN# 1010004 

   10/04/12 23:59           ST# AB123 

Sample Clock Out 
Receipt 

Clock Out displays each set of clock in/outs.  Time is reported in hours and 
minutes (not in hours and hundredths of hours) on a 24-hour clock since the last 
Payroll Report was run. 

The week ending date is the current date. This is followed by the total hours 
since the last Payroll Report was run. 

The report can be printed either for a specific employee or for all employees. 

Change Job Code 

Use Change Job Code function in any of the following ways: 

• A specific soft key: [CLOCK IN/OUT] 

• A function under the [OTHER FUNC] 

From Sales Mode 

1. In Sales Mode, touch [CSR FUNC] 

2. On the left-hand top corner, touch [CLOCK IN/OUT] 

3. ln the Payroll Functions > Select Payroll Function, touch [CLOCK IN] 
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4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER]. A Clock In receipt 
prints 

  Clock In 

   CASHIER #1  at 07:58  
   
   JOB CODE: 1 

  

   REG # 102  CSH#1         TRAN# 101010 

   10/04/12   22:34         ST#   AB123  
  

Change Job Code 
Sample 

(Clock In Receipt) 

From [OTHER FUNC] Key 

1. Press [OTHER FUNC] 

2. In Other Functions, touch [CLOCK IN/OUT] 

3. ln the Payroll Functions > Select Payroll Function, touch [CLOCK IN] 

4. Key an employee number and touch [OK] or press [ENTER] 

5. Key a password and touch [OK] or press [ENTER]. A Clock Out receipt 
prints followed by a new Clock In receipt with the new job code 

 Clock Out  

 Cashier# 2 at 16:01 

 STORE MANAGER 

  JOB                       TOTAL 

 CODE TIME IN    TIME OUT  HOURS 

------------------------------------------------ 

 1 10/10/12 08:00 10/10/12 16:00 08:00 

Change Job Code 
Sample 

(Clock Out 
receipt prints 
first followed 
by Clock In 
receipt) 
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 2 10/10/12 08:01 10/10/12 16:00 08:00 

  3 10/10/12 08:01 10/10/12 16:00 08:00 

  

  ENDING 10/10/12 16:01    08:00 

  

  REG# 101  CSH#2        TRAN# 1010004 

  10/04/12  23:59        ST# AB123  

  

  Clock In 

   CASHIER #1  at 07:58  
  

   JOB CODE: 2 

  

   REG # 102 CSH#1    TRAN# 1010005 

   10/04/12  22:34    ST# AB123   

Change Job Code 
Sample 

(Clock In Receipt 
with change in Job 
Code from 1 to 2) 

Reporting 

The Payroll Report prints either a current or close payroll report that lists the dates 
and times each employee clocked in and out. If an employee is clocked in when a 
report is run, that employee’s clock out date and time are listed as ‘PENDING’. 

The report must be closed manually from the POS and is separate from any other 
“close” function. The Payroll Report can be printed from the Site Report Navigator.  

The report can be printed for a specific employee (by employee ID number) or for all 
employees. 

Payroll Report Highlights  

• Time is reported in hours and minutes (not in hours and hundredths of hours) 
on a 24-hour clock. For example, a Payroll Report for someone who clocked in 
at 15:44 and clocked out at 23:59 would report Total Hours of 8:15, indicating 
the employee worked 8 hours and 15 minutes. 
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• The payroll report does not reset total hours to zero. 

• The close payroll report does reset total hours to zero. 

• The report can be printed either for a specific employee or for all employees. 

  05/17/02                       11:51 

 CURRENT PAYROLL REPORT 

 ------------------------------------- 

 001 JO MARCH 

 265-45-9876 

 TIME IN         TIME OUT       TOTAL 

                                HOURS 

 ------------------------------------- 

 05-15-02  11:00 05-15-02 19:00  8:00 

 05-16-02  12:00 05-16-02 19:00  7:00 

  

 ENDING 05-18-02                15:00 

  

 EMPLOYEE SIGNATURE: 

 ------------------------------------- 

 MANAGER SIGNATURE: 

 ------------------------------------- 

  002 PETER WOLF 

 129-28-1038 

   TOTAL 

 TIME IN         TIME OUT        HOURS 

Sample Payroll Report 
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 -------------------------------------- 

 05-15-02 15:44  05-15-02 23:59  8:15 

 05-16-02 12:00  PENDING  

 ENDING 05-18-02 8:15  

 EMPLOYEE SIGNATURE: 

 -------------------------------------- 

 MANAGER SIGNATURE: 

 -------------------------------------- 

  

If no employees have clocked in or out during the payroll period chosen, 
“*** No Records Found ***” prints on the report. 

Troubleshooting 

# Message Description / Action 

E1126 MUST CLOCK OUT 
FIRST 

Employee attempted to clock in, but has not 
clocked out yet. 

E1127 MUST CLOCK IN FIRST Employee attempted to clock out, but had not 
clocked in yet. 

E1206 PAYROLL RECORD FULL Run the Payroll Report function. 

E1208 MUST CLOCK OUT 
FIRST Must clock out before trying to clock in. 

E1209 MUST CLOCK IN FIRST Must clock in before trying to clock out. 

E7023 LAN COMMS DOWN 

Journal Only: Attempted to clock in or out or 
tried to reprint a clock in or out ticket and the 
LAN was down. See the site’s procedures for 
handling this situation. 
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Transactions 
Overview 

A transaction is any function that can affect the total amount in the drawer.  Our 
system supports several types, including: 

 Sales 

 Refunds 

 Pay In 

 Pay Out 

 Safe Drop 

 Safe Loan 

The last four items in the above list are discussed in separate sections. Sales and 
Refunds do not occur in the same transaction.  

There are a few additional functions that work on a transaction by transaction basis: 

 Suspend / Recall Transaction (Sales and/or Refunds only) 

 Ticket Print (any completed or suspended transaction) 

Using Transactions 

Refund 

1. Press [REFUND] 

2. Enter items to be refunded, following store policies and procedures 

3. Press [TOTAL] if required 

4. Press [MOP] 

Note: If refunding a card payment additional information may be required by 
the card processor. 

 



Transactions 

614 

Recall Pending Transactions 

This function can be used in one of the following two ways: 

 A specific soft key: [SUSP] 

 A function under the [OTHER FUNC] key 

1. Do one of the following:  

 Press [SUSP] 

 Press [Other Func], select “View Pending Transactions (Recall)" 
from the list and press [ENTER] 

2. If only one transaction is pending it will be automatically recalled. If 
more than one transaction is pending, touch the appropriate transaction 
(to recall) from the list 

Suspend Transaction 

1. Press [SUSP] 

The transaction gets suspended 

Note: Transaction cannot be suspended if it includes a prepaid fuel sale. 

Ticket Print 

The most recent transaction is always displayed at the top of the list and 
highlighted. 

 To print most recent transaction, press [TICKET PRINT] [ENTER] 

 To print older transaction, press [TICKET PRINT] and then either key the 
entry number or touch the transaction to be printed.  Use down arrow to 
view older transactions. 
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Configuring Transactions  

Parameter Path Value Description 

Allow 
Suspended 
Sales 

Reporting > Report 
Configuration Yes, No Allows a period close when 

suspended sales are present.  

Force Refund 
Print 

Store Operations > 
Sales > Sales 
Configuration 

Yes, No 

Select to print a refund 
receipt when the cashier 

performs a refund in the Sales 
mode. 

(If not selected, the refund 
prints on the journal only.) 

Print Receipt 
Store Operations > 
Sales > Sales 
Configuration 

Yes, No 

Select to print a receipt for 
every transaction. 

(If not selected, a receipt will 
only print for No Sale, 

Pay In, Pay Out, Clock 
in/Clock Out, Void, car wash, 

POP Discounts, and Credit 
transactions or when using the 
[TICKET PRINT] key.) 

Reporting 

All transaction types occurring within a reporting period are represented on Summary 
and Cashier Reports for that period. 

Sales, Refunds, Pay in and Pay Out are all represented on the Summary and Cashier 
Reports with “Safe Drop” being included as a type of “Pay Out” and “Safe Loan” as a 
type of “Pay In”. 

Suspended Sales are represented as memo items in those same reports as shown 
below: 
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                                        MEMO ITEMS      
SUSPENDED             2          3.39 

SUSPEND/VOID          1          0.65 

UNSETTLED SUSPENDS    1          2.08    

    

Sample Memo Items 
showing number and 
amount of suspended 
transactions in 
Cashier, Summary 
and Close Shift 
Reports 

Report Details 

 SUSPENDED: Number of times and total amount of suspended transactions. 
This happens when the [SUSPEND] key is used to suspend and then recall a 
transaction. If a single transaction is suspended more than once, each time the 
transaction is suspended adds to the total number and amount of suspends. 

 SUSPEND/VOID: Number of times and total amount of suspended transactions 
that were voided rather than settled. 

 UNSETTLED SUSPENDS: The number and amount of transactions suspended at 
the time a period is closed. 

Troubleshooting 

      #  Message  Description/Action 

  (#) RECEIPT(S) 
PENDING 

The indicated number of transactions (#) are 
suspended. 

  

NETWORK 
SUSPENDED 
TRANSACTION 

The controller is retrieving a network suspended 
transaction from a workstation. 

  SUSPENDED 
TRANSACTION 

A transaction is currently suspended. 

E1155 
NO PENDING 
TRANSACTIONS 

Appears if the View Pending Transactions 
function is selected and there are no suspended 
transactions. 

E1157 
UNABLE TO 
SUSPEND 

Sale cannot be suspended. Perhaps the maximum 
number of 

suspended sales have been exceeded. 
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      #  Message  Description/Action 

E1160 
MAXIMUM PENDING 
TRANS. EXCEEDED 

Too many transactions are suspended. Only one 
credit transaction can be suspended at a time. 

E1162 
NEED TO SETTLE 
PENDING TRANS. 

Attempted to close a shift while a network 
transaction is suspended. Settle the pending 
transaction and then close the shift. 

E1187 

NETWORK 
SUSPENDED 
TRANSACTION 

Attempted to recall a network transaction from a 
different  terminal than the one on which the 
transaction was suspended. Use the same 
terminal to recall the transaction. 

E1283 
SUSPEND WITH 
FUEL INVALID 

Attempted to suspend a transaction with a 
prepaid fuel sale, which is not allowed. 
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